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How Simulink Works

The following sections explain how Simulink® models and simulates dynamic
systems. This information can be helpful in creating models and interpreting

simulation results.

Introduction (p. 1-2)
Modeling Dynamic Systems (p. 1-3)

Simulating Dynamic Systems
(p. 1-14)

Modeling and Simulating Discrete
Systems (p. 1-31)

Brief overview of Simulink.

How Simulink models a dynamic
system.

How Simulink simulates a dynamic
system.

How Simulink models and simulates
discrete systems.



1 How Simulink Works

1-2

Introduction

Simulink is a software package that enables you to model, simulate, and
analyze systems whose outputs change over time. Such systems are often
referred to as dynamic systems. Simulink can be used to explore the behavior
of a wide range of real-world dynamic systems, including electrical circuits,
shock absorbers, braking systems, and many other electrical, mechanical, and
thermodynamic systems. This section explains how Simulink works.

Simulating a dynamic system is a two-step process with Simulink. First,

a user creates a block diagram, using the Simulink model editor, that
graphically depicts time-dependent mathematical relationships among the
system’s inputs, states, and outputs. The user then commands Simulink to
simulate the system represented by the model from a specified start time to
a specified stop time.



Modeling Dynamic Systems

Modeling Dynamic Systems

A Simulink block diagram model is a graphical representation of a
mathematical model of a dynamic system. A mathematical model of a dynamic
system is described by a set of equations. The mathematical equations
described by a block diagram model are known as algebraic, differential,
and/or difference equations.

Block Diagram Semantics

A classic block diagram model of a dynamic system graphically consists

of blocks and lines (signals). The history of these block diagram model is
derived from engineering areas such as Feedback Control Theory and Signal
Processing. A block within a block diagram defines a dynamic system in
itself. The relationships between each elementary dynamic system in a
block diagram are illustrated by the use of signals connecting the blocks.
Collectively the blocks and lines in a block diagram describe an overall
dynamic system.

Simulink extends these classic block diagram models by introducing the
notion of two classes of blocks, nonvirtual block and virtual blocks. Nonvirtual
blocks represent elementary systems. A virtual block is provided for graphical
organizational convenience and plays no role in the definition of the system of
equations described by the block diagram model. Examples of virtual blocks
are the Bus Creator and Bus Selector which are used to reduce block diagram
clutter by managing groups of signals as a "bundle." You can use virtual
blocks to improve the readability of your models.

In general, block and lines can be used to describe many "models of
computations." One example would be a flow chart. A flow chart consists of
blocks and lines, but one cannot describe general dynamic systems using
flow chart semantics.

The term "time-based block diagram" is used to distinguish block diagrams
that describe dynamic systems from that of other forms of block diagrams. In
Simulink, we use the term block diagram (or model) to refer to a time-based
block diagram unless the context requires explicit distinction.

To summarize the meaning of time-based block diagrams:
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® Simulink block diagrams define time-based relationships between signals
and state variables. The solution of a block diagram is obtained by
evaluating these relationships over time, where time starts at a user
specified "start time" and ends at a user specified "stop time." Each
evaluation of these relationships is referred to as a time step.

® Signals represent quantities that change over time and are defined for all
points in time between the block diagram’s start and stop time.

® The relationships between signals and state variables are defined by a set
of equations represented by blocks. Each block consists of a set of equations
(block methods). These equations define a relationship between the input
signals, output signals and the state variables. Inherent in the definition
of a equation is the notion of parameters, which are the coefficients found
within the equation.

Creating Models

Simulink provides a graphical editor that allows you to create and connect
instances of block types (see , Chapter 3, “Creating a Model”, ) selected from
libraries of block types (see Blocks—Alphabetical List) via a library browser.
Simulink provides libraries of blocks representing elementary systems that
can be used as building blocks. The blocks supplied with Simulink are called
built-in blocks. Simulink users can also create their own block types and use
the Simulink editor to create instances of them in a diagram. User-defined
blocks are called custom blocks.

Time

Time is an inherent component of block diagrams in that the results of a block
diagram simulation change with time. Put another way, a block diagram
represents the instantaneous behavior of a dynamic system. Determining

a system’s behavior over time thus entails repeatedly solving the model at
intervals, called time steps, from the start of the time span to the end of the
time span. Simulink refers to the process of solving a model at successive time
steps as simulating the system that the model represents.

States

Typically the current values of some system, and hence model, outputs are
functions of the previous values of temporal variables. Such variables are
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called states. Computing a model’s outputs from a block diagram hence
entails saving the value of states at the current time step for use in computing
the outputs at a subsequent time step. Simulink performs this task during
simulation for models that define states.

Two types of states can occur in a Simulink model: discrete and continuous
states. A continuous state changes continuously. Examples of continuous
states are the position and speed of a car. A discrete state is an approximation
of a continuous state where the state is updated (recomputed) using finite
(periodic or aperiodic) intervals. An example of a discrete state would be the
position of a car shown on a digital odometer where it is updated every second
as opposed to continuously. In the limit, as the discrete state time interval
approaches zero, a discrete state becomes equivalent to a continuous state.

Blocks implicitly define a model’s states. In particular, a block that needs
some or all of its previous outputs to compute its current outputs implicitly
defines a set of states that need to be saved between time steps. Such a block
is said to have states.

The following is a graphical representation of a block that has states:

X
S — (states) »
[1nput) foutput)

Blocks that define continuous states include the following standard Simulink
blocks:

¢ Integrator

® State-Space

e Transfer Fen

e Zero-Pole

The total number of a model’s states is the sum of all the states defined

by all its blocks. Determining the number of states in a diagram requires

parsing the diagram to determine the types of blocks that it contains and
then aggregating the number of states defined by each instance of a block

1-5
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type that defines states. Simulink performs this task during the Compilation
phase of a simulation.

Working with States

Simulink provides the following facilities for determining, initializing, and
logging a model’s states during simulation:

® The model command and the Simulink debugger’s states command
display information about the states defined by a model, including the total
number of states defined by the model, the block that defines each state,
and the initial value of each state.

¢ The Simulink debugger displays the value of a state at each time step
during a simulation (see , Chapter 12, “Simulink Debugger”, ).

¢ The Data Import/Export pane of a model’s Configuration Parameters
dialog box (see “Importing and Exporting States” on page 9-24) allows you
to specify initial values for a model’s states and instruct Simulink to record
the values of the states at each time step during simulation as an array or
structure variable in the MATLAB® workspace.

Continuous States

Computing a continuous state entails knowing its rate of change, or derivative.
Since the rate of change of a continuous state typically itself changes
continuously (i.e., is itself a state), computing the value of a continuous state
at the current time step entails integration of its derivative from the start of
a simulation. Thus modeling a continuous state entails representing the
operation of integration and the process of computing the state’s derivative at
each point in time. Simulink block diagrams use Integrator blocks to indicate
integration and a chain of operator blocks connected to the integrator block
to represent the method for computing the state’s derivative. The chain

of block’s connected to the Integrator’s is the graphical counterpart to an
ordinary differential equation (ODE).

In general, excluding simple dynamic systems, analytical methods do not
exist for integrating the states of real-world dynamic systems represented
by ordinary differential equations. Integrating the states requires the use
of numerical methods called ODE solvers. These various methods trade
computational accuracy for computational workload. Simulink comes with
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computerized implementations of the most common ODE integration methods
and allows a user to determine which it uses to integrate states represented
by Integrator blocks when simulating a system.

Computing the value of a continuous state at the current time step entails
integrating its values from the start of the simulation. The accuracy of
numerical integration in turn depends on the size of the intervals between
time steps. In general, the smaller the time step, the more accurate the
simulation. Some ODE solvers, called variable time step solvers, can
automatically vary the size of the time step, based on the rate of change

of the state, to achieve a specified level of accuracy over the course of a
simulation. Simulink allows the user to specify the size of the time step in
the case of fixed-step solvers or allow the solver to determine the step size in
the case of variable-step solvers. To minimize the computation workload, the
variable-step solver chooses the largest step size consistent with achieving an
overall level of precision specified by the user for the most rapidly changing
model state. This ensures that all model states are computed to the accuracy
specified by the user.

Discrete States

Computing a discrete state requires knowing the relationship between the
current time and its value at the time at which it previously changed value.
Simulink refers to this relationship as the state’s update function. A discrete
state depends not only on its value at the previous time step but also on the
values of a model’s inputs. Modeling a discrete state thus entails modeling the
state’s dependency on the systems’ inputs at the previous time step. Simulink
block diagrams use specific types of blocks, called discrete blocks, to specify
update functions and chains of blocks connected to the inputs of the block’s
to model the state’s dependency on system inputs.

As with continuous states, discrete states set a constraint on the simulation
time step size. Specifically a step size must be chosen that ensure that all the
sample times of the model’s states are hit. Simulink assigns this task to a
component of the Simulink system called a discrete solver. Simulink provides
two discrete solvers: a fixed-step discrete solver and a variable-step discrete
solver. The fixed-step discrete solver determines a fixed step size that hits all
the sample times of all the model’s discrete states, regardless of whether

the states actually change value at the sample time hits. By contrast, the
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variable-step discrete solver varies the step size to ensure that sample time
hits occur only at times when the states change value.

Modeling Hybrid Systems

A hybrid system is a system that has both discrete and continuous states.
Strictly speaking, Simulink treats any model that has both continuous and
discrete sample times as a hybrid model, presuming that the model has
both continuous and discrete states. Solving such a model entails choosing
a step size that satisfies both the precision constraint on the continuous
state integration and the sample time hit constraint on the discrete states.
Simulink meets this requirement by passing the next sample time hit,

as determined by the discrete solver, as an additional constraint on the
continuous solver. The continuous solver must choose a step size that
advances the simulation up to but not beyond the time of the next sample
time hit. The continuous solver can take a time step short of the next sample
time hit to meet its accuracy constraint but it cannot take a step beyond the
next sample time hit even if its accuracy constraint allows it to.

Block Parameters

Key properties of many standard blocks are parameterized. For example,
the Constant value of the Simulink Constant block is a parameter. Each
parameterized block has a block dialog that lets you set the values of the
parameters. You can use MATLAB expressions to specify parameter values.
Simulink evaluates the expressions before running a simulation. You can
change the values of parameters during a simulation. This allows you to
determine interactively the most suitable value for a parameter.

A parameterized block effectively represents a family of similar blocks. For
example, when creating a model, you can set the Constant value parameter of
each instance of the Constant block separately so that each instance behaves
differently. Because it allows each standard block to represent a family of
blocks, block parameterization greatly increases the modeling power of the
standard Simulink libraries.

Tunable Parameters

Many block parameters are tunable. A tunable parameter is a parameter
whose value can be changed without recompiling the model (see “Model
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Compilation” on page 1-14 for more information on compiling a Simulink
model). For example, the gain parameter of the Gain block is tunable. You
can alter the block’s gain while a simulation is running. If a parameter is
not tunable and the simulation is running, Simulink disables the dialog box
control that sets the parameter.

Note Simulink does not allow you to change the values of source block
parameters through either a dialog box or the Model Explorer while a
simulation is running. Opening the dialog box of a source block with tunable
parameters causes a running simulation to pause. While the simulation

is paused, you can edit the parameter values displayed on the dialog box.
However, you must close the dialog box to have the changes take effect and
allow the simulation to continue.

It should be pointed out that parameter changes do not immediately occur,
but are queued up and then applied at the start of the next time step during
model execution. Returning to our example of the constant block, the function
it defines is signal(t) = ConstantValue for all time. If we were to allow the
constant value to be changed immediately, then the solution at the point in
time at which the change occurred would be invalid. Thus we must queue the
change for processing at the next time step.

You can use the Inline parameters option on the Optimization pane of the
Model Parameter Configuration Dialog Box to specify that all parameters
in your model are nontunable except for those that you specify. This can
speed up execution of large models and enable generation of faster code from
your model. See “Model Parameter Configuration Dialog Box” on page 9-66
for more information.

Block Sample Times

Every Simulink block is considered to have a sample time, even continuous
blocks (e.g., blocks that define continuous states, such as the Integrator
block) and blocks that do not define states, such as the Gain block. Discrete
blocks allows you to specify their sample times via a Sample Time parameter.
Continuous blocks are considered to have an infinitesimal sample time called
a continuous sample time. A block that is neither discrete or continuous is
said to have an implicit sample time that it inherits from its inputs. The
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implicit sample time is continuous if any of the block’s inputs are continuous.
Otherwise, the implicit sample time is discrete. An implicit discrete sample
time is equal to the shortest input sample time if all the input sample times
are integer multiples of the shortest time. Otherwise, the implicit sample time
is equal to the fundamental sample time of the inputs, where the fundamental
sample time of a set of sample times is defined as the greatest integer divisor
of the set of sample times.

Simulink can optionally color code a block diagram to indicate the sample
times of the blocks it contains, e.g., black (continuous), magenta (constant),
yellow (hybrid), red (fastest discrete), and so on. See “Mixed Continuous and
Discrete Systems” on page 1-41 for more information.

Custom Blocks

Simulink allows you to create libraries of custom blocks that you can

then use in your models. You can create a custom block either graphically
or programmatically. To create a custom block graphically, you draw a
block diagram representing the block’s behavior, wrap this diagram in an
instance of the Simulink Subsystem block, and provide the block with a
parameter dialog, using the Simulink block mask facility. To create a block
programmatically, you create an M-file or a MEX-file that contains the block’s
system functions (see “Writing S-Functions” in the Simulink documentation).
The resulting file is called an S-function. You then associate the S-function
with instances of the Simulink S-Function block in your model. You can add
a parameter dialog to your S-Function block by wrapping it in a Subsystem
block and adding the parameter dialog to the Subsystem block.

Systems and Subsystems

A Simulink block diagram can consist of layers. Each layer is defined by a
subsystem. A subsystem is part of the overall block diagram and ideally has
no impact on the meaning of the block diagram. Subsystems are provided
primarily to help in the organization aspects a block diagram. Subsystems do
not define a separate block diagram.

Simulink differentiates between two different types of subsystems: virtual
and nonvirtual. The main difference is that nonvirtual subsystems provide
the ability to control when the contents of the subsystem are evaluated.
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Flattening the Model Hierarchy

While preparing a model for execution, Simulink generates internal "systems"
that are collections of block methods (equations) that are evaluated together.
The semantics of time-based block diagrams doesn’t require creation of these
systems. Simulink creates these internal systems as a means to manage the
execution of the model. Roughly speaking, there will be one system for the
top-level block diagram which is referred to as the root system, and several
lower-level systems derived from nonvirtual subsystems and other elements
in the block diagram. You will see these systems in the Simulink Debugger.
The act of creating these internal systems is often referred to as flattening
the model hierarchy.

Conditionally Executed Subsystems

You can create conditionally executed subsystems that are executed only
when a transition occurs on a triggering, function-call, action, or enabling
input (see “Creating Conditionally Executed Subsystems” on page 3-35).
Conditionally executed subsystems are atomic, i.e., the equations that they
define are evaluated as a unit.

Atomic Subsystems

Unconditionally executed subsystems are virtual by default. You can,
however, designate an unconditionally executed subsystem as atomic (see the
Atomic Subsystem). This is useful if you need to ensure that the equations
defined by a subsystem are evaluated as a unit.

Signals

Simulink uses the term signal to refer to a time varying quantity that has
values at all points in time. Simulink allows you to specify a wide range of
signal attributes, including signal name, data type (e.g., 8-bit, 16-bit, or 32-bit
integer), numeric type (real or complex), and dimensionality (one-dimensional
or two-dimensional array). Many blocks can accept or output signals of any
data or numeric type and dimensionality. Others impose restrictions on the
attributes of the signals they can handle.

On the block diagram, you will find that the signals are represented with lines

that have an arrowhead. The source of the signal corresponds to the block
that writes to the signal during evaluation of its block methods (equations).
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The destinations of the signal are blocks that read the signal during the
evaluation of its block methods (equations). A good analogy of the meaning
of a signal is to consider a classroom. The teacher is the one responsible for
writing on the white board and the students read what is written on the white
board when they choose to. This is also true of Simulink signals, a reader of
the signal (a block method) can choose to read the signal as frequently or
infrequently as so desired.

Block Methods

Blocks represent multiple equations. These equations are represented

as block methods within Simulink. These block methods are evaluated
(executed) during the execution of a block diagram. The evaluation of these
block methods is performed within a simulation loop, where each cycle
through the simulation loop represent evaluation of the block diagram at

a given point in time.

Method Types

Simulink assigns names to the types of functions performed by block methods.
Common method types include:

® QOutputs

Computes the outputs of a block given its inputs at the current time step
and its states at the previous time step.

e Update

Computes the value of the block’s discrete states at the current time step,
given its inputs at the current time step and its discrete states at the
previous time step.

® Derivatives

Computes the derivatives of the block’s continuous states at the current
time step, given the block’s inputs and the values of the states at the
previous time step.
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Method Naming Convention

Block methods perform the same types of operations in different ways for
different types of blocks. The Simulink user interface and documentation uses
dot notation to indicate the specific function performed by a block method:

BlockType.MethodType

For example, Simulink refers to the method that computes the outputs of
a Gain block as

Gain.OQutputs

The Simulink debugger takes the naming convention one step further and
uses the instance name of a block to specify both the method type and the
block instance on which the method is being invoked during simulation, e.g.,

g1.0utputs

Model Methods

In addition to block methods, Simulink also provides a set of methods that
compute the model’s properties and its outputs. Simulink similarly invokes
these methods during simulation to determine a model’s properties and its
outputs. The model methods generally perform their tasks by invoking block
methods of the same type. For example, the model Outputs method invokes
the Outputs methods of the blocks that it contains in the order specified by
the model to compute its outputs. The model Derivatives method similarly
invokes the Derivatives methods of the blocks that it contains to determine
the derivatives of its states.
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Simulating a dynamic system refers to the process of computing a system’s
states and outputs over a span of time, using information provided by the
system’s model. Simulink simulates a system when you choose Start from
the Model Editor’s Simulation menu, with the system’s model open.

A Simulink component called the Simulink Engine responds to a Start
command, performing the following steps.

Model Compilation

First, the Simulink engine invokes the model compiler. The model compiler
converts the model to an executable form, a process called compilation. In
particular, the compiler

e Evaluates the model’s block parameter expressions to determine their
values.

* Determines signal attributes, e.g., name, data type, numeric type, and
dimensionality, not explicitly specified by the model and checks that each
block can accept the signals connected to its inputs.

® Simulink uses a process called attribute propagation to determine
unspecified attributes. This process entails propagating the attributes of a
source signal to the inputs of the blocks that it drives.

¢ Performs block reduction optimizations.

¢ Flattens the model hierarchy by replacing virtual subsystems with the
blocks that they contain (see “Solvers” on page 1-17).

® Determines the block sorted order (see “Controlling and Displaying the
Sorted Order” on page 4-23 for more information).

® Determines the sample times of all blocks in the model whose sample times
you did not explicitly specify (see “Sample Time Propagation” on page 1-36).

Link Phase

In this phase, the Simulink Engine allocates memory needed for working
areas (signals, states, and run-time parameters) for execution of the block
diagram. It also allocates and initializes memory for data structures that
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store run-time information for each block. For built-in blocks, the principal
run-time data structure for a block is called the SimBlock. It stores pointers
to a block’s input and output buffers and state and work vectors.

Method Execution Lists

In the Link phase, the Simulink engine also creates method execution lists.
These lists list the most efficient order in which to invoke a model’s block
methods to compute its outputs. Simulink uses the block sorted order lists
generated during the model compilation phase to construct the method
execution lists.

Block Priorities

Simulink allows you to assign update priorities to blocks (see “Assigning
Block Priorities” on page 4-25 ). Simulink executes the output methods of
higher priority blocks before those of lower priority blocks. Simulink honors
the priorities only if they are consistent with its block sorting rules.

Simulation Loop Phase

The simulation now enters the simulation loop phase. In this phase, the
Simulink engine successively computes the states and outputs of the
system at intervals from the simulation start time to the finish time, using
information provided by the model. The successive time points at which the
states and outputs are computed are called time steps. The length of time
between steps is called the step size. The step size depends on the type of
solver (see “Solvers” on page 1-17) used to compute the system’s continuous
states, the system’s fundamental sample time (see “Modeling and Simulating
Discrete Systems” on page 1-31), and whether the system’s continuous states
have discontinuities (see “Zero-Crossing Detection” on page 1-19).

The Simulation Loop phase has two subphases: the Loop Initialization phase
and the Loop Iteration phase. The initialization phase occurs once, at the
start of the loop. The iteration phase is repeated once per time step from the
simulation start time to the simulation stop time.

At the start of the simulation, the model specifies the initial states and

outputs of the system to be simulated. At each step, Simulink computes new
values for the system’s inputs, states, and outputs and updates the model to
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reflect the computed values. At the end of the simulation, the model reflects
the final values of the system’s inputs, states, and outputs. Simulink provides
data display and logging blocks. You can display and/or log intermediate
results by including these blocks in your model.

Loop Iteration
At each time step, the Simulink Engine

1 Computes the model’s outputs.

The Simulink Engine initiates this step by invoking the Simulink model
Outputs method. The model Outputs method in turn invokes the model
system Outputs method, which invokes the Outputs methods of the blocks
that the model contains in the order specified by the Outputs method
execution lists generated in the Link phase of the simulation (see “Solvers”
on page 1-17).

The system Outputs method passes the following arguments to each
block Outputs method: a pointer to the block’s data structure and to its
SimBlock structure. The SimBlock data structures point to information
that the Outputs method needs to compute the block’s outputs, including
the location of its input buffers and its output buffers.

2 Computes the model’s states.

The Simulink Engine computes a model’s states by invoking a solver. Which
solver it invokes depends on whether the model has no states, only discrete
states, only continuous states, or both continuous and discrete states.

If the model has only discrete states, the Simulink Engine invokes the
discrete solver selected by the user. The solver computes the size of the
time step needed to hit the model’s sample times. It then invokes the
Update method of the model. The model Update method invokes the
Update method of its system, which invokes the Update methods of each of
the blocks that the system contains in the order specified by the Update
method lists generated in the Link phase.

If the model has only continuous states, the Simulink Engine invokes the
continuous solver specified by the model. Depending on the solver, the
solver either in turn calls the Derivatives method of the model once or
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enters a subcycle of minor time steps where the solver repeatedly calls
the model’s Outputs methods and Derivatives methods to compute the
model’s outputs and derivatives at successive intervals within the major
time step. This is done to increase the accuracy of the state computation.
The model Outputs method and Derivatives methods in turn invoke their
corresponding system methods, which invoke the block Outputs and
Derivatives in the order specified by the Outputs and Derivatives methods
execution lists generated in the Link phase.

3 Optionally checks for discontinuities in the continuous states of blocks.

Simulink uses a technique called zero-crossing detection to detect
discontinuities in continuous states. See “Zero-Crossing Detection” on page
1-19 for more information.

4 Computes the time for the next time step.

Simulink repeats steps 1 through 4 until the simulation stop time is reached.

Solvers

Simulink simulates a dynamic system by computing its states at successive
time steps over a specified time span, using information provided by the
model. The process of computing the successive states of a system from its
model is known as solving the model. No single method of solving a model
suffices for all systems. Accordingly, Simulink provides a set of programs,
known as solvers, that each embody a particular approach to solving a model.
The Configuration Parameters dialog box allows you to choose the solver
most suitable for your model (see “Choosing a Solver Type” on page 9-7).

Fixed-Step Solvers Versus Variable-Step Solvers
Simulink solvers fall into two basic categories: fixed-step and variable-step.

Fixed-step solvers solve the model at regular time intervals from the beginning
to the end of the simulation. The size of the interval is known as the step size.
You can specify the step size or let the solver choose the step size. Generally,
decreasing the step size increases the accuracy of the results while increasing
the time required to simulate the system.
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Variable-step solvers vary the step size during the simulation, reducing the
step size to increase accuracy when a model’s states are changing rapidly and
increasing the step size to avoid taking unnecessary steps when the model’s
states are changing slowly. Computing the step size adds to the computational
overhead at each step but can reduce the total number of steps, and hence
simulation time, required to maintain a specified level of accuracy for models
with rapidly changing or piecewise continuous states.

Continuous Versus Discrete Solvers
Simulink provides both continuous and discrete solvers.

Continuous solvers use numerical integration to compute a model’s continuous
states at the current time step from the states at previous time steps and the
state derivatives. Continuous solvers rely on the model’s blocks to compute
the values of the model’s discrete states at each time step.

Mathematicians have developed a wide variety of numerical integration
techniques for solving the ordinary differential equations (ODEs) that
represent the continuous states of dynamic systems. Simulink provides

an extensive set of fixed-step and variable-step continuous solvers, each
implementing a specific ODE solution method (see “Choosing a Solver Type”
on page 9-7).

Discrete solvers exist primarily to solve purely discrete models. They compute
the next simulation time step for a model and nothing else. They do not
compute continuous states and they rely on the model’s blocks to update the
model’s discrete states.

Note You can use a continuous solver, but not a discrete solver, to solve a
model that contains both continuous and discrete states. This is because a
discrete solver does not handle continuous states. If you select a discrete
solver for a continuous model, Simulink disregards your selection and uses a
continuous solver instead when solving the model.

Simulink provides two discrete solvers, a fixed-step discrete solver and a
variable-step discrete solver. The fixed-step solver by default chooses a step
size and hence simulation rate fast enough to track state changes in the
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fastest block in your model. The variable-step solver adjusts the simulation
step size to keep pace with the actual rate of discrete state changes in your
model. This can avoid unnecessary steps and hence shorten simulation time
for multirate models (see “Determining Step Size for Discrete Systems” on
page 1-35 for more information).

Minor Time Steps

Some continuous solvers subdivide the simulation time span into major and
minor time steps, where a minor time step represents a subdivision of the
major time step. The solver produces a result at each major time step. It
uses results at the minor time steps to improve the accuracy of the result at
the major time step.

Zero-Crossing Detection

When simulating a dynamic system, Simulink checks for discontinuities in
the system’s state variables at each time step, using a technique known as
zero-crossing detection. If Simulink detects a discontinuity within the current
time step, it determines the precise time at which the discontinuity occurs and
takes additional time steps before and after the discontinuity. This section
explains why zero-crossing detection is important and how it works.

Discontinuities in state variables often coincide with significant events in the
evolution of a dynamic system. For example, the instant when a bouncing
ball hits the floor coincides with a discontinuity in its velocity. Because
discontinuities often indicate a significant change in a dynamic system, it

is important to simulate points of discontinuity precisely. Otherwise, a
simulation could lead to false conclusions about the behavior of the system
under investigation. Consider, for example, a simulation of a bouncing ball.
If the point at which the ball hits the floor occurs between simulation steps,
the simulated ball appears to reverse position in midair. This might lead an
investigator to false conclusions about the physics of the bouncing ball.

To avoid such misleading conclusions, it is important that simulation steps
occur at points of discontinuity. A simulator that relies purely on solvers
to determine simulation times cannot efficiently meet this requirement.
Consider, for example, a fixed-step solver. A fixed-step solver computes the
values of state variables at integral multiples of a fixed step size. However,
there is no guarantee that a point of discontinuity will occur at an integral
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multiple of the step size. You could reduce the step size to increase the
probability of hitting a discontinuity, but this would greatly increase the
execution time.

A variable-step solver appears to offer a solution. A variable-step solver
adjusts the step size dynamically, increasing the step size when a variable

is changing slowly and decreasing the step size when the variable changes
rapidly. Around a discontinuity, a variable changes extremely rapidly. Thus,
in theory, a variable-step solver should be able to hit a discontinuity precisely.
The problem is that to locate a discontinuity accurately, a variable-step solver
must again take many small steps, greatly slowing down the simulation.

How Zero-Crossing Detection Works

Simulink uses a technique known as zero-crossing detection to address this
problem. With this technique, a block can register a set of zero-crossing
variables with Simulink, each of which is a function of a state variable that
can have a discontinuity. The zero-crossing function passes through zero from
a positive or negative value when the corresponding discontinuity occurs. At
the end of each simulation step, Simulink asks each block that has registered
zero-crossing variables to update the variables. Simulink then checks whether
any variable has changed sign since the last step. Such a change indicates
that a discontinuity occurred in the current time step.

If any zero crossings are detected, Simulink interpolates between the previous
and current values of each variable that changed sign to estimate the times of
the zero crossings (e.g., discontinuities). Simulink then steps up to and over
each zero crossing in turn. In this way, Simulink avoids simulating exactly at
the discontinuity, where the value of the state variable might be undefined.

Zero-crossing detection enables Simulink to simulate discontinuities
accurately without resorting to excessively small step sizes. Many Simulink
blocks support zero-crossing detection. The result is fast and accurate
simulation of all systems, including systems with discontinuities.
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Implementation Details

An example of a Simulink block that uses zero crossings is the Saturation
block. Zero crossings detect these state events in the Saturation block:

® The input signal reaches the upper limit.

® The input signal leaves the upper limit.

® The input signal reaches the lower limit.

® The input signal leaves the lower limit.

Simulink blocks that define their own state events are considered to have
intrinsic zero crossings. If you need explicit notification of a zero-crossing

event, use the Hit Crossing block. See “Blocks with Zero Crossings” on page
1-22 for a list of blocks that incorporate zero crossings.

The detection of a state event depends on the construction of an internal
zero-crossing signal. This signal is not accessible by the block diagram. For
the Saturation block, the signal that is used to detect zero crossings for the
upper limit is zcSignal = UpperLimit - u, where u is the input signal.

Zero-crossing signals have a direction attribute, which can have these values:
® rising - A zero crossing occurs when a signal rises to or through zero, or

when a signal leaves zero and becomes positive.

® falling - A zero crossing occurs when a signal falls to or through zero, or
when a signal leaves zero and becomes negative.

® cither - A zero crossing occurs if either a rising or falling condition occurs.

For the Saturation block’s upper limit, the direction of the zero crossing is
either. This enables the entering and leaving saturation events to be detected
using the same zero-crossing signal.

If the error tolerances are too large, it is possible for Simulink to fail to detect
a zero crossing. For example, if a zero crossing occurs within a time step, but
the values at the beginning and end of the step do not indicate a sign change,
the solver steps over the crossing without detecting it.
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The following figure shows a signal that crosses zero. In the first instance, the
integrator steps over the event. In the second, the solver detects the event.

not detected
detected

If you suspect this is happening, tighten the error tolerances to ensure that
the solver takes small enough steps. For more information, see “Maximum
order” on page 9-42.

Note Using the Refine output option (see “Output options” on page 9-51)
does not help locate the missed zero crossings. You should alter the maximum
step size or output times.

Caveat

It is possible to create models that exhibit high-frequency fluctuations about
a discontinuity (chattering). Such systems typically are not physically
realizable; a massless spring, for example. Because chattering causes
repeated detection of zero crossings, the step sizes of the simulation become
very small, essentially halting the simulation.

If you suspect that this behavior applies to your model, you can use the
Zero crossing control option on the Solver pane of the Configuration
Parameters dialog box (see “Zero crossing control” on page 9-40) to disable
zero-crossing detection. Although disabling zero-crossing detection can
alleviate the symptoms of this problem, you no longer benefit from the
increased accuracy that zero-crossing detection provides. A better solution is
to try to identify the source of the underlying problem in the model.

Blocks with Zero Crossings

The following table lists blocks that use zero crossings and explains how the
blocks use the zero crossings:
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Block Description of Zero Crossing

Abs One: to detect when the input signal crosses zero in
either the rising or falling direction.

Backlash Two: one to detect when the upper threshold is engaged,
and one to detect when the lower threshold is engaged.

Dead Zone Two: one to detect when the dead zone is entered (the

input signal minus the lower limit), and one to detect
when the dead zone is exited (the input signal minus
the upper limit).

From Workspace

One: to detect when the input signal has a discontinuity
in either the rising or falling direction

Hit Crossing

One: to detect when the input crosses the threshold.

If

One: to detect when the If condition is met.

Integrator If the reset port is present, to detect when a reset
occurs. If the output is limited, there are three zero
crossings: one to detect when the upper saturation limit
is reached, one to detect when the lower saturation
limit is reached, and one to detect when saturation is
left.

MinMax One: for each element of the output vector, to detect
when an input signal is the new minimum or maximum.

Relay One: if the relay is off, to detect the switch on point. If
the relay is on, to detect the switch off point.

Relational One: to detect when the output changes.

Operator

Saturation Two: one to detect when the upper limit is reached or
left, and one to detect when the lower limit is reached
or left.

Sign One: to detect when the input crosses through zero.

Signal Builder One: to detect when the input signal has a discontinuity
in either the rising or falling direction

Step One: to detect the step time.
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Block Description of Zero Crossing

Subsystem For conditionally executed subsystems: one for the
enable port if present, and one for the trigger port, if
present.

Switch One: to detect when the switch condition occurs.

Switch Case One: to detect when the case condition is met.

Algebraic Loops

Some Simulink blocks have input ports with direct feedthrough. This means
that the output of these blocks cannot be computed without knowing the

v

alues of the signals entering the blocks at these input ports. Some examples

of blocks with direct feedthrough inputs are as follows:

The Math Function block

The Gain block

The Integrator block’s initial condition ports

The Product block

The State-Space block when there is a nonzero D matrix
The Sum block

The Transfer Fen block when the numerator and denominator are of the
same order

The Zero-Pole block when there are as many zeros as poles

An algebraic loop generally occurs when an input port with direct feedthrough
is driven by the output of the same block, either directly, or by a feedback path
through other blocks with direct feedthrough. An example of an algebraic
loop is this simple scalar loop.

— |,

u

[
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Mathematically, this loop implies that the output of the Sum block is an
algebraic state z constrained to equal the first input ¥ minus z (i.e. z = u - 2).
The solution of this simple loop is z = /2, but most algebraic loops cannot be
solved by inspection.

It is easy to create vector algebraic loops with multiple algebraic state
variables z1, z2, etc., as shown in this model.

22

=+
Ll
21 z2i+z1-1 Solwe 21 Ijl
b+ Bl S0 »
- Algebraic Constraint Drisplay =1

21 o

22 22-21-1 Solve 22
fiz) w==0 H
1 - Algebraic Constraintt Crisplay 22

Constant Sumi

r
+
¥
¥

X

The Algebraic Constraint block is a convenient way to model algebraic
equations and specify initial guesses. The Algebraic Constraint block
constrains its input signal F(z) to zero and outputs an algebraic state z.

This block outputs the value necessary to produce a zero at the input. The
output must affect the input through some feedback path. You can provide an
initial guess of the algebraic state value in the block’s dialog box to improve
algebraic loop solver efficiency.

A scalar algebraic loop represents a scalar algebraic equation or constraint of
the form F(z) = 0, where z is the output of one of the blocks in the loop and
the function F consists of the feedback path through the other blocks in the
loop to the input of the block. In the simple one-block example shown on the
previous page, F(z) =z - (u - z). In the vector loop example shown above,

the equations are

z2 + z1 - 1 =
z2 - z1 - 1

Il
S O

Algebraic loops arise when a model includes an algebraic constraint F(z) = 0.
This constraint might arise as a consequence of the physical interconnectivity
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of the system you are modeling, or it might arise because you are specifically
trying to model a differential/algebraic system (DAE).

When a model contains an algebraic loop, Simulink calls a loop solving
routine at each time step. The loop solver performs iterations to determine
the solution to the problem (if it can). As a result, models with algebraic loops
run slower than models without them.

To solve F(z) = 0, the Simulink loop solver uses Newton’s method with weak
line search and rank-one updates to a Jacobian matrix of partial derivatives.
Although the method is robust, it is possible to create loops for which the loop
solver will not converge without a good initial guess for the algebraic states z.
You can specify an initial guess for a line in an algebraic loop by placing an IC
block (which is normally used to specify an initial condition for a signal) on
that line. As shown above, another way to specify an initial guess for a line in
an algebraic loop is to use an Algebraic Constraint block.

Whenever possible, use an IC block or an Algebraic Constraint block to specify
an initial guess for the algebraic state variables in a loop.

Highlighting Algebraic Loops

You can cause Simulink to highlight algebraic loops when you update,
simulate, or debug a model. Use the ashow command to highlight algebraic
loops when debugging a model.

To cause Simulink to highlight algebraic loops that it detects when
updating or simulating a model, set the Algebraic loop diagnostic on

the Diagnostics pane of the Configuration Parameters dialog box to
Error (see “Configuration Parameters Dialog Box” on page 9-37 for more
information). This causes Simulink to display an error dialog (the Diagnostics
Viewer) and recolor portions of the diagram that represent the algebraic loops
that it detects. Simulink uses red to color the blocks and lines that constitute
the loops. Closing the error dialog restores the diagram to its original colors.
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For example, the following figure shows the block diagram of the hydcyl demo
model in its original colors.
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The following figure shows the diagram after updating when the Algebraic
loop diagnostic is set to Error.
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In this example, Simulink has colored the algebraic loop red, making it stand
out from the rest of the diagram.

Eliminating Algebraic Loops

Simulink can eliminate some algebraic loops that include any of the following
types of blocks:

® Atomic Subsystem

* Enabled Subsystem

* Model

To enable automatic algebraic loop elimination for a loop involving a

particular instance of an Atomic Subsystem or Enabled Subsystem block,
select the Minimize algebraic loop occurrences parameter on the block’s
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parameters dialog box. To enable algebraic loop elimination for a loop
involving a Model block, check the Minimize algebraic loop occurrences
parameter on the Model Referencing configuration parameters dialog (see
“Model Referencing Pane” on page 9-96) of the model referenced by the Model
block. If a loop includes more than one instance of these blocks, you should
enable algebraic loop elimination for all of them, including nested blocks.

The Simulink Minimize algebraic loop solver diagnostic allows you to
specify the action Simulink should take, for example, display a warning
message, if it is unable to eliminate an algebraic loop involving a block for
which algebraic loop elimination is enabled. See “Diagnostics Pane” on page
9-67 for more information.

Algebraic loop minimization is off by default because it is incompatible
with conditional input branch optimization in Simulink (see “ Optimization
Pane” on page 9-53) and with single output/update function optimization
in Real-Time Workshope. If you need these optimizations for an atomic or
enabled subsystem or referenced model involved in an algebraic loop, you
must eliminate the algebraic loop yourself.

As an example of the ability of Simulink to eliminate algebraic loops, consider
the following model.

- Gain Integrator

Im Outt

Constant 5 o
Atomic Subsystem
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Simulating this model with the solver’s Algebraic Loop diagnostic set to error
(see “Diagnostics Pane” on page 9-67) reveals that this model contains an
algebraic loop involving its atomic subsystem.

Imi Cut

Constant 5 — o
Atomic Subsystam

Checking the atomic subsystem’s Minimize algebraic loop occurrences
parameter causes Simulink to eliminate the algebraic loop from the compiled
version of the model.

[SBlock Parameters: Atomic Subsystem 2l x|
Sub

Im Oul

a { Selsct the seftings for the subsystem block

Constant

Alomic Subsystem J¥ {Show port sbels]

Read/wiite permissions: | Readwitte |

Name of enor callback function:

Permit hiearchical resolutios [ Al |

W Treat as atomic unit

T ————P | ¥ Miinize algebraic laop accurences
Sample time (1 for inhered]

[1

AT syster code: [ Auta |
AT function name options: [ Auto |
AT il name options: [ 4wt |

oK | Cancel T |
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As a result, the model now simulates without error.

Im Outt

Constant Atomic Subsystem

Note that Simulink is able to eliminate the algebraic loop involving this
model’s atomic subsystem because the atomic subsystem contains a block with
a port that does not have direct feed through, i.e., the Integrator block.

If you remove the Integrator block from the atomic subsystem, Simulink is
unable to eliminate the algebraic loop. Hence, attempting to simulate the
model results in an error.

- int [ outl

Gain

Im St =

Constant 5 — o
Atomic Subsystam

/1|=
T

Eain
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Modeling and Simulating Discrete Systems

Simulink has the ability to simulate discrete (sampled data) systems,
including systems whose components operate at different rates (multirate
systems) and systems that mix discrete and continuous components (hybrid
systems). This capability stems from two key Simulink features:

e SampleTime block parameter

Some Simulink blocks have a SampleTime parameter that you can use to
specify the block’s sample time, i.e., the rate at which it executes during
simulation. All blocks have either an explicit or implicit sample time
parameter. Continuous blocks are examples of blocks that have an implicit
(continuous) sample time. It is possible for a block to have multiple sample
times as provided with blocksets such as the Signal Processing Blockset
or created by a user using the S-Function block.

® Sample-time inheritance

Most standard Simulink blocks can inherit their sample time from

the blocks connected to their inputs. Exceptions include blocks in the
Continuous library and blocks that do not have inputs (e.g., blocks from the
Sources library). In some cases, source blocks can inherit the sample time
of the block connected to its input.

The ability to specify sample times on a block-by-block basis, either directly
through the SampleTime parameter or indirectly through inheritance, enables
you to model systems containing discrete components operating at different
rates and hybrid systems containing discrete and continuous components.

Specifying Sample Time

Simulink allows you to specify the sample time of any block that has a
SampleTime parameter. You can use the block’s parameter dialog box to set
this parameter. You do this by entering the sample time in the Sample time
field on the dialog box. You can enter either the sample time alone or a vector
whose first element is the sample time and whose second element is an offset:
[T, T,]. Various values of the sample time and offset have special meanings.

The following table summarizes valid values for this parameter and how
Simulink interprets them to determine a block’s sample time.
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Sample Time

Usage

[Ts, Tl
0> Ts 5 Tsim
IT,] < T,

Specifies that updates occur at simulation times

t,=n* T, + [T
where n is an integer in the range 1. .7 /T and T
is the length of the simulation. Blocks that have a
sample time greater than 0 are said to have a discrete
sample time.

The offset allows you to specify that Simulink update
the block later in the sample interval than other
blocks operating at the same rate.

[0, 0], O

Specifies that updates occur at every major and minor
time step. A block that has a sample time of 0 is said
to have a continuous sample time.

[0, 1]

Specifies that updates occur only at major time
steps, skipping minor time steps (see “Minor Time
Steps” on page 1-19). This setting avoids unnecessary
computations for blocks whose sample time cannot
change between major time steps. The sample time of
a block that executes only at major time steps is said
to be fixed in minor time step.

['1s O]s -1

If the block is not in a triggered subsystem,

this setting specifies that the block inherits its
sample time from the block connected to its input
(inheritance) or, in some cases, from the block
connected to its output (back inheritance). If the
block is in a triggered subsystem, you must set the
SampleTime parameter to this setting.

Note that specifying sample-time inheritance for

a source block can cause Simulink to assign an
inappropriate sample time to the block if the source
drives more than one block. For this reason, you
should avoid specifying sample-time inheritance for
source blocks. If you do, Simulink displays a warning
message when you update or simulate the model.
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Sample Time

Usage

[-2, Tl

Specifies that a block has a variable sample time, i.e.,
computes its output only at times when the output
changes. Every block with variable sample time has a
unique T, determined by Simulink. The only built-in
Simulink block that can have variable sample time
is the Pulse Generator block. The sample time color
(see "Displaying Sample Time Colors") for variable
sample time is yellow.

inf

The meaning of this sample time depends on whether
the active model configuration’s inline parameters
optimization (see “Inline parameters” on page 9-57)
is enabled.

If the inline parameters optimization is enabled, inf
signifies that the block’s output can never change (see
“Constant Sample Time” on page 1-39). This speeds
up simulation and the generated code by eliminating
the need to recompute the block’s output at each
time step. If the inline parameters optimization is
disabled or the block with inf sample time drives an
output port of a conditionally executed subsystem,
Simulink treats inf as -1, i.e., as inherited sample
time. This allows you to tune the block’s parameters
during simulation.

Changing a Block’s Sample Time

You cannot change the SampleTime parameter of a block while a simulation
is running. If you want to change a block’s sample time, you must stop and
restart the simulation for the change to take effect.

Compiled Sample Time

During the compilation phase of a simulation, Simulink determines the
sample time of the block from its SampleTime parameter (if it has a
SampleTime parameter), sample-time inheritance, or block type (Continuous
blocks always have a continuous sample time). It is this compiled sample
time that determines the sample rate of a block during simulation. You can

1-33



1 How Simulink Works

1-34

determine the compiled sample time of any block in a model by first updating
the model and then getting the block’s CompiledSampleTime parameter,
using the get param command.

Purely Discrete Systems

Purely discrete systems can be simulated using any of the solvers; there is
no difference in the solutions. To generate output points only at the sample
hits, choose one of the discrete solvers.

Multirate Systems

Multirate systems contain blocks that are sampled at different rates. These
systems can be modeled with discrete blocks or with both discrete and
continuous blocks. For example, consider this simple multirate discrete model.

z+0.1 C
z0.2 p
DTF1 vl
Caonstant z+0.1 C
z0.2

DTF2 ¥id)

For this example the DTF1 Discrete Transfer Fen block’s Sample time is set
to [1 0.1], which gives it an offset of 0.1. The DTF2 Discrete Transfer Fcn
block’s Sample time is set to 0.7, with no offset.



Modeling and Simulating Discrete Systems

Starting the simulation and plotting the outputs using the stairs function

[t,x,y] = sim('multirate', 3);
stairs(t,y)

produces this plot

y@) J—F

y(1)

For the DTF'1 block, which has an offset of 0.1, there is no output until t =
0.1. Because the initial conditions of the transfer functions are zero, the
output of DTF1, y(1), is zero before this time.

Determining Step Size for Discrete Systems

Simulating a discrete system requires that the simulator take a simulation
step at every sample time hit, that is, at integer multiples of the system’s
shortest sample time. Otherwise, the simulator might miss key transitions in
the system’s states. Simulink avoids this by choosing a simulation step size to
ensure that steps coincide with sample time hits. The step size that Simulink
chooses depends on the system’s fundamental sample time and the type of
solver used to simulate the system.

The fundamental sample time of a discrete system is the greatest integer
divisor of the system’s actual sample times. For example, suppose that a
system has sample times of 0.25 and 0.5 second. The fundamental sample
time in this case is 0.25 second. Suppose, instead, the sample times are 0.5
and 0.75 second. In this case, the fundamental sample time is again 0.25
second.

You can direct Simulink to use either a fixed-step or a variable-step discrete

solver to solve a discrete system. A fixed-step solver sets the simulation step
size equal to the discrete system’s fundamental sample time. A variable-step
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solver varies the step size to equal the distance between actual sample time
hits.

The following diagram illustrates the difference between a fixed-step and
a variable-size solver.

S S P S S S U

0.oo0 0.25 0.50 0.75 1.00 1.25 1.50

Fixed-Step Solwver

S S S

0.oo0 0.25 0.50 0.75 1.00 1.25 1.50

S
v

Variahle-Step Solver

In the diagram, arrows indicate simulation steps and circles represent sample
time hits. As the diagram illustrates, a variable-step solver requires fewer
simulation steps to simulate a system, if the fundamental sample time is
less than any of the actual sample times of the system being simulated. On
the other hand, a fixed-step solver requires less memory to implement and

is faster if one of the system’s sample times is fundamental. This can be an
advantage in applications that entail generating code from a Simulink model
(using Real-Time Workshop®).

Sample Time Propagation

When updating a model’s diagram, for example, at the beginning of a
simulation, Simulink uses a process called sample time propagation to
determine the sample times of blocks that inherit their sample times. The
figure below illustrates a Discrete Filter block with a sample time of Ts
driving a Gain block.

1
— 1
14221

Dizcrete Filter Gain
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Because the Gain block’s output is simply the input multiplied by a constant,
its output changes at the same rate as the filter. In other words, the Gain
block has an effective sample rate equal to that of the filter’s sample rate. This
is the fundamental mechanism behind sample time propagation in Simulink.

Simulink assigns an inherited sample time to a block based on the sample
times of the blocks connected to its inputs, using the following rules.

If all the inputs have the same sample time, Simulink assigns that sample
time to the block.

If the inputs have different sample times and if all the input sample times
are integer multiples of the fastest input sample time, the block is assigned
the sample time of the fastest input.

If the inputs have different sample times and some of the input sample
times are not integer multiples of the fastest sample time and a
variable-step solver is being used, the block is assigned continuous sample
time.

If the inputs have different sample times and some of the input sample
times are not integer multiples of the fastest sample time and a fixed-step
solver is being used, and the greatest common divisor of the sample times
(the fundamental sample time) can be computed, the block is assigned the
fundamental sample time; otherwise, in this case, the block is assigned
continuous sample time.

Note A Model block can inherit its sample time from its inputs only if
the inputs and outputs of the model that it references do not depend on
the sample time (see “Model Block Sample Times” on page 3-61 for more
information).
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Under some circumstances, Simulink also back propagates sample times to
source blocks if it can do so without affecting the output of a simulation. For
instance, in the model below, Simulink recognizes that the Sine Wave block is
driving a Discrete-Time Integrator block, so it assigns the Sine Wave block and
the Gain block the same sample time as the Discrete-Time Integrator block.

|‘_":| KTs b -
1
z-1
L . Out1
Sine Wave Discrete-Time Gain Ts=-1

Ts=-1 Integrator Ts=-1

You can verify this by selecting Sample Time Colors from the Simulink
Format menu and noting that all blocks are colored red. Because the
Discrete-Time Integrator block only looks at its input at its sample times, this
change does not affect the outcome of the simulation but does result in a
performance improvement.

Replacing the Discrete-Time Integrator block with a continuous Integrator
block, as shown below, and recoloring the model by choosing Update
diagram from the Edit menu cause the Sine Wave and Gain blocks to change
to continuous blocks, as indicated by their being colored black.

K }
\/ ° Out1

Sine Wave Integrator Gain Ts=-1
Ts = -1 Ts=-1
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Constant Sample Time

A block whose output cannot change from its initial value during a simulation
is said to have constant sample time. A block has constant sample time if it
satisfies both of the following conditions:

e All of its parameters are nontunable, either because they are inherently
nontunable or because they have been inlined (see “Inline parameters” on
page 9-57).

® The block’s sample time has been declared infinite (inf) or its sample time
is declared to be inherited and it inherits a constant sample time from
another block to which it is connected.

When Simulink updates a model, for example, at the beginning of a
simulation, Simulink determines which blocks, if any, have constant
sample time, and computes the initial values of the output ports. During
the simulation, Simulink uses the initial values whenever the outputs of
blocks with constant sample time are required, thus avoiding unnecessary
computations.

You can determine which blocks have constant sample time by selecting
Sample Time Colors from the Format menu and updating the model.
Blocks with constant sample time are colored magenta.

For example, in this model, as sample time colors show, both the Constant
and Gain blocks have constant sample time.

K T=
1 1 > L]
=1

Constant Gain Discrete-Time Soope
Sample Time = inf Sample Time = -1 Integrator

b J

Inline Parametarz= on

The Gain block has constant sample time because it inherits its sample time
from the Constant block and all of the model’s parameters are inlined, i.e.,
nontunable.
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Note The Simulink block library includes a few blocks, e.g., the S-Function,
Level-2 M-File S-Function, Rate Transition, and Model block, whose ports can
produce outputs at different sample rates. It is possible for some of the ports
of such blocks to inherit a constant sample time. The ports with constant
sample time produce output only once, at the beginning of the simulation. The
other ports produce outputs at their sample rates.

How Simulink Treats Blocks with Infinite Sample Times and
Tunable Parameters

A block that has tunable parameters cannot have constant sample time even if
its sample time is specified to be infinite. This is because the fact that a block
has one or more tunable parameters means that you can change the values of
its parameters during simulation and hence the value of its outputs. In this
case, Simulink uses sample time propagation (see “Sample Time Propagation”
on page 1-36) to determine the block’s actual sample time.

For example, consider the following model.

The fast-rate (1) dizcrete integrator badepropagates its zample time to the constant blodk

In1 ~ -

B " ot ~

¥ " Tt

4 -
In3 -
Sine Wave KTz -
Ts=1 Ind otz -~
L =1 outz ~ -
= Discrete-Time -
\ Antegrater =
=1 -
Notes-
ODEZ Solver, 1zec fixed-step, singletasking mode
inline parameters turned off {1 )

In2 Constant Switch
Tz=4 Tz =inf
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In this example, although the Constant block’s sample time is specified to be
infinite, it cannot have constant sample time because the inlined parameters
option is off for this model and therefore the block’s Constant value
parameter is tunable. Since the Constant block’s output can change during
the simulation, Simulink has to determine a sample time for the block that
ensures accurate simulation results. It does this by treating the Constant
block’s sample time as inherited and using sample time propagation to
determine its sample time. The first nonvirtual block in the diagram branch to
which the Constant block is connected is the Discrete-Time Integrator block.
As a result, the block inherits its sample time (1 sec) via back propagation
from the Discrete-Time Integrator block.

Mixed Continuous and Discrete Systems

Mixed continuous and discrete systems are composed of both sampled and
continuous blocks. Such systems can be simulated using any of the integration
methods, although certain methods are more efficient and accurate than
others. For most mixed continuous and discrete systems, the Runge-Kutta
variable-step methods, ode23 and ode45, are superior to the other methods in
terms of efficiency and accuracy. Because of discontinuities associated with
the sample and hold of the discrete blocks, the ode15s and ode113 methods
are not recommended for mixed continuous and discrete systems.
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Simulink Basics

The following sections explain how to perform basic Simulink tasks.

Starting Simulink (p. 2-2)
Opening Models (p. 2-3)
Model Editor (p. 2-5)
Saving a Model (p. 2-9)

Printing a Block Diagram (p. 2-13)

Generating a Model Report (p. 2-18)

Summary of Mouse and Keyboard
Actions (p. 2-21)

Ending a Simulink Session (p. 2-25)

Customizing the Simulink User
Interface (p. 2-26)

How to start Simulink.
How to open a Simulink model.
Overview of the Model Editor.

How to save a Simulink model to
disk.

How to print a Simulink block
diagram.

How to generate an HTML report on
a model’s structure and content.

Lists key combinations and mouse
actions that you can use to execute
Simulink commands.

How to end a Simulink session.

How to add your own commands to
the Simulink Tools menu and to
hide or disable controls on Simulink
dialog boxes.



2 Simulink Basics

Starting Simulink

To start Simulink, you must first start MATLAB. Consult your MATLAB
documentation for more information. You can then start Simulink in two
ways:

¢ (Click the Simulink icon El on the MATLAB toolbar.
¢ Enter the simulink command at the MATLAB prompt.

On Microsoft Windows platforms, starting Simulink displays the Simulink
Library Browser.
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- W Simulink.
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2| User-Defined Functions
« 2] Additional Math & Discrete
B Real-Time Workshop
B Simulink Extras
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G
e
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]

Logkup Tables

&l
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2
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]
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]
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Forts & Subsystems ]
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The Library Browser displays a tree-structured view of the Simulink block
libraries installed on your system. You can build models by copying blocks
from the Library Browser into a model window (see “Editing Blocks” on page
4-4).
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On UNIX, platforms, starting Simulink displays the Simulink block library

window.
lLibrary: simulink 10l =|
File Edit WYiew Formatb Help
u R 2
“y Pk i \ LT
Soumas Sinks Continuous Disc it Discontinuities Signal Signal
Routing Attributes
+ - 88 - IL £ :
. = y=flu} y=fitu) ® x Misc
- X <= @ =C
Math Logic and Bit Lookup Uzar-Defined Model For= & Mode -\Wide
Dperations Dperations Tablkes Functions Varification Subsystams Ltilities
Blocksets & COmmanty Additional Math o Simulink Block Library 6.0
Toolboses used blocks & Discrete smes Copyright c) 19902004
The MathWoarks, Inc.

The Simulink library window displays icons representing the block libraries
that come with Simulink. You can create models by copying blocks from the
library into a model window.

Note On Windows, you can display the Simulink library window by
right-clicking the Simulink node in the Library Browser window.

Opening Models
To edit an existing model diagram, either

¢ (Click the Open button on the Library Browser’s toolbar (Windows only)
or select Open from the Simulink library window’s File menu and then
choose or enter the file name for the model to edit.

e Enter the name of the model (without the .mdl extension) in the MATLAB
Command Window. The model must be in the current directory or on the
path.

Opening Models with Different Character Encodings

If you open a model created in a MATLAB session configured to support
one character set encoding, for example, Shift_JIS, in a MATLAB session
configured to support another character encoding, for example, US_ASCII,
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Simulink displays a warning or an error message, depending on whether

it can or cannot encode the model, using the current character encoding,
respectively. The warning or error message specifies the encoding of the
current session and the encoding used to create the model. To avoid corrupting
the model (see “Saving Models with Different Character Encodings” on page
2-10) and ensure correct display of the model’s text, you should

1 Close all models open in the current session.

2 Use the slCharacterEncoding command to change the character encoding
of the current MATLAB session to that of the model as specified in the
warning message.

3 Reopen the model.

You can now safely edit and save the model.

Avoiding Initial Model Open Delay

You may notice that the first model that you open in a MATLAB session
takes longer to open than do subsequent models. This is because to reduce
its own startup time and to avoid unnecessary consumption of your system’s
memory, MATLAB does not load Simulink into memory until the first time
you open a Simulink model. You can cause MATLAB to load Simulink at
MATLAB startup, and thus avoid the initial model opening delay, using either
the -r MATLAB command line option or your MATLAB startup.m file to run
either load_simulink (loads Simulink) or simulink (loads Simulink and
opens the Simulink Library browser) at MATLAB startup. For example, to
load Simulink at MATLAB startup on Microsoft Windows systems, create a
desktop shortcut with the following target:

<matlabroot>\bin\win32\matlab.exe -r load_simulink

Similarly, the following command loads Simulink at MATLAB startup on
UNIX systems:

matlab -r load_simulink



Model Editor

Model Editor

When you open a Simulink model or library, Simulink displays the model or
library in an instance of the Model Editor.

3 =0l
File Edit Yiew Smulation Format Tools Help -4— Menu Bar

DEE&| sBR 2 2y spp |ioma - D@Bes REBME T & -d—— Toolbar

wan der Pol Equation

«4—(anvos

The van der Pol Equation =
Double-click
(Double-click on the " for mare info) ”h“E:':

To start and stop the tion, use the "
selection inthe "Simulation" pull-down menu

RE [100% fodess | ——— Status Bar

Editor Components
The Model Editor includes the following components.

Menvu Bar

The Simulink menu bar contains commands for creating, editing, viewing,
printing, and simulating models. The menu commands apply to the model
displayed in the editor. See Chapter 3, “Creating a Model” and Chapter 9,
“Running Simulations” for more information.

Toolbar

The toolbar allows you to execute Simulink’s most frequently used Simulink
commands with a click of a mouse button. For example, to open a Simulink
model, click the open folder icon on the toolbar. Letting the mouse cursor
hover over a toolbar button or control causes a tooltip to appear. The tooltip
describes the purpose of the button or control. You can hide the toolbar by
clearing the Toolbar option on the Simulink View menu.
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Canvas

The canvas displays the model’s block diagram. The canvas allows you to
edit the block diagram. You can use your system’s mouse and keyboard to
create and connect blocks, select and move blocks, edit block labels, display
block dialog boxes, and so on. See Chapter 4, “Working with Blocks” for more
information.

Context Menus

Simulink displays a context-sensitive menu when you click the right mouse
button over the canvas. The contents of the menu depend on whether a block
is selected. If a block is selected, the menu displays commands that apply only
to the selected block. If no block is selected, the menu displays commands that
apply to a model or library as a whole.

Status Bar

The status bar appears only in the Windows version of the Model Editor.
When a simulation is running, the status bar displays the status of the
simulation, including the current simulation time and the name of the current
solver. You can display or hide the status bar by selecting or clearing the
Status Bar option on the Simulink View menu.

Undoing a Command
You can cancel the effects of up to 101 consecutive operations by choosing

Undo from the Edit menu. You can undo these operations:

® Adding, deleting, or moving a block

® Adding, deleting, or moving a line

® Adding, deleting, or moving a model annotation

¢ Editing a block name

® Creating a subsystem (see “Undoing Subsystem Creation” on page 3-32

for more information)

You can reverse the effects of an Undo command by choosing Redo from
the Edit menu.



Model Editor

Zooming Block Diagrams

Simulink allows you to enlarge or shrink the view of the block diagram in the
current Simulink window. To zoom a view:

® Select Zoom In from the View menu (or type r) to enlarge the view.
® Select Zoom Out from the View menu (or type v) to shrink the view.

® Select Fit System to View from the View menu (or press the space bar) to
fit the diagram to the view.

® Select Normal from the View menu (or type 1) to view the diagram at
actual size.

By default, Simulink fits a block diagram to view when you open the diagram
either in the model browser’s content pane or in a separate window. If you
change a diagram’s zoom setting, Simulink saves the setting when you close
the diagram and restores the setting the next time you open the diagram. If
you want to restore the default behavior, choose Fit System to View from
the View menu the next time you open the diagram.

Panning Block Diagrams

You can use the mouse to pan model diagrams that are too large to fit in the
Model Editor’s window. To do this, position the mouse over the diagram and
hold down the left mouse button and the p or q key on the keyboard. Moving
the mouse now pans the model diagram in the editor window.

View Command History

Simulink maintains a history of the modeling viewing commands, i.e., pan
and zoom, that you execute for each model window. The history allows you to
quickly return to a previous view in a window, using the following commands,
accessible from the Model Editor’s View menu and tool bar:

¢ Back (+)—Displays the previous view in the view history.

¢ Forward (=*)—Displays the next view in the view history.

® Go To Parent (') —Opens, if necessary, the parent of the current
subsystem and brings its window to the top of the desktop.
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Note Simulink maintains a separate view history for each model

window opened in the current session. As a result, the View > Back and
View > Forward commands cannot cross window boundaries. For example,
if window reuse is not on and you open a subsystem in another window, you
cannot use the View > Back command to go to the window displaying the
parent system. You must use the View > Go To Parent command in this
case. On the other hand, if you enable window reuse and open a subsystem in
the current window, you can use View > Back to restore the parent view.
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Saving a Model

You can save a model by choosing either the Save or Save As command from
the File menu. Simulink saves the model by generating a specially formatted
file called the model file (with the .md1 extension) that contains the block
diagram and block properties.

If you are saving a model for the first time, use the Save command to provide
a name and location for the model file. Model file names must start with a
letter and can contain no more than 63 letters, numbers, and underscores.
The file name must not be the same as that of a MATLAB command.

If you are saving a model whose model file was previously saved, use the Save
command to replace the file’s contents or the Save As command to save the
model with a new name or location. You can also use the Save As command
to save the model in a format compatible with previous releases of Simulink
(see “Saving a Model in Earlier Formats” on page 2-10).

Simulink follows this procedure while saving a model:

1 Ifthe mdl file for the model already exists, it is renamed as a temporary file.

2 Simulink executes all block PreSaveFcn callback routines, then executes
the block diagram’s PreSaveFcn callback routine.

3 Simulink writes the model file to a new file using the same name and an
extension of mdl.

4 Simulink executes all block PostSaveFcn callback routines, then executes
the block diagram’s PostSaveFcn callback routine.

5 Simulink deletes the temporary file.

If an error occurs during this process, Simulink renames the temporary file to
the name of the original model file, writes the current version of the model to
a file with an .err extension, and issues an error message. Simulink performs
steps 2 through 4 even if an error occurs in an earlier step.

2-9



2 Simulink Basics

2-10

Saving Models with Different Character Encodings

When Simulink saves a model, it uses the character encoding in effect when
the model was created (the original encoding) to encode the text stored in the
model’s .md1 file, regardless of the character encoding in effect when the model
is saved. This can lead to model corruption if you save a model whose original
encoding differs from encoding currently in effect in the MATLAB session.

For example, it’s possible you could have introduced characters that cannot
be represented in the model’s original encoding. If this is the case, Simulink
saves the model as model. err where model is the model’s name, leaving the
original model file unchanged. Simulink also displays an error message that
specifies the line and column number of the first unrepresentable character.
To recover from this error without losing all the changes you’ve made to
the model in the current session, use the following procedure. First, use a
text editor to find the character in the .err file at the position specified by
the save error message. Then, returning to Simulink, find and delete the
corresponding character in the open model and resave the model . Repeat this
process until you are able to save the model without error.

It’s possible that your model’s original encoding can represent all the text
changes that you’ve made in the current session, albeit incorrectly. For
example, suppose you open a model whose original encoding is A in a
MATLAB session whose current encoding is B. Further, suppose you edit the
model to include a character that has different encodings in A and B and then
save the model. For example, suppose that the encoding for x in B is the same
as the coding for y in A and you insert x in the model while B is in effect,
save the model, and then reopen the model with A in effect. In this scenario,
Simulink will display x as y. To alert you to the possibility of such corruptions,
Simulink displays a warning message when you save a model and the current
and original encoding differ but the original encoding can encode, possibly
incorrectly, all the characters to be saved in the model file.

Saving a Model in Earlier Formats

The Save As command allows you to save a model created with the latest
version of Simulink in formats used by earlier versions of Simulink, including
Simulink 4 (Release 12), Simulink 4.1 (Release 12.1), Simulink 5 (Release 13),
Simulink 5.1 (Release 13SP1), and Simulink 6 (Release 14, compatible with
Release 14, Release 14SP1, and Release 14SP2). You might want to do this,



Saving a Model

for example, if you need to make a model available to colleagues who have
access only to one of these earlier versions of Simulink.

To save a model in earlier format:

1 Select Save As from the Simulink File menu.

Simulink displays the Save As dialog box.

savens 21x]
Save in: I () simgeneral j = |‘j( Ed-
|cvs bangbang.md|
bkl bounce, mdl
| Jinternal countersdermna, mdl
Dia dblcarttmdl
|amdl_auto_build_tokens dblpend1.mdl
|amdl_auto_save_tokens dblpendz.md|
KN — i
File name: |hydcyl.mdl Save I
Save as type: ISimuIink Modets [*.mdl] j Cancel |

Simulink Models [*.mdl]

Simulink 6.0/R14 Models [*.mdl

2 Select a format from the Save as type list on the dialog box.

3 Click the Save button.

When saving a model in an earlier version’s format, Simulink saves the model
in that format regardless of whether the model contains blocks and features
that were introduced after that version. If the model does contain blocks

or use features that postdate the earlier version, the model might not give
correct results when run by the earlier version. For example, matrix and
frame signals do not work in Release 11, because Release 11 does not have
matrix and frame support. Similarly, models that contain unconditionally
executed subsystems marked "Treat as atomic unit" might produce different
results in Release 11, because Release 11 does not support unconditionally
executed atomic subsystems.
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The command converts blocks that postdate the earlier version into empty
masked subsystem blocks colored yellow. For example, post-Release 11 blocks
include

® Lookup Table (n-D)

® Assertion

* Rate Transition

® PreLookup Index Search
e Interpolation (n-D)

¢ Direct Lookup Table (n-D)
¢ Polynomial

® Matrix Concatenation

® Signal Specification

® Bus Creator

e If, Whilelterator, Forlterator, Assignment
* SwitchCase

® Bitwise Logical Operator

Post-Release 11 blocks from Simulink blocksets appear as unlinked blocks.
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Printing a Block Diagram

Printing a Block Diagram

You can print a block diagram by selecting Print from the File menu (on a
Microsoft Windows system) or by using the print command in the MATLAB
Command Window (on all platforms).

On a Microsoft Windows system, the Print menu item prints the block
diagram in the current window.

Print Dialog Box

When you select the Print menu item, the Print dialog box appears. The
Print dialog box enables you to selectively print systems within your model.
Using the dialog box, you can print

The current system only
The current system and all systems above it in the model hierarchy

The current system and all systems below it in the model hierarchy, with
the option of looking into the contents of masked and library blocks

All systems in the model, with the option of looking into the contents of
masked and library blocks

An overlay frame on each diagram
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The portion of the Print dialog box that supports selective printing is similar
on supported platforms. This figure shows how it looks on a Microsoft
Windows system. In this figure, only the current system is to be printed.

r— Options

o . - ~

Current sy{:&m Current system Current system All zystems

: and ab:cwe and be:-low
L R IR
™ Include Print Log 7| Look unden mash disleg
I | Bxpand unigue [ibran i

™ Frame: ID:W’E'\l00Ibm-:'\simulink'\simulink'\sldefaultfram I

Cancel |

When you select either the Current system and below or All systems
option, two check boxes become enabled. In this figure, All systems is

selected.

— Optionz
. . e o~
Current systam Current systam Current system Al systams
. andat:cwe andbglow
LI LI R
™ Include Print Log ™ Look under mask dialog
™ Expand unigue library links
I™ Frame: [D:'Shoolboxisimulinksimulinksidefaulram . |

ak. I Cancel |

Selecting the Look Under Mask Dialog check box prints the contents of
masked subsystems when encountered at or below the level of the current
block. When you are printing all systems, the top-level system is considered
the current block, so Simulink looks under any masked blocks encountered.



Printing a Block Diagram

Selecting the Expand Unique Library Links check box prints the contents
of library blocks when those blocks are systems. Only one copy is printed
regardless of how many copies of the block are contained in the model. For
more information about libraries, see “Working with Block Libraries” on page
4-34.

The print log lists the blocks and systems printed. To print the print log,
select the Include Print Log check box.

Selecting the Frame check box prints a title block frame on each diagram.
Enter the path to the title block frame in the adjacent edit box. You can
create a customized title block frame, using the MATLAB frame editor. See
frameedit in the MATLAB reference for information on using the frame
editor to create title block frames.

Print Command
The format of the print command is

print -ssys -device filename

sys is the name of the system to be printed. The system name must be
preceded by the s switch identifier and is the only required argument. sys
must be open or must have been open during the current session. If the
system name contains spaces or takes more than one line, you need to specify
the name as a string. See the examples below.

device specifies a device type. For a list and description of device types, see
the documentation for the MATLAB print function.

filename is the PostScript file to which the output is saved. If filename
exists, it is replaced. If filename does not include an extension, an

appropriate one is appended.

For example, this command prints a system named untitled.

print -suntitled
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This command prints the contents of a subsystem named Sub1 in the current
system.

print -sSub1

This command prints the contents of a subsystem named Requisite
Friction.

print (['-sRequisite Friction'])

The next example prints a system named Friction Model, a subsystem
whose name appears on two lines. The first command assigns the newline
character to a variable; the second prints the system.

cr = sprintf('\n');
print (['-sFriction' cr 'Model'])

To print the currently selected subsystem, enter

print(['-s', gcb])

Specifying Paper Size and Orientation

Simulink lets you specify the type and orientation of the paper used to print
a model diagram. You can do this on all platforms by setting the model’s
PaperType and PaperOrientation properties, respectively (see “Model

and Block Parameters”), using the set_param command. You can set the
paper orientation alone, using the MATLAB orient command. On Windows,
the Print and Printer Setup dialog boxes let you set the page type and
orientation properties as well.

Positioning and Sizing a Diagram

You can use a model’s PaperPositionMode and PaperPosition parameters to
position and size the model’s diagram on the printed page. The value of the
PaperPosition parameter is a vector of form [left bottom width height].
The first two elements specify the bottom-left corner of a rectangular area

on the page, measured from the page’s bottom-left corner. The last two
elements specify the width and height of the rectangle. When the model’s
PaperPositionMode is manual, Simulink positions (and scales, if necessary)



Printing a Block Diagram

the model’s diagram to fit inside the specified print rectangle. For example,
the following commands

vdp

set_param('vdp', 'PaperType', 'usletter')
set_param('vdp', 'PaperOrientation', 'landscape')
set _param('vdp', 'PaperPositionMode’', 'manual')
set_param('vdp', 'PaperPosition', [0.5 0.5 4 4])
print -svdp

print the block diagram of the vdp sample model in the lower-left corner of a
U.S. letter-size page in landscape orientation.

If PaperPositionMode is auto, Simulink centers the model diagram on the
printed page, scaling the diagram, if necessary, to fit the page.
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Generating a Model Report

A Simulink model report is an HTML document that describes a model’s
structure and content. The report includes block diagrams of the model and
its subsystems and the settings of its block parameters.

To generate a report for the current model:

1 Select Print details from the model’s File menu.

The Print Details dialog box appears.

<} Print Details - fuelsys

=101 x|

File lacationfnaming options
Directary & Current (pwd)

& Temparary tempdin)

" Cther: Il‘tElat—toastenm21perrecnbin1win32
[ Incrernent filenarme to prevent ovenwriting old files
Systermn reporting aptions

o © Currentand abowe ¢ Currentand below  © Entire model

e oane L
Frint I Cancel |

The dialog box allows you to select various report options (see “Model
Report Options” on page 2-19).

2 Select the desired report options on the dialog box.
3 Select Print.

Simulink generates the HTML report and displays the in your system’s
default HTML browser.
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While generating the report, Simulink displays status messages on a
messages pane that replaces the options pane on the Print Details dialog box.

<} Print Details - fuelsys =10 x|
|3) Impartant messages {running a loop) LI
Looping on madel "fuelsys”
Looping on machine "fuelsys"
Looping on systerm "fuelsys”
Could not find any "Block” abjects for summary tahle.

You can select the detail level of the messages from the list at the top of the
messages pane. When the report generation process begins, the Print button
on the Print Details dialog box changes to a Stop button. Clicking this
button terminates the report generation. When the report generation process
finishes, the Stop button changes to an Options button. Clicking this button
redisplays the report generation options, allowing you to generate another
report without having to reopen the Print Details dialog box.

Model Report Options

The Print Details dialog box allows you to select the following report options.

Directory

The directory where Simulink stores the HTML report that it generates.
The options include your system’s temporary directory (the default), your
system’s current directory, or another directory whose path you specify in
the adjacent edit field.

Increment filename to prevent overwriting old files

Creates a unique report file name each time you generate a report for the
same model in the current session. This preserves each report.
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Current object
Include only the currently selected object in the report.

Current and above

Include the current object and all levels of the model above the current object
in the report.

Current and below
Include the current object and all levels below the current object in the report.

Entire model
Include the entire model in the report.

Look under mask dialog
Include the contents of masked subsystems in the report.

Expand unique library links

Include the contents of library blocks that are subsystems. The report
includes a library subsystem only once even if it occurs in more than one
place in the model.
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Summary of Mouse and Keyboard Actions

Simulink provides mouse and keyboard shortcuts for many of its commands.
The following tables summarize these shortcuts.

“Model Viewing Shortcuts” on page 2-21
“Block Editing Shortcuts” on page 2-22

“Line Editing Shortcuts” on page 2-23

“Signal Label Editing Shortcuts” on page 2-23
“Annotation Editing Shortcuts” on page 2-24

LMB means press the left mouse button; CMB, the center mouse button;
and RMB, the right mouse button.

Model Viewing Shortcuts

The following table lists keyboard shortcuts for viewing models.

Task Microsoft Windows | UNIX

Zoom in r r

Zoom out v v

Zoom to normal (100%) | 1 1

Pan left d or Ctrl+Left Arrow | d or Ctrl+Left Arrow

Pan right g or Ctrl+Right g or Ctrl+Right
Arrow Arrow

Pan up e or Ctrl+Up Arrow e or Ctrl+Up Arrow

Pan down c or Ctrl+Down c or Ctrl+Down
Arrow Arrow

Fit selection to screen f f

Fit diagram to screen Space Space

Pan with mouse

Hold down p or q and
drag mouse

Hold down p or q and
drag mouse

Go back in pan/zoom
history

b or Shift+Left Arrow

b or Shift+Left Arrow
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Task

Microsoft Windows

UNIX

Go forward in pan/zoom
history

t or Shift+Right
Arrow

t or Shift+Right
Arrow

Delete selection

Delete or Back Space

Delete or Back Space

Move selection

Use arrow keys

Use arrow keys

Block Editing Shortcuts
The following table lists mouse and keyboard actions that apply to blocks.

Task Microsoft Windows | UNIX

Select one block LMB LMB

Select multiple blocks Shift + LMB Shift + LMB; or CMB
alone

Copy block from Drag block Drag block

another window

Move block Drag block Drag block

Duplicate block Ctrl + LMB and drag; | Ctrl + LMB and drag;

or RMB and drag

or RMB and drag

Connect blocks

LMB

LMB

Disconnect block

Shift + drag block

Shift + drag block; or
CMB and drag

Open selected Enter Return
subsystem
Go to parent of selected | Esc Esc

subsystem
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Line Editing Shortcuts

The following table lists mouse and keyboard actions that apply to lines.

Task Microsoft Windows UNIX

Select one line LMB LMB

Select multiple lines | Shift + LMB Shift + LMB; or CMB
alone

Draw branch line

Ctrl + drag line; or RMB
and drag line

Ctrl + drag line; or RMB
+ drag line

Route lines around
blocks

Shift + draw line
segments

Shift + draw line
segments; or CMB and
draw segments

Move line segment

Drag segment

Drag segment

Move vertex

Drag vertex

Drag vertex

Create line
segments

Shift + drag line

Shift + drag line; or CMB
+ drag line

Signal Label Editing Shortcuts
The next table lists mouse and keyboard actions that apply to signal labels.

Action

Microsoft Windows

UNIX

Create signal

Double-click line, then

Double-click line, then

label enter label enter label

Copy signal label | Ctrl + drag label Ctrl + drag label

Move signal label | Drag label Drag label

Edit signal label | Click in label, then edit Click in label, then edit

Delete signal
label

Shift + click label, then
press Delete

Shift + click label, then
press Delete
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Annotation Editing Shortcuts

The next table lists mouse and keyboard actions that apply to annotations.

Action Microsoft Windows UNIX
Create Double-click in diagram, Double-click in diagram,
annotation then enter text then enter text

Copy annotation

Ctrl + drag label

Ctrl + drag label

Move annotation

Drag label

Drag label

Edit annotation

Click in text, then edit

Click in text, then edit

Delete
annotation

Shift + select annotation,
then press Delete

Shift + select annotation,
then press Delete




Ending a Simulink Session

Ending a Simulink Session

Terminate a Simulink session by closing all Simulink windows.

Terminate a MATLAB session by choosing one of these commands from the
File menu:

® On a Microsoft Windows system: Exit MATLAB
¢ On a UNIX system: Quit MATLAB
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Customizing the Simulink User Interface

Simulink allows you to use M-code to perform the following customizations of
the standard Simulink user interface:

® Add custom commands to the Model Editor’s Tools menu (see “Adding
Custom Commands to the Tools Menu” on page 2-26)

¢ Enable, disable, or hide widgets on standard Simulink dialog boxes that
are dynamically generated (see “Disabling and Hiding Dialog Box Controls”
on page 2-29)

Registering Customizations

To customize the Simulink user interface, you must create an M-file function
called s1_customization.m and include it on the MATLAB path of the
Simulink installation that you want to customize. The s1_customization
function should accept one argument: a handle to the customization manager,

eg.,

function sl _customization(cm)

The customization manager is an object that includes methods for
registering Tools menu and control customizations. Your instance of
the s1_customization function should use these methods to register
customizations specific to your application. For more information, see the
following sections on performing customizations.

Simulink reads the s1_customization.m file when it starts. If you
subsequently change the s1_customization.m file, you must restart Simulink
or enter the following command at the MATLAB command line

slcustomize

to effect the changes.

Adding Custom Commands to the Tools Menu

Simulink allows you to add items to the end of the Model Editor’s Tools menu
that invoke M-code functions that you specify. Adding items to the Tools
menu entails the following tasks:
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® For each item, create a function that returns a schema that specifies the
item’s label and the callback function to be invoked when the user selects
the item. This function is called a schema function (see “Creating Schema
Functions” on page 2-28 for more information).

® (Create a function that returns the schema functions for the items that you
want to add to the Tools menu. This function is called the custom Tools
menu function (see “Creating the Custom Tools Menu Function” on page
2-28)

® Register the custom tools menu function with the Simulink customization
manager at Simulink startup, e.g., in an sl_customization.m file in the
MATLAB path (see “Registering Custom Tools Menu Items” on page 2-28).

Example: Adding a Command to the Model Editor’s Tools Menu

The following s1_customization.m file adds two items to the Model Editor’s
Tools menu.

function sl _customization( cm )

%% Register custom tools menu function.
cm.addCustomToolsMenuFcn(@getMyMenuItems);

end

%% Define the custom tools menu function.
function schemaFcns = getMyMenuItems

schemaFcns = {@getItem1, @getItem2};
end

%% Define the scheme function for first menu item.
function schema = getItemi

schema = sl _action_schema;

schema.label = 'My Item 1';

schema.callback = @figure;
end

%% Define the schema function for second menu item.

function schema = getItem2
schema = sl action_schema;
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schema.label = ['Time ' datestr(now)];
end

Creating Schema Functions

A schema function specifies the label and callback for a custom item on the
Model Editor’s Tools menu. The schema function does this by creating and
returning an object that specifies the label and callback. The following schema
function illustrates this process:

function schema = getItemi

%% Create a schema object
schema = sl _action_schema;

%% Specify the menu item's label.
schema.label = 'My Item 1';

%% Specify the menu item's callback function.
schema.callback = @figure;

end

Creating the Custom Tools Menu Function

The custom tools menu function is used to register custom items to be
included on the Model Editor’s Tools menu. The function specifies the items
by creating and returning a cell array of pointers to schema functions (see
“Creating Schema Functions” on page 2-28) that define the custom entries.
For example, the following custom tools menu function returns a cell array
that specifies two custom menu items.

function schemaFcns = getMyMenuItems
schemaFcns = {@getItem1, @getItem2};
end

Registering Custom Tools Menu ltems

Custom items to be included on the Model Editor’s Tools menu
must be registered with the Simulink customization manager by the
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sl_customization.m file for a Simulink installation (see “Registering
Customizations” on page 2-26). The s1_customization function does this by
passing a pointer to a function that specifies the items (see “Creating the
Custom Tools Menu Function” on page 2-28) to the customization manager’s
addCustomToolsMenuFcn method as illustrated in the following example.

function sl _customization( cm )

%% Register custom tools menu function.
cm.addCustomToolsMenuFcn(@getMyMenuItems);

end

Debugging Custom Tools Menu Callbacks

On Microsoft Windows, selecting a custom Tools menu item whose callback
contains a breakpoint can cause the mouse to become unresponsive or the
menu to remain open and on top of other windows. To fix these problems, use
the M debugger’s keyboard commands to continue execution of the callback.

Disabling and Hiding Dialog Box Controls

Simulink includes a customization API that allows you to disable and hide
controls (also referred to as widgets), such as text fields and buttons, on most
Simulink dialog boxes. The customization API allows you to disable or hide
controls on an entire class of dialog boxes, for example, parameter dialog
boxes via a single method call.

Before attempting to customize a Simulink dialog box or class of dialog
boxes, you must first ensure that the dialog box or class of dialog boxes is
customizable. Any dialog box that appears in the dialog pane of the Model
Explorer is customizable. In addition, any dialog box that has widget IDs is
customizable. Thus, to determine whether a standalone dialog box (i.e., one
that does not appear in the Model Explorer) is customizable, open the dialog
box, enable widget ID display (see “Widget IDs” on page 2-32), and position the
mouse over a widget. If a widget ID appears, the dialog box is customizable.

Once you have determined that a dialog box or class of dialog boxes is

customizable, you must write M code to customize the dialog boxes. This
entails writing callback functions that disable or hide controls for a specific
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dialog box or class of dialog boxes (see “Writing Control Customization
Callback Functions” on page 2-31) and registering the callback functions
via an object called the customization manager (see “Registering Control
Customization Callback Functions” on page 2-32). Simulink then invokes
the callback functions to disable or hide the controls whenever a user opens
the dialog boxes.

Example: Disabling a Button on a Simulink Dialog Box

The following s1_customization.m file disables the Build button on the
Real-Time Workshop pane of the Configuration Parameters dialog box
for any model whose name contains “engine.”

function sl_customization(cm)

% Disable for standalone Configuration Parameters dialog box
cm.addD1lgPreOpenFcn('Simulink.ConfigSet',@disableRTWBuildButton)
% Disable for Configuration Parameters dialog box that appears in
% the Model Explorer
cm.addD1lgPreOpenFcn('Simulink.RTWCC',@disableRTWBuildButton)

end

function disableRTWBuildButton(dialogH)

hSrc = dialogH.getSource; % Simulink.RTWCC
hModel = hSrc.getModel;
modelName = get_param(hModel, 'Name');

if ~isempty(strfind(modelName, 'engine'))
% takes a cell array of widget Factory ID
dialogH.disableWidgets({'Simulink.RTWCC.Build'})
end

end

To test this customization, put the preceding s1_customization.m file on the
MATLAB path and open the engine demo model, for example, by entering the
command engine at the MATLAB command line.
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Writing Control Customization Callback Functions

A callback function for disabling or hiding controls on a dialog box should
accept one argument: a handle to the dialog box object that contains the
controls you want to disable or hide. The dialog box object provides methods
that the callback function can use to disable or hide the controls that the
dialog box contains.

The dialog box object also provides access to objects containing information
about the current model. Your callback function can use these objects to
determine whether to disable or hide controls. For example, the following
callback function uses these objects to disable the Build button on the
Real-Time Workshop pane of the Configuration Parameters dialog box
displayed in the Model Explorer for any model whose name contains “engine.”

function disableRTWBuildButton(dialogH)

hSrc = dialogH.getSource; % Simulink.RTWCC
hModel = hSrc.getModel;
modelName = get_param(hModel, 'Name');

if ~isempty(strfind(modelName, 'engine'))
% takes a cell array of widget Factory ID
dialogH.disableWidgets({'Simulink.RTWCC.Build'})
end

Dialog Box Methods

Dialog box objects provide the following methods for enabling, disabling, and
hiding controls:

® disableWidgets(widgetIDs)
® hideWidgets(widgetIDs)

where widgetIDs is a cell array of widget identifiers (see “Widget IDs” on page
1-15) that specify the widgets to be disabled or hidden.
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Widget IDs

A widget ID is a string that identifies a control on a Simulink dialog box. To
determine the widget id for a particular control, execute the following code at
the MATLAB command line:

cm = sl customization_manager;
cm.showWidgetIdAsToolTip = true

Then, open the dialog box that contains the control and move the mouse
cursor over the control to display a tooltip containing the widget id for the
control. For example, moving the cursor over the Start time field on the
Solver pane of the Configuration Parameters dialog box reveals that the
widget id for the Start time field is Simulink.SolverCC.StartTime.

E& Model Explorer ] 4
File Edit View Tools Add Help

(D@ s mmx MME%F £08 @OE 48

ETEEE])
USearch: Iby Block Type ;I Type: IChart LI Search
Solver
—Simulation time
Start time: ID.D I Stop time: |2D
— Solver options ISimuIink. SolverCC.StartTime I
Type: W Salver: I ode45 (Domand-Prince) LI
Max step size: auto Felative tolerance: |1e-3
Min step size: auto Absolute tolerance: |1e—5
Initial step size: auto
Zero crossing contral: IW
[T Automatically handle data transfers between tasks
Revert | Help | Apphy

Registering Control Customization Callback Functions

To register control customization callback functions for a particular
Simulink installation, include code in the installation’s sl_customization.m
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file (see“Registering Customizations” on page 2-26 ) that invokes the
customization manager’s addD1gPreOpenFcn on the callbacks.

The addD1gPreOpenFcn takes two arguments. The first argument is the type
name of the dialog box’s source (see “Dialog Box Sources” on page 2-33) and
the second is a pointer to the callback function to be registered. Invoking this
method causes Simulink to invoke the registered function for each dialog box
that it generates. Simulink invokes the function before it opens the dialog
box, allowing the function to perform the customizations before they become
visible to the user.

The following example registers a callback that disables the Build button on
the Real-Time Workshop pane of the Configuration Parameters dialog
box (see “Writing Control Customization Callback Functions” on page 2-31).

function sl _customization(cm)

% Disable for standalone Configuration Parameters dialog box

cm.addD1lgPreOpenFcn('Simulink.ConfigSet',@disableRTWBuildButton)

% Disable for Configuration Parameters dialog box that appears in

% the Model Explorer
cm.addD1lgPreOpenFcn('Simulink.RTWCC',@disableRTWBuildButton)

end

Note that registering a customization callback causes Simulink to invoke

the callback for every dialog box generated by the source specified by the
method’s source argument. Thus, if the specified source type applies to a class
of dialog boxes, Simulink invokes the callback for every instance of that class
of dialog boxes. This allows you to use a single callback to disable or hide a
control for an entire class of dialog boxes. In particular, you can use a single
callback to disable or hide the control for a parameter that is common to most
built-in Simulink blocks. This is because most built-in block dialog boxes have
a common source: Simulink.SLDialogSource.

Dialog Box Sources

Dialog box sources are objects that specify the contents of a specific dialog box
or class of dialog boxes. The following table lists the type names and dialog
boxes specified by some key dialog box sources.
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Source Type

Source of

Simulink

.SLDialogSource

Block parameter dialog boxes

Simulink

.ConfigSet

Configuration Parameters
dialog box that appears
when the user selects
Simulation > Configuration
Parameters from the Model
Editor’s tool bar.

Simulink.

SolverCC

Solver pane of the Configuration
Parameters dialog box that appears
in the dialog box view of the Model
Explorer

Simulink.

DataIOCC

Data Import/Export pane of the
Configuration Parameters dialog
box that appears in the dialog box
view of the Model Explorer

Simulink.

OptimizationCC

Optimization pane of the
Configuration Parameters
dialog box that appears in the dialog
box view of the Model Explorer

Simulink.

HardwareCC

Hardware Implementation pane
of the Configuration Parameters
dialog box that appears in the dialog
box view of the Model Explorer

Simulink.

ModelReferenceCC

Model Reference pane of the
Configuration Parameters dialog
box that appears in the dialog box
view of the Model Explorer

Simulink.

RTWCC

Real-Time Workshop pane of the
Configuration Parameters dialog
box that appears in the dialog box
view of the Model Explorer
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The following sections explain how to perform tasks required to create

Simulink models.

Creating an Empty Model (p. 3-3)
Selecting Objects (p. 3-4)

Specifying Block Diagram Colors
(p. 3-6)

Connecting Blocks (p. 3-11)
Annotating Diagrams (p. 3-20)
Creating Subsystems (p. 3-30)
Creating Conditionally Executed
Subsystems (p. 3-35)

Referencing Models (p. 3-52)
Modeling with Control Flow Blocks
(p. 3-71)

Using Callback Functions (p. 3-83)
Working with Model Workspaces

(p. 3-88)
Working with Data Stores (p. 3-95)

How to create a new model.
How to select objects in a model.

How to specify the colors of blocks,
lines, and annotations and the
background of the diagram.

How to draw connections between
blocks.

How to add annotations to a block
diagram.

How to create subsystems.

How to create subsystems that are
executed only when specified events
occur or conditions are satisfied.

How to include one model as a block
in another model.

How to use control flow blocks to
model control logic.

How to use callback routines to
customize a model.

How to modify, save, and reload a
model’s private workspace.

How to create and access data stores.
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Model Advisor (p. 3-101)

Managing Model Versions (p. 3-104)

Model Discretizer (p. 3-115)

How to use the Model Advisor
to configure a model for efficient
simulation and code generation.

How to use version control systems
to manage and track development of
Simulink models.

How to create a discrete model from
a continuous model.
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Creating an Empty Model

To create an empty model, click the New button on the Library Browser’s
toolbar (Windows only) or choose New from the library window’s File menu
and select Model. You can move the window as you do other windows.
“Getting Started” describes how to build a simple model. “Modeling
Equations” on page 7-2 describes how to build systems that model equations.

Creating a Model Template

When you create a new model, Simulink configures it with default settings.
For instance, by default, new models have a white canvas, the ode45 solver,
and a visible toolbar. You can change these settings to your liking after
creating the new model.

Or you can write a function that creates a model that has settings you prefer,
using the commands listed in “Model Construction Commands”in the online
Simulink reference. Executing this function generates a new model with
your customized parameter settings.

For example, the following function creates a Simulink model featuring a
green canvas, the ode3 solver, and a hidden toolbar:

function new_model(modelname)

NEW_MODEL Create a new, empty Simulink model
NEW_MODEL ( 'MODELNAME') creates a new model with
the name 'MODELNAME'. Without the 'MODELNAME'
argument, the new model is named 'my untitled'.

o® o o°

o°

if nargin ==
modelname = 'my _untitled';
end

% create and open the model
open_system(new_system(modelname));

% set default screen color
set_param(modelname, 'ScreenColor', 'green');

% set default solver
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set_param(modelname, 'Solver', 'ode3');

% set default toolbar visibility
set_param(modelname, 'Toolbar', 'off');

% save the model
save_system(modelname);

Selecting Objects

3-4

Many model building actions, such as copying a block or deleting a line,
require that you first select one or more blocks and lines (objects).

Selecting an Object

To select an object, click it. Small black square handles appear at the corners
of a selected block and near the end points of a selected line. For example, the
figure below shows a selected Sine Wave block and a selected line.

W, —a

Sine Miave

When you select an object by clicking it, any other selected objects are
deselected.

Selecting Multiple Objects

You can select more than one object either by selecting objects one at a time,
by selecting objects located near each other using a bounding box, or by
selecting the entire model.

Selecting Multiple Objects One at a Time

To select more than one object by selecting each object individually, hold down
the Shift key and click each object to be selected. To deselect a selected object,
click the object again while holding down the Shift key.



Selecting Obijects

Selecting Multiple Objects Using a Bounding Box
An easy way to select more than one object in the same area of the window is
to draw a bounding box around the objects:

1 Define the starting corner of a bounding box by positioning the pointer at
one corner of the box, then pressing and holding down the mouse button.
Notice the shape of the cursor.

+
F—-

Sine Wave

Scope

2 Drag the pointer to the opposite corner of the box. A dotted rectangle
encloses the selected blocks and lines.

e

Sine Wave

Scope

3 Release the mouse button. All blocks and lines at least partially enclosed
by the bounding box are selected.

o AN

Sine Wi awe

Scope

Selecting All Objects

To select all objects in the active window, select Select All from the Edit
menu. You cannot create a subsystem by selecting blocks and lines in this
way. For more information, see “Creating Subsystems” on page 3-30.
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Specifying Block Diagram Colors

Simulink allows you to specify the foreground and background colors of

any block or annotation in a diagram, as well as the diagram’s background
color. To set the background color of a block diagram, select Sereen color
from the Simulink Format menu. To set the background color of a block or
annotation or group of such items, first select the item or items. Then select
Background color from the Simulink Format menu. To set the foreground
color of a block or annotation, first select the item. Then select Foreground
color from the Simulink Format menu.

In all cases, Simulink displays a menu of color choices. Choose the desired
color from the menu. If you select a color other than Custom, Simulink
changes the background or foreground color of the diagram or diagram
element to the selected color.

Choosing a Custom Color

If you choose Custom, Simulink displays the Simulink Choose Custom
Color dialog box.

Basic colors:

F0 1 1 [
Uil e |
I T
Ui bl
Ao il

LCustom colors:

| | (] -
e

Define Custom Colars 3> |

Cancel |

The dialog box displays a palette of basic colors and a palette of custom colors
that you previously defined. If you have not previously created any custom
colors, the custom color palette is all white. To choose a color from either
palette, click the color, and then click the OK button.
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Defining a Custom Color

To define a custom color, click the Define Custom Colors button on the
Choose Custom Color dialog box. The dialog box expands to display a
custom color definer.

Choose Custom Color EHE
Basic colars:

R NS
Il
B T OEE
IR RS
L i i il
I T MM

LCustom colors:

o _ _
ol B\ o

Sat: |1 45 Green: |205

|~ Hue-saturation cursor

\ Luminescence cursor

Define Custanm Colors > | Color|3glid Lum: |1 20 Blue: |2g1
Cancel | Add ta Custom Colors |

The color definer allows you to specify a custom color by

¢ Entering the red, green, and blue components of the color as values
between 0 (darkest) and 255 (brightest)

® Entering hue, saturation, and luminescence components of the color as
values in the range 0 to 255

® Moving the hue-saturation cursor to select the hue and saturation of the
desired color and the luminescence cursor to select the luminescence of
the desired color

The color that you have defined in any of these ways appears in the

Color | Solid box. To redefine a color in the Custom colors palette, select the
color and define a new color, using the color definer. Then click the Add to
Custom Colors button on the color definer.

Specifying Colors Programmatically

You can use the set_param command at the MATLAB command line or in an
M-file program to set parameters that determine the background color of a
diagram and the background color and foreground color of diagram elements.
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The following table summarizes the parameters that control block diagram
colors.

Parameter Determines

ScreenColor Background color of block diagram
BackgroundColor Background color of blocks and annotations
ForegroundColor Foreground color of blocks and annotations

You can set these parameters to any of the following values:
® 'pblack', 'white’, 'red', 'green’', 'blue’', 'cyan', 'magenta’, 'yellow',
‘gray’', 'lightBlue’, 'orange’', 'darkGreen'
* '[r,g,b]"
where r, g, and b are the red, green, and blue components of the color

normalized to the range 0.0 to 1.0.

For example, the following command sets the background color of the
currently selected system or subsystem to a light green color:

set_param(gcs, 'ScreenColor', '[0.3, 0.9, 0.5]")

Displaying Sample Time Colors

Simulink can color code the blocks and lines in your model to indicate the
sample rates at which the blocks operate.

Color Use

Black Continuous sample time

Magenta Constant sample time

Red Fastest discrete sample time

Green Second fastest discrete sample time
Blue Third fastest discrete sample time
Light Blue Fourth fastest discrete sample time
Dark Green Fifth fastest discrete sample time
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Color Use
Orange Sixth fastest discrete sample time
Yellow Can indicate one of the following:

¢ A block with hybrid sample time, e.g., subsystems
grouping blocks and Mux or Demux blocks grouping
signals with different sample times, Data Store
Memory blocks updated and read by different tasks.

® Variable sample time. See the Pulse Generator
block and “Specifying Sample Time” on page 1-31
for more information.

® A block with the seventh, eighth, etc., sample time.

Cyan Blocks in triggered subsystems

Gray Fixed in minor step

To enable the sample time colors feature, select Sample Time Colors from
the Format menu.

Simulink does not automatically recolor the model with each change you
make to it, so you must select Update Diagram from the Edit menu to
explicitly update the model coloration. To return to your original coloring,
disable sample time coloration by again choosing Sample Time Colors.

The color that Simulink assigns to each block depends on its sample time
relative to other sample times in the model. This means that the same sample
time may be assigned different colors in a top-level model and in the models
that it references (see “Referencing Models” on page 3-52). For example,
suppose that a model defines three sample times: 1, 2, and 3. Further,
suppose that it references a model that defines two sample times: 2 and 3.

In this case, blocks operating at the 2 sample rate appear as green in the
top-level model and as red in the referenced model.

It is important to note that Mux and Demux blocks are simply grouping
operators; signals passing through them retain their timing information. For
this reason, the lines emanating from a Demux block can have different colors
if they are driven by sources having different sample times. In this case, the
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Mux and Demux blocks are color coded as hybrids (yellow) to indicate that
they handle signals with multiple rates.

Similarly, Subsystem blocks that contain blocks with differing sample times
are also colored as hybrids, because there is no single rate associated with
them. If all the blocks within a subsystem run at a single rate, the Subsystem
block is colored according to that rate.
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Connecting Blocks

Simulink block diagrams use lines to represent pathways for signals among
blocks in a model (see “Annotating Diagrams” on page 3-20 for information on
signals). Simulink can connect blocks for you or you can connect the blocks
yourself by drawing lines from their output ports to their input ports.

Automatically Connecting Blocks

You can command Simulink to connect blocks automatically. This eliminates
the need for you to draw the connecting lines yourself. When connecting
blocks, Simulink routes lines around intervening blocks to avoid cluttering
the diagram.

Connecting Two Blocks
To autoconnect two blocks:

1 Select the source block.

2 :ine[i:gave

1

L 4
\7
i

Constant Fain

= B

Integratoer
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2 Hold down Ctrl and left-click the destination block.

Simulink connects the source block to the destination block, routing the
line around intervening blocks if necessary.

Jine Tawve
1 - >:>
Con=tant Fain
K
» 1
-

Integrator

When connecting two blocks, Simulink draws as many connections as possible
between the two blocks as illustrated in the following example.

hat1 |
Chat i |
Chat2 |

SubSwrstem

Sub3yr=tzen

Before autoconnect After autoconnect

Connecting Groups of Blocks

Simulink can connect a group of source blocks to a destination block or a
source block to a group of destination blocks.

To connect a group of source blocks to a destination block:
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1 Select the source blocks.

Sine TWave

Sine Wavel

2 Hold down Ctrl and left-click the destination block.

& >
v/
Sine Tave H]
& >
v/

Sine Wawel

To connect a source block to a group of destination blocks:

1 Select the destination blocks.

Dizplary

(Y

Displayl

2 Hold down Ctrl and left-click the source block.

Di=plazr

)

Di=playl
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Manually Connecting Blocks
Simulink allows you to draw lines manually between blocks or between lines

and blocks. You might want to do this if you need to control the path of the
line or to create a branch line.

Drawing a Line Between Blocks
To connect the output port of one block to the input port of another block:

1 Position the cursor over the first block’s output port. It is not necessary
to position the cursor precisely on the port. The cursor shape changes to
crosshairs.

[ >

Constant & ain

2 Press and hold down the mouse button.

3 Drag the pointer to the second block’s input port. You can position the
cursor on or near the port or in the block. If you position the cursor in the
block, the line is connected to the closest input port. The cursor shape
changes to double crosshairs.

>
Constant & ain

4 Release the mouse button. Simulink replaces the port symbols by a
connecting line with an arrow showing the direction of the signal flow. You
can create lines either from output to input, or from input to output. The
arrow is drawn at the appropriate input port, and the signal is the same.

>

Constant & ain

Simulink draws connecting lines using horizontal and vertical line segments.
To draw a diagonal line, hold down the Shift key while drawing the line.
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Drawing a Branch Line

A branch line is a line that starts from an existing line and carries its signal
to the input port of a block. Both the existing line and the branch line carry
the same signal. Using branch lines enables you to cause one signal to be
carried to more than one block.

In this example, the output of the Product block goes to both the Scope block
and the To Workspace block.

—» ]
Froduct Seope
Ta Wotspace

To add a branch line:

1 Position the pointer on the line where you want the branch line to start.

2 While holding down the Ctrl key, press and hold down the left mouse
button.

3 Drag the pointer to the input port of the target block, then release the
mouse button and the Ctrl key.

You can also use the right mouse button instead of holding down the left
mouse button and the Ctrl key.

Drawing a Line Segment

You might want to draw a line with segments exactly where you want them
instead of where Simulink draws them. Or you might want to draw a line
before you copy the block to which the line is connected. You can do either by
drawing line segments.

To draw a line segment, you draw a line that ends in an unoccupied area
of the diagram. An arrow appears on the unconnected end of the line. To
add another line segment, position the cursor over the end of the segment
and draw another segment. Simulink draws the segments as horizontal and
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vertical lines. To draw diagonal line segments, hold down the Shift key while
you draw the lines.

Moving a Line Segment
To move a line segment:

1 Position the pointer on the segment you want to move.

=
i P

Sine WMiave

Caonstant

Froduct

2 Press and hold down the left mouse button.

=
v i
Sine WMiave - Froduct
-
—
Caonstant

3 Drag the pointer to the desired location.

=
v . » -
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s
Caonstant
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4 Release the mouse button.

=

S

Sine WMiave

Caonstant

Froduct

To move the segment connected to an input port, position the pointer over the
port and drag the end of the segment to the new location. You cannot move

the segment connected to an output port.

Moving a Line Vertex
To move a vertex of a line:

1 Position the pointer on the vertex, then press and hold down the mouse

button. The cursor changes to a circle that encloses the vertex.

N

Constant

2 Drag the pointer to the desired location.

=
K*@”

Constant

Scope

Scope

3 Release the mouse button.

|

Constant

]

Scope
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Inserting Blocks in a Line

You can insert a block in a line by dropping the block on the line. Simulink
inserts the block for you at the point where you drop the block. The block that
you insert can have only one input and one output.

To insert a block in a line:

1 Position the pointer over the block and press the left mouse button.

3 Release the mouse button to drop the block on the line. Simulink inserts
the block where you dropped it.

N D -

Sine Waine Sain Siopes
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Disconnecting Blocks

To disconnect a block from its connecting lines, hold down the Shift key, then
drag the block to a new location.
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Annotating Diagrams

Annotations provide textual information about a model. You can add an
annotation to any unoccupied area of your block diagram.

This sample model )
shows a constant signal % 7 Annototions

being input to a Scope. /
1

7 =

Constant

Scope

Thiz black generates
a constant signal
with a walue of 1.

This block displays itz input
graphically in a window that
laoks like an oscilloscope.

To create a model annotation, double-click an unoccupied area of the block
diagram. A small rectangle appears and the cursor changes to an insertion
point. Start typing the annotation contents. Each line is centered within the
rectangle that surrounds the annotation.

To move an annotation, drag it to a new location.
To edit an annotation, select it:

* To replace the annotation, click the annotation, then double-click or drag
the cursor to select it. Then, enter the new annotation.

® To insert characters, click between two characters to position the insertion
point, then insert text.

* To replace characters, drag the mouse to select a range of text to replace,
then enter the new text.

To delete an annotation, hold down the Shift key while you select the
annotation, then press the Delete or Backspace key.
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To change the font of all or part of an annotation, select the text in the
annotation you want to change, then choose Font from the Format menu.
Select a font and size from the dialog box.

To change the text alignment (e.g., left, center, or right) of the annotation,
select the annotation and choose Text Alignment from the model window’s
Format or context menu. Then choose one of the alignment options (e.g.,
Center) from the Text Alignment submenu.
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Annotations Properties Dialog Box

The Annotation Properties dialog box allows you to specify the contents and
format of the currently selected annotation and to associate a click function
with the annotation. To display the Annotation Properties dialog box for
an annotation, select the annotation and then select Annotation Properties
from the model editor’s Edit or context menu. The dialog box appears.

E! Annotation properties: van der Pol Equation ﬂ
—Annaotation

Annotations are freefloating text that can be used to describe models.

fop (==}

Teod:

wvan der Pol Equation
[~ Drop shadow Foreground color: lm
[~ Enable TeX commands Baclkground color: lm
Font... Alignment: lm

—ClickFen

The ClickFen is called when a user singleclicks on this annotation. For example, to
browse 3 web site specified in the annotation text tny
an = getCallback Annotation; web(an Text);

[~ Use display text as click callback

The dialog box includes the following controls.

Text

Displays the current text of the annotation. Edit this field to change the

annotation text.
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Drop shadow
Checking this option causes Simulink to display a drop shadow around the
annotation, giving it a 3-D appearance.

Enable TeX commands

Checking this option enables use of TeX formatting commands in this
annotation. See “Using TeX Formatting Commands in Annotations” on page
3-27 for more information.

Font

Clicking this button displays a font chooser dialog box. Use the font chooser to
change the font used to render the annotation’s text.

Foreground color
Specifies the color of the annotation text.

Background color
Specifies the color of the background of the annotation’s bounding box.

Alignment
Specifies the alignment of the annotation’s text relative to its bounding box.

ClickFcn

Specifies MATLAB code to be executed when a user single-clicks this
annotation. Simulink stores the code entered in this field with the model.
See “Associating Click Functions with Annotations” on page 3-24 for more
information.

Use display text as click callback

Checking this option causes Simulink to treat the text in the Text field as

the annotation’s click function. The specified text must be a valid MATLAB
expression comprising symbols that are defined in the MATLAB workspace
when the user clicks this annotation. See “Associating Click Functions with
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Annotations” on page 3-24 for more information. Note that selecting this
option disables the ClickFen edit field.

Annotation Callback Functions

Simulink allows you to associate the following callback functions with
annotations.

Click Function

A click function is an M function that Simulink invokes when a user
single-clicks an annotation. Simulink allows you to associate a click function
with any of a model’s annotations (see “Associating Click Functions with
Annotations” on page 3-24). Simulink uses the color blue to display the text
of annotations associated with click functions. This allows the user to see

at a glance which annotations are associated with click functions. Click
functions allow you to add hyperlinks and custom command “buttons” to your
model’s block diagram. For example, you can use click functions to allow a
user to display the values of workspace variables referenced by the model

or to open related models simply by clicking on annotations displayed on
the block diagram.

Load Function
Simulink invokes this function when it loads the model containing the
associated annotation. To associate a load function with an annotation, set the

LoadFcn property of the annotation to the desired function (see “Annotations
API” on page 3-26).

Delete function

Simulink invokes this function before deleting the associated annotation. To
associate a delete function with an annotation, set the DeleteFcn property of
the annotation to the desired function (see “Annotations API” on page 3-26).

Associating Click Functions with Annotations

Simulink provides two ways to associate a click function with an annotation
via the annotation’s properties dialog box (see “Annotations Properties
Dialog Box” on page 3-22). You can specify either the annotation itself as the
click function or a separately defined function. To specify the annotation
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itself as the click function, enter a valid MATLAB expression in the dialog
box’s Text field and check the Use display text as callback option. To
specify a separately defined click function, enter the M-code that defines the
click function in the dialog box’s ClickFen edit field. The following model
illustrates the two ways to associate click functions with an annotation.

1

Constant

E] fnnctation praperties: doc sct param
—bnnotatian

x|

Arratationa ore fiee-flaating best that can be wsed ta descibe modek:

—bppaalanc
Teat
Huc ==t_perem
W Omp shadow Foreground edar. | Cuztam vI

™ Enabk Tex commands:

Eackgraund :nh:l \white 'rl
Nig"rnert:l Cirter vI

Fort...

— OickFen

The DickFen iz caled when a uzer tingle-cicks an this annotation. For edample, o
biowe= a web ske speciied in the annctalion kst by
an = getCalbackfnnotation; mab(an. Test);

W Use dicplay text &= cick calback

doc: ke|_palam

oK I Cancel | Hep | tpny

Gain Terminatar

/ /IShowhelpforset_param
\ =

Eﬂnru:llatic-n propoikics: Show help tmn seb param

—Annoteton

Bnnotalioes are fae-losting test that can be ussd to deccriba medalk.

—ApPEIREC
Texl:
[ baw help for ==t_param
W Drop shadov Foreground :nhr:l Cuztam vl

I” Enable Tex commande

Fanl... |

Backgiound mlu:l Wita vl
A.Iiu"rnnd:l Certe "I

r—CliekFen

The CickFen iz caled when a uzer shgle-dicks on this arnotation For e<ample, 1o
bropze 4 web ske zoemlied nthe anmtaton = oy
o1 = petCalbackfnnotation: weblan. T exl]:

I~ Usa display terl a2 dick calback

dac 2et_palam

gEoo b e ke

Bipply

Annotation fext as the click function

Separately defined click function

Clicking either of the annotations in this model displays help for the Simulink

set_param command.
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Note You can also use M-code to associate a click function with an
annotation. See “Annotations API” on page 1-7 for more information.

Selecting and Editing Annotations Associated with Click
Functions

Associating an annotation with a click function prevents you from selecting
the annotation by clicking on it. You must use drag select the annotation.
Similarly, you cannot make the annotation editable on the diagram by clicking
its text. To make the annotation editable on the diagram, first drag-select it,
then select Edit Annotation Text from the model editor’s Edit or context
menu.

Annotations API

Simulink provides an application program interface (API) that enables you
to use M programs to get and set the properties of annotations. The API
comprises the following elements:

e Simulink.Annotation class

Allows M-code, e.g., annotation load functions (see “Load Function” on page
3-24), to set the properties of annotations

® getCallbackAnnotation function

Gets the Simulink.Annotation object for the annotation associated with
the currently executing annotation callback function
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Using TeX Formatting Commands in Annotations

You can use TeX formatting commands to include mathematical and other
symbols and Greek letters in block diagram annotations.

Linearization of Double Pendulum

81" = 196200781 + 392400782 -
]
BE" = 20 240071 -132. 6603702 "—C)
thetat
mhere
thetad dot 2 thetat dot
81 = position of top joint
B2 = position of bottom joint
=127 . 2400 -
Zaint
1 ||..|1_‘ T
- - 2
: g »( 2 )
thetaz
theta? dot2 thetaz dot

To use TeX commands in an annotation:

1 Select the annotation.

2 Select Enable TeX Commands from the model editor’s Format menu.
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3 Enter or edit the text of the annotation, using TeX commands where needed
to achieve the desired appearance.

Linearization of Double Pendulum

“thetat" = -19 6200™thetat + 389 24900™theta?
‘theta2" = 20 2400™th etad -1232 B803™thetaZ

where

“thetal = position of top joint
“theta? = position of bottom joint

See “Mathematical Symbols, Greek Letters, and TeX Characters” in the
MATLAB documentation for information on the TeX formatting commands
supported by Simulink.

4 Deselect the annotation by clicking outside it or typing Esc.

Simulink displays the formatted text.

Linearization of ouble Pendulum

81" = -19.6200781 + 20.2400782
82" = 39.2400™81 -132 6603782

whers

B1 = position of tap joint
82 = position of bottom joint

Creating Annotations Programmatically

You can use the Simulink add_block command to create annotations at the
command line or in an M-file program. Use the following syntax to create
the annotation:

add_block('built-in/Note', 'path/text','Position’',
[center_x, O,
0, center_yl);

where path is the path of the diagram to be annotated, text is the text of
the annotation, and [center x, 0, 0, center_y] is the position of the center
of the annotation in pixels relative to the upper left corner of the diagram.
For example, the following sequence of commands
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new_system('test')

open_system( 'test')

add_block('built-in/Gain', 'test/Gain', 'Position', [260, 125,
290, 155])

add_block('built-in/Note', 'test/programmatically created',
'"Position', [550 0 0 180])

creates the following model:

=10l x|

File Edit WYiew Simulation Format Tools Help

E >
Gain

programmatically created

Ready 100% odeds
4

To delete an annotation, use the find_system command to get the
annotation’s handle. Then use set_param to set the annotation’s Name
property to the empty string, e.g.,

h = find_system('test', 'FindAll', 'on', 'Type', 'annotation');
set_param(h, 'Name';, '');
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As your model increases in size and complexity, you can simplify it by
grouping blocks into subsystems. Using subsystems has these advantages:

¢ It helps reduce the number of blocks displayed in your model window.

¢ It allows you to keep functionally related blocks together.

¢ It enables you to establish a hierarchical block diagram, where a Subsystem
block is on one layer and the blocks that make up the subsystem are on
another.

You can create a subsystem in two ways:

® Add a Subsystem block to your model, then open that block and add the
blocks it contains to the subsystem window.

¢ Add the blocks that make up the subsystem, then group those blocks into a
subsystem.

Creating a Subsystem by Adding the Subsystem
Block

To create a subsystem before adding the blocks it contains, add a Subsystem
block to the model, then add the blocks that make up the subsystem:

1 Copy the Subsystem block from the Ports & Subsystems library into your
model.

2 Open the Subsystem block by double-clicking it.

Simulink opens the subsystem in the current or a new model window,
depending on the model window reuse mode that you selected (see “Window
Reuse” on page 3-33).

3 In the empty Subsystem window, create the subsystem. Use Inport blocks
to represent input from outside the subsystem and Outport blocks to
represent external output.
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For example, the subsystem shown includes a Sum block and Inport and
Outport blocks to represent input to and output from the subsystem.

C—,
In » C)
2, i D1ut

In1

Creating a Subsystem by Grouping Existing Blocks

If your model already contains the blocks you want to convert to a subsystem,
you can create the subsystem by grouping those blocks:

1 Enclose the blocks and connecting lines that you want to include in
the subsystem within a bounding box. You cannot specify the blocks to
be grouped by selecting them individually or by using the Select All
command. For more information, see “Selecting Multiple Objects Using a
Bounding Box” on page 3-5.

For example, this figure shows a model that represents a counter. The Sum
and Unit Delay blocks are selected within a bounding box.

[ T

H - P zimout
Constant + v z v
Sum Unit Delay To Wolspace

When you release the mouse button, the two blocks and all the connecting
lines are selected.

2 Choose Create Subsystem from the Edit menu. Simulink replaces the
selected blocks with a Subsystem block.

This figure shows the model after you choose the Create Subsystem
command (and resize the Subsystem block so the port labels are readable).

In1 Ot 1 I zimout

Constant To Wokspace

Subsystem
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If you open the Subsystem block, Simulink displays the underlying system,
as shown below. Notice that Simulink adds Inport and Outport blocks to
represent input from and output to blocks outside the subsystem.

o | [T,

I ’-P+ z »( 1)

Sum Unit Delay

As with all blocks, you can change the name of the Subsystem block. You can
also use the masking feature to customize the block’s appearance and dialog
box. See Chapter 11, “Creating Masked Subsystems”.

Undoing Subsystem Creation

To undo creation of a subsystem by grouping blocks, select Undo from the
Edit menu. You can undo creation of a subsystem that you have subsequently
edited. However, the Undo command does not undo any nongraphical changes
that you made to the blocks, such as changing the value of a block parameter
or the name of a block. Simulink alerts you to this limitation by displaying a
warning dialog box before undoing creation of a modified subsystem.

Model Navigation Commands

Subsystems allow you to create a hierarchical model comprising many layers.
You can navigate this hierarchy, using the Simulink Model Browser (see
“The Model Browser” on page 8-22) and/or the following model navigation
commands:

e Open

The Open command opens the currently selected subsystem. To execute
the command, select Open from the Simulink Edit menu, press Enter, or
double-click the subsystem.

* Open block in new window

Opens the currently selected subsystem regardless of the Simulink window
reuse settings (see “Window Reuse” on page 3-33).
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¢ Go to Parent

The Go to Parent command displays the parent of the subsystem
displayed in the current window. To execute the command, press Esc or
select Go to Parent from the Simulink View menu.

Window Reuse

You can specify whether Simulink model navigation commands use the
current window or a new window to display a subsystem or its parent.
Reusing windows avoids cluttering your screen with windows. Creating a
window for each subsystem allows you to view subsystems side by side with
their parents or siblings. To specify your preference regarding window reuse,
select Preferences from the Simulink File menu and then select one of the
following Window reuse type options listed in the Simulink Preferences
dialog box.

Reuse Type | Open Action Go to Parent (Esc) Action

none Subsystem appears in a | Parent window moves to the
new window. front.

reuse Subsystem replaces the | Parent window replaces
parent in the current subsystem in current window
window.

replace Subsystem appears in Parent window appears.
a new window. Parent Subsystem window disappears.
window disappears.

mixed Subsystem appears in its | Parent window rises to front.
own window. Subsystem window disappears.

Labeling Subsystem Ports

Simulink labels ports on a Subsystem block. The labels are the names of
Inport and Outport blocks that connect the subsystem to blocks outside the
subsystem through these ports.

You can hide (or show) the port labels by

® Selecting the Subsystem block, then choosing Hide Port Labels (or Show
Port Labels) from the Format menu
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® Selecting an Inport or Outport block in the subsystem and choosing Hide
Name (or Show Name) from the Format menu

® Selecting the Show port labels option in the Subsystem block’s parameter
dialog

This figure shows two models. The subsystem on the left contains two Inport
blocks and one Outport block. The Subsystem block on the right shows the
labeled ports.

I it
In —DD—@ outl
(2 et Ot In

Zain

Inz2

Sum Subsystem
Subsystem with Inport and Outport blocks Subsystem with labeled ports

Controlling Access to Subsystems

Simulink allows you to control user access to subsystems that reside in
libraries. In particular, you can prevent a user from viewing or modifying the
contents of a library subsystem while still allowing the user to employ the
subsystem in a model.

To control access to a library subsystem, open the subsystem’s parameter
dialog box and set its Access parameter to either ReadOnly or NoReadOrWrite.
The first option allows a user to view the contents of the library subsystem
and make local copies but prevents the user from modifying the original
library copy. The second option prevents the user from viewing the contents of,
creating local copies, or modifying the permissions of the library subsystem.
See the Subsystem block in the Simulink Referenceguide for more information
on subsystem access options. Note that both options allow a user to use the
library system in models by creating links (see “Working with Block Libraries”
on page 4-34).
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Creating Conditionally Executed Subsystems

A conditionally executed subsystem is a subsystem whose execution depends
on the value of an input signal. The signal that controls whether a subsystem
executes is called the control signal. The signal enters the Subsystem block
at the control input.

Conditionally executed subsystems can be very useful when you are building
complex models that contain components whose execution depends on other
components.

Simulink supports the following types of conditionally executed subsystems:

An enabled subsystem executes while the control signal is positive. It starts
execution at the time step where the control signal crosses zero (from the
negative to the positive direction) and continues execution while the control
signal remains positive. Enabled subsystems are described in more detail
in “Enabled Subsystems” on page 3-36.

A triggered subsystem executes once each time a trigger event occurs. A
trigger event can occur on the rising or falling edge of a trigger signal,
which can be continuous or discrete. Triggered subsystems are described in
more detail in “Triggered Subsystems” on page 3-40.

A triggered and enabled subsystem executes once on the time step when
a trigger event occurs if the enable control signal has a positive value at
that step. See “Triggered and Enabled Subsystems” on page 3-43 for more
information.

A control flow subsystem executes one or more times at the current time
step when enabled by a control flow block that implements control logic
similar to that expressed by programming language control flow statements
(e.g., if-then, while, do, and for. See “Modeling with Control Flow
Blocks” on page 3-71 in the online documentation for more information.
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Note Simulink displays an error if you connect a Constant, Model, or
S-Function block with constant sample time (see “Constant Sample Time”
on page 1-39) to the output port of a conditionally executed subsystem. To
avoid the error, either change the sample time of the block to a nonconstant
sample time or insert a Signal Conversion block between the block with
constant sample time and the output port.

Enabled Subsystems

Enabled subsystems are subsystems that execute at each simulation step
where the control signal has a positive value.

An enabled subsystem has a single control input, which can be scalar or
vector valued.

e Ifthe input is a scalar, the subsystem executes if the input value is greater
than zero.

e Ifthe input is a vector, the subsystem executes if any of the vector elements
is greater than zero.

For example, if the control input signal is a sine wave, the subsystem is
alternately enabled and disabled, as shown in this figure. An up arrow
signifies enable, a down arrow disable.

Simulink uses the zero-crossing slope method to determine whether an enable
is to occur. If the signal crosses zero and the slope is positive, the subsystem
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is enabled. If the slope is negative at the zero crossing, the subsystem is
disabled.

Creating an Enabled Subsystem

You create an enabled subsystem by copying an Enable block from the Ports &
Subsystems library into a subsystem. Simulink adds an enable symbol and an
enable control input port to the Subsystem block.

n

Subsystem

Setting Output Values While the Subsystem Is Disabled. Although an
enabled subsystem does not execute while it is disabled, the output signal is
still available to other blocks. While an enabled subsystem is disabled, you
can choose to hold the subsystem outputs at their previous values or reset
them to their initial conditions.

Open each Outport block’s dialog box and select one of the choices for the
Output when disabled parameter, as shown in the following dialog box:
® Choose held to cause the output to maintain its most recent value.

® Choose reset to cause the output to revert to its initial condition. Set the
Initial output to the initial value of the output.

Block Parameters: Outl

— Outport

Provide an output port for a subsystern or model. The 'Output when
dizabled' and 'Initial output’ parameters only apply to conditionally executed
subspstems. When a conditionally executed subspstem iz dizabled, the
output iz either held at itz last value or gt ta the ‘Initial output’. The ‘Initial
output' parameter can be specified az the empty matrix, [I, in which case
the initial output is equal to the output of the block feeding the outport.

Fart nurnber:

I Select an option fo set the Outport output while the
== subsystem is disabled.

Output when dizabled:

Initial output:

¥~ The initial condition and the value when reset.
QK I Cancel Help | Apply |
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Setting States When the Subsystem Becomes Reenabled. When an
enabled subsystem executes, you can choose whether to hold the subsystem
states at their previous values or reset them to their initial conditions.

To do this, open the Enable block dialog box and select one of the choices for
the States when enabling parameter, as shown in the dialog box following:

e Choose held to cause the states to maintain their most recent values.

® Choose reset to cause the states to revert to their initial conditions.

Block Parameters: Enable

Enable Port
IVF'Iace thiz block in a subsystem to create an enabled subsystem. ‘

=
F

States when enabling: Iheld J
™ Show output part e

QK I Cancel | Help | Lppli |

Select an option to set the states when the subsystem is
reenabled.

Outputting the Enable Control Signal. An option on the Enable block
dialog box lets you output the enable control signal. To output the control
signal, select the Show output port check box.

Block Parameters: Enable

Enable Port
[Place thiz block in a subsyztem to create an enabled subsystem, |
Paramet
States when enabling: Iheld ﬂ

QK I Cancel | Help | Apply |

This feature allows you to pass the control signal down into the enabled
subsystem, which can be useful where logic within the enabled subsystem is
dependent on the value or values contained in the control signal.

Blocks an Enabled Subsystem Can Contain

An enabled subsystem can contain any block, whether continuous or discrete.
Discrete blocks in an enabled subsystem execute only when the subsystem
executes, and only when their sample times are synchronized with the
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simulation sample time. Enabled subsystems and the model use a common
clock.

Note Enabled subsystems can contain Goto blocks. However, only state
ports can connect to Goto blocks in an enabled subsystem. See the Simulink
demo model, clutch, for an example of how to use Goto blocks in an enabled
subsystem.

For example, this system contains four discrete blocks and a control signal.
The discrete blocks are

e Block A, which has a sample time of 0.25 second

¢ Block B, which has a sample time of 0.5 second

¢ Block C, within the enabled subsystem, which has a sample time of 0.125
second

® Block D, also within the enabled subsystem, which has a sample time of
0.25 second

The enable control signal is generated by a Pulse Generator block, labeled
Signal E, which changes from 0 to 1 at 0.375 second and returns to 0 at 0.875
second.

ﬂ_ﬂ_ﬂ Signal E

¥ -t
.
J-L J-L
1 Enable
z
Sine Wiave Blodk & Dizplay CT_)_F ; 1
Te=0.25 In1 P Outl
Ts=0.125
! 1]
e - Wiz Ouw? > -
; CZ—w - w2
Fandom Blodk B Scope Inz z et
Number Ts=05 Er—— Tblocé:gﬁ
S - == 0,
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The chart below indicates when the discrete blocks execute.

| | | | Il | | |
L | — - — e —— —— -
Signal E 0 o ] L ———
BockD | I L _|_ & _ | A_ | _I__ -wﬁﬁm
[aolag
Black ( __|_|__*__1.._L_l._|__|__
eck | 1 I
Block & _l_I__l_ _F:*_T__‘
o —I—-T -7t -1 -
| | |

Time [sex)

Blocks A and B execute independently of the enable control signal because
they are not part of the enabled subsystem. When the enable control signal
becomes positive, blocks C and D execute at their assigned sample rates until
the enable control signal becomes zero again. Note that block C does not
execute at 0.875 second when the enable control signal changes to zero.

Triggered Subsystems

Triggered subsystems are subsystems that execute each time a trigger event
occurs.

A triggered subsystem has a single control input, called the trigger input, that
determines whether the subsystem executes. You can choose from three types
of trigger events to force a triggered subsystem to begin execution:

® rising triggers execution of the subsystem when the control signal rises
from a negative or zero value to a positive value (or zero if the initial value
is negative).

e falling triggers execution of the subsystem when the control signal falls
from a positive or a zero value to a negative value (or zero if the initial
value is positive).

e either triggers execution of the subsystem when the signal is either rising
or falling.
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Note In the case of discrete systems, a signal’s rising or falling from zero is
considered a trigger event only if the signal has remained at zero for more

than one time step preceding the rise or fall. This eliminates false triggers
caused by control signal sampling.

For example, in the following timing diagram for a discrete system, a rising
trigger (R) does not occur at time step 3 because the signal has remained at

zero for only one time step when the rise occurs.

o 1 2 = 4 s 8 7T
| | 1 | | | |
| | | | | | I
[ N I T e
| | —l | | I

| | | 1

: LT
F R F R E

Signal Level

 Time

A simple example of a triggered subsystem is illustrated.

ﬂ_ﬂ_ﬂ Trigger
Signal

E—bln Out P simout

Sine Wiawe

Trigger

1

=
In

Unit Crelay

Clut

In this example, the subsystem is triggered on the rising edge of the square

wave trigger control signal.
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Creating a Triggered Subsystem

You create a triggered subsystem by copying the Trigger block from the Ports
& Subsystems library into a subsystem. Simulink adds a trigger symbol and a
trigger control input port to the Subsystem block.

£

Subsystemn

To select the trigger type, open the Trigger block dialog box and select one of
the choices for the Trigger type parameter, as shown in the following dialog
box:

Block Parameters: Trigger: #

— Trigger Port

Flace thiz block in a subsystem to create a tiggered subsysten.

=
F

44— Select the trigger fype.

Trigger type: ([T

States when enabling: Iheld -

[~ Show output port

Dutput data ype: Iauto j

[¥ Enable zero crossing detection

QK I Cancel | Help | Apply |

Simulink uses different symbols on the Trigger and Subsystem blocks to
indicate rising and falling triggers (or either). This figure shows the trigger
symbols on Subsystem blocks.

£ * i1
Subsystermn with Subsystem with Subsystem with
Rizing trigger Falling trigger Rizing ar Falling
trigger

Outputs and States Between Trigger Events. Unlike enabled subsystems,
triggered subsystems always hold their outputs at the last value between
triggering events. Also, triggered subsystems cannot reset their states when
triggered; states of any discrete blocks are held between trigger events.
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Outputting the Trigger Control Signal. An option on the Trigger block
dialog box lets you output the trigger control signal. To output the control
signal, select the Show output port check box.

Block Parameters: Trigger: E #

— Trigger Port

Flace thiz block in a subsystem to create a triggered subsystem.

=

Trigger type: ([T

States when enabling: Iheld -
I Show output port < Select this check box to show the output port.
Mutput data bpe; Iauto j

[¥ Enable zero crossing detection

QK I Cancel | Help | Apply |

The Output data type field allows you to specify the data type of the output
signal as auto, int8, or double. The auto option causes the data type of the

output signal to be set to the data type (either int8 or double) of the port to

which the signal is connected.

Function-Call Subsystems

You can use a Trigger block to create a subsystem whose execution is
determined by logic internal to an S-function instead of by the value of a
signal. These subsystems are called function-call subsystems. For more
information about function-call subsystems, see “Function-Call Subsystems”
in the “Writing S-Functions Guide”.

Blocks That a Triggered Subsystem Can Contain

All blocks in a triggered systems must have either inherited (- 1) or constant
(inf) sample time. This is to indicate that the blocks in the triggered
subsystem run only when the triggered subsystem itself runs, i.e., when it is
triggered. This requirement means that a triggered subsystem cannot contain
continuous blocks, such as the Integrator block.

Triggered and Enabled Subsystems

A third kind of conditionally executed subsystem combines both types of
conditional execution. The behavior of this type of subsystem, called a
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triggered and enabled subsystem, is a combination of the enabled subsystem
and the triggered subsystem, as shown by this flow diagram.

Triggerevent

Dion't execute the subsystem

Exzcute the subsystem

A triggered and enabled subsystem contains both an enable input port and
a trigger input port. When the trigger event occurs, Simulink checks the
enable input port to evaluate the enable control signal. If its value is greater
than zero, Simulink executes the subsystem. If both inputs are vectors, the
subsystem executes if at least one element of each vector is nonzero.

The subsystem executes once at the time step at which the trigger event
occurs.

Creating a Triggered and Enabled Subsystem

You create a triggered and enabled subsystem by dragging both the Enable
and Trigger blocks from the Ports & Subsystems library into an existing
subsystem. Simulink adds enable and trigger symbols and enable and trigger
and enable control inputs to the Subsystem block.

I 4

Subsystemn

3-44



Creating Conditionally Executed Subsystems

You can set output values when a triggered and enabled subsystem is disabled
as you would for an enabled subsystem. For more information, see “Setting
Output Values While the Subsystem Is Disabled” on page 3-37. Also, you can
specify what the values of the states are when the subsystem is reenabled.
See “Setting States When the Subsystem Becomes Reenabled” on page 3-38.

Set the parameters for the Enable and Trigger blocks separately. The
procedures are the same as those described for the individual blocks.

A Sample Triggered and Enabled Subsystem

A simple example of a triggered and enabled subsystem is illustrated in the

model below.

E'."able Trigger
Signal Signal
n 4
Sine Wrave Dizplay
= Subsystem -
Enable Trigger
1
In = aut
Unit Dalay
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Creating Alternately Executing Subsystems

You can use conditionally executed subsystems in combination with Merge
blocks to create sets of subsystems that execute alternately, depending on the
current state of the model. The following figure shows a model that uses two
enabled blocks and a Merge block to model a full-wave rectifier — a device that
converts AC current to pulsating DC current.

.
Sine Wave ; i
n Ercbile
p{h  Outl—
pos -_‘_____ p— In Gimin Out
Mo __FE_
A’V Mg —
Mo Soope
SEin Ldl I
L. SIS EL R il
] g
n Cut)—
Trteal In Gain o

The block labeled “pos” is enabled when the AC waveform is positive; it passes
the waveform unchanged to its output. The block labeled “neg” is enabled
when the waveform is negative; it inverts the waveform. The Merge block
passes the output of the currently enabled block to the Mux block, which
passes the output, along with the original waveform, to the Scope block. The
Scope creates the following display.

|lemop e dEE B2 5
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Conditional Execution Behavior

To speed simulation of a model, Simulink by default avoids unnecessary
execution of blocks connected to Switch, Multiport Switch, and conditionally
executed blocks, a behavior called conditional execution (CE) behavior. You
can disable this behavior for all Switch and Multiport Switch blocks in

a model or for specific conditionally executed subsystems (see “Disabling
Conditional Execution Behavior” on page 3-50).

The following model illustrates conditional execution behavior.

_?_._!_1_._(?_:0

Gain block’s sorted order
(1:2) is second (2) in the
gondise / enabled subsystem’s
Pulse Type = Sample based N eXNU"Oﬂ(Oﬂme(IL
Period = 100
Pulse Width = 50

Phase = 50
Sample Time = 0.01

\ 4
B

o

Gain

|

0:1{1
5 I L]
1 (Ppini outl [ AN

C tant -~
ons an;/ Enabled \
P Subsystem \

.” Propagate exec context z on
-

e \

Enable

Inl Outl
Initial output = []
Output when disabled = held

Simulink computes the outputs of the Constant block and Gain block only
while the enabled subsystem is enabled (i.e., at time steps 0.5 to 1.0, 1.5 to
2.0, and so on). This is because the output of the Constant block is required
and the input of the Gain block changes only while the enabled subsystem
is enabled. When CE behavior is off, Simulink computes the outputs of the
Constant and Gain blocks at every time step, regardless of whether the
outputs are needed or change.
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In this example, Simulink regards the enabled subsystem as defining an
execution context for the Constant and Gain blocks. Although the blocks
reside graphically in the model’s root system, Simulink invokes the blocks’
methods during simulation as if the blocks reside in the enabled subsystem.
Simulink indicates this in the sorted order labels displayed on the diagram for
the Constant and Gain blocks. The notations list the subsystem’s (id = 1) as
the execution context for the blocks even though the blocks exist graphically
at the model’s root level (id = 0).

Propagating Execution Contexts

In general, Simulink defines an execution context as a set of blocks to be
executed as a unit. At model compilation time, Simulink associates an
execution context with the model’s root system and with each of its nonvirtual
subsystems. Initially, the execution context of the root system and each
nonvirtual subsystem is simply the blocks that it contains.

When compiling a model, Simulink examines each block in the model to
determine whether it meets the following conditions:

e Its output is required only by a conditionally executed subsystem or its
input changes only as a result of the execution of a conditionally executed.
* The subsystem’s execution context can propagate across its boundaries.

® The output of the block is not a testpoint (see “Working with Test Points”
on page 5-43).

® The block is allowed to inherit its conditional execution context.
Simulink does not allow some built-in blocks, e.g., the Delay
block, ever to inherit their execution context. Also, S-Function

blocks can inherit their execution context only if they specify the
SS _OPTION CAN_BE CALLED CONDITIONALLY option.

® The block is not a multirate block.

¢ Its sample time is inherited (-1) or constant (inf).

If a block meets these conditions and execution context propagation is
enabled for the associated conditionally executed subsystem (see “Disabling

Conditional Execution Behavior” on page 3-50), Simulink moves the block
into the execution context of the subsystem. This ensures that the block’s
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methods are executed during the simulation loop only when the corresponding
conditionally executed subsystem executes.

Behavior for Switch Blocks

This behavior treats the input branches of a Switch or Multiport Switch block
as invisible, conditionally executed subsystems, each of which has its own
execution context that is enabled only when the switch’s control input selects
the corresponding data input. As a result, switch branches execute only when
selected by switch control inputs.

Displaying Execution Contexts

To determine the execution context to which a block belongs, select Sorted
order from the model window’s Format menu. Simulink displays the sorted
order index for each block in the model in the upper-right corner of the block.
The index has the format s:b, where s specifies the subsystem to whose
execution context the block belongs and b is an index that indicates the block’s
sorted order in the subsystem’s execution context, e.g., 0:0 indicates that the
block is the first block in the root subsystem’s execution context.

If a bus is connected to the block’s input (see “Bus-Capable Blocks” on page
5-11), Simulink displays the block’s sorted order as s:B, e.g., 0:B indicates
that the block belongs to the root system’s execution context and has a bus
connected to its input.

Simulink expands the sorted order index of conditionally executed subsystems
to include the system ID of the subsystem itself in curly brackets as illustrated
in the following figure.

+H
+H +H+ H
FPules
Genarator ?‘
o nowel
1 —=ini Ot Scope
Constant Enablad Gain

Subsystam
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In this example, the sorted order index of the enabled subsystem is 0:1{1}.
The 0 indicates that the enabled subsystem resides in the model’s root system.
The first 1 indicates that the enabled subsystem is the second block on

the root system’s sorted list (zero-based indexing). The 1 in curly brackets
indicates that the system index of the enabled subsystem itself is 1. Thus any
block whose system index is 1 belongs to the execution context of the enabled
subsystem and hence executes when it does. For example, the Constant
block’s index, 1:0, indicates that it is the first block on the sorted list of the
enabled subsystem, even though it resides in the root system.

Disabling Conditional Execution Behavior

To disable conditional execution behavior for all Switch and Multiport Switch
blocks in a model, turn off the Conditional input branch execution
optimization on the Optimization pane of the Configuration Parameters
dialog box (see “ Optimization Pane” on page 9-53). To disable conditional
execution behavior for a specific conditionally executed subsystem, uncheck
the Propagate execution context across subsystem boundary option on
the subsystem’s parameter dialog box.

Even if this option is enabled, a subsystem’s execution context cannot
propagate across its boundaries under either of the following circumstances:

® The subsystem is a triggered subsystem with a latched input port.

® The subsystem has one or more output ports that specify an initial
condition, i.e., whose initial condition is other than []. In this case, a
block connected to the subsystem’s output cannot inherit the subsystem’s
execution context.
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Displaying Execution Context Bars

Simulink can optionally display bars next to the ports of subsystems across
which execution contexts cannot propagate, i.e., on subsystems from which no
block can inherit its execution context.

+H+ +H+
xecution cantext bars

Fulss
Genearabor

1 —mfint ouifb—— w1 )

Constant

Enablec
Subsystam

To display the bars, select Execution context indicator from the model
editor’s Format > Block Displays menu.
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Simulink allows you to include models in other models as blocks, a feature
called model referencing. You create references to other models by creating
instances of Model blocks in a parent model (see “Creating a Model Reference’
on page 3-54). Each instance of a Model block in a parent model represents a
reference to another model called a referenced model. A Model block displays
inputs and outputs corresponding to the root-level inputs and outputs of the
model it references, enabling you to incorporate the referenced model into the
block diagram of the parent model.

4

During simulation, Simulink invokes an automatically generated S-function,
called the referenced model’s simulation target, to compute the Model block’s
outputs as needed. If the simulation target does not exist at the beginning
of a simulation, Simulink generates it from the referenced model. If the
simulation target does exist, Simulink checks whether the referenced model
has changed significantly since the target was last generated. If so, Simulink
regenerates the target to reflect the changes to the referenced model (see
“Building Simulation Targets” on page 3-64 for more information).

Note Real-Time Workshop similarly generates library modules, called
Real-Time Workshop targets, for the referenced models and a stand-alone
executable for the root model, with the parent target invoking the referenced
model targets to compute the referenced model outputs as needed. See the
“Real-Time Workshop User’s Guide” for more information.

A referenced model can itself reference other models. The topmost model in a
hierarchy of model references is called the root model. A parent model can
contain multiple references to the same model as long as the referenced model
does not define global data. You can parameterize model references such
that each reference to a model can specify different values for variables that
define the model’s behavior (see “Parameterizing Model References” on page
3-56 for more information).

Simulink includes a set of demos that illustrate various aspects of model
referencing. To access these demos from the MATLAB command line,
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In the MATLAB Command Window, type

demos

A list of MATLAB products appears on the left side of the Help window.

2 From the left side of the window, select Simulink.

A list of Simulink examples appears on the right side of the Help window.

3 Under Simulink, select Modeling Features.

This category contains most of the model referencing demos.

Model Referencing Versus Subsystems

Like subsystems, model referencing allows you to organize large models
hierarchically, with Model blocks representing major subsystems. However,
model referencing has significant advantages over subsystems in many
applications. The advantages include:

Modular development

You can develop the referenced model independently from the models in
which it is used.

Inclusion by reference

You can reference a model multiple times in another model without having
to make redundant copies and multiple models can reference the same
model.

Incremental loading

The referenced model is not loaded until it is needed, speeding up model
loading (see “Incremental Loading” on page 3-67 for more information).

Incremental code generation

Simulink and Real-Time Workshop create binaries to be used in simulations
and stand-alone applications to compute the outputs of the included blocks.
If the binaries are up-to-date, that is, the binaries are not older than the
models from which they were generated, no code generation occurs when
models that reference them are simulated or compiled.
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Simulink provides a tool to convert atomic subsystems to stand-alone models
and to reconfigure the root model by replacing the subsystems with Model
blocks. For further information, see “Converting Subsystems to Model
References” on page 3-70. It also provides a command, find_mdlrefs, to find
all models directly or indirectly referenced by a given model.

Creating a Model Reference
To create a reference to a model in another model:

1 If the model is not on the MATLAB path, add it to the MATLAB path.

2 Enable the parent model’s Inline parameters optimization if it is not
already enabled (see “Inline parameters” on page 9-57).

3 Create an instance of the Model block in the parent model (for example, by
opening the Library Browser and dragging an instance from the Ports &
Subsystems block library to the parent model).

lparent *

File Edit Yiew Simulation Format Tools Help
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4 Open the newly created Model block’s parameter dialog box.

CBlock Parameters: Model3 | !

21|

—Model Reference

Specify the name of a Simulink model. During update diagram, simulation, and code
generation, Simulink generates code for the referenced model and uses the generated
code. These operations alzo refresh Model blocks to reflect graphical changes, such
as humber of ports, in the referenced model. To refresh without perfarming these
operations, select Edit-> Refresh Model Blocks.

=
F

Model name [without the .mdl extension]:

|<Enter Model Mame::

Model arguments:

Model argument walues [for this instance]:

Open todel |

[ o |

Lancel

Apply

5 Enter the name of the referenced model in the parameter dialog box’s
Model name field. The referenced model must be configured to use a

fixed-step solver.

6 Click OK to apply the model name and close the dialog box.

If the referenced model contains any root-level inputs or outputs, Simulink
displays corresponding input and output ports on the Model block instance
that you have created. Use these ports to connect the reference model to

other ports in the parent model.
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Note See “Referenced Model I/0” on page 3-63 for information on connecting
blocks in a parent model to a model that has bus inputs or outputs.

Opening a Referenced Model

To open a referenced model, select the Model block that references the model.
Then select Open Model from the model editor’s Edit menu or from the
block’s context menu.

Parameterizing Model References

Simulink allows you to parameterize references to models, i.e., use workspace
variables to determine their behavior. You can parameterize a model in the
following ways:

e Use global nontunable parameters in the MATLAB workspace or in a model
workspace to determine the behavior of all references to a given model.

A global nontunable parameter is a MATLAB variable or a
Simulink.Parameter object whose storage class is auto. The value of such
a variable cannot be changed during simulation.

e Use global tunable parameters in the MATLAB workspace to determine the
behavior of all references to a given model in the model.

A global tunable parameter is a parameter specified by an object of
Simulink.Parameter class that has a storage class other than auto. The
value of such a variable can be changed during simulation, allowing you
to change the behavior of the referenced models.

® Use model arguments in the model to specify different behavior for
different references to the same model (see “Model Referencing and the
Inline Parameters Optimization” on page 3-56).

Model Referencing and the Inline Parameters Optimization
Simulink does not support the off setting of the inline parameters
optimization (see “Inline parameters” on page 9-57) for models that contain
Model blocks. Simulink ignores the settings in the Tunable Parameter
dialog box (see “Model Parameter Configuration Dialog Box” on page 9-66)
for models that contain Model blocks and for referenced models. To help you
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convert existing models to model referencing, Simulink provides a command
that converts tunable parameters specified in the Tunable Parameter dialog
box, which do not work with model referencing, to global tunable parameters
that do work with model referencing. Type

help tunablevars2parameterobjects

at the MATLAB command line for more information.

Using Model Arguments

Model arguments let you create references to the same model that behave
differently. For example, suppose you want each reference to a counter model
to be able to specify initial and increment values for the counter where the
specified values can differ from reference to reference. Using model arguments
to parameterize references to the counter model allows you to do this.

Note Run the sldemo _mdlref paramargs demo to see parameterized model
references in action.

Using model arguments requires that you

® Declare model workspace variables that determine the model’s behavior
as model arguments

® Assign values to the model arguments in each reference to the
parameterized model

The following sections explain how to perform these tasks.

Declaring Model Arguments

To declare some or all of a model’s model workspace variables as model
arguments:

1 Open the referenced model.

2 Open the Model Explorer.
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3 Select the model’s workspace in the Model Explorer.

& Model Explorer
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4 Ifyou have not already done so, use the Model Explorer to create MATLAB
variables in the model’s workspace that determine the model’s behavior.
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5 Enter the names of the workspace variables that you want to declare as

model arguments as a comma-separated list in the Model arguments field
in the model workspace’s dialog box.

& Model Explorer
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6 Click the Apply button on the dialog box to confirm the entered names.

Note If a model does not declare a variable in its workspace as a model
argument, the variable has the same value in every reference to the model
and cannot be tuned from a parent model. For example, suppose that a
model defines a variable k in its workspace but does not declare it as a
model argument. Further, suppose that the model assigns a value of 5

to k in its workspace. Then the value of k will be 5 in every reference to
the model in other models.

Assigning Values to Model Arguments

If a model declares model arguments, you must assign values to the model
arguments in each reference to the model, i.e., in each Model block that
references the model.

To assign values to a model’s model arguments in a Model block that
references the model:
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1 Open the Model block’s parameter dialog box.
2] x|

CBlock Parameters: Model

—Model Reference
Specify the name of a Simulink model. During update diagram, simulation, and code
generation, Simulink generates code for the referenced model and uses the generated
code. These operations alzo refresh Model blocks to reflect graphical changes, such
as humber of ports, in the referenced model. To refresh without perfarming these

operations, select Edit-> Refresh Model Blocks.

=3 |
F

Model name [without the .mdl extension]:

Icounter

Model arguments:

Iinit_value,inc:r

Model argument walues [for this instance]:

Open todel |

Apply |

2 Enter a comma-delimited list of values for the parameter arguments in the
Model argument values field in the same order in which the arguments

appear in the Model arguments field.

Ok | Lancel |

E1Block Parameters: Model

—Model Reference
Specify the name of a Simulink model. During update diagram, simulation, and code
generation, Simulink generates code for the referenced model and uses the generated
code. These operations alzo refresh Model blocks to reflect graphical changes, such
as humber of ports, in the referenced model. To refresh without perfarming these
operations, select Edit-> Refresh Model Blocks.

=3 |
F

Model name [without the .mdl extension]:

Icounter
Model arguments:
Iinit_value,inc:r

Model argument walues [for this instance]:

J1a

Open todel |

Apply |

You can enter the values as literal values, variable names, MATLAB
expressions, and Simulink parameter objects. The value for a particular

Ok | Lancel |
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argument must have the same dimensions and data and numeric type as
the model workspace variable that defines the argument.

Model Block Sample Times

The sample times of a Model block are the sample times of the model that

it references. If the referenced model needs to run at specific rates, the
referenced model’s simulation target specifies the required rates. Otherwise,
the target specifies that the referenced model inherits its sample time from
the parent model. Specifically, a referenced model inherits its sample time if
all the following conditions are true:

® None of its blocks specify sample times (other than inherited and constant).
¢ It does not have any continuous states.
® It does not contain any blocks that use absolute time.

® It specifies a fixed-step solver but not a fixed step size.

e After sample time propagation, it has only one sample time (not counting
constant and triggered sample time).

¢ It does not contain any blocks that preclude sample time inheritance (see
“Blocks That Preclude Sample-Time Inheritance” on page 3-62)

You can use a referenced model that inherits its sample time anywhere

in a parent model. By contrast, you cannot use a referenced model that
has intrinsic sample times in a triggered, function call, or for an iterator
subsystem. Further, to avoid rate transition errors, you must ensure that
blocks connected to a referenced model with intrinsic samples times operate
at the same rates as the referenced model.
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To determine whether a referenced model inherits its sample time, set the
Periodic sample time constraint on the Solver configuration parameters
dialog pane to Ensure sample time independent (see “Periodic sample
time constraint” on page 9-44). If the model is unable to inherit sample times,
this setting causes Simulink to display an error message when generating the
referenced model’s simulation (or Real-Time Workshop) target. To determine
the intrinsic sample time of a referenced model (or the fastest intrinsic sample
time for multirate referenced models), first update a model that references it.
Then select a Model block that references the referenced model and enter the
following command at the MATLAB command line:

get param(gcb, 'CompiledSampleTime')

Blocks That Preclude Sample-Time Inheritance

Using a block whose output depends on an inherited sample time in a
referenced model can cause a simulation to produce unexpected or erroneous
results. For this reason, when building a simulation target for a model
that does not need to run at a specified rate, Simulink checks whether the
model contains any blocks, including any S-Function blocks, whose outputs
are functions of the inherited simulation time. If so, Simulink generates

a simulation target that specifies a default sample time and displays an
error if you have set the Periodic sample time constraint on the Solver
configuration parameters dialog pane to Ensure sample time independent
(see “Periodic sample time constraint” on page 9-44).

The outputs of the following built-in blocks depend on their inherited sample
time and hence preclude a referenced model from inheriting its sample time

from the parent model:

® Discrete-Time Integrator

From Workspace (if it has input data that contains time)

Probe (if probing sample time)

Rate Limiter

e Sine Wave
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Simulink assumes that the output of an S-function does not depend on
inherited sample time unless the S-function explicitly declares the contrary
(see "Writing S-Functions" for information on how to create S-functions that
declare whether their output depends on their inherited sample time). Thus,
to avoid simulation errors with referenced models that inherit their sample
time, you need to take care not to include S-functions in the referenced models
that fail to declare whether their output depends on their inherited sample
time. Simulink by default warns you if your model contains such blocks when
you update or simulate the model (see “Unspecified inheritability of sample
time” on page 9-69).

Referenced Model 1/0

Simulink imposes the following restrictions on connecting signals to the
inputs and outputs of Model blocks.

Bus 1/0 Limitations

A parent model can reference a model with bus input or output ports only if
each bus port meets the following conditions:

® The port is defined by a bus object, i.e., an instance of Simulink.Bus class
specified as the value of the port block’s Bus object parameter.

® The bus object is defined in a workspace that is visible from both the
parent and the referenced model, e.g., the MATLAB workspace for a model
referenced by a root model.

Similarly, the bus connected to a bus input port of a referenced model must be
defined by the same bus object that defines the bus input, i.e., the bus must
be created by a Bus Creator block whose Bus object parameter is set to the
bus object as is the Inport of the referenced model. This explains why the bus
object must be visible to both the parent and the referenced model.

Index 1/0 Limitations

In some circumstances, Simulink does not propagate 0- or 1-based indexing
information to the root-level ports connected to blocks in the referenced model
that accept indices, e.g., the Assignment block, or produce indices, e.g., the
For Iterator block. In particular, if a root-level input port is connected to index
inputs in the referenced model whose 0- or 1-based indexing properties differ,
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Simulink does not set the 0- or 1-based indexing property of the input port.
Similarly, if a root-level output port of the referenced model is connected to
index outputs in the model that have different 0- or 1-based indexing settings,
Simulink does not set the 0- or 1-based indexing property of the root-level
output port. This can cause Simulink to miss incompatible index connections
when the model is referenced by another model.

Matching 1/0 Rates

In a referenced model, the first nonvirtual block connected downstream from
a root-level Inport of the referenced model and the first nonvirtual block
connected upstream from a root-level Outport must have the sample time as
the Inport or Outport block. If the rates do not match when you update or
start a simulation of the referencing model, Simulink halts and displays an
error. You can use Rate Transition blocks to match the root-level input and
output sample times as illustrated in the following diagram.
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Building Simulation Targets

A simulation target is an S-function that computes the outputs of a referenced
model during simulation of the model’s parent. You can command Simulink
to generate simulation targets for model references at any time by updating
the model’s diagram or by executing the slbuild command at the MATLAB
command line or you can let Simulink determine whether and when to

build the simulation targets. If the simulation target for a referenced model
does not exist at the start of a simulation, Simulink generates the target.
Subsequently, if the files or workspace variables used to build the target
change, it may be necessary to rebuild the target to reflect the changes,
depending on whether the changes affect target outputs. You can let Simulink
determine whether to rebuild existing targets or specify that Simulink always
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or never rebuild targets at the beginning of a simulation (see “Rebuild options
for all referenced models” on page 9-97).

While generating a target, Simulink displays status messages at the MATLAB
command line to enable you to monitor the target generation process, which
entails generating and compiling code and linking the compiled target code
with compiled code from standard code libraries to create an executable file.

Simulink creates simulation targets in the current working directory. It
stores intermediate files used to generate the simulation targets in separate
subdirectories of a subdirectory of the working directory named slprj. If the
slprj directory does not exist, Simulink creates it. The Simulink Accelerator
and Real-Time Workshop also use the slprj subdirectory of the current
working directory to store intermediate files used to build acceleration targets
and stand-alone targets, respectively.

Project Directories

The policy of having all Simulink-related products store generated files in
the same subdirectory of the current work directory makes it easy for you to
keep all the generated files for a given project together and separate from
generated files belonging to other projects. All that is required is that you
create a separate directory for each project and make the directory for a given
project the current working directory when you are working on the project.

Function-Call Models

Simulink allows certain blocks, such as a Function-Call Generator or

an appropriately configured custom S-function, to control execution of

a referenced model during a time step, using a function-call signal (see
“Function-Call Subsystems” for more information). A referenced model
capable of being invoked in this way is called a function-call model. The block
that controls execution of the function-call model is known as the function-call
controller. To view a function-call model demo, select Simulink > Model
Features > Model Reference Function-Call from the Demos pane of

the MATLAB Help Browser.
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To create a function-call model, insert a Trigger block in the root level of the
referenced model and set the Trigger block’s Trigger type parameter to
function-call. Model blocks that reference a function-call model display a
function-call trigger port to which you can connect the function-call signal

emitted by a function-call controller block.
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To be a function-call model, a referenced model must meet the following
conditions in addition to the conditions that any referenced model must meet.

¢ [fthe Sample time type of the function-call model’s Trigger block is
triggered, the model must be sample-time independent, i.e., all of the
blocks that it contains must inherit their sample times. You can ensure
that the model meets this condition by setting its Periodic sample time

constraint to Ensure sample time independent.
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¢ Ifthe Sample time type is periodic, the sample-time period cannot
contain an offset.

® The solver specified by the model must be a fixed-step solver.
® The model cannot have direct internal connections between its root-level

input and output ports.

A limitation also exists on the function-call signal itself, namely, you
cannot use vector function-call signals to control a function-call model. The
function-call signal must be a scalar.

Note Simulink does not honor the None and Warning settings for the Invalid
root Inport/OQutport block connection diagnostic for the referenced model.
It reports all invalid root port connections as errors.

Model Interfaces

A referenced model’s interface consists of its input and output ports (and
trigger port in the case of function-call models) and its parameter arguments.
Model block instances depict the interfaces of the models they reference.

Incremental Loading

Simulink takes advantage of this fact to defer loading of referenced models
until you update or simulate the model that references them. This feature,
called incremental loading, allows you to begin editing a model before it is
completely loaded, a useful capability when you need to make changes to
large, complex models.

Note To take advantage of incremental loading, models referenced by Model
blocks must have been opened and saved at least once in Release 14 (or
a later version) of Simulink.

Refreshing Model Blocks

Refreshing Model blocks refers to the process of updating them to reflect
graphical changes in the interfaces of the models they reference. To refresh
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all of a model’s Model blocks, select Refresh Model Blocks from the model’s
Edit menu. To update a specific Model block, select Refresh from the block’s
context (pop-up) menu.

You should refresh a Model block instance if the model that it references has
changed since the block was created or since it was last refreshed and the
changes affect the block’s graphical appearance, for example, the referenced
model gained or lost a port. Simulink provides diagnostics that enable you
to detect changes in the interfaces of referenced models that could require
refreshing the Model blocks that reference them. The diagnostics include

® Model block version mismatch (see “Model block version mismatch” on
page 9-88)

¢ [/O port and parameter mismatch (see “Port and parameter mismatch”
on page 9-89)

Displaying Referenced Model Version Numbers

To display the version numbers of the models referenced by a model (see
“Managing Model Versions” on page 3-104), select Model block version from
the Block displays submenu of the parent model’s Format menu. Simulink
displays the version numbers in the icons of the corresponding Model block
instances.

countar
Count
Rev = 1.10

Model

Scope
countar
Count

Rev=1.10
Modell

The version number displayed on a Model block’s icon refers to the version
of the model used to create the block or refresh the block when it was last
refreshed.
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Browsing Model Reference Dependencies

To browse a graph of the models that a model references directly or indirectly,
select Tools > Model Reference Graph from the Model Editor’s menu bar
or enter view_mdlrefs at the MATLAB command line. A MATLAB figure
window appears that displays a browsable graph of the models that the top
model references.

=} Model Reference Dependency Graph: slddemo_mdiref_depgraph i | Ellil
File Help N

¢ dldemo_mdiref_deparaph ¥

gldemo_mdlref_outdoor_temp

gldermo_mdlref_F2C

gldemo_mdiref_heater
gdemo_mdlref_thermostat

Click on a node to open the model

gldermo_mdlref_heatZcost

The nodes in the graph represent Simulink models. The directed lines indicate
model dependencies. Click any node in the graph to open the corresponding
model. The window’s File menu allows you to open, close, and save models
and print and refresh the dependency graph. The window’s Help menu
allows you to display the demos pane of the MATLAB Help Browser. For
more information, select Simulink > Model Features > Visualizing Model
Reference Architectures from the Help Browser’s Demos pane.
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Converting Subsystems to Model References
Converting an existing model to use model referencing can be
a time-consuming and error-prone task if done by hand. See

Simulink.SubSystem.convertToModelReference for a MATLAB command
that automates this task.
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Modeling with Control Flow Blocks

The control flow blocks are used to implement the logic of the following C-like
control flow statements in Simulink:

e for

e if-else

® switch

e while (includes while and do-while control flow statements)

Although all the preceding control flow statements are implementable in

Stateflowe, these blocks are intended to provide Simulink users with tools that
meet their needs for simpler logical requirements.

Creating Conditional Control Flow Statements

You create C-like conditional control flow statements using ordinary
subsystems and the following blocks from the Subsystems library.

C Statement | Blocks Used
if-else If, Action Port

switch Switch Case, Action Port
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If-Else Control Flow Statements
The following diagram depicts a generalized if-else control flow statement
implementation in Simulink.
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Construct a Simulink if-else control flow statement as follows:

® Provide data inputs to the If block for constructing if-else conditions.

Inputs to the If block are set in the If block properties dialog box. Internally,
they are designated as u1, u2,..., un and are used to construct output
conditions.

® Set output port if-else conditions for the If block.

Output ports for the If block are also set in its properties dialog box. You
use the input values u1, u2, ..., un to express conditions for the if,
elseif, and else condition fields in the dialog box. Of these, only the if field
is required. You can enter multiple elseif conditions and select a check box
to enable the else condition.

® Connect each condition output port to an Action subsystem.

Each if, elseif, and else condition output port on the If block is connected
to a subsystem to be executed if the port’s case is true. You create these
subsystems by placing an Action Port block in a subsystem. This creates
an atomic Action subsystem with a port named Action, which you then
connect to a condition on the If block. Once connected, the subsystem takes
on the identity of the condition it is connected to and behaves like an
enabled subsystem.
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For more detailed information, see the If and Action Port blocks.

Note All blocks in an Action subsystem driven by an If or Switch Case block
must run at the same rate as the driving block.

Switch Control Flow Statements

The following diagram depicts a generalized switch control flow statement
implementation in Simulink.
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Construct a Simulink switch control flow statement as follows:

® Provide a data input to the argument input of the Switch Case block.

The input to the Switch Case block is the argument to the switch control
flow statement. This value determines the appropriate case to execute.
Noninteger inputs to this port are truncated.

e Add cases to the Switch Case block based on the numeric value of the
argument input.

You add cases to the Switch Case block through the properties dialog of the
Switch Case block. Cases can be single or multivalued. You can also add an
optional default case, which is true if no other cases are true. Once added,
these cases appear as output ports on the Switch Case block.

® Connect each Switch Case block case output port to an Action subsystem.
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Each case output of the Switch Case block is connected to a subsystem to be
executed if the port’s case is true. You create these subsystems by placing
an Action Port block in a subsystem. This creates an atomic subsystem
with a port named Action, which you then connect to a condition on the
Switch Case block. Once connected, the subsystem takes on the identity of
the condition and behaves like an enabled subsystem. Place all the block
programming executed for that case in this subsystem.

For more detailed information, see “Simulink Reference” for the Switch Case
and Action Port blocks.

Note After the subsystem for a particular case is executed, an implied break
is executed that exits the switch control flow statement altogether. Simulink
switch control flow statement implementations do not exhibit “fall through”

behavior like C switch statements.

Creating lterator Control Flow Statements

You create C-like iterator control flow statements using subsystems and the
following blocks from the Subsystems library.

C Statement Blocks Used

do-while While Iterator
for For Iterator
while While Iterator
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While Control Flow Statements

The following diagram depicts a generalized C-like while control flow
statement implementation in Simulink.
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In a Simulink while control flow statement, the While Iterator block iterates
the contents of a While subsystem, an atomic subsystem. For each iteration
of the While Iterator block, the block programming of the While subsystem
executes one complete path through its blocks.

Construct a Simulink while control flow statement as follows:

e Place a While Iterator block in a subsystem.

The host subsystem becomes a while control flow statement as indicated
by its new label, while {...}. These subsystems behave like triggered
subsystems. This subsystem is host to the block programming you want to
iterate with the While Iterator block.

® Provide a data input for the initial condition data input port of the While
Iterator block.

The While Iterator block requires an initial condition data input (labeled
IC) for its first iteration. This must originate outside the While subsystem.
If this value is nonzero, the first iteration takes place.

® Provide data input for the conditions port of the While Iterator block.
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Conditions for the remaining iterations are passed to the data input port
labeled cond. Input for this port must originate inside the While subsystem.

® You can set the While Iterator block to output its iterator value through
its properties dialog.
The iterator value is 1 for the first iteration and is incremented by 1 for
each succeeding iteration.

® You can change the iteration of the While Iterator block to do-while
through its properties dialog.

This changes the label of the host subsystem to do {...} while. With

a do-while iteration, the While Iteration block no longer has an initial
condition (IC) port, because all blocks in the subsystem are executed once
before the condition port (labeled cond) is checked.

For specific details, see “Simulink Reference” for the While Iterator block.
For Control Flow Statements

The following diagram depicts a generalized for control flow statement
implementation in Simulink:
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In a Simulink for control flow statement, the For Iterator block iterates
the contents of a For Iterator Subsystem, an atomic subsystem. For each
iteration of the For Iterator block, the block programming of the For Iterator
Subsystem executes one complete path through its blocks.
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Construct a Simulink for control flow statement as follows:
® Drag a For Iterator Subsystem block from the Library Browser or Library
window into your model.

® You can set the For Iterator block to take external or internal input for
the number of iterations it executes.

Through the properties dialog of the For Iterator block you can set it to take
input for the number of iterations through the port labeled N. This input
must come from outside the For Iterator Subsystem.

You can also set the number of iterations directly in the properties dialog.

® You can set the For Iterator block to output its iterator value for use in the
block programming of the For Iterator Subsystem.

The iterator value is 1 for the first iteration and is incremented by 1 for
each succeeding iteration.
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The For Iterator block works well with the Assignment block to reassign
values in a vector or matrix. This is demonstrated in the following example.
Note the matrix dimensions in the data being passed.
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The above example outputs the sin value of an input 2-by-5 matrix (2 rows,
5 columns) using a For subsystem containing an Assignment block. The
process is as follows:

1 A 2-by-5 matrix is input to the Selector block and the Assignment block.
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2 The Selector block strips off a 2-by-1 matrix from the input matrix at the
column value indicated by the current iteration value of the For Iterator
block.

3 The sine of the 2-by-1 matrix is taken.
4 The sine value 2-by-1 matrix is passed to an Assignment block.

5 The Assignment block, which takes the original 2-by-5 matrix as one of
its inputs, assigns the 2-by-1 matrix back into the original matrix at the
column location indicated by the iteration value.

The rows specified for reassignment in the property dialog for the
Assignment block in the above example are [1,2]. Because there are only
two rows in the original matrix, you could also have specified -1 for the
rows, i.e., all rows.

Note Experienced Simulink users will note that the sin block is already
capable of taking the sine of a matrix. The above example uses the sin
block only as an example of changing each element of a matrix with the
collaboration of an Assignment block and a For Iterator block.

Comparing Stateflow and Control Flow Statements

Stateflow already possesses the logical capabilities of the Simulink control
flow statements. It can call Function-Call subsystems (see “Function-Call
Subsystems” on page 3-43) on condition or iteratively. However, since
Stateflow provides a great deal more in logical sophistication, if your
requirements are simpler, you might find the capabilities of the Simulink
control flow blocks sufficient for your needs. In addition, the control flow
statements offer a few advantages, which are listed in the following topics.

Sample Times

The Function-Call subsystems that Stateflow can call are triggered
subsystems. Triggered subsystems inherit their sample times from the calling
block. However, the Action subsystems used in if-else and switch control
flow statements and the While and For subsystems that make up while and
for control flow statements are enabled subsystems. Enabled subsystems
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can have their own sample times independent of the calling block. This also
allows you to use more categories of blocks in your iterated subsystem than in
a Function-Call subsystem.

Resetting of States When Reenabled

Simulink control flow statement blocks allow you to retain or reset (to their
initial values) the values of states for Action, For, and While subsystems when
they are reenabled. For detailed information, see “Simulink Reference” for
the While Iterator and For Iterator blocks regarding the parameter States
when starting and the reference for the Action Port block regarding the
parameter States when execution is resumed.

Using Stateflow with the Control Flow Blocks

You might want to consider the possibility of using Stateflow and the Simulink
control flow blocks together. The following sections contain some examples
that give you a few suggestions on how to combine the two.

Using Stateflow with If-Else or Switch Subsystems. In the following
model, Stateflow places one of a variety of values in a Stateflow data object.
Upon chart termination, a Simulink if control flow statement uses that data
to make a conditional decision.
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In this case, control is given to a Switch Case block, which uses the value to
choose one of several case subsystems to execute.
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Using Stateflow with While Subsystems. In the following diagram,
Stateflow computes the value of a data object that is available to a condition
input of a While Iterator block in do-while mode.
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The While Iterator block has iterative control over its host subsystem, which
includes the Stateflow Chart block. In do-while mode, the While block is
guaranteed to operate for its first iteration value (= 1 ). During that time, the
Stateflow chart is awakened and sets a data value used by the While Iterator
block, which is evaluated as a condition for the next while iteration.
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In the following diagram, the While block is now set in while mode. In this
mode, the While Iterator block must have input to its initial condition port in
order to execute its first iteration value. This value must come from outside
the While subsystem.
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If the initial condition is true, the While Iterator block wakes up the Stateflow
chart and executes it to termination. During that time the Stateflow chart
sets data, which the While Iterator condition port uses as a condition for

the next iteration.
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Using Callback Functions

You can define MATLAB expressions that execute when the block diagram or
a block is acted upon in a particular way. These expressions, called callback
functions, are specified by block, port, or model parameters. For example,
the function specified by a block’s OpenFcn parameter is executed when you
double-click on that block’s name or its path changes.

Tracing Callbacks

Callback tracing allows you to determine the callbacks Simulink invokes and
in what order Simulink invokes them when you open or simulate a model. To
enable callback tracing, select the Callback tracing option on the Simulink
Preferences dialog box or execute set_param(0, 'CallbackTracing',
‘on'). This option causes Simulink to list callbacks in the MATLAB
Command Window as they are invoked.

Creating Model Callback Functions

You can create model callback functions interactively or programmatically.
Use the Callbacks pane of the model’s Model Properties dialog box (see
“Callbacks Pane” on page 3-108) to create model callbacks interactively. To
create a callback programmatically, use the set _param command to assign a
MATLAB expression that implements the function to the model parameter
corresponding to the callback (see “Model Callback Functions” on page 3-83).

For example, this command evaluates the variable testvar when the user
double-clicks the Test block in mymodel:

set_param('mymodel/Test', 'OpenFcn', testvar)

You can examine the clutch system (clutch.mdl) for routines associated
with many model callbacks.

Model Callback Functions
The following table describes callback functions associated with models.
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Parameter When Executed
CloseFcn Before the block diagram is closed.
PostLoadFcn After the model is loaded. Defining a callback routine

for this parameter might be useful for generating an
interface that requires that the model has already
been loaded.

InitFcn Called at start of model simulation.
PostSaveFcn After the model is saved.
PreLoadFcn Before the model is loaded. Defining a callback

routine for this parameter might be useful for
loading variables used by the model.

PreSaveFcn Before the model is saved.

StartFcn Before the simulation starts.

StopFcn After the simulation stops. Output is written to
workspace variables and files before the StopFcn is
executed.

Note Beware of adverse interactions between callback functions of models
referenced by other models. For example, suppose that model A references
model B and that model A’s OpenFcn creates variables in the MATLAB
workspace and model B’s CloseFcn clears the MATLAB workspace. Now
suppose that simulating model A requires rebuilding model B. Rebuilding B
entails opening and closing model B and hence invoking model B’s CloseFcn,
which clears the MATLAB workspace, including the variables created by
A’s OpenFen.

Creating Block Callback Functions

You can create model callback functions interactively or programmatically.
Use the Callbacks pane of the model’s Block Properties dialog box (see
“Callbacks Pane” on page 4-15) to create model callbacks interactively. To
create a callback programmatically, use the set _param command to assign

a MATLAB expression that implements the function to the block parameter
corresponding to the callback (see “Block Callback Parameters” on page 3-85).
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Note A callback for a masked subsystem cannot directly reference the
parameters of the masked subsystem (see “About Masks” on page 11-2). The
reason? Simulink evaluates block callbacks in a model’s base workspace
whereas the mask parameters reside in the masked subsystem’s private
workspace. A block callback, however, can use get_param to obtain the value
of a mask parameter, e.g., get_param(gcb, 'gain'), where gain is the
name of a mask parameter of the current block.

Block Callback Parameters

This table lists the parameters for which you can define block callback
routines, and indicates when those callback routines are executed. Routines
that are executed before or after actions take place occur immediately before
or after the action.

Parameter When Executed

ClipboardFcn When the block is copied or cut to the system
clipboard.

CloseFcn When the block is closed using the close system
command.

CopyFcn After a block is copied. The callback is recursive for

Subsystem blocks (that is, if you copy a Subsystem
block that contains a block for which the CopyFcn
parameter is defined, the routine is also executed).
The routine is also executed if an add_block
command is used to copy the block.

DeleteChildFcn After a block is deleted from a subsystem.

DeleteFcn Before a block is deleted, e.g., when the user deletes
the block or closes the model containing the block.
This callback is recursive for Subsystem blocks.

DestroyFcn When the block has been destroyed.

InitFcn Before the block diagram is compiled and before
block parameters are evaluated.
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Parameter When Executed

ErrorFcn When an error has occurred in a subsystem. The
callback function should have the following form:

errorMsg = errorHandler(subsys, errorType)

where errorHandler is the name of the callback
function, subsys is a handle to the subsystem in
which the error occurred, errorType is a string
that indicates the type of error that occurred, and
errorMsg is a string specifying the text of an error
message to be displayed to the user. Simulink
displays the error message returned by the callback

function.

LoadFcn After the block diagram is loaded. This callback is
recursive for Subsystem blocks.

ModelCloseFcn Before the block diagram is closed. This callback is
recursive for Subsystem blocks.

MoveFcn When the block is moved or resized.

NameChangeFcn After a block’s name and/or path changes. When a

Subsystem block’s path is changed, it recursively
calls this function for all blocks it contains after
calling its own NameChangeFcn routine.

OpenFcn When the block is opened. This parameter is
generally used with Subsystem blocks. The routine
is executed when you double-click the block or when
an open_system command is called with the block as
an argument. The OpenFcn parameter overrides the
normal behavior associated with opening a block,
which is to display the block’s dialog box or to open
the subsystem.

ParentCloseFcn Before closing a subsystem containing the block or
when the block is made part of a new subsystem
using the new_system command (see new_system in
the online Simulink reference).

PreSaveFcn Before the block diagram is saved. This callback is
recursive for Subsystem blocks.
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Parameter When Executed

PostSaveFcn After the block diagram is saved. This callback is
recursive for Subsystem blocks.

StartFcn After the block diagram is compiled and before the
simulation starts. In the case of an S-Function
block, StartFcn executes immediately before the
first execution of the block’s md1ProcessParameters
function. See "S-Function Callback Methods"

in the online Simulink documentation for more
information.

StopFcn At any termination of the simulation. In the
case of an S-Function block, StopFcn executes
after the block’s md1Terminate function executes.
See "S-Function Callback Methods” in the online
Simulink documentation for more information.

UndoDeleteFcn When a block delete is undone.

Port Callback Parameters

Block input and output ports have a single callback parameter,
ConnectionCallback. This parameter allows you to set callbacks on ports
that are triggered every time the connectivity of those ports changes.
Examples of connectivity changes include deletion of blocks connected to the
port and deletion, disconnection, or connection of branches or lines to the port.

Use get _param to get the port handle of a port and set_param to set the
callback on the port. For example, suppose the currently selected block has
a single input port. The following code fragment sets foo as the connection
callback on the input port.

phs = get param(gcb, 'PortHandles');
set_param(phs.Inport, 'ConnectionCallback', 'foo');

The first argument of the callback function must be a port handle. The
callback function can have other arguments (and a return value) as well. For

example, the following is a valid callback function signature.

function foo(port, otherArgi, otherArg2)
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Working with Model Workspaces

Simulink provides each model with its own workspace for storing variable
values. The model workspace is similar to the base MATLAB workspace
except that

Variables in a model’s workspace are visible only in the scope of the model.

If both the MATLAB workspace and a model workspace define a variable
of the same name (and the variable does not appear in any intervening
masked subsystem or referenced model workspaces), Simulink uses the
value of the variable in the model workspace. A model’s workspace
effectively provides it with its own name space, allowing you to create
variables for the model without risk of conflict with other models.

When the model is loaded, the workspace is initialized from a data source.

The data source can be the model’s MDL-file, a MAT-file, or M-code stored
in the model file (see “Data source” on page 3-91 for more information).

You can interactively reload and save MAT-file and M-code data sources.

The only kinds of Simulink data objects that a model workspace can
contain are

= Simulink.Parameter objects
= Simulink.Signal objects whose storage class is auto
In general, parameter variables in a model workspace are not tunable.

However, you can tune model workspace variables declared as model
arguments (see “Using Model Arguments” on page 3-57 for more
information).

Note When resolving references to variables used in a referenced model,
i.e., a model referenced by a Model block (see “Referencing Models” on page
3-52), Simulink resolves the referenced model’s variables as if the parent
model does not exist. For example, suppose a referenced model references a
variable that is defined in both the parent model’s workspace and in the
MATLAB workspace but not in the referenced model’s workspace. In this
case, Simulink uses the variable defined in the MATLAB workspace.
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Changing Model Workspace Data

The procedure for modifying a workspace depends on the workspace’s data
source. See the following sections for more information:

® “Changing Workspace Data Whose Source is the Model File” on page 3-89
® “Changing Workspace Data Whose Source Is a MAT-File” on page 3-89
® “Changing Workspace Data Whose Source Is M-Code” on page 3-90

Changing Workspace Data Whose Source is the Model File

If a model workspace’s data source is data stored in the model, you can use
the Model Explorer (see “The Model Explorer” on page 8-2) or MATLAB
commands to change the model’s workspace (see “Using MATLAB Commands
to Change Workspace Data” on page 3-90).

For example, to create a variable in a model workspace, using the Model
Explorer, first select the workspace in the Model Explorer’s Model Hierarchy
pane. Then select MATLAB Variable from the Model Explorer’s Add menu
or toolbar. You can similarly use the Add menu or the Model Explorer toolbar
to add a Simulink.Parameter object to a model workspace.

To change the value of a model workspace variable, select the workspace,
then select the variable in the Model Explorer’s Contents pane and edit

the value displayed in the Contents pane or in the Model Explorer’s object
Dialog pane. To delete a model workspace variable, select the variable in the
Contents pane and select Delete from the Model Explorer’s Edit menu or
toolbar. To save the changes, save the model.

Changing Workspace Data Whose Source Is a MAT-File

You can also use the Model Explorer or MATLAB commands to modify
workspace data whose source is a MAT-file. In this case, if you want to make
the changes permanent, you must save the changes to the MAT-file, using
the Save To Source button on the model workspace dialog box (see “Model
Workspace Dialog Box” on page 3-91). To discard changes to the workspace,
use the Reinitialize From Source button on the model workspace’s dialog
box.
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Changing Workspace Data Whose Source Is M-Code

The safest way to change data whose source is M-code is to edit and reload the
source, i.e., edit the M-code and then clear the workspace and reexecute the
code, using the Reinitialize From Source button on the model workspace’s
dialog box. You can use the Export to MAT-File and Import From MAT-file
buttons to save and reload alternative versions of the workspace that result
from editing the M code source or the workspace variables themselves.

Using MATLAB Commands to Change Workspace Data

To use MATLAB commands to change data in a model workspace, first get the
workspace for the currently selected model:

hws = get param(bdroot, 'modelworkspace');

This command returns a handle to a Simulink.ModelWorkspace object
whose properties specify the source of the data used to initialize the model
workspace. Edit the properties to change the data source. Use the workspace’s
methods to list, set, and clear variables, evaluate expressions in, and save and
reload the workspace.

For example, the following MATLAB sequence of commands creates variables
specifying model parameters in the model’s workspace, saves the parameters,
modifies one of them, and then reloads the workspace to restore it to its
previous state.

hws = get param(bdroot, 'modelworkspace');
hsw.DataSource = 'MAT-File';

hws.FileName = 'params';
hws.assignin('pitch', -10);
hws.assignin('roll', 30);
hws.assignin('yaw', -2);

hws.saveToSource;

hws.assignin('roll', 35);

hws.reload;
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Model Workspace Dialog Box

The Model Workspace Dialog Box enables you to specify a model workspace’s
source and model reference arguments. To display the dialog box, select the
model workspace in the Model Explorer’s Model Hierarchy pane.

% Model Explorer

(=S|
File Edit Wiew Tools Add Help
D2 imaxBH%HFf0 @@ 48 |3xraza
JJSearch |by Block Type j Type: |Assignment j % Search |
todel Hierarchy ‘ Contents of. Model Workspace Model Workspace
= EF]Simulink Root I Mame I \u’a\uel DalaTypeI ok space dota
g----ﬁBase ‘workspace Data source: I MOL-File (readvwrite) LI
E--Emo__t_:lws

H Model Workspace
H .Conliguration [Active) 3 z

;---@Cude for untitled Model arguments [for referencing this model)
@Adwce for untitled

Impart From MAT-F\Iel Expart Ta kAT -File| Clear Workspacel

Lantents |§earchF\esuIts | Fgverl Help Spply

The dialog box contains the following controls.

Data source
Specifies the source of this workspace’s data. The options are
® Mdl-File

Specifies that the data source is the model itself. Selecting this option

causes additional controls to appear (see “MDL-File Source Controls” on
page 3-92).

® MAT-File

Specifies that the data source is a MAT file. Selecting this option causes
additional controls to appear (see “MAT-File Source Controls” on page 3-92).
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® \-code

Specifies that the data source is M code stored in the model file. Selecting
this option causes additional controls to appear (see “M-Code Source
Controls” on page 3-93).

MDL-File Source Controls

Selecting Md1-File as the Data source for a workspace causes the Model
Workspace dialog box to display additional controls.

Model Workzpace
Wwiorkzpace data

Data source: | MDL-File LI

Irnpart From MAT -File | Expart Tio MAT File | LClear Workspacel

Import From MAT-File. This button lets you import data from a MAT-file.
Selecting the button causes Simulink to display a file selection dialog box. Use
the dialog box to select the MAT file that contains the data you want to import.

Export To MAT-File. This button lets you save the selected workspace as a
MAT-file. Selecting the button causes Simulink to display a file selection
dialog box. Use the dialog box to select the MAT file to contain the saved data.

Clear Workspace. This button clears all data from the selected workspace.

MAT-File Source Controls

Selecting MAT-File as the Data source for a workspace causes the Model
Workspace dialog box to display additional controls.

‘Wwiorkzpace data

Data source: | MAT-File j

File name: I

Reinitialize Fram Sourcel Save To Source |

Impart From MAT-File I Ezport Ta MAT-FiIel CIealWorkspacel
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File name. File name or path name of the MAT file that is the data source
for the selected workspace. If a file name, the name must reside on the
MATLAB path.

Reinitialize From Source. Clears the workspace and reloads the data from
the MAT-file specified by the File name field.

Save To Source. Save the workspace in the MAT-file specified by the File
name field.

Import From MAT-File. Loads data from a specified MAT file into the
selected model workspace without first clearing the workspace. Selecting this
option causes Simulink to display a file selection dialog box. Use the dialog
box to enter the name of the MAT-file that contains the data to be imported.

Export To MAT-File. Saves the data in the selected workspace in a MAT-file.
Selecting the button causes Simulink to display a file selection dialog box. Use
the dialog box to select the MAT file to contain the saved data.

Clear Workspace. Clears the selected workspace.

M-Code Source Controls

Selecting M-Code as the Data source for a workspace causes the Model
Workspace dialog box to display additional controls.

—Workspace data

['ata source: | M-Code LI
M-Code:

Reinitialize From Sourcel
Irnpart From MAT -File | Export Tio MAT-File: EIealWorkspacel
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M-Code. Specifies M-code that initializes the selected workspace. To change
the initialization code, edit this field, then select the Reinitialize from
source button on the dialog box to clear the workspace and execute the
modified code.

Reinitialize from Source. Clears the workspace and executes the contents
of the M-Code field.

Import From MAT-File. Loads data from a specified MAT file into the
selected model workspace without first clearing the workspace. Selecting this
option causes Simulink to display a file selection dialog box. Use the dialog
box to enter the name of the MAT-file that contains the data to be imported.

Export To MAT-File. Saves the data in the selected workspace in a MAT-file.
Selecting the button causes Simulink to display a file selection dialog box. Use
the dialog box to select the MAT file to contain the saved data.

Clear Workspace. Clears the selected workspace.

Model Arguments

This field allows you to specify arguments that can be passed to instances of
this model referenced by another model. See “Using Model Arguments” on
page 3-57 for more information.
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Working with Data Stores

Data stores are signals that are accessible at any point in a model hierarchy
at or below the level in which they are defined. Because they are accessible
across model levels, data stores allow subsystems and model references to
share data without having to use I/O ports to pass the data from level to level
(see “Data Store Examples” on page 3-99 for examples of using data stores to
share data among subsystems and model references).

Defining Data Stores

Defining a data store entails creating an object whose properties specify the
properties of the data store. You can use either Data Store Memory blocks
or instances of Simulink.Signal class to define data stores. Each approach
has advantages. Data Store Memory blocks give you more control over the
scope of data stores within a model and allow initialization of data stores.
Simulink.Signal objects avoid cluttering a model with blocks and allows
data stores to be visible across model reference boundaries.

Using Data Store Memory Blocks to Define Data Stores

To use a Data Store Memory block to define a data store, drag an instance of
the block into the model at the topmost level from which you want the data
store to be visible. For example, to define a data store that is visible at every
level in a model (except in model references), drag the Data Store Memory
block into the root level of the model. To define a data store that is visible
only in a particular subsystem (and the subsystems that it contains), drag
the block into the subsystem. Once you have created the Data Store Memory
block, use its parameter dialog box to define the data stores properties,
including its name, data type, complexity.

Using Signal Objects to Define Data Stores

To use a signal object to define a data store, create an instance of
Simulink.Signal object in a workspace that is visible to every model that
needs to access the data store. For example, to define a data store that is
visible to a top model and all the models that it references, use the Model
Explorer or MATLAB commands to create the signal object in the base (i.e.,
MATLAB) workspace. To define a data store that is visible only in a particular
model, create the signal object in the model’s workspace (see “Changing Model
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Workspace Data” on page 3-89). You can use Simulink.Signal objects to
define data stores that are visible in only one model (a local data store) or in a
top model and the models that the top model references (a global data store).

When creating the object, assign it to a workspace variable whose name is
the name you want to be assigned to the data store. Once you have created
the object, use the Model Explorer or MATLAB commands to set the following
properties of the signal object to the values that you want the corresponding
data store property to have.

DataType
Dimensions
Complexity
SampleTime
SamplingMode

StorageClass

For example, the following commands defines a data store named Error in the
MATLAB workspace:

Error = Simulink.Signal;

Error.Description = 'Use to signal that subsystem output is
invalid';

Error.DataType = 'boolean';

Error.Complexity = 'real’;

Error.Dimensions = 1;
Error.SamplingMode="'Sample based';
Error.SampleTime = 0.1;
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Note A signal object that defines a local store, i.e., that resides in a model
workspace, must inherit the value of its StorageClass property, i.e., the
value must be auto (the default). In the case of a signal object that defines a
global store, i.e., that resides in the base workspace, the only properties that
can inherit their values are StorageClass and SampleTime. You must specify
explicit values for all of the other relevant properties of the object. In either
case, when using a signal object to define a data store, you must specify the
object’s SamplingMode as 'Sample based'.

Accessing Data Stores

To set the value of a data store at each time step, create an instance of a Data
Store Write block at the level of your model that computes the value, set its
Data store name parameter to the name of the data store to be updated, and
connect the output of the block that computes the value to the input of the
Data Store Write block, e.g.,

— =08 I Error
Compars [rata Store
To Constant irite
1} e 15
In1 Cutl
3ain
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To get the value of a data store at each time step, create an instance of a
Data Store Read block at the level of your model that needs the value, set the
block’s Data store name parameter to the name of the data store to be read,
and connect the output of the data store read block to the input of the block
that need’s the data store’s value, e.g.,

Errar [Scope]
[rata Store
e{int Outi
[Scope]
A f
Goto r‘\
Inl 1 Error - |
LUJ Scope
Sine Wave [ata Store
Read =_|
Sitch
pe{ini Out

When connected to a global data store, a data store access block displays the
word Global above the data store’s name.

“Global” indicates that Error is
defined by a signal object in the
MATLAB workspace.

[Scope]

Goto

[
L

Sine Wave

[rata Store
Read

b Switch
Lgedint Outt

B

This is done to remind you that the data store is defined by a signal object in
the MATLAB workspace rather than by a Data Store Memory block.
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Data Store Examples

The following examples illustrate the use of these constructs to define and
access data stores.

Local Data Store Example

The following model illustrates creation and access of a local data store, i.e., a
data store that is visible only in a model or particular subsystem.

Data Store
Wirite

Compare
To Constant

p{int Out1
A
Errar
Sine Miave Data Store
Read
= = Switch
] Ini outd -
- e O
T- In Out
T - Gain

This model uses a data store to permit subsystem A to signal that its output
is invalid. If subsystem A’s output is invalid, the model uses the output
of subsystem B.
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Global Data Store Example

The following model replaces the subsystems of the previous example with
functionally identical submodels to illustrate use of a global data store to
share data in a model reference hierarchy.

a [Soope]
[Soope] —In Outt From
)

Crata Store

Read [Z]Model Propetties x|
b Swmitoh M ain | Callbacks IHistor_l,l | Diescription =
Line] it Qut1

Model callback: Model pre-load function:

8t | Error = Simulink. Signal;

- Postload... | Ermor.Description = 'Use to zsignal that subsystem outp
- InitFen Error.DataType = ‘boolean';

- StartFen Error. Complexity = 'real’;

Error. Dimensions = 1;

Errar. SamplingMode="S ample bazed';

Sine Wave

When the model is loaded, this code creates a
signal object in the MATLAB workspace that

defines the global data store Error used toindicate — | =27 " | Enor.SampleTime = 0.1; M|
that submodel A's output s invalid. l o

0k I Cancel I Help | Apply |

-~ StopFon
- PreSaveFch

In this example, the top model uses a signal object in the MATLAB workspace
to define the error data store. This is necessary because data stores are
visible across model boundaries only if they are defined by signal objects

in the MATLAB workspace.
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Model Advisor

The Model Advisor checks a model or subsystem for conditions and
configuration settings that can result in inaccurate or inefficient simulation of
the system represented by the model or generation of inefficient code from
the model. It produces a report that lists all the suboptimal conditions or
settings that it finds, suggesting better model configuration settings where
appropriate.

Launching the Model Advisor

You can use any of the following methods to launch the Model Advisor.

e Select Model Advisor from the model editor’s Tools menu.

¢ In the Contents pane of the Model Explorer (see “The Model Explorer”
on page 8-2), select Advice for model, where model is the name of the
model that you want to check.

e At the MATLAB prompt, enter modeladvisor(model), where model
is a handle or path of the model or subsystem you want to check (see
modeladvisor for more information).
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Model Advisor Window

The Model Advisor window appears below, showing a report for the vdp

demo model.

%" Web Browser - Model Advisor 10l =l
File Edit Wew Go Debug Desktop Window Help | | A X

- G 0 =Ruf =] w]
I Select ar [ Model Advisor Report for 'vdp'

Check System |

Check the system for the
following selected conditi

deselect all

E O Simulink

[ ldentify unconnected lines,
input ports, and output ports

[# Check roat maodel Inpart
block specifications

[# Check the hardware
implementation

[V Check optimization settings

[# Check for parameter
tunahility infarmation
ignored by Simulink

[# Check for implicit signal
resolution

[# Check for optimal hus
virtuality

[# ™ Check sample times and
tasking mode

= * Cherk for Muy blocks

| N

Mode!version: 1.5
Geherated on: 27-Dec-2004 15:39:13

Identify unconnected lines, input ports, and output ports

Passed

Check root model Inport block specifications

Passed

Check the hardware implementation

Your current systemn target file is grt.tlc. Consider using et e ar an
ERT-baszed target, such as mpc555_exp. tie, for final production
deployment of the code.

A |

The left pane lists the checks that the Model Advisor performs. The check
boxes displayed in this pane allow you to select some or all of the checks. To
perform the checks, clickCheck System button at the top of the pane. The
Model Advisor displays the results of the checks in the right pane.

Note When you open the Model Advisor on a model that you have previously
checked, the Model Advisor initially displays the report generated the last
time you checked the model. If you recheck the model, the new report replaces
the previous report in the Model Advisor window.
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Checking Code-Generation Targets

Before running the Model Advisor on a model, select the target you plan to use
in the Real-Time Workshop pane of the Configuration Parameters dialog
box (see “Configuration Parameters Dialog Box” on page 9-37). The Model
Advisor works most effectively with ERT and ERT-based targets (targets
based on the Real-Time Workshop Embedded Coder).

Model Advisor Demo Models
The Real-Time Workshop includes demos that illustrate usage of the Model

Advisor. To run the demos, select the following links:

® rtwdemo_advisorl

® rtwdemo_advisor2

® rtwdemo_advisor3

You can also access these demos by opening the general Real-Time Workshop
demo package (rtwdemos) and navigating to the Model Advisor-related

models in the “Optimizations” group. You can also run these demos from the
MATLAB command line. For example, the command

modeladvisor('rtwdemo_advisori')
launches the rtwdemo_advisori model. Note that demo models

rtwdemo_advisor2 and rtwdemo_advisor3 require Stateflow and Fixed-Point
Toolbox.
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Simulink has features that help you to manage multiple versions of a model.

As you edit a model, Simulink generates version control information about
the model, including a version number, who created and last updated the
model, and an optional change history. Simulink saves the automatically
generated version control information with the model. See “Version Control
Properties” on page 3-113 for more information.

The Simulink Model Parameters dialog box lets you edit some of the
version control information stored in the model and select various version
control options (see “Model Properties Dialog Box” on page 3-107).

The Simulink Model Info block lets you display version control information,
including information maintained by an external version control system, as
an annotation block in a model diagram.

Simulink version control parameters let you access version control
information from the MATLAB command line or an M-file.

The Source Control submenu of the Simulink File menu allows you to
check models into and out of your source control system. See “Source
Control Interface” in the MATLAB documentation for more information.

Specifying the Current User

When you create or update a model, Simulink logs your name in the model for
version control purposes. Simulink assumes that your name is specified by at
least one of the following environment variables: USER, USERNAME, LOGIN, or
LOGNAME. If your system does not define any of these variables, Simulink does
not update the user name in the model.
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UNIX systems define the USER environment variable and set its value to the
name you use to log on to your system. Thus, if you are using a UNIX system,
you do not have to do anything to enable Simulink to identify you as the
current user.

Windows systems, on the other hand, might define some or none of the
“user name” environment variables that Simulink expects, depending on the
version of Windows installed on your system and whether it is connected to
a network. Use the MATLAB command getenv to determine which of the
environment variables is defined. For example, enter

getenv('user')

at the MATLAB command line to determine whether the USER environment
variable exists on your Windows system. If not, you must set it yourself. On
Windows 98, set the value by entering the following line

set user=yourname

in your system’s autoexec.bat file, where yourname is the name by which
you want to be identified in a model file. Save the file autoexec.bat and
reboot your computer for the changes to take effect.

Note The autoexec.bat file typically is found in the c:\ directory on your
system’s hard disk.
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On Windows, use the Environment variables pane of the System
Properties dialog box to set the USER environment variable (if it is not
already defined).

Environment Variables 1 d |

User variables for paulk

Value B
@tripoli. mathworks. com
[ \Applications\Arbortext-5.0'Epic
C:\Temp

Variable

C:\Temp
paulk
New Edit | Delete |
System variables
Variable | Value |L|

PROCESSOR_A... x86
PROCESSOR_ID... x&G6 Family 15 Model 2 Stepping 9, Genu...
PROCESSOR_LE... 15

PROCESSOR_R... 0209 |
TEMP Ci !I,TEMP LI
Mew | Edit | Delete I

To display the System Properties dialog box, select

Start > Settings > Control Panel to open the Control Panel.

Double-click the System icon. To set the USER variable, enter USER in the
Variable field and enter your login name in the Value field. Click Set to save
the new environment variable. Then click OK to close the dialog box.
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Model Properties Dialog Box

The Model Properties dialog box allows you to set various version control
parameters and model callback functions. To display the dialog box, choose

Model Properties from the Simulink File menu.

E1Model Properties

Callbacks |

Hiztory I Drescription I

21|

Source file:
Last Saved:
Created On:
I Modified:
Model Version:

Model Information for: vdp

A8 a0 A nightlmatlabitoolboxhsimulink s simdemossimoenera

Wed Apr 21 03:46:41 2004
FriAug 18 16:03:13 2000
no

12

|

Ok I Lancel

Help

Apply

The dialog box includes the following panes.

Main Pane

The Main pane summarizes information about the current version of this

model.
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Callbacks Pane

The Callbacks pane lets you specify functions to be invoked by Simulink at
specific points in the simulation of the model.

x|

I ain

History | Drescription |

todel callbacks | Model pre-load function:
PreLoadFen
i PostloadFen
InitFcn
StartFcn
StopFen

i PreSaveFon
PostSaveFon
i ClogeFen

QK. I Cancel | Help | Apply |

In the left pane, select the callback. In the right pane, enter the name of
the function you want to be invoked for the selected callback. See “Creating
Model Callback Functions” on page 3-83 for information on the callback
functions listed on this pane.
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History Pane
The History pane allows you to enable, view, and edit this model’s change
history.

E! Model Properties ﬂﬂ
Main I Callbacks | Histary I Drescription I
Model infarmation
Created by: IThe Mathieorks Ine. Last saved by Ibatserve
Created or: Eug 18 16:03:19 2000 Last saved on: IApr 21 03:46:41 2004
¥ Fead Only Model version: |1_2
Model history:
Frompt to update model history: I Mever 'l
ok | cncel | 1 ey |

The History pane has two panels: the Model information panel and the
Model History panel.

Version Information Panel

The contents of the Version information panel depend on the item selected
in the list at the top of the panel. When View current values is selected,
the panel shows the following fields.

Created by. Name of the person who created this model. Simulink sets this
property to the value of the USER environment variable when you create the
model. Edit this field to change the value.

Created on. Date and time this model was created.
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Model version. Version number for this model. You cannot edit this field.

Last saved by. Name of the person who last saved this model. Simulink
sets the value of this parameter to the value of the USER environment variable
when you save a model.

Last saved date. Date that this model was last saved. Simulink sets the
value of this parameter to the system date and time whenever you save
a model.

Read Only. Deselecting this option shows the format strings for each of the
fields listed when the option is selected.

E1Model Properties i . ed e
Main I Callbacks | Histary I Drescription I
Model infarmation
Created by: IThe Mathiwarks Inc. Last zaved by: |X<Auto>
Created on: IFri Aug1816:03192000  Last saved on: |X<Auto>
I~ Read Only Model version: |1_X<Aulolncrement:2>
Model history:
Frompt to update model history: I Mewver 'l
Ok Lancel | Apply |
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Model version. Enter a format string describing the format used to display
the model version number in the Model Properties pane and in Model Info
blocks. The value of this parameter can be any text string. The text string
can include occurrences of the tag %<AutoIncrement:#> where # is an integer.
Simulink replaces the tag with an integer when displaying the model’s version
number. For example, it displays the tag

1.%<AutoIncrement:2>

as

1.2

Simulink increments # by 1 when saving the model. For example, when you
save the model,

1.%<1.%<AutoIncrement:2>

becomes

1.%<1.%<AutolIncrement:3>
and Simulink reports the model version number as 1.3.

Last saved by. Enter a format string describing the format used to display
the Last saved by value in the History pane and the ModifiedBy entry in
the history log and Model Info blocks. The value of this field can be any string.
The string can include the tag %<Auto>. Simulink replaces occurrences of this
tag with the current value of the USER environment variable.

Last saved on. Enter a format string describing the format used to display
the Last saved on date in the History pane and the ModifiedOn entry in
the history log and the in Model Info blocks. The value of this field can be any
string. The string can contain the tag %$<Auto>. Simulink replaces occurrences
of this tag with the current date and time.

Model History Panel

The model history panel contains a scrollable text field and an option list. The
text field displays the history for the model in a scrollable text field. To change
the model history, edit the contents of this field. The option list allows you to
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enable or disable the Simulink model history feature. To enable the history
feature, select When saving model from the Prompt to update model
history list. This causes Simulink to prompt you to enter a comment when
saving the model. Typically you would enter any changes that you have made
to the model since the last time you saved it. Simulink stores this information
in the model’s change history log. See “Creating a Model Change History” on
page 3-112 for more information. To disable the change history feature, select
Never from the Prompt to update model history list.

Model Description Pane
This pane allows you to enter a description of the model.

[=IModel Properties ed b3
Mair I Callbacks I Histary |D

Model description:

Ok I Lancel | Help | Apply |

Creating a Model Change History

Simulink allows you to create and store a record of changes to a model in the
model itself. Simulink compiles the history automatically from comments that
you or other users enter when they save changes to a model.
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Logging Changes

To start a change history, select When saving model from the Prompt to
update model history list on the History pane on the Simulink Model
Properties dialog box. The next time you save the model, Simulink displays
a Log Change dialog box.

+ |Log Change: vdp_modelinfo [ %]

Modified Comment:

Paulk. -- Mon Jul 27 17:22:51 1333

¥ Show thiz dialog box nest time when save
V' Include "Modified Cormments" in "Modified History'

Save |

To add an item to the model’s change history, enter the item in the Modified
Comments edit field and click Save. If you do not want to enter an item for
this session, clear the Include "Modified Contents" in "Modified History"
option. To discontinue change logging, clear the Show this dialog box next
time when save option.

Version Control Properties

Simulink stores version control information as model parameters in a model.
You can access this information from the MATLAB command line or from an
M-file, using the Simulink get _param command. The following table describes
the model parameters used by Simulink to store version control information.

Property Description

Created Date created.

Creator Name of the person who created this
model.

Modified By Person who last modified this model.
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Property

Description

ModifiedByFormat

Format of the ModifiedBy parameter.
Value can be any string. The string

can include the tag %<Auto>. Simulink
replaces the tag with the current value of
the USER environment variable.

ModifiedDate

Date modified.

ModifiedDateFormat

Format of the ModifiedDate parameter.
Value can be any string. The string

can include the tag %<Auto>. Simulink
replaces the tag with the current date and
time when saving the model.

ModifiedComment

Comment entered by user who last
updated this model.

ModifiedHistory

History of changes to this model.

ModelVersion

Version number.

ModelVersionFormat

Format of model version number. Can be
any string. The string can contain the
tag %<AutoIncrement:#> where # is an
integer. Simulink replaces the tag with #
when displaying the version number. It
increments # when saving the model.

Description

Description of model.

LastModificationDate

Date last modified.
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Model Discretizer

The Model Discretizer selectively replaces continuous Simulink blocks with
discrete equivalents. Discretization is a critical step in digital controller
design and for hardware in-the-loop simulations.

The Model Discretizer enables you to

Identify a model’s continuous blocks.
Change a block’s parameters from continuous to discrete.

Apply discretization settings to all continuous blocks in the model or to
selected blocks.

Create configurable subsystems that contain multiple discretization
candidates along with the original continuous block(s).

Switch among the different discretization candidates and evaluate the
resulting model simulations.

Requirements

To use the Model Discretizer, you must have the Control System Toolbox,
Version 5.2, installed.

Discretizing a Model from the Model Discretizer GUI

To discretize a model:

“Start the Model Discretizer” on page 3-117
“Specify the Transform Method” on page 3-118
“Specify the Sample Time” on page 3-118

“Specify the Discretization Method” on page 3-118
“Discretize the Blocks” on page 3-122
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The f14 model, shown below, demonstrates the steps in discretizing a model.

Elra =10l x|
File Edit WYiew Simulation Format Tools Help
~ . - o
DS2E&| % B < » =[nm e G @
-
Stick Input _’qp"‘:"g“"ce@
. Pilot G fome
Mz pilat Scope
kulation
Stick Input
1 "
—{zlpte (md)  Blevator Cormand (ded) Hie{ (] Blevator Deflection d (deg) Mz Pilat ig)
Ta.s+1
g (rdiec) Vertical Vieaoity w (ftises) |4
- ™ Actuztor
ontmolier Wodel
>—> Viertical (GUst wELSt (fiiser)
Angle of
Attack
Fitch Fate q {mdises) -1
wig 2t L ] e Fiotary Gust qust {rdises w110
og st alpha (=d)
A=t
Crnyden Wind Crnarics
Giust hodels hiq fodel
F-14 Flight Contmol
(Double click on the *?* far mome info)
Double click
hem for
To start and stop the simulation, use the *Stan’ and Simulink Help
*Stop* s2lkections in the "Simulation® pull-down menu.
Ready [1o02 |odets v
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Start the Model Discretizer

To open the tool, select Tools > Control Design > Model Discretizer from
the Simulink model editor’s menu bar. The Simulink Model Discretizer
appears.

QZSimuIink Model Discrel 10l =|
File ‘“iew Discretize Help
= EHES e P |
Containg continuous block: PDiscretization setting
W4 Current selection: 14
-4 Actuator Model
-m Aircraft Dynamics Wd | Transform method: |zer0-0rder hald LI
] Controller O I1 2
2] Dryden Wind Gust | | 23MRE IME: :
-% Mz pilot ealeulation || Critical frequency: [I.0 [Hz =l
: Pilat
Replace current selection with:
|Discrete blocks (Enter parameters in s-domain) LI
Lacation forblack in configurable subsysterm:
|New discrete suhsystem LI b4
Store Settings | Discard Settingsl el
rDiscretization statu
Continuous blocks in model: 12
Total blocks transformed: 1]
Continuous blocks in current selection: 12
Blocks transformed in current selection: 0
4| | »
Simulink Model Discretizer

Alternatively, you can open the Model Discretizer from the MATLAB
Command Window using the slmdldiscui function.

The following command opens the Simulink Model Discretizer window
with the f14 model:

slmdldiscui('f14")

To open a new Simulink model or library from the Model Discretizer, select
Load model from the File menu.
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Specify the Transform Method

The transform method specifies the type of algorithms used in the
discretization. For more information on the different transform methods,
see “Continuous/Discrete Conversions of LTI Models” in the Control System
Toolbox documentation.

The Transform method drop-down list contains the following options:

® zero-order hold
Zero-order hold on the inputs.
e first-order hold
Linear interpolation of inputs.
® tustin
Bilinear (Tustin) approximation.
® tustin with prewarping
Tustin approximation with frequency prewarping.
® matched pole-zero

Matched pole-zero method (for SISO systems only).

Specify the Sample Time

Enter the sample time in the Sample time field.

You can specify an offset time by entering a two-element vector for discrete
blocks or configurable subsystems. The first element is the sample time and
the second element is the offset time. For example, an entry of [1.0 0.1]
would specify a 1.0 second sample time with a 0.1 second offset. If no offset is
specified, the default is zero.

You can enter workspace variables when discretizing blocks in the s-domain.
See “Discrete blocks (Enter parameters in s-domain)” on page 3-119.

Specify the Discretization Method

Specify the discretization method in the Replace current selection with
field. The options are
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® “Discrete blocks (Enter parameters in s-domain)” on page 3-119

Creates a discrete block whose parameters are retained from the
corresponding continuous block.

® “Discrete blocks (Enter parameters in z-domain)” on page 3-120

Creates a discrete block whose parameters are “hard-coded“ values placed
directly into the block’s dialog.

® “Configurable subsystem (Enter parameters in s-domain)” on page 3-121

Create multiple discretization candidates using s-domain values for the
current selection. A configurable subsystem can consist of one or more
blocks.

® “Configurable subsystem (Enter parameters in z-domain)” on page 3-122

Create multiple discretization candidates in z-domain for the current
selection. A configurable subsystem can consist of one or more blocks.

Discrete blocks (Enter parameters in s-domain). Creates a discrete block
whose parameters are retained from the corresponding continuous block.

The sample time and the discretization parameters are also on the block’s
parameter dialog box.

The block is implemented as a masked discrete block that uses c2d to
transform the continuous parameters to discrete parameters in the mask
initialization code.

These blocks have the unique capability of reverting to continuous behavior if
the sample time is changed to zero. Entering the sample time as a workspace
variable (' Ts', for example) allows for easy changeover from continuous to
discrete and back again. See “Specify the Sample Time” on page 3-118.

Note Parameters are not tunable when Inline parameters is selected in the
model’s Configuration Parameters dialog box.
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The following figure shows a continuous Transfer Function block next to a
Transfer Function block that has been discretized in the s-domain. The Block
Parameters dialog box for each block is shown below the block.

Block Parameters: Trai

 Transfer Fon

b atriv expression far numerator, vectar expression for denominator

for descending powers of =

Output width equals the number of raws in the numeratar. Coefficients are

=

Mumeratar:

Ji

Drenominatar:

)]

Absolute tolerance:

Iauto

0K Cancel Help Apply

tustin
1

=+1

Block Parameters: Di

DizcretizedT ransferFon [mask] [link]

Continuous mask uses c2d to transform parameters onta the Discrete
Transfer function block inside.

=
F

Murmeratar [enter in s-domain:]

]

Denaminator [enter in s-domair:]

Jin1

Sample time;

|1

Method: |hustin

=

Ok | Cancel | Help | Apply

Discrete blocks (Enter parameters in z-domain). Creates a discrete
block whose parameters are “hard-coded” values placed directly into the
block’s dialog box. The model discretizer uses the c2d function to obtain the

discretized parameters, if needed.

For more help on the c2d function, type the following in the Command

Window:

help c2d
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The following figure shows a continuous Transfer Function block next to a
Transfer Function block that has been discretized in the z-domain. The Block
Parameters dialog box for each block is shown below the block.

=+1 z+0.5
K| Block Parameters E|
— Transfer Fon r~ Dizcrete Transfer Fon
I atrix expression for numeratar, vector exprezsion for denaminatar I atri expression for numeratar, vectar expression for denominator. Output
Output width equals the number of rows in the numerator. Coefficients are width equals the number of rows in the numerator. Coefficients are for
for descending powers of = descending powers of 2.
P P
Mumeratar: Mumeratar:
Jm Ji
Denominatar: Crenominatar:
i Jnos
Abzolute tolerance: Sample time [-1 for inherited]:
Iauto |1
Ok Cancel Help Apply QK Cancel Help Apply

Note If you want to recover exactly the original continuous parameter values
after the Model Discretization session, you should enter parameters in the
s-domain.

Configurable subsystem (Enter parameters in s-domain). Create
multiple discretization candidates using s-domain values for the current
selection. A configurable subsystem can consist of one or more blocks.

The Location for block in configurable subsystem field becomes active
when this option is selected. This option allows you to either create a new
configurable subsystem or overwrite an existing one.

Note The current directory must be writable in order to save the library or
libraries for the configurable subsystem option.
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Configurable subsystem (Enter parameters in z-domain). Create
multiple discretization candidates in z-domain for the current selection. A
configurable subsystem can consist of one or more blocks.

The Location for block in configurable subsystem field becomes active
when this option is selected. This option allows you to either create a new
configurable subsystem or overwrite an existing one.

Note The current directory must be writable in order to save the library or
libraries for the configurable subsystem option.

Configurable subsystems are stored in a library containing the discretization
candidates and the original continuous block. The library will be named
<model name>_disc_lib and it will be stored in the current directory. For
example a library containing a configurable subsystem created from the f14
model will be named f14 _disc_lib.

If multiple libraries are created from the same model, then the filenames
will increment accordingly. For example, the second configurable subsystem
library created from the f14 model will be named f14_disc_1lib2.

You can open a configurable subsystem library by right-clicking on the
subsystem in the Simulink model and selecting Link options > Go to
library block from the pop-up menu.

Discretize the Blocks

To discretize blocks that are linked to a library, you must either discretize the
blocks in the library itself or disable the library links in the model window.

You can open the library from the Model Discretizer by selecting Load model
from the File menu.

You can disable the library links by right-clicking on the block and selecting
Link options -> Disable link from the pop-up menu.

There are two methods for discretizing blocks.
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Select Blocks and Discretize.

1 Select a block or blocks in the Model Discretizer tree view pane.

To choose multiple blocks, press and hold the Ctrl button on the keyboard
while selecting the blocks.

Note You must select blocks from the Model Discretizer tree view. Clicking
blocks in the Simulink editor does not select them for discretization.

2 Select Discretize current block from the Discretize menu if a single
block is selected or select Discretize selected blocks from the Discretize
menu if multiple blocks are selected.

You can also discretize the current block by clicking the Discretize button,
shown below.

N

Store the Discretization Settings and Apply Them to Selected Blocks
in the Model.

1 Enter the discretization settings for the current block.

2 Click Store Settings.

This adds the current block with its discretization settings to the group
of preset blocks.

3 Repeat steps 1 and 2, as necessary.

4 Select Discretize preset blocks from the Discretize menu.
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Deleting a Discretization Candidate from a Configurable
Subsystem

You can delete a discretization candidate from a configurable subsystem by
selecting it in the Location for block in configurable subsystem field and
clicking the Delete button, shown below.

x|

Undoing a Discretization
To undo a discretization, click the Undo discretization button, shown below.

=]

Alternatively, you can select Undo discretization from the Discretize
menu.

This operation undoes discretizations in the current selection and its children.

For example, performing the undo operation on a subsystem will remove
discretization from all blocks in all levels of the subsystem’s hierarchy.
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Viewing the Discretized Model

The Model Discretizer displays the model in a hierarchical tree view.

Viewing Discretized Blocks

The block’s icon in the tree view becomes highlighted with a “z” when the block
has been discretized. The following figure shows that the Aircraft Dynamics
Model subsystem has been discretized into a configurable subsystem with

three discretization candidates. The other blocks in this f14 model have not
been discretized.

" Simulink Model Discretizer 10l =|
File ‘“iew Discretize Help

B EHEC o2

Caontains continuous hlock) FDiscretization setting

W4 Current selection:  Aircraft Dynamics Model
& Actuator Model

ircraft Dynamics M [ Transform method: |zero-order ho -
24 Aircraft D ics bg [T i thod der hold

Transfer Fn.l )
g TransferFenz || Sample time: o0
=2 Cantroller [ra [z =]
& Alpha-sensar Loy
@ Pitch Rate Lead F| | Replace current selection with:
& Proportional plus
& Stick Prefilter
-2+ Dryden wind Gust w| | Location far black in configurable subsysterm:
i@ Q-gust model

Configurable subsystemn (Parameters in s-domain)LI

Aircraft Dynamics Model discrete version 1 LI X

Mew discrete subsystemn

Aircraft Dynamics Model discrete ion 1
Aircraft Dynamics Model discrete version 2
Aircraft Dynamics Model discrete version 3

Confinuous Blocks in moder: 12
Total blocks transformed: 2

Continuous blocks in current selection: 2
Blocks transformed in current selection: 2

JE1 I i

[Simulink Model Discretizer
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The following figure shows the Aircraft Dynamics Model subsystem of the f14
demo model after discretization into a configurable subsystem containing the
original continuous model and three discretization candidates.

g [m[ 3]
File Edit Wew Simulation Format Tools Help
Ded&| sBE|Z 2 » IINDrmaI v”@ | == i e
w
Stick Input :""‘9""‘59@
Pilat & fome
Nz pilot Scope
cakulation
Stick Irput jri
—{alpha (d)  Blevator Gommand {deg) He ! Mz Pilat ig)
Ta.s+1
e (rmodisec) Vertical Vigoeity w (ftisec)
Actuator
Contmlzr hodel
Open block Angke of
Open block in new window Attack
wa Cut _,®
a Copy alpha frad)
“a b Clear
Dryde n Wind
Gust hiadels Blo ice Aircraft Dynamics Model
[Mask parameters. .. Aircraft Dynamics Madel discrete wersion 1
SubSystem parameters. .. Aircraft Dynamics Madel discrete version 2
F14 Flght Gontrol Block properties... v Aircraft Dynamics Madel discrete version 3
. it .
(Double click on the *?* formome info) Real-Time Workshop »
Fixed-Point settings. ..
Ta start and stop the simulstion, uss the *Start® and
*Stop* s=lections in the “Simulation® pulldown menu. Mechanical environment. .
Mask subsystam —
e .hgjm,., odeds &

The following figure shows the library containing the Aircraft Dynamics
Model configurable subsystem with the original continuous model and three
discretization candidates.
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E!Lihrary: f14_disc_lib - |EI|1|
File Edit WYiew Formatb Help
m W -
DEEES| B0 hE 4
Temphic
[Elevator Deftection d g Elevator Deftection d o) Elevator Deftection d o) Elevator Deftection d o)
Wartizal Velogity W kses) Wartizal Velosty W Tk e Wartizal Velogity W kses) Wartizal Velogity W kses) Wartizal Velogity W kses)
[Vartical Gust wELBE (o) [artizal Gust WLt (e [artizal Gust WLt (e [artizal Gust WLt (e
Fitch Pt q pacisac) b a a a Fitch Fite q factiac] b
Fiotary Fiotary F [Fiotary Gust qaust fradte) [Fiotary Gust qaust fradte)
pr— Fircratt Fircratt Fircratt Fircratt
e Dyramics Dyramics Dyramics Dyramics
i Mol Mol Mol Mol
(Conigrie 5 ) disoree version 1 dsoree version 2 dsoree version 3
Aincraft Oy ramics Model dacrebe version 3
0% Locked 4

Ready

Refreshing Model Discretizer View of the Model
To refresh the Model Discretizer’s tree view of the model when the model has
been changed, click the Refresh button, shown below.

2

Alternatively, you can select Refresh from the View menu.
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Discretizing Blocks from the Simulink Model

You can replace continuous blocks in a Simulink model with the equivalent
blocks discretized in the s-domain using the Discretizing library.

The procedure below shows how to replace a continuous Transfer Fen block in
the Aircraft Dynamics Model subsystem of the f14 model with a discretized
Transfer Fen block from the Discretizing Library. The block is discretized

in the s-domain with a zero-order hold transform method and a 2—second
sample time.

1 Open the f14 model.

2 Open the Aircraft Dynamics Model subsystem in the f14 model.

E!fl-{.-"nircraft Dynamics Model - |EI|1|
File Edit WYiew Simulation Format Tools Help
DSE&|$ER| < » = |hom Y RE T ®
Elevator
Deflection
d deq)
-
=-Zw . .
Werical Gust Werical Velbcity
wiiust (frzac) Transter Fen 2 w iftis=c)
Ua
LT
f
Fiotary Gust s Pitsh Rate
qGust (mdfsec) Transfer Fen.d q (mdfzac)
Ready [1o02 |odeds v
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3 Open the Discretizing library window.

Enter discretizing at the MATLAB command prompt. The Library:
discretizing window opens. This library contains s-domain discretized

blocks.
SlLibrary: discretizing 10l =|
File Edit WYiew Formatb Help
" [
D _ Discretized Distretized
Repeating Sequence Signal Genemtor Ghip Signal
- tustin tustin Tustin
tustin | # = AxtBu a1 2(2-1)
duydt = G Du o ==l
=P
Dissretzed Dizs retized Py m—
Derivative iSoEtize Dissretized
State-Space
P Trnsfer Fen Fem-Pok
tustin
2
E =s{(1,[1 100
Discretzed - "
Discretzed
Trnzport Delay 2 LTI System
‘ ‘
Diseetred Discretzed
Varable Trnsport Delay

Trnsporn Delay

Sirmulink Discretzer Libmny 1.0
Sopyrght () 19902002 The hathWors, Inc.

4 Add the Discretized Transfer Fen block to the fl4/Aircraft Dynamics

Model window.

a Click the Discretized Transfer Fen block in Library: discretizing

window.
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b Drag it into the fl4/Aircraft Dynamics Model window.

E! / Aircraft Dynamics Model - | EI|5|
File Edit Wew Simulation Format Tools Help
D= E@& £l < IINmma\ ‘“@Iﬂ”ﬁ?@
Elevator
Deflection
d ideg)
» {1
=-Im . P
Vertieal Gust Wiartizal Vialoe ity
WSt (fusec) TmnsferFen.2 w (ftisec)
Ua
Tkt
1
=g
Rotary Gust Pitch Aate
qGust (md/sac) Trnsfer Fen.d q (Rdisec)
tustin
=1
Discretzad
Trnsfer Fon
Ready |1002% [ [ |ode4s v

5 Open the parameter dialog box for the Transfer Fen.1 block.

Double-click the Transfer Fen.1 block in the fl4/Aircraft Dynamics
Model window. The Block Parameters: Transfer Fen.1 dialog box
opens.

Block Parameters: Transfer Fcn.1 : |

r~ Transfer Fon

I atrix expression for numeratar, vectar expression for denarminatar.
Output width equals the number of raws in the numerator. Coefficients are
for dezcending powers of 5.

P
F

Numerator:
[
Drenominatar:
[(1.4a]

Absolute tolerance:

Iauto

oK. I Cancel Help Apply
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6 Open the parameter dialog box for the Discretized Transfer Fen block.

Double-click the Discretized Transfer Fcn block in the fl4/Aircraft
Dynamics Model window. The Block Parameters: Discretized
Transfer Fen dialog box opens.

Block Parameters: Discretized Transfer Fen |

r— DiscretizedT ransferFon [mask] [link]

Continuous mask uses c2d to transform parameters onto the Dizcrete
Transfer function block inside.

Mumerator [enter in s-domain:]

]

Denominator [enter in s-domain:]
0]

Absolute tolerance:

Iauto

Sample time:
1

Method: Itustin j

QK I Cancel | Help | Apply |

Copy the parameter information from the Transfer Fcn.1 block’s dialog box
to the Discretized Transfer Fen block’s dialog box.

Block Parameters: Discretized Transfer Fcn #

r— DiscretizedT ransferFon [mask] [link]

Continuous mask uses c2d to transform parameters onto the Dizcrete
Transfer function block inside.

Mumerator [enter in s-domain:]
]

Denominator [enter in s-domain:]
j[1.al

Absolute tolerance:

Iauto

Sample time:
1

Method: Itustin j

QK I Cancel Help Apply |
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7 Enter 2 in the Sample time field.
8 Select zoh from the Method drop-down list.

The parameter dialog box for the Discretized Transfer Fen. now looks like
this.

Block Parameters: Discretized Transfer Fem A

r— DiscretizedTransferFon [mask] (link]

Contituouzs mazk uses c2d ta transfarm parameters onta the Discrete
Transfer function block inside.

— Parameters
Mumerator [enter in ¢-domain;]

[l
Denaminatar [enter it s-domain:]
[[1Ma]

Abzolute tolerance:

Iauto

Sample time;

QK. I Cancel | Help | Apply |
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9 Click OK.

The f14/Aircraft Dynamics Model window now looks like this.

ircraft Dynamics Model 10l =l
File Edit Wiew Simulation Format Tools  Help
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Elevatar
Deflection
d {deg)
= 1
T I
Vertioal Gust s Venial Veleity
wiiust (ftfsec) Trnsfer Fen.2 w (fumee)
Ua [t
e ol
= 1
Ll
Fiotary Gust S Pitch Rate
qGEust (mdisec) Transfer Fen.d q imdisec)
zoh
1
=-hig
Dige retied
T=nster Fon
Ready [10d% [ode4s v
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10 Delete the original Transfer Fen.1 block.
a Click the Transfer Fen.1 block.

b Press the Delete key. The fl4/Aircraft Dynamics Model window now

looks like this.

Efld,.-"nircraft Dynamics Model
File Edit Wiew Simulation Format Tools  Help

=101 %]

Elkevator
Deflection
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= 1
o I
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------------------ > et 2 )
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1
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Dis: retived
Trnster Fen
Ready [10d% | [ [ode4s v

11 Add the Discretized Transfer Fen block to the model.
a Click the Discretized Transfer Fen block.
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b Drag the Discretized Transfer Fcen block into position to complete the
model. The fl4/Aircraft Dynamics Model window now looks like this.

E!fl-#,.'"nircraft Dynamics Model 10| =|
File Edit Wiew Simulation Format Toaols Help
DIﬁﬂ%l%EﬂDQ }llNormaI V”@: |H{r®
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Discretizing a Model from the MATLAB Command
Window

Use the sldiscmdl function to discretize Simulink models from the MATLAB
Command Window. You can specify the transform method, the sample time,
and the discretization method with the sldiscmdl function.

For example, the following command discretizes the f14 model in the s-domain
with a 1-second sample time using a zero-order hold transform method:

sldiscmdl('f14',1.0,"'zoh"')

For more information on the sldiscmdl function, see “Model Construction
Commands” in “Simulink Reference”.



Working with Blocks

This section explores the following block-related topics.

About Blocks (p. 4-2)

Editing Blocks (p. 4-4)

Working with Block Parameters
(p. 4-7)

Changing a Block’s Appearance
(p. 4-17)

Displaying Block Outputs (p. 4-21)

Controlling and Displaying the
Sorted Order (p. 4-23)

Lookup Table Editor (p. 4-26)

Working with Block Libraries
(p. 4-34)

Accessing Block Data During
Simulation (p. 4-53)

Explains the difference between
virtual and nonvirtual blocks.

How to cut and paste blocks.

How to set parameters that
determine a block’s behavior.

How to change the size, orientation,
color, and labeling of a block.

How to display the values of block
outputs on the block diagram during
simulation.

How to set a block’s execution
priority and display its execution
order.

How to change the elements of
lookup table blocks.

How to create and use block libraries.

How to use the Simulink block
run-time interface to access block
data during a simulation.
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About Blocks

4-2

Blocks are the elements from which Simulink models are built. You can model
virtually any dynamic system by creating and interconnecting blocks in
appropriate ways. This section discusses how to use blocks to build models
of dynamic systems.

Block Data Tips

On Microsoft Windows, Simulink displays information about a block in a
pop-up window when you allow the pointer to hover over the block in the
diagram view. To disable this feature or control what information a data tip
includes, select Block data tips options from the Simulink View menu.

Virtual Blocks

When creating models, you need to be aware that Simulink blocks fall into
two basic categories: nonvirtual and virtual blocks. Nonvirtual blocks play an
active role in the simulation of a system. If you add or remove a nonvirtual
block, you change the model’s behavior. Virtual blocks, by contrast, play no
active role in the simulation; they help organize a model graphically. Some
Simulink blocks are virtual in some circumstances and nonvirtual in others.
Such blocks are called conditionally virtual blocks. The following table lists
Simulink virtual and conditionally virtual blocks.

Block Name Condition Under Which Block Is Virtual

Bus Selector Virtual if input bus is virtual.

Demux Always virtual.

Enable Virtual unless connected directly to an Outport
block.

From Always virtual.

Goto Always virtual.

Goto Tag Visibility Always virtual.

Ground Always virtual.
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Block Name Condition Under Which Block Is Virtual

Inport Virtual unless the block resides in a conditionally
executed or atomic subsystem and has a direct
connection to an Outport block.

Mux Always virtual.

Outport Virtual when the block resides within any
subsystem block (conditional or not), and does not
reside in the root (top-level) Simulink window.

Selector Virtual except in matrix mode.

Signal Specification | Always virtual.

Subsystem Virtual unless the block is conditionally executed
and/or the block’s Treat as Atomic Unit option
is selected.

Terminator Always virtual.

Trigger Virtual when the Outport port is not present.

4-3
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The Simulink Editor allows you to cut and paste blocks in and between models.

Copying and Moving Blocks from One Window to
Another

As you build your model, you often copy blocks from Simulink block libraries
or other libraries or models into your model window. To do this:

1 Open the appropriate block library or model window.

2 Drag the block to copy into the target model window. To drag a block,
position the cursor over the block, then press and hold down the mouse
button. Move the cursor into the target window, then release the mouse
button.

You can also drag blocks from the Simulink Library Browser into a model
window. See “Browsing Block Libraries” on page 4-48 for more information.

Note Simulink hides the names of Sum, Mux, Demux, Bus Creator, and Bus
Selector blocks when you copy them from the Simulink block library to a
model. This is done to avoid unnecessarily cluttering the model diagram. (The
shapes of these blocks clearly indicate their respective functions.)

You can also copy blocks by using the Copy and Paste commands from the
Edit menu:

1 Select the block you want to copy.
2 Choose Copy from the Edit menu.
3 Make the target model window the active window.

4 Choose Paste from the Edit menu.

Simulink assigns a name to each copied block. If it is the first block of its type
in the model, its name is the same as its name in the source window. For
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example, if you copy the Gain block from the Math library into your model
window, the name of the new block is Gain. If your model already contains a
block named Gain, Simulink adds a sequence number to the block name (for
example, Gainl, Gain2). You can rename blocks; see “Manipulating Block
Names” on page 4-19.

When you copy a block, the new block inherits all the original block’s
parameter values.

Simulink uses an invisible five-pixel grid to simplify the alignment of blocks.
All blocks within a model snap to a line on the grid. You can move a block
slightly up, down, left, or right by selecting the block and pressing the arrow
keys.

You can display the grid in the model window by typing the following
command in the MATLAB window.

set_param('<model name>', 'showgrid','on')
To change the grid spacing, enter
set_param('<model name>', 'gridspacing',<number of pixels>)
For example, to change the grid spacing to 20 pixels, enter
set_param('<model name>', 'gridspacing',20)

For either of the above commands, you can also select the model, then enter
gcs instead of <model name>.

You can copy or move blocks to compatible applications (such as word
processing programs) using the Copy, Cut, and Paste commands. These
commands copy only the graphic representation of the blocks, not their
parameters.

Moving blocks from one window to another is similar to copying blocks, except
that you hold down the Shift key while you select the blocks.

You can use the Undo command from the Edit menu to remove an added
block.
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Moving Blocks in a Model

To move a single block from one place to another in a model window, drag the
block to a new location. Simulink automatically repositions lines connected to
the moved block.

To move more than one block, including connecting lines:

1 Select the blocks and lines. If you need information about how to select
more than one block, see “Selecting Multiple Objects” on page 3-4.

2 Drag the objects to their new location and release the mouse button.

Copying Blocks in a Model

You can copy blocks in a model as follows. While holding down the Ctrl key,
select the block with the left mouse button, then drag it to a new location.
You can also do this by dragging the block using the right mouse button.
Duplicated blocks have the same parameter values as the original blocks.
Sequence numbers are added to the new block names.

Deleting Blocks

To delete one or more blocks, select the blocks to be deleted and press the
Delete or Backspace key. You can also choose Clear or Cut from the Edit
menu. The Cut command writes the blocks into the clipboard, which enables
you to paste them into a model. Using the Delete or Backspace key or the
Clear command does not enable you to paste the block later.

You can use the Undo command from the Edit menu to replace a deleted
block.
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Working with Block Parameters

Every Simulink block has a set of attributes, called parameters or properties,
that govern its appearance and its behavior during simulation. Some types
of attributes are common to all blocks. For example, all blocks have a block
name attribute. Other attributes are specific to a particular type of block. For
example, only Gain blocks have a Gain parameter. Simulink allows you to
specify values for many of a block’s attributes, thus enabling you to customize
the block’s appearance or behavior to fit the requirements of a particular
application.

Simulink provides the following means for specifying block parameters:

¢ Format menu

The Model Editor’s Format menu allows you to specify attributes of the
currently selected block that are visible on the model’s block diagram, such
as the block’s name and color (see “Changing a Block’s Appearance” on page
4-17 for more information).

¢ Block Properties dialog box

Specifies various attributes that are common to all blocks (see “Block
Properties Dialog Box” on page 4-12 for more information).

¢ Block Parameter dialog box

Every block has a dialog box that allows you to specify values for attributes
that are specific to that type of block. See “Displaying a Block’s Parameter
Dialog Box” on page 4-8 for information on displaying a block’s parameter
dialog box. For information on the parameter dialog of a specific block, see
“Simulink Blocks” in the online Simulink reference.

® Model Explorer

The Model Explorer allows you to quickly find one or more blocks and set
their properties, thus facilitating global changes to a model, for example,
changing the gain of all of a model’s Gain blocks. See “The Model Explorer”
on page 8-2 for more information.

® set param command
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set_param enables you to use M-file programs and scripts to specify block
attributes. See set_param in the online Simulink reference for more
information.

Displaying a Block’s Parameter Dialog Box

You can also display a block’s parameter dialog box by double-clicking it in
the model or library window.

Note This holds true for all blocks with parameter dialog boxes except for
Subsystem blocks. You must use the Model Editor’s Edit menu or context
menu to display a Subsystem block’s parameter dialog box.

You can also display a block’s parameter dialog box by selecting the block
in the model’s block diagram and choosing BLOCK Parameters from the
model window’s Edit menu or from the model window’s context (right-click)
menu, where BLOCK is the name of the block you selected, e.g., Constant
Parameters.

Specifying Parameter Values

You can use a MATLAB constant, model or base workspace variable, or
expression that evaluates to a numerical value to specify the value of a
numeric parameter. If the value is the name of a workspace variable or
MATLAB expression, Simulink evaluates the variable or expression when it
compiles the model to determine the parameter’s value. If the variable is not
defined in the model or MATLAB workspace or the expression uses variables
that are not defined in the model or MATLAB workspace, Simulink halts the
compilation and displays an error message.

Note You can specify a parameter’s data type as well as its value. See
“Specifying Block Parameter Data Types” on page 6-5 for more information.

Working with Tunable Parameters

Simulink lets you change the values of many block parameters during
simulation. Such parameters are called tunable parameters. In general,
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only parameters that represent mathematical variables, such as the Gain
parameter of the Gain block, are tunable. Parameters that specify the
appearance or structure of a block, e.g., the number of inputs of a Sum block,
or when it is evaluated, e.g., a block’s sample time or priority, are not tunable.
You can tell whether a particular parameter is tunable by examining its edit
control in the block’s dialog box or Model Explorer during simulation. If the
control is disabled, the parameter is disable.

Note As a model optimization, you can declare even tunable parameters as
nontunable. See “Inlining Parameters” on page 4-11 for more information.

Tuning Block Parameters

You can use a block’s dialog box or the Model Explorer to modify the tunable
parameters of any block, except a source block (see “Changing Source Block
Parameters” on page 4-9). You can also use the MATLAB Command Line to
tune block parameters.

To use the block’s parameter dialog box, open the block’s parameter dialog box,
change the value displayed in the dialog box, and click the dialog box’s OK
or Apply button. You can use the set_param command to change the value
of a block parameter at the MATLAB Command Line during simulation. Or,
if the model uses a MATLAB workspace variable to specify the parameter’s
value, you can change the parameter’s value by assigning a new value to the
variable. In either case, you must update the model’s block diagram for the
change to take effect.

Changing Source Block Parameters

Opening the dialog box of a source block with tunable parameters (see “Source
Blocks with Tunable Parameters” on page 4-10) causes a running simulation
to pause. While the simulation is paused, you can edit the parameter values
displayed on the dialog box. However, you must close the dialog box to have
the changes take effect and allow the simulation to continue. Similarly,
starting a simulation causes any open dialog boxes associated with source
blocks with tunable parameters to close.

4-9
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Note If you enable the Inline parameters option, Simulink does not pause
the simulation when you open a source block’s dialog box because all of the
parameter fields are disabled and can be viewed but cannot be changed.

The Model Explorer disables the parameter fields that it displays in the list
view and the dialog pane for a source block with tunable parameters while

a simulation is running. As a result, you cannot use the Model Explorer to
change the block’s parameters. However, while the simulation is running, the
Model Explorer displays a Modify button in the dialog view for the block.
Clicking the Modify button opens the block’s dialog box. Note that this
causes the simulation to pause. You can then change the block’s parameters.
You must close the dialog box to have the changes take effect and allow the
simulation to continue. Your changes appear in the Model Explorer after you
close the dialog box.

Source Blocks with Tunable Parameters. Source blocks with tunable
parameters include the following blocks.
® Simulink source blocks, including

= Band-Limited White Noise

= Chirp Signal

= Constant

= Pulse Generator

= Ramp

= Random Number

= Repeating Sequence

= Signal Generator

= Sine Wave

= Step

= Uniform Random Number

® User-developed masked subsystem blocks that have one or more tunable
parameters and one or more output ports, but no input ports.
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¢ S-Function and M-file (level 2) S-Function blocks that have one or more
tunable parameters and one or more output ports but no input ports.

Inlining Parameters

As an optimization, you can specify that some or all of a model’s tunable
parameters be nontunable. Declaring parameters as nontunable allows the
Real-Time Workshop to include the parameters as constants in code generated
from the model, an optimization known as inlining parameters. To inline

all of a model’s parameters, select the Inline parameters option on the
Optimization pane of the model’s active configuration set.

To inline some but not all of a model’s parameters, you must first declare all
of the parameters as inlined by selecting the Inline parameters option on
the active set’s Optimization pane. You must then specify the exceptions,
using either the Model Parameter Configuration dialog box (see “Model
Parameter Configuration Dialog Box” on page 9-66) or Simulink.Parameter
objects.

Note When compiling a model with the inlined parameters option on,
Simulink checks to ensure that the data types of the workspace variables used
to specify the model’s tunable parameter values are compatible with code
generation. If not, Simulink halts the compilation and displays an error. See
the “Real-Time Workshop” for more information.

Using Parameter Objects to Specify Parameter Tunability
To declare a parameter to be tunable even when the Inline parameters
option is set, use an instance of Simulink.Parameter class to specify the
parameter’s value and set the parameter object’s RTWInfo.StorageClass
property to any value but 'Auto’' (the default).

gain.RTWInfo.StorageClass = 'SimulinkGlobal';
If you set the RTWInfo.StorageClass property to any value other than Auto,

you should not include the parameter in the tunable parameters table in the
model’s Model Parameter Configuration dialog box.
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Note Simulink halts model compilation and displays an error message if
it detects a conflict between the properties of a parameter as specified by
a parameter object and the properties of the parameter as specified in the
Model Parameter Configuration dialog box.

Block Properties Dialog Box

This dialog box lets you set a block’s properties. To display this dialog, select
the block in the model window and then select Block Properties from the
Edit menu.

-} Block Properties: Produck i ]

General

Block &nnotation | Callbacks |

Information

General block properties.

Description: test field that is generally used for zaving comments about the
block.

Friority: specifies the block's sequencing during execution relative to other
blocks with priorities in the same window.

Tag: a general text field as label which iz zaved with the block.

Description:

Pricrity:

Tag:

Ok | Cancel | Help | Apply |

The dialog box contains the following tabbed panes.
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General Pane
This pane allows you to set the following properties.

Description. Brief description of the block’s purpose.

Priority. Execution priority of this block relative to other blocks in the model.
See for more information.

Tag. Text that is assigned to the block’s Tag parameter and saved with the
block in the model. You can use the tag to create your own block-specific
label for a block.

Block Annotation Pane

The block annotation pane allows you to display the values of selected
parameters of a block in an annotation that appears beneath the block’s icon.

+} Block Properties: Produck =0 x]

General | Block &nnotation

Callbacks |

Information

Block annotation iz a get of stiing shown below the block name. Available
block property tokens are listed on the left for user to chooze from. The
annotation text can be edited on the right side edit field. See example syntax
ot the bottarn.

Block property tokens: Enter text and tokens for annotation:

]

*%<BackgroundColor:
*%<BlockDescription:
*%<BlockType>
#<DataTypelveride.
*<Description:
*<Diagnostics>
*<DropShadow:
*%<ForegroundColors
#«<Handle:»
#<Hilitedncestors:
*<|nputSameD T
*<|nputs>
F«LinkStatus:
*%<LockScale>
FeMask:
ehaskTypes

H<Mint axDverflowlc T Example spntas:
4 4 Mame=%<Mame:

Ok | Cancel Help
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Enter the text of the annotation in the text field that appears on the right side
of the pane. The text can include block property tokens, for example

%s<Name>
Priority = %<priority>

of the form %<param> where param is the name of a parameter of the block.
When displaying the annotation, Simulink replaces the tokens with the
values of the corresponding parameters, e.g.,

+

—

Product
Priarty = 2

LA

The block property tag list on the left side of the pane lists all the tags that
are valid for the currently selected block. To include one of the listed tags
in the annotation, select the tag and then click the button between the tag
list and the annotation field.

You can also create block annotations programmatically. See “Creating Block
Annotations Programmatically” on page 4-15.
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Callbacks Pane

The Callbacks Pane allows you to specify implementations for a block’s
callbacks (see “Using Callback Functions” on page 3-83).

.-__:fﬁ:BIock Properties: Sum :0 - | Ellll

Generall Elock P.nnotationl Callbacksl

— Usage

To create or edit a callback function for this block, select it in the callback
list (helow, left). Then enter MATLAB code that implements the function in
the content pane (helow, right). The callback name’s suffix indicates its
status: “(has saved content).

Callback functions list: Content of callback function: “CliphoardFcn®

CliphoardFcn
CloseFcn
CopyFcn
DeleteFcn
DestroyFcn
InitFcn
LoadFcn
ModelCloseFcn
roveFcn
MNameChangeFcn
OpenFcn
FParentCloseFcn

I

Ok | Cancel| Help | |

To specify an implementation for a callback, select the callback in the callback
list on the left side of the pane. Then enter MATLAB commands that
implement the callback in the right-hand field. Click OK or Append to save
the change. Simulink appends an asterisk to the name of the saved callback
to indicate that it has been implemented.

Creating Block Annotations Programmatically

You can use a block’s AttributesFormatString parameter to display selected
parameters of a block beneath the block as an “attributes format string,” i.e., a
string that specifies values of the block’s attributes (parameters). “Model and
Block Parameters” in “Simulink Reference” describes the parameters that a
block can have. Use the Simulink set param command to set this parameter
to the desired attributes format string.
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The attributes format string can be any text string that has embedded
parameter names. An embedded parameter name is a parameter name
preceded by %< and followed by >, for example, %<priority>. Simulink
displays the attributes format string beneath the block’s icon, replacing
each parameter name with the corresponding parameter value. You can use
line-feed characters (\n) to display each parameter on a separate line. For
example, specifying the attributes format string

pri=%<priority>\ngain=%<Gain>

for a Gain block displays

[ >
Gain

pri=10
gain=1

If a parameter’s value is not a string or an integer, Simulink displays N/S
(not supported) for the parameter’s value. If the parameter name is invalid,
Simulink displays "???" as the parameter value.

State Properties Dialog Box

The State Properties dialog box allows you to specify code generation
options for certain blocks with discrete states. See “Block States: Storing and
Interfacing” in “Real-Time Workshop User’s Guide” for more information.
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Changing a Block’s Appearance

The Simulink Editor allows you to change the size, orientation, color, and
label location of a block in a block diagram.

Changing the Orientation of a Block

By default, signals flow through a block from left to right. Input ports are on
the left, and output ports are on the right. You can change the orientation of a
block by selecting one of these commands from the Format menu:

¢ The Flip Block command rotates the block 180 degrees.
¢ The Rotate Block command rotates a block clockwise 90 degrees.
The following figure shows how Simulink orders ports after changing the

orientation of a block using the Rotate Block and Flip Block menu items.
The text in the blocks shows their orientation.

1 2 3
VYV Y R
Fﬂ/tﬂtv—-» Down | ==
12 Left * Rightr:: ]
22 to g— Flip — p» | to xZ
3 SRight + Left | 5
= | v 4’%
0t h

Resizing a Block

To change the size of a block, select it, then drag any of its selection handles.
While you hold down the mouse button, a dotted rectangle shows the new
block size. When you release the mouse button, the block is resized.
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For example, the following figure below shows a Signal Generator block
being resized. The lower-right handle was selected and dragged to the cursor
position. When the mouse button is released, the block takes its new size.

This figure shows a block being resized:

i Signal
Generator |

Displaying Parameters Beneath a Block

You can cause Simulink to display one or more of a block’s parameters beneath
the block. You specify the parameters to be displayed in the following ways:

* By entering an attributes format string in the Attributes format string
field of the block’s Block Properties dialog box (see “Block Properties
Dialog Box” on page 4-12)

® By setting the value of the block’s AttributesFormatString property to
the format string, using set_param

Using Drop Shadows

You can add a drop shadow to a block by selecting the block, then choosing
Show Drop Shadow from the Format menu. When you select a block with
a drop shadow, the menu item changes to Hide Drop Shadow. The following
figure shows a Subsystem block with a drop shadow:

(3
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Manipulating Block Names

All block names in a model must be unique and must contain at least one
character. By default, block names appear below blocks whose ports are on
the sides, and to the left of blocks whose ports are on the top and bottom, as
the following figure shows:

)D} Tap to bnﬁnmv

e
Left to right

Note Simulink commands interprets a forward slash, i.e., /, as a block path
delimiter. For example, the path vdp/Mu designates a block named Mu in the
model named vdp. Therefore, avoid using forward slashes (/) in block names
to avoid causing Simulink to interpret the names as paths.

Changing Block Names

You can edit a block name in one of these ways:

® To replace the block name, click the block name, double-click or drag the
cursor to select the entire name, then enter the new name.

® To insert characters, click between two characters to position the insertion
point, then insert text.

¢ To replace characters, drag the mouse to select a range of text to replace,
then enter the new text.

When you click the pointer anywhere else in the model or take any other
action, the name is accepted or rejected. If you try to change the name of a
block to a name that already exists or to a name with no characters, Simulink
displays an error message.

You can modify the font used in a block name by selecting the block, then
choosing the Font menu item from the Format menu. Select a font from the
Set Font dialog box. This procedure also changes the font of any text that
appears inside the block.
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You can cancel edits to a block name by choosing Undo from the Edit menu.

Note If you change the name of a library block, all links to that block become
unresolved.

Changing the Location of a Block Name
You can change the location of the name of a selected block in two ways:

® By dragging the block name to the opposite side of the block.

¢ By choosing the Flip Name command from the Format menu. This
command changes the location of the block name to the opposite side of
the block.

For more information about block orientation, see “Changing the Orientation
of a Block” on page 4-17.

Changing Whether a Block Name Appears

To change whether the name of a selected block is displayed, choose a menu
item from the Format menu:

® The Hide Name menu item hides a visible block name. When you select
Hide Name, it changes to Show Name when that block is selected.

¢ The Show Name menu item shows a hidden block name.

Specifying a Block’s Color

See “Specifying Block Diagram Colors” on page 3-6 for information on how to
set the color of a block.
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Displaying Block Outputs

Simulink can display block outputs as data tips on the block diagram while a
simulation is running.

van der Pol Equation

[sli3]

Scope

The van der Pol Equation B o

{Doubkeclickon the "?* for monme info) Doubleclick
hee for

Simulink Help

To start and stop the simulation. uss the "Start/Stop”
salaction in the "Simulation® pulldown meanu

You can specify whether and when to display block outputs (see “Enabling
Port Values Display” on page 4-21) and the size and format of the output
displays and the rate at which Simulink updates them during a simulation
(see “Port Values Display Options” on page 4-22).

Enabling Port Values Display

To turn display of port output values on or off, select Port Values from the
Model Editor’s View menu. A menu of display options appears. Select one of
the following display options from the menu:
¢ Show none

Turns port value displaying off.
¢ Show when hovering

Displays output port values for the block under the mouse cursor.

* Toggle when selected
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Selecting a block displays its outputs. Reselecting the block turns the
display off.

When using the Microsoft Windows version of Simulink, you can turn block

output display when hovering on or off from the Model Editor’s toolbar. To do
this, select the block output display button on the toolbar.

[ . =10 ]
CNEsbes REE T ®
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| »

— Click to show/hide block output when hovering
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Port Values Display Options

To specify other display options, select Port > Values > Options from the
Model Editor’s View menu. The Block Output Display Options dialog
box appears.

vdp - Block Dutput Display Dptions k|

—Dizplay options

Fant size: [ptz] I)I

Hef[eSh Int8lva| [S] L e e e e R e e e e O e e

—Dizplay values:

& Show Mone £ Show When Hovering € Togale when Selected

—Dizplay Format

Floating pairt: I %5.3a vI Fix point [ztored integer): I short vI

To increase the size of the output display text, move the Font size slider to
the right. To increase the rate at which Simulink updates the displays, move
the Refresh interval slider to the left.

4-22



Controlling and Displaying the Sorted Order

Controlling and Displaying the Sorted Order

The sorted order is an ordering of the blocks in the model that Simulink uses
as a starting point for determining the order in which to invoke the blocks’
methods (see “Block Methods” on page 1-12) during simulation. Simulink
allows you to display the sorted order for a model and to assign priorities to
blocks that can influence where they appear in the sorted order. For more
information, see

¢ “How Simulink Determines the Sorted Order” on page 4-23
¢ “Displaying the Sorted Order” on page 4-24
® “Assigning Block Priorities” on page 4-25

How Simulink Determines the Sorted Order
Simulink uses the following basic rules to sort the blocks:

e Each block must appear in the sorted order ahead any of the blocks whose
direct-feedthrough ports (see “About Direct-Feedthrough Ports” on page
4-24) it drives.

This rule ensures that the direct-feedthrough inputs to blocks will be valid
when block methods that require current inputs are invoked.

® Blocks that do not have direct feedthrough inputs can appear
anywhere in the sorted order as long as they precede any blocks whose
direct-feedthrough inputs they drive.

Putting all blocks that do not have direct-feedthrough ports at the head of
the sorted order satisfies this rule. It thus allows Simulink to ignore these
blocks during the sorting process.

The result of applying these rules is a sorted order in which blocks without
direct feedthrough ports appear at the head of the list in no particular order
followed by blocks with direct-feedthrough ports in the order required to
supply valid inputs to the blocks they drive.

During the sorting process, Simulink checks for and flags the occurrence

of algebraic loops, that is, signal loops in which a direct-feedthrough

output of a block is connected directly or indirectly to the corresponding
direct-feedthrough input of the block. Such loops seemingly create a deadlock
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condition, because the block needs the value of the direct-feedthrough input
to compute its output.

However, an algebraic loop can represent a set of simultaneous algebraic
equations (hence the name) where the block’s input and output are the
unknowns. Further, these equations can have valid solutions at each time
step. Accordingly, Simulink assumes that loops involving direct-feedthrough
ports do, in fact, represent a solvable set of algebraic equations and attempts
to solve them each time the block’s output is required during a simulation.
For more information, see “Algebraic Loops” on page 1-24.

About Direct-Feedthrough Ports

In order to ensure that the sorted order reflects data dependencies

among blocks, Simulink categorizes a block’s input ports according to the
dependency the block’s outputs on its inputs. An input port whose current
value determines the current value of one of the block’s outputs is called a
direct-feedthrough port. Examples of blocks that have direct-feedthrough
ports include the Gain, Product, and Sum blocks. Examples of blocks that
have non-direct-feedthrough inputs include the Integrator block (its output is
a function purely of its state), the Constant block (it does not have an input),
and the Memory block (its output is dependent on its input in the previous
time step).

Displaying the Sorted Order

To display the sorted order, select Sorted order from the Simulink Format
menu. Selecting this option causes Simulink to display a notation in the top
right corner of each block in a block diagram.
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The notation for most blocks has the format s:b, where s specifies the index
of the subsystem to whose execution context (see “Conditional Execution
Behavior” on page 3-47) the block belongs and b specifies the block’s
position in the sorted order for that execution context. The sorted order of a
Function-Call Subsystem cannot be determined at compile time. Therefore,
for these subsystems, Simulink uses either the notation s:F, if the system has
one initiator, where s is the index of the subsystem that contains the initiator,
or the notation M, if the subsystem has more than one initiator.

Assigning Block Priorities

You can assign priorities to nonvirtual blocks or virtual subsystem blocks in
a model (see “Virtual Blocks” on page 4-2). Higher priority blocks appear
before lower priority blocks in the sorted order, though not necessarily before
blocks that have no assigned priority.

You can assign block priorities interactively or programmatically. To set
priorities programmatically, use the command

set_param(b, 'Priority','n")

where b is a block path and n is any valid integer. (Negative numbers and

0 are valid priority values.) The lower the number, the higher the priority;
that is, 2 is higher priority than 3. To set a block’s priority interactively, enter
the priority in the Priority field of the block’s Block Properties dialog box
(see “Block Properties Dialog Box” on page 4-12).

Simulink honors the block priorities that you specify only if they are
consistent with the Simulink block sorting algorithm. If Simulink is unable to
honor a block priority, it displays a Block Priority Violation diagnostic
message (see “Diagnostics Pane” on page 9-67).
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The Lookup Table Editor allows you to inspect and change the table elements
of any lookup table (LUT) block in a model (see “Lookup Tables” in the
“Simulink Reference”), including custom LUT blocks that you have created,
using the Simulink Mask Editor (see “Editing Custom LUT Blocks” on page
4-31). You can also use a block’s parameter dialog to edit its table. However,
that requires you to open the subsystem containing the block first and then
its parameter dialog box. The LUT Editor allows you to skip these steps. This
section explains how to open and use the LUT Editor to edit LUT blocks.

Note You cannot use the LUT Editor to change the dimensions of a lookup
table. You must use the block’s parameter dialog box for this purpose.

To open the editor, select Lookup table editor from the Simulink Tools
menu. The editor appears.

=lofx|

<} Lookup Table Editor: fuelsys,fuel rate controller/Airflow calculation,/Pum|
File Edit FPlot Help

ES|E’:*§E‘--’§-|ML®|{E

Mocdels: : Wiewving "2-0r Lookup Takle" block data [T(: 2]

lm (= | Breakpairts | Column (1) (2] (3] (4] (3]

Tahle blocks: Rowy 0.05 0.1 0.15 0.2 0.25 -
(1) 50 -0055635| 0018533 00418458 0052676 0038323 j

(2] 75 -00022528 0048509 0051486 0087984 0071079

. " (3] 100 0025693 0081797 0072524 0078908 0075734

! Sensor correction and (4] 125 0.043519 0.072m 00802 0083314) 0084399

Lo | throttle command (5) 150 0056269 0079885 0086183 0088452 0089029
i aTE A A faN el ot a ) mna o [ ala e e et d [N s lata et iat T
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Data Type: Row: I double LI Colum: I double LI Table: I double LI

Dimenzion Selector:

Dimenzion size 18 19
Select 2-0 slice

r Transpose display
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The editor contains two panes and a toolbar. The pane on the left is a LUT
block browser. It allows you to browse and select LUT blocks in any open
model (see “Browsing LUT Blocks” on page 4-27). The pane on the right allows
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you to edit the selected block’s lookup table (“Editing Table Values” on page
4-28). The toolbar gives you one-click access to the editor’s most frequently
used commands. Each toolbar button has a tooltip that explains its function.

Browsing LUT Blocks

The Models list in the upper-left corner of the LUT Editor lists the names of
all models open in the current MATLAB session. To browse any open model’s
LUT table blocks, select the model’s name from the list. A tree-structured
view of the selected model’s LUT blocks appears in the Table blocks field
beneath the Models list.

hdadels:

Iﬁ fuglsys LI =
Table blocks:

El'" fuel rate cortroller
Airflow calculation
[ Sensor correction and
| thrcttle command

| 2

The tree view initially lists all the LUT blocks that reside at the model’s root
level. It also displays any subsystems that contain LUT blocks. Clicking
the expand button (+) to the left of the subsystem’s name expands the tree
to show the LUT blocks in that subsystem. The expanded view also shows
any subsystems in the expanded subsystem. You can continue expanding
subsystem nodes in this manner to display LUT blocks at any level in the
model hierarchy.

Clicking any LUT block in the LUT block tree view displays the block’s lookup

table in the right-hand pane, allowing you to edit the table (see “Editing Table
Values” on page 4-28).
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Note If you want to browse the LUT blocks in a model that is not currently
open, you can command the LUT Editor to open the model. To do this, select
Open from the LUT Editor’s File menu.

Editing Table Values

The Viewing “2-D lookup Table” block data [T(:,:)] table view of the LUT
Editor allows you to edit the lookup table of the LUT block currently selected
in the adjacent tree view.

Wigwing "2-0 Lookup Table" block data [T ]
Breakpointz Column 4} (2] (3]
Rty 0.05 0.1 0.75 -
(1 a0 -0.055635 0.018533 0.041945
(2 5 -0.0022328 0.046509 0.061466
(3 100 0025693 0.081797 0072524
4 125 0.043519 0.07201 0.0802
(5) 150 0.056269 0.079685 0.086183
(] 173 0085119 0.05591 00912
3 (rd| 20 NA744 57 nna122a 1 Na&sFA1 2 _llﬂ
] [SR—

The table view displays the entire table if it is one- or two-dimensional or a
two-dimensional slice of the table if the table has more than two dimensions
(see “Displaying N-D Tables” on page 4-29). To change any of the displayed
values, double-click the value. The LUT Editor replaces the value with an edit
field containing the value. Edit the value, then press Enter or click outside
the field to confirm the change.

The LUT Editor records your changes in a copy of the table that it maintains.
To update the copy maintained by the LUT block itself, select Update block
data from the LUT Editor’s File menu. To restore the LUT Editor ‘s copy to
the values stored in the block, select Reload block data from the File menu.
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Displaying N-D Tables
If the lookup table of the LUT block currently selected in the LUT Editor’s

tree view has more than two dimensions, the editor’s table view displays a
two-dimensional slice of the table.

Wiewing "LookuphDinterpldx (mask)" block data [T 17):

Breakpoirts Colinh (1) (2 (3) (4) (5)
Ry 05 1 3 5 15 =l
1) 0 1 1 21 31 L
(2) 10 2 12 22 az 42
(3) 20 3 13 23 33 43
1G] 30 4 14 24 3 44
(5 40 s 15 25 35 45
(6) 50 6 16 26 36 46
(7) &0 7 17 o7 kT4 47
(8) 70 5 18 28 33 43| —
(9) 80 9 19 29 33 43
cam an in

falnl an A [=1a} T
Rl | »

Data Type: Row: I douhble ﬂ Column: I double j Tahle: I couble LI

P

Dimension Selectar:

Dimenzion size 10 5} 5
Select 2-D slice A - Al = 1 =

r Transpose display

The Data Type beneath the table allows you to specify the entry data type

by row, column, or for the entire table. By default, the data type is double.

To change the data type, select the pop-up index list for the table section for
which you want to change the data type.

The Dimension Selector specifies which slice currently appears and allows
you to select another slice. The selector consists of a 2-by-N array of controls
where N is the number of dimensions in the lookup table. Each column
corresponds to a dimension of the lookup table. The first column corresponds
to the first dimension of the table, the second column to the second dimension
of the table, and so on. The top row of the selector array displays the size of
each dimension. The remaining rows specify which dimensions of the table
correspond to the row and column axes of the slice and the indices that select
the slice from the remaining dimensions.
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For example, the following selector displays slice (;,;,1) of a 3-D table.
Dirmension Selector:
Dimension size 10 ] 3
Select 2-0 slice Al = Al ;I 1 2

[ Transpoze dizplay

To change the displayed orientation of the data, check Transpose display.
Note that this transposition does not affect the underlying data.
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Plotting LUT Tables

Select Linear or Mesh from the Plot menu of the LUT Editor to display
a linear or mesh plot of the table or table slice currently displayed in the
editor’s table view.

<) Look-Up Table Editor: fuelsys/fuel rate controller/Airflow calculation/Pumping C =lax|
File Flot Help
Pédt?l& Block Parameters Data:
fuelsys | @ Breakpoirts | -Colurnne-= o ey i) (4 I
[Table blocks: --Row-- 0.05 0.1 0.15 0.2 0.~
_iiﬂfuelrate contraller (13 50 -0.055635 0.018533 0.041948 0.052676 0.C
= 2F| Arflow calculati 2 75 -0.0022628]  0.046508) 00B1466) 0.067964) O
E (3 T00 0.025693 0.061797 0.072524 0.076908 0.C
- B# Sensor correction and i (4) 125 0.043518)  0.07201 00802 0083314 o
| thrattle command [53] 150 0.056269 0.079685 0.086183 0.088452 0.C
() 175 0.066119 0.0859 0.0812 0.092865 0.C
(7 200 0.074147 0.091229 0.095612 0.096834 0.C
(8 250 0.086497 0.10024 010335 0.10383 _DI_VI
S — = =

Linear / \ Mesh

ne=

Editing Custom LUT Blocks

You can use the LUT Editor to edit custom lookup table blocks that you or

others have created. To do this, you must first configure the LUT Editor to
recognize the custom LUT blocks in your model. Once you have configured
the LUT Editor to recognize the custom blocks, you can edit them as if they
were standard blocks.
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To configure the LUT editor to recognize custom LUT blocks, select
Configure from the editor’s File menu. The Look-Up Table Blocks Type
Configuration dialog box appears.

<} Look-Up Table Blocks Type Configuration ﬂ
v Lse Simulink default look-up table blacks list

|n] Block Type Maszk Type Breakpoint Mame Tahle Mame Mumber of dimens..| Explicit dimensions
1 |Lookup Inputvalues Qutputvalues

2 |5-Function Fixed-Paint Look-... [#LookUpData LookUpData

3 |5-Function Fixed-Paint Look-... |RowLookUpData,... (TableLookUpData

4 |3-Function Fixed-Point Look-...

5 |5-Function LookupldsSearch  |bpData

B |5-Function LookupMDDirect mxTable masktahDims explicitumbDims
T |5-Function LookupMDinterp bp1,bp2,bp3 bpd b tahleData numbDimsPopups... |explicitfumDims

8 |5-Function LookupMDinterpldx tahle numbDimsPopups... |explicitfumDims

9 |5-Function S-function: sftahle2 [xindex_idxyindex_i... [tahle_idx

10 |S-Function S-function: sfun_di... [<VECT WECT

11 |SuhSystem Lookup Table {2-0 [xy t

12 |SuhSystem Repeating table rep_seq_t rep_seq_y

Add Rermoye | Ok | Cancel |

By default the dialog box displays a table of the types of LUT blocks that the
LUT Editor currently recognizes. By default these are the standard Simulink
LUT blocks. Each row of the table displays key attributes of a LUT block type.

Adding a Custom LUT Type
To add a custom block to the list of recognized types,

1 Click the Add button on the dialog box.
A new row appears at the bottom of the block type table.

2 Enter information for the custom block in the new row under the following
headings.
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Field Name

Description

Block Type Block type of the custom LUT block. The block
type is the value of the block’s BlockType
parameter.

Mask Type Mask type in this field. The mask type is the

value of the block’s MaskType parameter.

Breakpoint Name

Names of the custom LUT block’s parameters
that store its breakpoints.

Table Name

Name of the block parameter that stores the
custom block’s lookup table.

Number of dimensions

Leave empty.

Explicit Dimensions

Leave empty.

3 Click OK.

Removing Custom LUT Types

To remove a custom LUT type from the list of types recognized by the LUT
Editor, select the custom type’s entry in the table in the Look-Up Table
Blocks Type Configuration dialog box. Then select Remove. To remove
all custom LUT types, check the check box labeled Use Simulink default
look-up table blocks list at the top of the dialog box.
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Working with Block Libraries

Libraries are collections of blocks that can be copied into models. Blocks
copied from a library remain linked to their originals such that changes in
the originals automatically propagate to the copies in a model. Libraries
ensure that your models automatically include the most recent versions of
blocks developed by yourself or others.

Terminology
It is important to understand the terminology used with this feature.

Library - A collection of library blocks. A library must be explicitly created
using New Library from the File menu.

Library block - A block in a library.
Reference block - A copy of a library block.

Link - The connection between the reference block and its library block that
allows Simulink to update the reference block when the library block changes.

Copy - The operation that creates a reference block from either a library block
or another reference block.

This figure illustrates this terminology.

link
= -+
— | copy |
library it reference
block block
Library [Source) Model or Library (Destination)

Simulink Block Library

Simulink comes with a library of standard blocks called the Simulink block
library. See “Starting Simulink” on page 2-2 for information on displaying
and using this library.
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Creating a Library

Simulink allows you to create your own library of masked or subsystem
blocks. To create a library, select Library from the New submenu of the File
menu. Simulink displays a new window, labeled Library: untitled. If an
untitled window already appears, a sequence number is appended.

You can create a library from the command line using this command:
new_system('newlib', 'Library')

This command creates a new library named 'newlib'. To display the library,
use the open_system command.

Once you have create a library, you can drag blocks from models or other
libraries into it. You must provide a mask (see Chapter 11, “Creating Masked
Subsystems”) for any blocks that you want to be created as links in models
that reference the library.

The library must be named (saved) before you can copy blocks from it. See
“Adding Libraries to the Library Browser” on page 4-51 for information on
how to point the Library Browser to your new library.

Modifying a Library

When you open a library, it is automatically locked and you cannot modify its
contents. To unlock the library, select Unlock Library from the Edit menu.
Closing the library window locks the library.

Creating a Library Link

To create a link to a library block in a model, copy the block from the library to
the model (see “Copying and Moving Blocks from One Window to Another” on
page 4-4) or by dragging the block from the Library Browser (see “Browsing
Block Libraries” on page 4-48) into the model window.

When you drag a library block into a model or another library, Simulink
creates a copy of the library block, called the reference block, in the model
or the other library. You can change the values of the reference block’s
parameters but you cannot mask the block or, if it is masked, edit the mask.
Also, you cannot set callback parameters for a reference block. If the link is
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to a subsystem, you can make nonstructural changes to the contents of the
reference subsystem (see “Modifying a Linked Subsystem” on page 4-37).

The library and reference blocks are linked by name; that is, the reference
block is linked to the specific block and library whose names are in effect at
the time the copy is made.

If Simulink is unable to find either the library block or the source library on
your MATLAB path when it attempts to update the reference block, the link
becomes unresolved. Simulink issues an error message and displays these
blocks using red dashed lines. The error message is

Failed to find block "source-block-name"
in library "source-library-name"
referenced by block
"reference-block-path".

The unresolved reference block is displayed like this (colored red).

> Bad Link r

FEefetence Blodk Name

To fix a bad link, you must do one of the following:

¢ Delete the unlinked reference block and copy the library block back into
your model.

® Add the directory that contains the required library to the MATLAB path
and select Update Diagram from the Edit menu.

® Double-click the reference block. On the dialog box that appears, correct
the pathname and click Apply or Close.

Disabling Library Links

Simulink allows you to disable linked blocks in a model. Simulink ignores
disabled links when simulating a model. To disable a link, select the link,
choose Link options from the model window’s Edit or context menu, then
choose Disable link. To restore a disabled link, choose Restore link from
the Link Options menu.
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Modifying a Linked Subsystem

Simulink allows you to make any change to the local copy of an active
library link that does not alter the structure of the local copy. Examples of
nonstructural changes include changes to parameter values that do not affect
the structure of the subsystem. Examples of structural modifications include
adding or deleting a block or line or changing the number of ports on a block.

Note Simulink displays “parameterized link” on the parameter dialog box
of a masked subsystem whose parameters differ in value from those of the
library version to which it is linked. This allows you to determine whether
the local copy differs from the library version simply by opening the local
copy’s dialog box.

When you save the model containing the modified subsystem, Simulink saves
the changes to the local copy of the subsystem together with the path to the
library copy in the model’s model (.md1) file. When you reopen the system,
Simulink copies the library subsystem into the loaded model and applies

the saved changes.

Note If you attempt to use the Simulink GUI to make a structural change to
the local copy of an active library link, for example, by editing the subsystem’s
diagram, Simulink offers to disable the link to the subsystem. If you accept,
Simulink makes the change. Otherwise, it does not allow you to make the
structural change. Simulink does not prevent you from using set_param to
attempt to make a structural change to an active link. However, the results
of the change are undefined.

Propagating Link Modifications

If you restore a disabled link that has structural changes, Simulink prompts
you to either propagate or discard the changes. If you choose to propagate the
changes, Simulink updates the library version of the subsystem specified

by the restored link with the changes made in the model’s version of that
subsystem. If you choose to discard the changes, Simulink replaces the
version of the subsystem in the model with the version in the library. In either
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case, the end result is that the versions of the subsystem in the library and
the model are exactly the same.

If you restore a disabled link to a block with nonstructural changes, Simulink
enables the link without prompting you to propagate or discard the changes.
To see the nonstructural parameter differences between the model’s version of
a library block and the library block itself, choose View changes from the
Link options menu.

If you want to propagate or discard nonstructural changes, select the modified
copy of the library block in the model, choose Link options from the model
window’s Edit or context menu, then choose Propagate/Discard changes.
A dialog box appears that asks whether you want to propagate or discard the
changes. If you elect to propagate the changes, Simulink applies the changes
made to the model’s copy of the library block to the library block itself. If
you elect to discard the changes, Simulink removes the changes from the
model’s copy of the block. In either case, the library and model versions of
the block become the same.

Updating a Linked Block

Simulink updates out-of-date reference blocks in a model or library at these
times:
® When the model or library is loaded

® When you select Update Diagram from the Edit menu or run the
simulation

® When you query the LinkStatus parameter of a block, using the get param
command (see “Library Link Status” on page 4-46)

® When you use the find_system command

Making Backward-Compatible Changes to Libraries

Simulink provides the following features to facilitate making changes to
library blocks without invalidating models that use the library blocks.
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Forwarding Tables

Library forwarding tables enable Simulink to update models to reflect
changes in the names or locations of the library blocks that they reference.
For example, suppose that you rename a block in a library. You can use a
forwarding table for that library to enable Simulink to update models that
reference the block under its old name to reference it under its new name.

Simulink allows you to associate a forwarding table with any library. The
forwarding table for a library specifies the old locations and new locations of
blocks that have moved within the library or to another library. You associate
a forwarding table with a library by setting its ForwardingTable parameter to
a cell array of two-element cell arrays, each of which specifies the old and new
path of a block that has moved. For example, the following command creates
a forwarding table and assigns it to a library named Lib1.

set_param('Lib1', 'ForwardingTable', {{'Lib1/A', 'Lib2/A'}
{'Lib1/B', 'Lib1/C'}});

The forwarding table specifies that block A has moved from Lib1 to Lib2.
and that block B is now named C. Suppose that you opens a model that
contains links to Lib1/A and Lib1/B. Simulink updates the link to Lib1/A to
refer to Lib2/A and the link to Lib1/B to refer to Lib1/C. The changes become
permanent when you subsequently save the model.

Creating Aliases for Mask Parameters

Simulink lets you create aliases, i.e., alternate names, for a mask’s
parameters. A model can then refer to the mask parameter by either

its name or its alias. This allows you to change the name of a mask
parameter in a library block without having to recreate links to the block in
existing models (see “Example: Using Mask Parameter Aliases to Create
Backward-Compatible Parameter Name Changes” on page 4-40).

To create aliases for a masked block’s mask parameters, use the set_param
command to set the block’s MaskVarAliases parameter to a cell array that
specifies the names of the aliases in the same order as the mask names appear
in the block’s MaskVariables parameter.
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Example: Using Mask Parameter Aliases to Create
Backward-Compatible Parameter Name Changes. The following
example illustrates the use of mask parameter aliases to create
backward-compatible parameter name changes.

1 Create a library named mymd1.

2

2 Create the masked subsystem described in “Masked Subsystem Example
on page 11-6 in mymd1l.

3 Name the masked subsystem Line.

4 Set the masked subsystem’s annotation property (see“Block Annotation
Pane” on page 4-13 ) to display the value of its m and b parameters, i.e., to

%s<m>
%<b>

m
b

The library appears as follows:

E!Lihrarv: mylib r -0 x|

File Edit View Format Help

D&+ BR|

/;

Line
m = 1
b=10

Ready 100% [Unlocked S

5 Save mylib.
6 Create a model name mymd1.

7 Create an instance of the Line block in mymdl.
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8 Rename the instance LineA.
9 Change the value of LineA’s m parameter to -1.5.
10 Change the value of LineA’s b parameter to 3.

11 Set LineA’s annotation property to display the values of its m and b
parameters.

=] mymdi i B ] B

File Edit View Simulation Format Tools Help

DS 2R | 4|02

Clodk

Scope

Fl100% | | [FixedstepDiscrete

12 Configure mymdl to use a fixed-step, discrete solver with a 0.1 sec. step
size.

13 Save mymdl.
14 Simulate mymd1l.

Note that the model simulates without error.
15 Close mymdl.

16 Unlock mylib.
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17 Rename the m parameter of the Line block in mylib to slope.
18 Rename Line’s b parameter to intercept.

19 Change Line’s mask icon and annotation properties to reflect the
parameter name changes.

=] Library: mylib =10 =]

File Edit View Format Help

Dsd&| & BB

/;

Line
shope =1
intercapt = 0
Ready 100% |Unlocked 4

20 Save mylib.

21 Reopen mymdl.
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File Edit Wew Simulaton Format Tools

Help

=101 x|

DS &t 2R (=402

Clodk
LineA Scope
m = 777
b=777?
Fl100% | [FixedStepDiscrete

Note that LineA’s icon has reverted to the appearance of its library master
(i.e., mylib/Line) and that its annotation displays question marks for the
values of m and b. These changes reflect the parameter name changes in
the library block . In particular, Simulink cannot find any parameters
named m and b in the library block and hence does not know what to do
with the instance values for those parameters. As a result, LineA reverts
to the default values for the slope and intercept parameters, thereby
inadvertently changing the behavior of the model. The following steps show
how to use parameter aliases to avoid this inadvertent change of behavior.

22 Close mymdl.

23 Unlock mylib.

24 Select the Line block in mylib,

25 Execute the following command at the MATLAB command line.
1 b 1 } )

set_param(gch,

This specifies that m and b are aliases for the Line block’s slope and

intercept parameters.

'MaskVarAliases',{'m',
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26 Reopen mymdl.

=101 x|

File Edit View Simulation Format Tools Help

DS+t 2R | =S 4|02

Clodk

LineA Scope

m = FFF
s

Fl100% | | [FixedStepDiscrete

Note that LineA’s appearance now reflects the value of the slope parameter
under its original name, i.e., m. This is because when Simulink opened
the model it found the m is an alias for slope and assigned the value of m
stored in the model file to LineA’s slope parameter.

27 Change LineA’s block annotation property to reflect LineA’s parameter
name changes, i.e., replace

m = %<m>
b = %<b>
with

m = %<slope>
%<intercept>

(o
1l

LineA now appears as follows.
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=101 x|

File Edit View Simulation Format Tools Help

DS+t 2R | =S 4|02

Clodk

LineA Scope

m=3

Fl100% | | [FixedStepDiscrete

Note that LineA’s annotation shows that, thanks to parameter aliasing,
Simulink has correctly applied the parameter values stored for LineA in
mymd1’s model file to the block’s renamed parameters.

Breaking a Link to a Library Block

You can break the link between a reference block and its library block to cause
the reference block to become a simple copy of the library block, unlinked to
the library block. Changes to the library block no longer affect the block.
Breaking links to library blocks may enable you to transport a model as a
stand-alone model, without the libraries.

To break the link between a reference block and its library block, first disable
the block. Then select the block and choose Break Library Link from the
Link options menu. You can also break the link between a reference block
and its library block from the command line by changing the value of the
LinkStatus parameter to 'none' using this command:

set_param('refblock', 'LinkStatus', 'none')
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You can save a system and break all links between reference blocks and
library blocks using this command:

save_system('sys', 'newname', 'BreakLinks')

Note Breaking library links in a model does not guarantee that you can run
the model stand-alone, especially if the model includes blocks from third-party
libraries or optional Simulink blocksets. It is possible that a library block
invokes functions supplied with the library and hence can run only if the
library is installed on the system running the model. Further, breaking a link
can cause a model to fail when you install a new version of the library on a
system. For example, suppose a block invokes a function that is supplied
with the library. Now suppose that a new version of the library eliminates
the function. Running a model with an unlinked copy of the block results in
invocation of a now nonexistent function, causing the simulation to fail. To
avoid such problems, you should generally avoid breaking links to third-party
libraries and optional Simulink blocksets.

Finding the Library Block for a Reference Block

To find the source library and block linked to a reference block, select the
reference block. Then choose Go To Library Link from the Link options
submenu of the model window’s Edit or context menu. If the library is open,
Simulink selects and highlights the library block and makes the source
library the active window. If the library is not open, Simulink opens it and
selects the library block.

Library Link Status

All blocks have a LinkStatus parameter that indicates whether the block is a
reference block. The parameter can have these values.

Status Description

none Block is not a reference block.
resolved Link is resolved.

unresolved Link is unresolved.
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Status Description

implicit Block resides in library block and is itself not a link to
a library block. For example, suppose that A is a link
to a subsystem in a library that contains a Gain block.
Further, suppose that you open A and select the Gain
block. Then, get_param(gcb, 'LinkStatus') returns

implicit.
inactive Link is disabled.
restore Restores a broken link to a library block and discards

any changes made to the local copy of the library
block. For example, set_param(gcb, 'LinkStatus',
‘restore') replaces the selected block with a link to a
library block of the same type, discarding any changes
in the local copy of the library block. Note that this
parameter is a “write-only “parameter, i.e., it is usable
only with set param. You cannot use get _param to get
it.

propagate Restores a broken link to a library block and propagates
any changes made to the local copy to the library.

Displaying Library Links
Simulink optionally displays an arrow in the bottom left corner of each block
that represents a library link in a model.

/ﬁhrur',rlink

1
i > SR
U A =05
Sine Wave Discrete Display
Transfer Fon

{with initial states)

This arrow allows you to tell at a glance whether a block represents a link
to a library block or a local instance of a block. To enable display of library
links, select Library Link Display from the model window’s Format menu
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and then select either User (displays only links to user libraries) or All
(displays all links).

The color of the link arrow indicates the status of the link.

Color Status

Black Active link

Grey Inactive link

Red Active and modified

Locking Libraries

To lock a block library, set its Lock parameter to 'on' at the MATLAB
command line, using the set_param command. Locking a library prevents a
user from inadvertently modifying a library, for example, by moving a block
in the library or adding or deleting a block from the library. If you attempt
to modify a locked library, Simulink displays a dialog box that allows you to
unlock the library and make the change. You must then relock the library
from the MATLAB command line to prevent further changes.

Getting Information About Library Blocks

Use the 1ibinfo command to get information about reference blocks in a
system

Browsing Block Libraries

The Library Browser lets you quickly locate and copy library blocks into a
model. To display the Library Browser, click the Library Browser button
in the toolbar of the MATLAB desktop or Simulink model window or enter
simulink at the MATLAB command line.

Note The Library Browser is available only on Microsoft Windows platforms.
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The Library Browser contains three panes.
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Tree Pane Contents Pane

The tree pane displays all the block libraries installed on your system. The
contents pane displays the blocks that reside in the library currently selected
in the tree pane. The documentation pane displays documentation for the
block selected in the contents pane.

You can locate blocks either by navigating the Library Browser’s library tree
or by using the Library Browser’s search facility.
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Navigating the Library Tree

The library tree displays a list of all the block libraries installed on the
system. You can view or hide the contents of libraries by expanding or
collapsing the tree using the mouse or keyboard. To expand/collapse the tree,
click the +/- buttons next to library entries or select an entry and press the
+/- or right/left arrow key on your keyboard. Use the up/down arrow keys

to move up or down the tree.

Searching Libraries

To find a particular block, enter the block’s name in the edit field next to the
Library Browser’s Find button, then click the Find button.

Opening a Library

To open a library, right-click the library’s entry in the browser. Simulink
displays an Open Library button. Select the Open Library button to
open the library.

Creating and Opening Models

To create a model, select the New button on the Library Browser’s toolbar. To
open an existing model, select the Open button on the toolbar.

Copying Blocks

To copy a block from the Library Browser into a model, select the block in the
browser, drag the selected block into the model window, and drop it where
you want to create the copy.

Displaying Help on a Block
To display help on a block, right-click the block in the Library Browser and
select the button that subsequently pops up.

Pinning the Library Browser

To keep the Library Browser above all other windows on your desktop, select
the PushPin button on the browser’s toolbar.
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Adding Libraries to the Library Browser
To cause your own library to appear in the Library Browser:

Create a directory in the MATLAB path for the library that you want to
appear in the Library Browser.

Each library that you want to appear in the Library Browser must be
stored in its own directory on the MATLAB path. In other words, two
libraries cannot exist in the same directory.

Create or copy the library into its directory.

The directory for each library to be displayed in the Library Browser must
contain a file named slblocks.m that describes the library to be displayed.
The easiest way for you to create such a file is to use an existing slblocks.m
file as a template and edit it to describe your library. The next two steps
direct you to perform this task.

Create a copy of the
<MATLABROOT>/toolbox/simulink/blocks/slblocks.m file in the
library’s directory.

The file that you have copied is the slblocks.m file for the standard
Simulink libraries.

Edit the file as necessary to specify the name, open function, mask, and
structure of your library.

The comments in the slblocks.m file explain how to specify the information
about your library that the Library Browser needs.

Sample slblocks.m file. The following slblocks.m file describes a custom
block library named "My Library."

function blkStruct = slblocks
%SLBLOCKS Defines a block library.

% Library's name. The name appears in the Library Browser's
% contents pane.
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To

at

blkStruct.Name = ['My' sprintf('\n') 'Library'];

[)
)

he library's name. ;

blkStruct.OpenFcn = 'mylib';

% The argument to be set as the Mask Display for the subsystem.

% may comment this line out if no specific mask is desired.
% Example: blkStruct.MaskDisplay =
'plot([0:2*pi],sin([0:2*pi]));";

% No display for now.

% blkStruct.MaskDisplay = '';

% End of blocks

find additional examples of slblocks.m files on your system, enter

which('slblocks.m', '-all')

the MATLAB command prompt.

% The function that will be called when the user double-clicks on
t

You
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Accessing Block Data During Simulation

Simulink provides an application programming interface, called the block
run-time interface, that enables programmatic access to block data, such

as block inputs and outputs, parameters, states, and work vectors, while a
simulation is running. You can use this interface to access block run-time data
from the MATLAB command line, the Simulink Debugger, and from Level-2
M-file S-functions (see “Writing S-Functions in M” in “Writing S-Functions”).

Note You can use this interface even when the model is paused or is running
or paused in the debugger.

About Block Run-Time Obijects

The block run-time interface consists of a set of Simulink data object classes
(see “Working with Data Objects” on page 6-10) whose instances provide data
about the blocks in a running model. In particular, the interface associates
an instance of Simulink.RunTimeBlock, called the block’s run-time object,
with each nonvirtual block in the running model. A run-time object’s methods
and properties provide access to run-time data about the block’s I/O ports,
parameters, sample times, and states.

Accessing a Run-Time Object

Every nonvirtual block in a running model has a Run-timeObject parameter
whose value, while the simulation is running, is a handle for the blocks’
run-time object. This allows you to use get_param to obtain a block’s run-time
object. For example, the following statement

rto = get_param(gcb, 'RuntimeObject');

returns the run-time object of the currently selected block.
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Note Nonvirtual blocks (see “Virtual Blocks” on page 4-2) do not have
run-time objects. Blocks eliminated during model compilation as an
optimization also do not have run-time objects (see “Block reduction
optimization” on page 9-55). A run-time object exists only while the model
containing the block is running or paused. If the model is stopped, get_param
returns an empty handle. When you stop or pause a model, all existing
handles for run-time objects become empty.

Listening for Method Execution Events

One application for the block run-time API is to collect diagnostic data at key
points during simulation, such as the value of block states before or after
blocks compute their outputs or derivatives. The block run-time API provides
an event-listener mechanism that facilitates such applications. For more
information, see “Simulink Reference” for the add_exec_event_listener
command. For an example of using method execution events, enter

sldemo_msfcn_lms

at the MATLAB command line.
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This section describes how to create and use Simulink signals.

Signal Basics (p. 5-3)

Determining Output Signal
Dimensions (p. 5-16)

The Signal & Scope Manager
(p. 5-21)

The Signal Selector (p. 5-30)

Logging Signals (p. 5-34)

Signal Properties Dialog Box
(p. 5-38)

Working with Test Points (p. 5-43)

Displaying Signal Properties
(p. 5-45)

Explores key signal concepts,
including signal data types, signal
buses, virtual signals, signal
dimensions, and signal properties.

Explains the rules that determine
the dimensions of signals that blocks
output.

How to use the Signal & Scope
Manager to create signals and
displays for viewing signals during
simulation.

How to use the Signal Selector to
connect signal generators to block
inputs and block outputs to signal
viewers.

How to save signal values to
the MATLAB workspace during
simulation.

How to use the Signal Properties
dialog box to set signal properties.

How to ensure the visibility of a
model’s signals.

How to display signal properties on
a block diagram.
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Working with Signal Groups (p. 5-49) How to create and use
interchangeable groups of signals,
for example, to test a model.

Bus Editor (p. 5-64) How to use the Bus Editor to create
signal bus objects.
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Signal Basics

This section provides an overview of Simulink signals and explains how to
specify, display, and check the validity of signal connections.

About Signals

Simulink defines signals as the outputs of dynamic systems represented by
blocks in a Simulink diagram and by the diagram itself. The lines in a block
diagram represent mathematical relationships among the signals defined by
the block diagram. For example, a line connecting the output of block A to
the input of block B indicates that the signal output by B depends on the
signal output by A.

Note It is tempting but misleading to think of Simulink signals as traveling
along the lines that connect blocks the way electrical signals travel along a
telephone wire. This analogy is misleading because it suggests that a block
diagram represents physical connections between blocks, which is not the
case. Simulink signals are mathematical, not physical, entities and the lines
in a block diagram represent mathematical, not physical, relationships among
signals.

Creating Signals

You can create signals by creating source blocks in your model. For example,
you can create a signal that varies sinusoidally with time by dragging an
instance of the Sine block from the Simulink Sources library into the model.
See “Sources” in “Simulink Reference” for information on blocks that you can
use to create signals in a model. You can also use the Signal & Scope Manager
to create signals in your model without using blocks. See “The Signal & Scope
Manager” on page 5-21 for more information.

Signal Line Styles

Simulink uses a variety of line styles to display different types of signals in
the model window. Assorted line styles help you to differentiate the signal
types present in Simulink diagrams. The current signal types and their line
styles are as follows.
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Signal type | Line style | Description

Scalar and I Simu}ink us’es a thin, solid line to represent

Nonscalar the diagram’s scalar and nonscalar signals.

Nonscalar When the Wide nonscalar lines option is
enabled, Simulink uses a thick, solid line to
represent the diagram’s nonscalar signals.

Control e Simulink uses a thin, dash-dot line to
represent the diagram’s control signals.

Bus » Simulink uses a thick, composite line to
represent the diagram’s signal buses.

Other than using the Wide nonscalar lines option to display nonscalar
signals as thick, solid lines, you cannot customize or control the line style with
which Simulink displays signals. See “Wide nonscalar lines” on page 5-45 for
more information about this option.

Note As you construct a block diagram, Simulink uses a thin, solid line to
represent all signal types. The lines are then redrawn using the specified line
styles only after you update or start simulation of the block diagram.

Signal Labels

A signal label is text that appears next to the line that represents a signal
that has a name. The signal label displays the signal’s name. In addition,
if the signal is a virtual signal (see “Virtual Signals” on page 5-6) and its
Show propagated signals property is on (see “Show propagated signals”
on page 5-39), the label displays the names of the signals that make up the
virtual signal.

Simulink creates a label for a signal when you assign it a name in the Signal
Properties dialog box (see “Signal Properties Dialog Box” on page 5-38).
You can change the signal’s name by editing its label on the block diagram.
To edit the label, left-click the label. Simulink replaces the label with an edit
field. Edit the name in the edit field, the press Enter or click outside the
label to confirm the change.
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Displaying Signal Values

As with creating signals, you can use either blocks or the Signal & Scope
Manager to display the values of signals during a simulation. For example,
you can use either the Scope block or the Signal & Scope Manager to graph
time-varying signals on an oscilloscope-like display during simulation. See
“Sinks” in “Simulink Reference” for information on blocks that you can use to
display signals in a model.

Signal Data Types

Data type refers to the format used to represent signal values internally. The
data type of Simulink signals is double by default. However, you can create
signals of other data types. Simulink supports the same range of data types as
MATLAB. See “Working with Data Types” on page 6-2 for more information.

Signal Dimensions

Simulink blocks can output one- or two-dimensional signals. A
one-dimensional (1-D) signal consists of a stream of one-dimensional arrays
output at a frequency of one array (vector) per simulation time step. A
two-dimensional (2-D) signal consists of a stream of two-dimensional arrays
emitted at a frequency of one 2-D array (matrix) per block sample time. The
Simulink user interface and documentation generally refer to 1-D signals

as vectors and 2-D signals as matrices. A one-element array is frequently
referred to as a scalar. A row vector is a 2-D array that has one row. A column
vector is a 2-D array that has one column.

Simulink blocks vary in the dimensionality of the signals they can accept or
output. Some blocks can accept or output signals of any dimensions. Some
can accept or output only scalar or vector signals. To determine the signal
dimensionality of a particular block, see the block’s description in Blocks —
Alphabetical List in the online Simulink reference. See “Determining Output
Signal Dimensions” on page 5-16 for information on what determines the
dimensions of output signals for blocks that can output nonscalar signals.
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Note Simulink does not support dynamic signal dimensions during
simulation. That is, the size of a signal must remain constant while the
simulation executes. You can alter a signal’s size only after terminating the
simulation.

Complex Signals

The values of Simulink signals can be complex numbers. A signal whose
values are complex numbers is called a complex signal. You can introduce a
complex-valued signal into a model in the following ways:

® Load complex-valued signal data from the MATLAB workspace into the
model via a root-level Inport block.

® (Create a Constant block in your model and set its value to a complex
number.

® (Create real signals corresponding to the real and imaginary parts of a
complex signal, then combine the parts into a complex signal, using the
Real-Imag to Complex conversion block.

You can manipulate complex signals via blocks that accept them. If you are
not sure whether a block accepts complex signals, see the documentation for
the block in Blocks — Alphabetical List in the online Simulink reference.

Virtual Signals

A virtual signal is a signal that represents another signal graphically. Some
blocks, such as Bus Creator, Inport, and Outport blocks (see “Virtual Blocks”
on page 4-2), generate virtual signals either exclusively or optionally (see
“Virtual Versus Nonvirtual Buses” on page 5-10). Virtual signals are purely
graphical entities. They have no mathematical or physical significance.
Simulink ignores them when simulating a model.

Whenever you update or run a model, Simulink determines the nonvirtual
signal(s) represented by the model’s virtual signal(s), using a procedure
known as signal propagation. When running the model, Simulink uses the
corresponding nonvirtual signal(s), determined via signal propagation, to
drive the blocks to which the virtual signals are connected.
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Consider, for example, the following model.

L 4]

Di=playl

Di=play

The signals driving Gain blocks G1 and G2 are virtual signals corresponding
to signals s2 and s1, respectively. Simulink determines this automatically
whenever you update or simulate the model.

Displaying Virtual Signal Sources and Destinations

To display the nonvirtual block whose output is the source of a signal, select
the signal and then select Highlight to Source from the signal’s context
menu. Simulink highlights the path from the signal’s source block to the
signal itself.

Ot
Subsystern

To display the nonvirtual block that is the destination of a signal, select the
signal and then select Highlight to Destination from the signal’s context
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menu. Simulink highlights the path from the selected signal to the nonvirtual
block that it feeds.

Gain

To remove the highlighting, select Remove Highlighting from the block
diagram’s context menu.

Note If the path from a source block or to a destination block includes an
unresolved reference to a library block, Simulink highlights the path only
from or to the library block, respectively. This is to avoid time-consuming
library reference resolution while you are editing a model. To permit Simulink
to display the complete path, first update the diagram (e.g., by pressing
Ctrl-d). This causes Simulink to resolve all library references and hence
display the complete path to a destination block or from a source block.

Displaying the Nonvirtual Components of Virtual Signals

The Show propagated signals option (see “Signal Properties Dialog Box”
on page 5-38) displays the nonvirtual signals represented by virtual signals
in the labels of the virtual signals.
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I
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C1 Gain Display
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When you change the name of a nonvirtual signal, Simulink immediately
updates the labels of all virtual signals that represent the nonvirtual signal
and whose Show propagated signals is on, except if the path from the
nonvirtual signal to the virtual signal includes an unresolved reference to

a library block. In such cases, to avoid time-consuming library reference
resolutions while you are editing a block diagram, Simulink defers updating
the virtual signal’s label until you update the model’s block diagram either
directly (e.g., by pressing Ctrl-d) or by simulating the model.

Note Virtual signals can represent virtual as well as nonvirtual signals. For
example, you can use a Bus Creator block to combine multiple virtual and
nonvirtual signals into a single virtual signal. If during signal propagation,
Simulink determines that a component of a virtual signal is itself virtual,
Simulink uses signal propagation to determine the nonvirtual components of
the virtual component. This process continues until Simulink has determined
all nonvirtual components of a virtual signal.

Control Signals

A control signal is a signal used by one block to initiate execution of another
block, e.g., a function-call or action subsystem. When you update or start
simulation of a block diagram, Simulink uses a dash-dot pattern to redraw
lines representing the diagram’s control signals as illustrated in the following
example.
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Control signal

it =0

P

Signal Buses

A bus is a composite signal comprising a set of signals represented graphically
by a bundle of lines. It is analogous to a bundle of wires held together by

tie wraps. The components of a bus can have different data types and can
themselves be composite signals (i.e., buses or muxed signals). You can use
Bus Creator and Inport blocks to create signal buses and Bus Selector blocks
to access a bus’s components.

Signal bus

3451, 52

DisplayE

Selecting a bus and then Signal Dimensions from the model editor’s
Format menu displays the number of signal components carried by the bus.

Virtual Versus Nonvirtual Buses

Buses may be either virtual or nonvirtual. During simulation, blocks
connected to a virtual bus read their inputs from memory allocated to the
component signals, which may reside in noncontiguous areas of memory. By
contrast, blocks connected to a nonvirtual bus read their inputs from a copy
of the component signals maintained by Simulink in a contiguous area of
memory allocated to the bus.
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Some Simulink features, require use of nonvirtual buses. Others require
virtual buses. Nonvirtual buses also facilitate code generation by enabling
buses to be represented as data structures. In general, virtual buses can save
memory where nonvirtual buses are not required.

The Bus Creator and Inport blocks output virtual buses by default. To cause
them to output a nonvirtual bus, select the Qutput as structure option on
their parameter dialog boxes. You can also use the Signal Conversion block to
convert nonvirtual to virtual buses, and vice versa.

Note If a bus itself contains buses, the nested buses must all be either virtual
or nonvirtual. A bus cannot contain a mixture of virtual and nonvirtual
nested buses.

Bus-Capable Blocks
A bus-capable block is a block through which both virtual and nonvirtual

buses can pass. All virtual blocks are bus capable. Further, the following
nonvirtual blocks are also bus-capable:

® Memory

* Merge

® Switch

® Multiport Switch

® Rate Transition

e Unit Delay

® Zero-Order Hold

Some bus-capable blocks impose constraints on bus propagation through

them. See the documentation for the blocks in Blocks-Alphabetical List in the
online Simulink reference for more information.
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Connecting Buses to Subsystem Inports

Generally, an Inport block is a virtual block and hence accepts a bus as input.
However, an Inport block is nonvirtual if it resides in a conditionally executed
or atomic subsystem and it or any of its components is directly connected to
an output of the subsystem. In such a case, the Inport block can accept a
bus only if its components have the same data type. If the components are
of differing data types, attempting to simulate the model causes Simulink

to halt the simulation and display an error message. You can avoid this
problem, without changing the semantics of your model, by inserting a Signal
Conversion block between the Inport block and the Outport block to which

it was originally connected.

Consider, for example, the following model:

double
a double

- "
] norwirtual Outt

int1g

U[
k J
E
[s]

in1e

Atomic
Subsystam

wirtual

In this model, the Inport labeled nonvirtual is nonvirtual because it resides
in an atomic subsystem and one of its components (labeled a) is directly
connected to one of the subsystem’s outputs. Further, the bus connected to
the subsystem’s inputs has components of differing data types. As a result,
Simulink cannot simulate this model.
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Inserting a Signal Conversion block with the bus copy option selected breaks
the direct connection to the subsystem’s output and hence enables Simulink
to simulate the model.

nonvirtual

wirtual

ZBlock Parameters: Signal Conversion 2=l

—Signal Conversion

Convert a signal to a new type without altering signal values.

a)] The ‘Contiguous copy' option creates a contiguous segment of memory to store a
copy of an input signal when specifying signal storage attibutes for a collection of
digcontiguous signals. 'with optimizations enabled, the copy does not occur if the
operation is superfluous.

b) The ‘Bus copy' option outputs a copy of the incoming bus. Thiz iz useful for uze with
non-virtual inports in non-virtual subsystems.

] The “irtual bus' option converts the input bus to a virtual bus.

d] The "Monvirtual bus' option converts the input bus to a non-virtual bus.

=
F

Dusu: SR -

I™ Override optimizations and always copy signal

Ok I Lancel | Help | Apply |

Connecting Buses to Model Inports

If you want a root level Inport of a model to be able to accept a bus signal,
you must set the Inport’s bus object parameter to the name of a bus object
that defines the type of bus that the Inport accepts. See “Working with Data
Objects” on page 6-10 and Simulink.Bus class in “Simulink Reference” for
more information.

Checking Signal Connections

Many Simulink blocks have limitations on the types of signals they can
accept. Before simulating a model, Simulink checks all blocks to ensure that
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they can accommodate the types of signals output by the ports to which they
are connected. If any incompatibilities exist, Simulink reports an error and
terminates the simulation. To detect such errors before running a simulation,
choose Update Diagram from the Simulink Edit menu. Simulink reports
any invalid connections found in the process of updating the diagram.

Signal Glossary

The following table summarizes the terminology used to describe signals in
the Simulink user interface and documentation.

Term Meaning
Complex signal Signal whose values are complex numbers.
Data type Format used to represent signal values internally.

See “Working with Data Types” on page 6-2 for
more information.

Matrix Two-dimensional signal array.

Real signal Signal whose values are real (as opposed to
complex) numbers.

Scalar One-element array, i.e., a one-element, 1-D or 2-D
array.

Signal bus A composite signal made up of other signals,

including other buses. You can use Bus Creator
and Inport blocks to create signal buses.

Signal propagation Process used by Simulink to determine attributes
of signals and blocks, such as data types, labels,
sample time, dimensionality, and so on, that are
determined by connectivity.

Size Number of elements that a signal contains. The
size of a matrix (2-D) signal is generally expressed
as M-by-N, where M is the number of columns and
N is the number of rows making up the signal.

Test point A signal that must be accessible during simulation
(see “Signal Properties Dialog Box” on page 5-38).
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Term

Meaning

Vector

One-dimensional signal array.

Virtual signal

Signal that represents another signal or set of
signals.

Width

Size of a vector signal.
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Determining Output Signal Dimensions

If a block can emit nonscalar signals, the dimensions of the signals that the
block outputs depend on the block’s parameters, if the block is a source block;
otherwise, the output dimensions depend on the dimensions of the block’s
input and parameters.

Determining the Output Dimensions of Source Blocks

A source block is a block that has no inputs. Examples of source blocks include
the Constant block and the Sine Wave block. See the “Sources Library” table
in “Simulink Reference” for a complete listing of Simulink source blocks. The
output dimensions of a source block are the same as those of its output value
parameters if the block’s Interpret Vector Parameters as 1-D parameter is
off (i.e., not selected in the block’s parameter dialog box). If the Interpret
Vector Parameters as 1-D parameter is on, the output dimensions equal
the output value parameter dimensions unless the parameter dimensions
are N-by-1 or 1-by-N. In the latter case, the block outputs a vector signal

of width N.

As an example of how a source block’s output value parameter(s)

and Interpret Vector Parameters as 1-D parameter determine the
dimensionality of its output, consider the Constant block. This block outputs
a constant signal equal to its Constant value parameter. The following table
illustrates how the dimensionality of the Constant value parameter and the
setting of the Interpret Vector Parameters as 1-D parameter determine
the dimensionality of the block’s output.

Interpret Vector
Constant Value Parameters as 1-D Output
2-D scalar off 2-D scalar
2-D scalar on 1-D scalar
1-by-N matrix off 1-by-N matrix
1-by-N matrix on N-element vector
N-by-1 matrix off N-by-1 matrix
N-by-1 matrix on N-element vector
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Interpret Vector
Constant Value Parameters as 1-D Output
M-by-N matrix off M-by-N matrix
M-by-N matrix on M-by-N matrix

Simulink source blocks allow you to specify the dimensions of the signals
that they output. You can therefore use them to introduce signals of various
dimensions into your model.

Determining the Output Dimensions of Nonsource
Blocks

If a block has inputs, the dimensions of its outputs are, after scalar expansion,
the same as those of its inputs. (All inputs must have the same dimensions,
as discussed in “Signal and Parameter Dimension Rules” on page 5-17).

Signal and Parameter Dimension Rules

When creating a Simulink model, you must observe the following rules
regarding signal and parameter dimensions.

Input Signal Dimension Rule
All nonscalar inputs to a block must have the same dimensions.

A block can have a mix of scalar and nonscalar inputs as long as all the
nonscalar inputs have the same dimensions. Simulink expands the scalar
inputs to have the same dimensions as the nonscalar inputs (see “Scalar
Expansion of Inputs” on page 5-19) thus preserving the general rule.

Block Parameter Dimension Rule

In general, a block’s parameters must have the same dimensions as the
corresponding inputs.
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Two seeming exceptions exist to this general rule:

® A block can have scalar parameters corresponding to nonscalar inputs.

In this case, Simulink expands a scalar parameter to have the same
dimensions as the corresponding input (see “Scalar Expansion of
Parameters” on page 5-19) thus preserving the general rule.

If an input is a vector, the corresponding parameter can be either an N-by-1
or a 1-by-N matrix. In this case, Simulink applies the N matrix elements to
the corresponding elements of the input vector. This exception allows use
of MATLAB row or column vectors, which are actually 1-by-N or N-by-1
matrices, respectively, to specify parameters that apply to vector inputs.

Vector or Matrix Input Conversion Rules

Simulink converts vectors to row or column matrices and row or column
matrices to vectors under the following circumstances:

If a vector signal is connected to an input that requires a matrix, Simulink
converts the vector to a one-row or one-column matrix.

If a one-column or one-row matrix is connected to an input that requires a
vector, Simulink converts the matrix to a vector.

If the inputs to a block consist of a mixture of vectors and matrices and
the matrix inputs all have one column or one row, Simulink converts the
vectors to matrices having one column or one row, respectively.

Note You can configure Simulink to display a warning or error message if a
vector or matrix conversion occurs during a simulation. See “Vector/matrix
block input conversion” on page 9-80 for more information.

Scalar Expansion of Inputs and Parameters

Scalar expansion is the conversion of a scalar value into a nonscalar array
of the same dimensions. Many Simulink blocks support scalar expansion of
inputs and parameters. Block descriptions in the “Simulink Blocks” section
in“Simulink Reference” indicate whether Simulink applies scalar expansion
to a block’s inputs and parameters.
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Scalar Expansion of Inputs

Scalar expansion of inputs refers to the expansion of scalar inputs to match
the dimensions of other nonscalar inputs or nonscalar parameters. When the
input to a block is a mix of scalar and nonscalar signals, Simulink expands
the scalar inputs into nonscalar signals having the same dimensions as the
other nonscalar inputs. The elements of an expanded signal equal the value of
the scalar from which the signal was expanded.

The following model illustrates scalar expansion of inputs. This model adds
scalar and vector inputs. The input from block Constantl is scalar expanded
to match the size of the vector input from the Constant block. The input

is expanded to the vector [3 3 3].

B
[45 6] [ ]

Constant _.n-
.—.3 +
. Scope
Canstanti
Sum

When a block’s output is a function of a parameter and the parameter is
nonscalar, Simulink expands a scalar input to match the dimensions of the
parameter. For example, Simulink expands a scalar input to a Gain block to
match the dimensions of a nonscalar gain parameter.

Scalar Expansion of Parameters

If a block has a nonscalar input and a corresponding parameter is a scalar,
Simulink expands the scalar parameter to have the same number of elements
as the input. Each element of the expanded parameter equals the value of
the original scalar. Simulink then applies each element of the expanded
parameter to the corresponding input element.
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This example shows that a scalar parameter (the Gain) is expanded to a
vector of identically valued elements to match the size of the block input, a
three-element vector.

Constant ;
onstan & ain Soape
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The Signal & Scope Manager

The Signal & Scope Manager lets you globally manage signal generators
and viewers.

Note The Signal & Scope Manager requires that you start MATLAB with
Java enabled (the default).

To display the Signal & Scope Manager, select Signal & Scope Manager
from the model editor’s Tools or context menu. The Signal & Scope Manager

appears.
«): Signal & Scope Manager : vdp ;Iglll
- Types - Generatorsiiewers in model
Generators Generators  Wiewers |
B sirmulink ; El
EE o MName | Type | #in |
B Cornmunications El
W Signal Processing
Wiewers il

B Simulink
B Comrmunications ‘

W Signal Processing

~Signals connected to Generatoriiewer

Fort Connected signals

Attach tomodel == |

Help | Close |

The Signal & Scope Manager contains the following groups of controls.
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Generator and Viewer Types

This group of controls lets you create signal generators and viewers of various
types and associate them with your model.

rTypes

Generators

B Simulink

B Comrmunications
W Signal Processing
Wiewers

B Simulink
B Comrmunications

W Signal Processing

Attach to model == |

The tree control displays a list of the types of generators and viewers
installed on your system. The tree’s second-level nodes group the generators
and viewers by the products that provides them (i.e., Simulink and any
MathWorks blocksets installed on your system). Expand a product’s nodes to
see the generators and viewers that it provides.

For information on the attributes and usage of the generators and viewers,
see the documentation for the identically named source (i.e., generator)
and sink (i.e., viewer) blocks in the product’s documentation. For example,
for information on the generators and viewers provided with Simulink, see
“Simulink Reference” for the corresponding blocks in the “Sources” and
“Sinks” libraries.

Note The Scope viewer cannot display signals originating from the top-level
input ports of a referenced model.
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Creating and Connecting Viewers and Generators

You can create and connect generators and viewers either from the Signal
& Scope Manager itself or by selecting commands from a context menu.
To create an instance of a viewer from the Signal & Scope Manager and
associate the viewer with the currently selected model, select its type in the
type list and then click the Attach to model button beneath the list.

Or, to create a viewer and attach it to the currently selected signal, select
Create & Connect Viewer from the signal’s context menu. Simulink
displays a list of viewer types. Select a type. Simulink displays a list of
viewers of that type. Select a viewer. For example, to create a Simulink
Scope viewer and attach it to a signal, select Create & Connect
Viewer > Simulink > Scope from the signal’s context menu.

To connect an existing viewer to a signal, first select Connect To Existing
Viewer from the signal’s context menu; next, select the viewer from the list of
viewers; finally, select an axes from the list of axes.

Note You can display multiple signals on a single axis of a Simulink Scope
viewer. The Scope viewer uses different colors to distinguish different signals
displayed on the same axis and different line styles to distinguish different
elements of the same vector signal.

Generator and Viewer Objects

This group of controls lets you edit the sources and viewers already associated
with your model. It contains the following controls.
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Generators

The Generators pane displays a table listing the generators associated with
your model.

r Generatorsiiewers in model
Generators | Viewers |

klame Type

[ [ |

g & Constant

Each row corresponds to a generator. The columns specify each generator’s
name and type.

Viewers

The Viewers pane displays a table listing the viewers associated with your
model.

r Generatorsffiewsers in model

Gaenerators Yigwers |

|
Mame Type #in
] aly 2 'El
Temperature Scape P scope 1> )(l
Litility Scape & Floating Scope |1 T

Each row corresponds to a viewer. The columns specify each viewer’s name,
type, and number of inputs. If a viewer accepts a variable number of inputs,
the #in entry for the viewer contains a pull-down list that displays the range
of inputs that the viewer can accept. To change the number of inputs accepted
by the viewer, pull down the list and select the desired value.
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Edit Buttons

Selecting the table entry for a generator or viewer enables the following

buttons.

Button

Description

Opens the parameter dialog box for the selected generator
or viewer. The parameter dialog box enables you to view
and change the current settings of the selected object’s
parameters. See “Simulink Reference” for the corresponding
source or sink block for more information.

Opens the Signal Selector for the selected generator

or viewer. The Signal Selector lets you connect signal
generators to your model’s inputs and your model’s signals
to its signal viewers.

Note You can also use port or signal context menus to
connect signals to input ports and output ports to viewers.
For example, to connect a signal to a new viewer, select
Create Viewer from the signal or output port’s context
menu, then the type of viewer. To connect a signal to an
existing viewer, select Connect to Viewer, then the axis
to display the signal. You can connect multiple signals to
the axes of a Simulink Scope viewer. Similarly, to connect a
new signal generator to a block input port, select Create
Generator from the input port’s context menu, then the
type of generator.

x|

Deletes the selected generator or viewer.

Edit Menu

Selecting a row in the generator or viewer table and pressing the right button
on your mouse displays an edit menu containing entries corresponding to the
edit buttons described in the preceding section. It also displays a Rename
command for renaming the selected object (e.g., a viewer). Selecting this
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command causes Simulink to replace the selected object’s name with an edit
control. Use the edit control to rename the object.

Note You can also rename a signal generator on a model’s block diagram. To
do this, select Edit Source Name from the context menu of an input port to
which the signal generator is connected. Simulink replaces the source’s name
with an edit field containing the source’s name. Edit the name and then click
outside the field or press Enter to confirm your changes.

Signals connected to Generator/Viewer

This table lists the signals connected to the generator or viewer selected in
the Generator/Viewers control panel of the Signal & Scope Manager.

- Generatorsiviewers in model
Generators | iewers |

Mame Type
f & Sine Wave
® Constant

fxlals

!

"

rSignals connected to GeneratorNiewer7L
Output Cognecmgnals
1 Surmn:2 “

If the selected object is a signal generator, the table lists the block input ports
to which each of the generator’s outputs is connected. For each connection, the
first column of the table specifies the number of the corresponding generator
output. The second column specifies the number of the corresponding input
port and the name of the block that owns the input port. For example, in the
preceding figure, the Signals connected to Generator/Viewer table shows
that the first (and only output) of the selected Constant generator is connected
to the second input port of the block named Sum.
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If the selected object is a signal viewer, the Signals connected to
Generator/Viewer table lists the signals connected to the selected viewer.
For each connection, the first column of the table specifies the number of the
corresponding viewer axis. The second column specifies the number of the
corresponding output port and the name of the block that owns the output
port.

For example, in the next figure, the Signals connected to
Generator/Viewer table shows that the first axis of the selected signal
viewer is connected to the first output port of the block named Sum.

- Generatorsiiewers in model
Generators  Viewers |

MName

[ scope i o PR

Force Scope

~Signals connected to Generatoriiewer

Aves Connected signals
1 Surmn:l

-

Connection Menu

Selecting a connection in the Signals connected to Generator/Viewer
table and pressing the right button on your mouse displays a context menu.
To highlight the block to which the object is connected, select Hilight signal
in model from the menu. To open the Signal Selector, select Edit Signal
Connections from the model.

Adding Custom Viewers and Generators to the
Signal & Scope Manager

You can add custom signal viewers or generators so that they appear in the
Signal & Scope Manager. The following procedure assumes that you have a
custom viewer named newviewer that you want to add.
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1 Open a new Simulink library. For example, open the Simulink browser
and select File > New > Library.

2 Save the library. For example, save it as newlib.

3 In the MATLAB Command Window, set the library type for the library. For
example, to set the library type of newviewer to viewer,

set_param('newlib', 'LibraryType', 'SSMgrViewerLibrary')

To set library type for generators, use the type 'SSMgrGenLibrary'. For
example,

set_param('newlib', 'LibraryType', 'SSMgrGenLibrary')

4 Set the display name of the library. For example,

set_param('newlib', 'SSMgrDisplayString', 'My Custom Library')

5 Add the viewer or generator to the library.
6 Set the iotype of the viewer. For example,

set_param('newlib/newviewer', 'iotype', 'viewer')

7 Save the library newlib. In the Simulink window, select File > Save .

8 Using the MATLAB editor, create a file named sl_customization.m. In this
file, enter a directive to incorporate the new library as a viewer library. For
example, to save newlib as a viewer library, add the following lines:

function sl_customization(cm)

cm.addSigScopeMgrViewerLibrary('newlib"')
%send function

To add a library as a generator library, add a line like the following:

cm.addSigScopeMgrGeneratorLibrary('newlib"')

9 Add a corresponding cm.addSigScope line for each viewer or generator
library you want to add.
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10 Save the s1 _customization.m file on your MATLAB path. Edit this file to
add new viewer or generator libraries.

11 To see the new custom libraries, restart MATLAB and start the Signal &
Scope Manager.

Signal & Scope Manager : untitled - IEI Iil
rTypes - Generatorsiviewers in model
Generators Generators  Viewers |

e T Simulink - El
o Mame | Type | #in |

- W Communications El
- W Signal Processing

Wiewers ll
B gl Simulink
- W Communications ‘
- W Signal Processing

F- N & custorm view

rSignals connected to GeneratorMiewer———————————————

Fort Connected signals

Attach tomodel == |

Help Close
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The Signal Selector allows you to connect a signal or viewer object (see “The
Signal & Scope Manager” on page 5-21) or the Floating Scope to block inputs
and outputs. It appears when you click the signal selection button for a
signal or viewer object in the Signal & Scope Manager or on the toolbar of
the Floating Scope’s window.

«): Signal Selector : Scope _I- _ID ll
Select signals for object untitied/Scope’ |Axes1 j
Model hierarchy )ﬁl%l List contents: |All available signals j I_E!a *—ﬁ”EEEE =
w & Controller 1

| Controller  Contraller: 2
' Integratar
 Sum

Show signal names matching:

Help | Close |

The Signal Selector that appears when you click the signal selection button
applies only to the currently selected signal or viewer object (or the Floating
Scope). If you want to connect blocks to another signal or viewer object, you
must select the object in the Signal & Scope Manager and launch another
instance of the Signal Selector. The object used to launch a particular instance
of the Signal Selector is called that instance’s owner.

The Signal Selector includes the following control panels.

Port/Axis Selector

This list box allows you to select the owner output port (in the case of signal
generators) or display axis (in the case of signal viewers) to which you want to
connect blocks in your model.

Select signals for object 'untited1/Scopesyt’ |




The Signal Selector

The list box is enabled only if the signal generator has multiple outputs or
the signal viewer has multiple axes.

Model Hierarchy

This tree-structured list lets you select any subsystem in your model.

Model hierarchy 2|5 | | s—— Look Under Mask

& engine 1

y Combustion

y Compression

yDrag Toroque

2] Throttle & Manifold
MVehicle Dynamics

| valve timing

Library Links

4 |

Selecting a subsystem causes the adjacent port list panel to display the ports
available for connection in the selected subsystem. To display subsystems
included as library links in your model, click the Library Links button at
the top of the Model hierarchy panel. To display subsystems contained

by masked subsystems, click the Look Under Masks button at the top of
the panel.

Inputs/Signals List

The contents of this panel displays input ports available for connection to the
Signal Selector’s owner if the owner is a signal generator or signals available
for connection to the owner if the owner is a signal viewer.
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If the Signal Selector’s owner is a signal generator, the inputs/signals list by
default lists each input port in the system selected in the model hierarchy tree
that is either unconnected or connected to a signal generator.

List contents: |AII unconnected inputs j I?_‘:‘ :ﬁ”g;g; E#

[NEGan-———=—======= ==
IV Product: 2

1
Show si,gnal names matching: I

The label for each entry indicates the name of the block of which the port is an
input. If the block has more than one input, the label indicates the number
of the displayed port. A greyed label indicates that the port is connected

to a signal generator other than the Signal Selectors’ owner. Checking the
checkbox next to a port’s entry in the list connects the Signal Selector’s owner
to the port, replacing, if necessary, the signal generator previously connected
to the port.

To display more information on each signal, click the Detailed view button
at the top of the pane. The detailed view shows the path and data type of
each signal and whether the signal is a test point. The controls at the top
and bottom of the panel let you restrict the amount of information shown
in the ports list.

® To show named signals only, select Named signals only from the List
contents control at the top of the pane.

* To show test point signals only, select Test point signals only from
the List contents control.

* To show only signals whose signals match a specified string of characters,
enter the characters in the Show signals matching control at the bottom
of the Signals pane and press the Enter key.
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* To show the selected types of signals for all subsystems below the currently
selected subsystem in the model hierarchy, click the Current and Below
button at the top of the Signals pane.

To select or deselect a signal in the Signals pane, click its entry or use the
arrow keys to move the selection highlight to the signal entry and press the
Enter key. You can also move the selection highlight to a signal entry by
typing the first few characters of its name (enough to uniquely identify it).

Note You can continue to select and deselect signals on the block diagram
with the Signal Selector open. For example, shift-clicking a line in the block
diagram adds the corresponding signal to the set of signals that you previously
selected with the Signal Selector. Simulink updates the Signal Selector to
reflect signal selection changes you have made on the block diagram. However,
the changes do not appear until you select the Signal Selector window itself.
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Logging signals refers to the process of saving signal values to the MATLAB
workspace during simulation for later retrieval and postprocessing. Simulink
allows you to log a signal either by connecting the signal to a To Workspace,
Scope block or viewer, or root-level Outport block or by setting the signal’s
signal logging properties. The first method allows you to document in the
diagram itself the workspace variables used to store signal data. The second
method reduces diagram clutter by eliminating the need to use blocks to log
signals. Either method allows you to specify the names of the workspace
variables used to save signal data and to limit the amount of data logged

for a particular signal.

See “Simulink Reference” for the To Workspace and Outport blocks for
information on using these blocks to log signal data. The remainder of this
section explains how to use signal properties to log and access signal data.

Enabling Signal Logging

To enable signal logging for a signal, select the Log signal data option on
the signal’s Signal Properties dialog box (see “Signal Properties Dialog
Box” on page 5-38).

Note Simulink does not support signal logging for nonvirtual buses. If
you enable signal logging for a nonvirtual bus, Simulink displays an error
message when you simulate the model.

Globally Enabling and Disabling Signal Logging

You can globally enable or disable signal logging for a model by checking or
unchecking the Signal logging option on the Data Import/Export pane of
the Configuration Parameters dialog box (see “Signal logging” on page
9-50). Simulink logs signals only if this option is checked. If the option is not
checked, Simulink ignores the signal logging settings for individual signals.
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Specifying a Logging Name

You can assign a name, called the logging name, to the object used to log data
for a signal during simulation. If the signal to be logged does not have a name
or is an element of a composite signal that has another element of the same
name, you must specify a unique log name for the signal. To specify a log
name for a signal, select Custom from the Logging name list on the signal’s
Signal Properties dialog box and enter the custom name in the adjacent text
field. If a signal has a name you do not need to specify a logging name for the
signal, Simulink uses the signal’s name as its logging name.

Limiting the Data Logged for a Signal

The Data panel of the Signal Properties dialog box lets you limit the
amount of data logged for a signal. For example, you can specify the maximum
amount of data to be logged for a signal or a decimation factor that causes
Simulink to skip a specified number of time steps before logging a signal
value. See “Data” on page 5-41 for more information.

Logging Referenced Model Signals

To log signals in a model referenced by a Model block, select the Model block
and then select Log referenced signals from the model editor’s Edit menu
or from the block’s context menu. The Model Reference Signal Logging
dialog box appears.

+):Model Reference Signal Logging: mdlref_basic/Countera (mdiref_counter) i ; =101 x|
[ Model hierarch: kel I Log signals as specified by the referenced model
— Wl ndlref_counter TestPt
L - I - Signal Properties
™ output

Signal Name: ITestF’H
I™ Log signal data

~Logging hame
IUse signal na. LI ITeStF’M

rData

I7| Limit data paints toast: 5000
I Decimation: 7

Refresh

Ready Ok Cancel Help Anply
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The dialog box contains the following panes and controls.

Model Hierarchy

This pane displays the contents of the referenced model as a tree control
with expandable nodes. The top-level node represents the referenced model.
Expanding this node displays the subsystems that the referenced model
contains and any models that it itself references. Expanding a subsystem node
displays the subsystems that it contains and the models that it references.

Refresh Buiton
Refreshes the dialog box to reflect changes in the model hierarchy.

Signals

This pane displays the test points of the model or subsystem selected in the
Model Hierarchy pane (see “Working with Test Points” on page 5-43). Check
the check box next to a test point’s name to specify that it should be logged.

Log signals as specified by the referenced model

Checking this check box causes Simulink to log the signals that the referenced
model specifies should be logged.

Signal Properties

This pane is enabled if Log signals as specified by the referenced model
is not selected. In this case, the controls on this pane allow you to specify the
signal logging properties of the signal selected in the Signals pane. The
values that you specify override for this instance of the referenced model those
specified by the model itself. The controls correspond to the controls of the
same name on the Signal Properties dialog box. See “Signal Properties
Dialog Box” on page 5-38 for information on how to use them.

Viewing Logged Signal Data

To view logged signal data, either check the Inspect signals when
simulation is stopped/paused in the Data Import/Export pane of the
Configuration Parameters dialog box or select Tools > Inspect logged
signals from the model editor’s menu bar. The first method causes Simulink
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to display logged signals in the MATLAB Time Series Tools viewer (see
“Using the Time Series Tools GUI” in the online MATLAB documentation)
whenever a simulation ends or you pause a simulation. The second method
causes Simulink to display the data immediately.

Accessing Logged Signal Data

Simulink saves signal data that it logs during simulation in a Simulink

data object of type Simulink.ModelDatalLogs that resides in the MATLAB
workspace. The name of the object’s handle is logsout by default. The
Data Import/Export configuration pane (see “Data Import/Export Pane”

on page 9-48) allows you to specify another name for this object. See
Simulink.ModelDatalogs in the online Simulink reference for information on
extracting signal data from this object.
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Signal Properties Dialog Box

The Signal Properties dialog box lets you display and edit signal properties.
To display the dialog box, either

® Select the line that represents the signal whose properties you want to set
and then choose Signal Properties from the signal’s context menu or
from the Simulink Edit menu

or

® Select a block that outputs or inputs the signal and select Port Signal
Properties from the block’s context menu, then select the port to which
the signal is connected from the resulting menu

The Signal Properties dialog box appears.

Zlsignal Properties: {(unnamed) 2=l

Signal name: || Show propagated signals I off 'l
I~ Signal name must resolve to Simulink signal ohiect

Logging and accessibility I Real-Time 'Workshop | Documentation I

™ Logsignal data I Test point
—Logging name

I Usze signal name L”

—Data

I~ Limit data points to last ISDDD
I~ Decimation: |2

Ok I Lancel | Help | Apply |

The dialog box includes the follow controls.

Signal Properties Controls

Signal name
Name of signal.
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Signal name must resolve to a Simulink signal object.

Specifies that the MATLAB workspace must contain a Simulink.Signal
object with the same name as this signal. Simulink displays an error message
if it cannot find such an object when you update or simulate the model
containing this signal.

Show propagated signals

Note This option appears only for signals that originate from a virtual block
other than a Bus Selector block.

Show propagated signal names. You can select one of the following options:

Option

Description

off

Do not display signals represented by a virtual signal in the
signal’s label.

on

Display the virtual and nonvirtual signals represented by
a virtual signal in the signal’s label. For example, suppose
that virtual signal s1 represents a nonvirtual signal s2 and
a virtual signal s3. If this option is selected, the label for
s1is s1<s2, s3>.

all

Display all the nonvirtual signals that a virtual signal
represents either directly or indirectly. For example, suppose
that virtual signal s1 represents a nonvirtual signal s2 and a
virtual signal s3 and virtual signal s3 represents nonvirtual
signals s4 and s5. If this option is selected, the label for s1
is s1<s2,s4,s5>.

See “Displaying the Nonvirtual Components of Virtual Signals” on page 5-8
for more information.
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Logging and Accessibility Options

Select the Logging and accessibility tab on the Signal Properties
dialog box to display controls that enable you to specify signal logging and
accessibility options for this signal.

Logging and accessibility IHeaI-TimeW’orkshop I Documentation I
™ Logsignal data I Test point

—Logging name

I Usze signal name L”

—Data

I~ Limit data points to last ISDDD
I~ Decimation: |2

Log signal data

Select this option to cause Simulink to save this signal’s values to the
MATLAB workspace during simulation (see “Logging Signals” on page 5-34).

Test point
Select this option to designate this signal as a test point (see “Signal
Properties Dialog Box” on page 5-38).

Note If you select the Log signal data option for this signal, Simulink
selects and disables the Test point option so that you cannot deselect it. This
is because a signal must be a test point to be logged.

Logging name

This pair of controls, consisting of a list box and an edit field, specifies the
signal’s logging name, i.e., the name under which to be used to retrieve the
data that Simulink logs for this signal during simulation.
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Simulink uses the signal’s signal name as its logging name by default. To
specify a custom logging name, select Custom from the list box and enter the
custom name in the adjacent edit field.

Data

This group of controls enables you to limit the amount of data that Simulink
logs for this signal.

Diata

I~ Limit data points to last ISDDD
I~ Decimation: |2

The options are as follows.

Limit data points to last. Discard all but the last N data points where N is
the number entered in the adjacent edit field.

Decimation. Log every Nth data point where N is the number entered in the
adjacent edit field. For example, suppose that your model uses a fixed-step
solver with a step size of 0.1 s. if you select this option and accept the
default decimation value (2), Simulink records data points for this signal

at times 0.0, 0.2, 0.4, etc.

Real-Time Workshop Options

The following controls set properties used by Real-Time Workshop to generate
code from the model. You can ignore them if you are not going to generate
code from the model.

RTW storage class

Select the storage class of this signal from the list. See “Real-Time Workshop
User’s Guide” for an explanation of the listed options.

RTW storage type qualifier

Select the storage type of this signal from the list. See the “Real-Time
Workshop User’s Guide” for more information.
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Documentation Options

Description
Enter a description of the signal in this field.

Document link

Enter a MATLAB expression in the field that displays documentation for the
signal. To display the documentation, click "Document Link." For example,
entering the expression

web(['file:///' which('foo_signal.html')])

in the field causes MATLAB’s default Web browser to display
foo_signal.html when you click the field’s label.



Working with Test Points

Working with Test Points

A test point is a signal that Simulink guarantees to be observable, for example,
on a Floating Scope, during a simulation. Simulink allows you to designate
any signal in a model as a test point. Designating a signal as a test point
exempts the signal from model optimizations, such as signal storage reuse
(see “Signal storage reuse” on page 9-59) and block reduction (see “Implement
logic signals as boolean data (vs. double)” on page 9-59), that can render
signals inaccessible and hence unobservable during simulation.

Designating a Signal as a Test Point

To designate a signal as a test point, check the Test point option on the
signal’s Signal Properties dialog box (see “Signal Properties Dialog Box”
on page 5-38).

Note If you enable signal logging for a signal, Simulink designates the signal
as a test point automatically. This is because a signal must be accessible to be
logged (see “Enabling Signal Logging” on page 5-34 for more information).

Note If you set the test point property of a signal in a library that is
referenced by a model that is itself referenced by another model, you must
update the referenced model by opening and saving it. Otherwise, Simulink
cannot log or display the referenced signal.

Using Signal Objects to Designate Test Points

You can use Simulink.Signal objects to designate test points from the
MATLAB workspace. This allows you to designate test points in a model
without having to modify the model itself. To use a Simulink.Signal object
to control a signal’s visibility, the following conditions must be true:

* The model does not specify the signal as a test point, i.e., the Test point
option is unchecked in the Signal Properties dialog box.
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* The model specifies the signal’s storage class as auto (the default), i.e.,
the Storage class option in the signal’s Signal Properties dialog box is
set to auto.

e A Simulink.Signal object is associated with the signal, i.e., the MATLAB
workspace contains a signal object having the same name as the signal.

If all these conditions are true, you can designate the signal as a test point by
setting the associated object’s storage class property to any value but auto.

Displaying Test Point Indicators

By default, Simulink displays an indicator next to each signal that serves as
a test point. These test point indicators enable you to find the test points in
a model at a glance.

Test paint indicatars

N > S

Sine Wawve Gain Gain Gain2

The appearance of the indicator changes slightly to indicate test points for
which signal logging is enabled.

Logged signal indicatar

N>
U Ciutl

Sine Wawe Gain

To turn display of test point indicators on or off, select Port/Signal
Displays > Test Point Indicators from the Simulink Format menu.



Displaying Signal Properties

Displaying Signal Properties
A model window’s Format menu and its model context (right-click) menu offer
the following options for displaying signal properties on the block diagram.

Display Options

Wide nonscalar lines

Draws lines that carry vector or matrix signals wider than lines that carry
scalar signals.

[123] | ——inall

4 ——M=ignalz
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Signal dimensions
Display the dimensions of nonscalar signals next to the line that carries the
signal.

The format of the display depends on whether the line represents a single
signal or a bus. If the line represents a single vector signal, Simulink displays
the width of the signal. If the line represents a single matrix signal, Simulink
displays its dimensions as [N;xN,] where N, is the size of the ith dimension
of the signal. If the line represents a bus carrying signals of the same data
type, Simulink displays N{M} where N is the number of signals carried by the
bus and M is the total number of signal elements carried by the bus. If the
bus carries signals of different data types, Simulink displays only the total
number of signal elements {M}.

Port data types
Displays the data type of a signal next to the output port that emits the signal.

~_ | singke

inlig Mz
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The notation (c) following the data type of a signal indicates that the signal
is complex.

Signal Names
You can assign names to signals by

e Editing the signal’s label

® Setting the name parameter of the port or line that represents the signal,

e.g.,
p = get_param(gcb, 'PortHandles')
1 = get_param(p.Inport, 'Line')
set_param(l, 'Name', 's9')

Signal Labels

A signal’s label displays the signal’s name. A virtual signal’s label optionally
displays the signals it represents in angle brackets. You can edit a signal’s
label, thereby changing the signal’s name.

To create a signal label (and thereby name the signal), double-click the line
that represents the signal. The text cursor appears. Enter the name and click
anywhere outside the label to exit label editing mode.

Note When you create a signal label, take care to double-click the line.
If you click in an unoccupied area close to the line, you will create a model
annotation instead.

Labels can appear above or below horizontal lines or line segments, and left or
right of vertical lines or line segments. Labels can appear at either end, at the
center, or in any combination of these locations.

To move a signal label, drag the label to a new location on the line. When you
release the mouse button, the label fixes its position near the line.
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To copy a signal label, hold down the Ctrl key while dragging the label to
another location on the line. When you release the mouse button, the label
appears in both the original and the new locations.

To edit an existing signal label, select it:

* To replace the label, click the label, double-click or drag the cursor to select
the entire label, then enter the new label.

® To insert characters, click between two characters to position the insertion
point, then insert text.

* To replace characters, drag the mouse to select a range of text to replace,
then enter the new text.

To delete all occurrences of a signal label, delete all the characters in the
label. When you click outside the label, the labels are deleted. To delete a
single occurrence of the label, hold down the Shift key while you select the
label, then press the Delete or Backspace key.

To change the font of a signal label, select the signal, choose Font from the
Format menu, then select a font from the Set Font dialog box.

Displaying Signals Represented by Virtual Signals

To display the signal(s) represented by a virtual signal, click the signal’s label
and enter an angle bracket (<) after the signal’s name. (If the signal has no
name, simply enter the angle bracket.) Click anywhere outside the signal’s
label. Simulink exits label editing mode and displays the signals represented
by the virtual signal in brackets in the label.
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Working with Signal Groups

The Signal Builder block allows you to create interchangeable groups of signal
sources and quickly switch the groups into and out of a model. Signal groups
can greatly facilitate testing a model, especially when used in conjunction
with Simulink assertion blocks and the optional Model Coverage Tool.

Creating a Signal Group Set

To create an interchangeable set of signal groups:

1 Drag an instance of the Signal Builder block from the Simulink Sources
library and drop it into your model.

File Edit View Simulation Format Tools Help™

DIZHE| 4 BR (9 B w

04

E Signal 1 p-
I (¥

Signal Builder T .

e (s=c

Default waveform

Fl1o0% [ [ lodets

By default, the block represents a single signal group containing a single
signal source that outputs a square wave pulse.

2 Use the block’s signal editor (see “Signal Builder Dialog Box” on page
5-50) to create additional signal groups, add signals to the signal groups,
modify existing signals and signal groups, and select the signal group that
the block outputs.

3 Connect the output of the block to your diagram.

The block displays an output port for each signal that the block can output.

You can create as many Signal Builder blocks as you like in a model, each
representing a distinct set of interchangeable groups of signal sources. See
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“Simulating with Signal Groups” on page 5-60 for information on using signal
groups in a model.

Signal Builder Dialog Box

The Signal Builder block’s dialog box allows you to define the waveforms
of the signals output by the block. You can specify any waveform that is
piecewise linear.

To open the dialog box, double-click the block. The Signal Builder dialog
box appears.

<) signal Builder {untitled /Signal Builder) E =13l x|
File Edit Group Signal Azes Help
lzdsmels e~ rolHEwzax]r o ¢+
Group 1 Y,
Signal 1
0.8
0.6
4———— Group Panes
0.4 3
0.2
0 1 2 3 1 5 6 7 B 9 10
Time (sec)
Left Point Right Point
Hame: [Signal T [ T | Signal List
Index: [1 =] v | N
Click ta select signal \ \s@\an #1111
Help Area  Signal Nume Wusorm Selection Status Areo
and Index Coordinates

The Signal Builder dialog box allows you to create and modify signal groups
represented by a Signal Builder block. The Signal Builder dialog box
includes the following controls.
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Group Panes

Displays the set of interchangeable signal source groups represented by the
block. The pane for each group displays an editable representation of the
waveform of each signal that the group contains. The name of the group
appears on the pane’s tab. Only one pane is visible at a time. To display

a group that is invisible, select the tab that contains its name. The block
outputs the group of signals whose pane is currently visible.

Signal Axes

The signals appear on separate axes that share a common time range

(see “Signal Builder Time Range” on page 5-58). This allows you to easily
compare the relative timing of changes in each signal. The Signal Builder
automatically scales the range of each axis to accommodate the signal that
it displays. Use the Signal Builder’s Axes menu to change the time (T) and
amplitude (Y) ranges of the selected axis.

Signal List

Displays the names and visibility (see “Editing Signals” on page 5-52) of the
signals that belong to the currently selected signal group. Clicking an entry
in the list selects the signal. Double-clicking a signal’s entry in the list hides
or displays the signal’s waveform on the group pane.

Selection Status Area

Displays the name of the currently selected signal and the index of the
currently selected waveform segment or point.

Waveform Coordinates

Displays the coordinates of the currently selected waveform segment or point.
You can change the coordinates by editing the displayed values (see “Editing
Waveforms” on page 5-54).

Name

Name of the currently selected signal. You can change the name of a signal by
editing this field (see “Renaming a Signal” on page 5-54).
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Index

Index of the currently selected signal. The index indicates the output port at
which the signal appears. An index of 1 indicates the topmost output port, 2
indicates the second port from the top, and so on. You can change the index of
a signal by editing this field (see “Changing a Signal’s Index” on page 5-54).

Help Area

Displays context-sensitive tips on using Signal Builder dialog box features.

Editing Signal Groups
The Signal Builder dialog box allows you to create, rename, move, and delete
signal groups from the set of groups represented by a Signal Builder block.

Creating and Deleting Signal Groups

To create a signal group, you must copy an existing signal group and then
modify it to suit your needs. To copy an existing signal group, select its tab
and then select Copy from the Signal Builder’s Group menu. To delete a
group, select its tab and then select Delete from the Group menu.

Renaming Signal Groups

To rename a signal group, select the group’s tab and then select Rename from
the Signal Builder’s Group menu. A dialog box appears. Edit the existing
name in the dialog box or enter a new name. Click OK.

Moving Signal Groups

To reposition a group in the stack of group panes, select the pane and then
select Move right from the Signal Builder’s Group menu to move the group
lower in the stack or Move left to move the pane higher in the stack.

Editing Signals
The Signal Builder dialog box allows you to create, cut and paste, hide,
and delete signals from signal groups.
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Creating Signals

To create a signal in the currently selected signal group, select New from the
Signal Builder’s Signal menu. A menu of waveforms appears. The menu
includes a set of standard waveforms (Constant, Step, etc.) and a Custom
waveform option. Select one of the waveforms. If you select a standard
waveform, the Signal Builder adds a signal having that waveform to the
currently selected group. If you select Custom, a custom waveform dialog
box appears.

Custom waveform data |

Time YWalues: I

W Walles: I

OK | Cancel |

The dialog box allows you to specify a custom piecewise linear waveform to be
added to the groups defined by the Signal Builder block. Enter the custom
waveform’s time coordinates in the T Values field and the corresponding
signal amplitudes in the Y Values field. The entries in either field can be any
MATLAB expression that evaluates to a vector. The resulting vectors must
be of equal length. Click OK. The Signal Builder adds a signal having the
specified waveform to the currently selected group.

Cutting and Pasting Signals
To cut or copy a signal from one group and paste it into another group:

1 Select the signal you want to cut or copy.

2 Select Cut or Copy from the Signal Builder’s Edit menu or click the
corresponding button from the toolbar.

3 Select the group into which you want to paste the signal.

4 Select Paste from the Signal Builder’s Edit menu or click the
corresponding button on the toolbar.
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Renaming a Signal

To rename a signal, select the signal and choose Rename from the Signal
Builder’s Signal menu. A dialog box appears with an edit field that displays
the signal’s current name. Edit or replace the current name with a new name.
Click OK. Or edit the signal’s name in the Name field in the lower-left corner
of the Signal Builder dialog box.

Changing a Signal’s Index

To change a signal’s index, select the signal and choose Change Index from
the Signal Builder’s Signal menu. A dialog box appears with an edit field
containing the signal’s existing index. Edit the field and select OK. Or select
an index from the Index list in the lower-left corner of the Signal Builder
window.

Hiding Signals

By default, the Signal Builder dialog box displays the waveforms of a group’s
signals in the group’s tabbed pane. To hide a waveform, select the waveform
and then select Hide from the Signal Builder’s Signal menu. To redisplay

a hidden waveform, select the signal’s Group pane, then select Show from
the Signal Builder’s Signal menu to display a menu of hidden signals. Select
the signal from the menu. Alternatively, you can hide and redisplay a hidden
waveform by double-clicking its name in the Signal Builder’s signal list (see
“Signal List” on page 5-51).

Editing Waveforms

The Signal Builder dialog box allows you to change the shape, color, and line
style and thickness of the signal waveforms output by a signal group.

Reshaping a Waveform

The Signal Builder dialog box allows you to change the shape of a waveform
by selecting and dragging its line segments and points with the mouse or
arrow keys or by editing the coordinates of segments or points.
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Selecting a Waveform. To select a waveform, left-click the mouse on any
point on the waveform.

-~ Signal 1--F--

Time (sec)

The Signal Builder displays the waveform’s points to indicate that the
waveform is selected.
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To deselect a waveform, left-click any point on the waveform graph that is not
on the waveform itself or press the Esc key.

Selecting points. To select a point of a waveform, first select the waveform.
Then position the mouse cursor over the point. The cursor changes shape to
indicate that it is over a point.

0 abjects in model
Generators | Viewers |

Marme |

Constant
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Oumutl Connected signals
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Left-click the point with the mouse. The Signal Builder draws a circle around
the point to indicate that it is selected.
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To deselect the point, press the Esc key.

Selecting Segments. To select a line segment, first select the waveform that
contains it. Then left-click the segment. The Signal Builder thickens the
segment to indicate that it is selected.
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To deselect the segment, press the Esc key.

Moving Waveforms. To move a waveform, select it and use the arrow keys
on your keyboard to move the waveform in the desired direction. Each key
stroke moves the waveform to the next location on the snap grid (see “Snap
Grid” on page 5-57) or by 0.1 inches if the snap grid is not enabled.
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Dragging Segments. To drag a line segment to a new location, position the
mouse cursor over the line segment. The mouse cursor changes shape to show
the direction in which you can drag the segment.

04

0.2

Press the left mouse button and drag the segment in the direction indicated
to the desired location. You can also use the arrow keys on your keyboard
to move the selected line segment.

Dragging points. To drag a point along the signal amplitude (vertical) axis,
move the mouse cursor over the point. The cursor changes shape to a circle to
indicate that you can drag the point. Drag the point parallel to the x-axis to
the desired location. To drag the point along the time (horizontal) axis, press
the Shift key while dragging the point. You can also use the arrow keys on
your keyboard to move the selected point.

Snap Grid. Each waveform axis contains an invisible snap grid that
facilitates precise positioning of waveform points. The origin of the snap grid
coincides with the origin of the waveform axis. When you drop a point or
segment that you have been dragging, the Signal Builder moves the point or
the segment’s points to the nearest point or points on the grid, respectively.
The Signal Builder’s Axes menu allows you to specify the grid’s horizontal
(time) axis and vertical (amplitude) axis spacing independently. The finer the
spacing, the more freedom you have in placing points but the harder it is to
position points precisely. By default, the grid spacing is 0, which means that
you can place points anywhere on the grid; i.e., the grid is effectively off. Use
the Axes menu to select the spacing that you prefer.
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Inserting and Deleting points. To insert a point, first select the waveform.
Then hold down the Shift key and left-click the waveform at the point where
you want to insert the point. To delete a point, select the point and press
the Del key.

Editing Point Coordinates. To change the coordinates of a point, first select
the point. The Signal Builder displays the current coordinates of the point in
the Left Point edit fields at the bottom of the Signal Builder dialog box. To
change the amplitude of the selected point, edit or replace the value in the

y field with the new value and press Enter. The Signal Builder moves the
point to its new location. Similarly edit the value in the t field to change

the time of the selected point.

Editing Segment Coordinates. To change the coordinates of a segment,
first select the segment. The Signal Builder displays the current coordinates
of the endpoints of the segment in the Left Point and Right Point edit fields
at the bottom of the Signal Builder dialog box. To change a coordinate, edit
the value in its corresponding edit field and press Enter.

Changing the Color of a Waveform
To change the color of a signal waveform, select the waveform and then select

Color from the Signal Builder’s Signal menu. The Signal Builder displays
the MATLAB color chooser. Choose a new color for the waveform. Click OK.

Changing a Waveform’s Line Style and Thickness

The Signal Builder can display a waveform as a solid, dashed, or dotted line.
It uses a solid line by default. To change the line style of a waveform, select
the waveform, then select Line style from the Signal Builder’s Signal menu.
A menu of line styles pops up. Select a line style from the menu.

To change the line thickness of a waveform, select the waveform, then select
Line width from the Signal menu. A dialog box appears with the line’s
current thickness. Edit the thickness value and click OK.

Signal Builder Time Range

The Signal Builder’s time range determines the span of time over which its
output is explicitly defined. By default, the time range runs from 0 to 10
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seconds. You can change both the beginning and ending times of a block’s time
range (see “Changing a Signal Builder’s Time Range” on page 5-59).

If the simulation starts before the start time of a block’s time range, the
block extrapolates its initial output from its first two defined outputs. If the
simulation runs beyond the block’s time range, the block by default outputs
its final defined values for the remainder of the simulation. The Signal
Builder’s Simulation Options dialog box allows you to specify other final
output options (see “Signal values after final time” on page 5-61 for more
information).

Changing a Signal Builder’s Time Range
To change the time range, select Change time range from the Signal
Builder’s Axes menu. A dialog box appears.

} Set the total time range x|

Min time: | il

I aw Time: | 10

()3 Cancel

Edit the Min. time and Max. time fields as necessary to reflect the beginning
and ending times of the new time range, respectively. Click OK.

Exporting Signal Group Data

To export the data that define a Signal Builder block’s signal groups to the
MATLAB workspace, select Export to workspace from the block’s File
menu. A dialog box appears.

-} Export to workspace ll

‘W ariable name: | channels

()3 Cancel

The Signal Builder exports the data by default to a workspace variable named
channels. To export to a differently named variable, enter the variable’s
name in the Variable name field. Click OK. The Signal Builder exports the
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data to the workspace as the value of the specified variable. The exported
data is an array of structures.

Simulating with Signal Groups

You can use standard simulation commands to run models containing Signal
Builder blocks or you can use the Signal Builder’s Run all command (see
“Running All Signal Groups” on page 5-60).

Activating a Signal Group

During a simulation, a Signal Builder block always outputs the active signal
group. The active signal group is the group selected in the Signal Builder
dialog box for that block, if the dialog box is open, otherwise the group that
was selected when the dialog box was last closed. To activate a group, open
the group’s Signal Builder dialog box and select the group.

Running Different Signal Groups in Succession

The Signal Builder’s toolbar includes the standard Simulink buttons for
running a simulation. This facilitates running several different signal groups
in succession. For example, you can open the dialog box, select a group, run a
simulation, select another group, run a simulation, etc., all from the Signal
Builder’s dialog box.

Running All Signal Groups

To run all the signal groups defined by a Signal Builder block, open the block’s
dialog box and click the Run all *' button from the Signal Builder’s toolbar.
The Run all command runs a series of simulations, one for each signal group
defined by the block. If you have installed the optional Model Coverage Tool
on your system, the Run all command configures the tool to collect and save
coverage data for each simulation in the MATLAB workspace and display a
report of the combined coverage results at the end of the last simulation.
This allows you to quickly determine how well a set of signal groups tests
your model.
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Note To stop a series of simulations started by the Run all command, enter
Control-c at the MATLAB command line.

Simulation Options Dialog Box

The Simulation Options dialog box allows you to specify simulation options
pertaining to the Signal Builder. To display the dialog box, select Simulation
Options from the Signal Builder’s File menu. The dialog box appears.

-} Simulation Options x|
Signal walues after final time: IHold final value j
Sample time: | il

()3 Cancel

The dialog box allows you to specify the following options.

Signal values after final time

The setting of this control determines the output of the Signal Builder block if
a simulation runs longer than the period defined by the block. The options are

® Hold final value

Selecting this option causes the Signal Builder block to output the last
defined value of each signal in the currently active group for the remainder
of the simulation.
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® Extrapolate

Selecting this option causes the Signal Builder block to output values
extrapolated from the last defined value of each signal in the currently
active group for the remainder of the simulation.

® Set to zero

Selecting this option causes the Signal Builder block to output zero for the
remainder of the simulation.
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Sample time

Determines whether the Signal Builder block outputs a continuous (the
default) or a discrete signal. If you want the block to output a continuous
signal, enter 0 in this field. For example, the following display shows
the output of a Signal Builder block set to output a continuous Gaussian
waveform over a period of 10 seconds.

If you want the block to output a discrete signal, enter the sample time of
the signal in this field. The following example shows the output of a Signal
Builder block set to emit a discrete Gaussian waveform having a 0.5 second
sample time.
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Bus Editor

The Simulink Bus Editor allows you to change the properties of bus type
objects, i.e., instances of Simulink.Bus class. You can open the Bus Editor
in any of the following ways:

e Select Bus Editor from the model editor’s Tools menu.

¢ (lick the Launch Bus Editor button on a bus object’s dialog box in the
Model Explorer.

e Enter buseditor at the MATLAB command line.

After you have performed any of these actions, the Bus Types Editor appears.

<) Bus Types Editor [ 3]
Bus types in base workspac Bus elemer
= = cortrol Narme Dimenzion DataiBus Type Sarmple Time Carmplexity Sarmpling Mode
': valvel = 1 boolean 2 -1 resl = | Sarnple based T
ﬁ valvel 1 doukle 2 -1 resl = | Sarple based T
= 1 double hd -1 resl = | Sarple based T
] 1 contral = -1 real | Sample based 7|

: E

+ | P

. =: (cortral "Eus.mmc
| ain

"Header file that contains typedef for bUS“

[ Bus description

main bus

Lol I

‘Set description for bus ‘main’ ‘ Hela Cloze |

The Bus Types Editor contains the following groups of controls.
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Bus types in base workspace

This group contains a bus object hierarchy pane and a column of editing
command buttons.

m

us types in base workspace
contral
=== mnain

3

W

= b (control)

Lo [ [ | |

Bus Object Hierarchy Pane

The bus object hierarchy pane displays the structure of bus objects in the
Simulink base (i.e., MATLAB) workspace. The pane displays each object as
an expandable tree control. The root node of the tree displays the name of
the MATLAB variable that references the bus object and, if the bus contains
any elements, a button for expanding and collapsing the node. Expanding

a bus node displays nodes representing the bus’s top-level elements. Each
element node displays the element’s name. Selecting any top-level bus object
node displays the bus object’s properties in the control groups to the right of
the bus object hierarchy pane (“Editing Buttons” on page 5-65). Selecting
any element displays the element’s properties in the Bus Types Editor’s Bus
elements table.

Editing Buttons

This group of buttons allows you to create and modify bus objects in the
Simulink base (MATLAB) workspace. It includes the following buttons.

Command |lcon Description
Create _+ Create a bus object in the Simulink base
= (MATLAB) workspace.
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Command |lcon Description
Insert e Insert an element in the bus object selected in
= the Bus Editor’s bus object hierarchy pane.
Delete % Delete the bus or bus element selected in the
J Bus Editor’s bus object hierarchy pane.
Move Up + | Move the selected element up in the list of a
— bus object’s elements.
Move Down | _ Move the selected element down in the list of
ﬂ a bus object’s elements.

Simulink also provides a set of utility functions for creating and saving
bus objects. See the documentation for the following functions for more
information:

® Simulink.Bus.save

® Simulink.Bus.createObject

® Simulink.Bus.cellToObject

Bus elements

This table displays the properties of the top-level elements of the bus object
selected in the bus object hierarchy pane or of the selected element.

Bus element:

[Marne Dimensian DataBus Type Sarmple Time Cormplexity Sampling Mode
-1 real = | Sample bazed -

real = | Sample bazed -
-1 real = | Sample bazed -
-1 real | Sample based  ~|

1 hoolean
double
1 double
1 cortral

[EN KN KN K

The table’s cells contain controls that enable you to change the displayed
property values. See the documentation for Simulink.BusElement class for a
description of the usage and valid values for each property.
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Bus name

Specifies the name of the workspace variable that references the selected
bus object.

Header file

Name of a C header file that defines the user-defined type corresponding to
this bus. Simulink ignores this field, which is used by Real-Time Workshop.

Bus description
Description of this bus. Simulink ignores this field.
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Working with Data

The following sections explain how to specify the data types of signals and
parameters and how to create data objects.

Working with Data Types (p. 6-2)

Working with Data Objects (p. 6-10)

Subclassing Simulink Data Classes
(p. 6-23)

Associating User Data with Blocks
(p. 6-36)

How to specify the data types of
signals and parameters.

How to create data objects and
use them as signal and parameter
values.

How to create new types of data
objects.

How to associate data with a block.
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Working with Data Types

6-2

The term data type refers to the way in which a computer represents numbers
in memory. A data type determines the amount of storage allocated to a
number, the method used to encode the number’s value as a pattern of
binary digits, and the operations available for manipulating the type. Most
computers provide a choice of data types for representing numbers, each with
specific advantages in the areas of precision, dynamic range, performance, and
memory usage. To enable you to take advantage of data typing to optimize the
performance of MATLAB programs, MATLAB allows you to specify the data
types of MATLAB variables. Simulink builds on this capability by allowing
you to specify the data types of Simulink signals and block parameters.

The ability to specify the data types of a model’s signals and block parameters
is particularly useful in real-time control applications. For example, it allows
a Simulink model to specify the optimal data types to use to represent
signals and block parameters in code generated from a model by automatic
code-generation tools, such as Real-Time Workshop available from The
MathWorks. By choosing the most appropriate data types for your model’s
signals and parameters, you can dramatically increase performance and
decrease the size of the code generated from the model.

Simulink performs extensive checking before and during a simulation to
ensure that your model is typesafe, that is, that code generated from the model
will not overflow or underflow and thus produce incorrect results. Simulink
models that use the default data type (double) are inherently typesafe. Thus,
if you never plan to generate code from your model or use a nondefault data
type in your models, you can skip the remainder of this section.

On the other hand, if you plan to generate code from your models and use
nondefault data types, read the remainder of this section carefully, especially
the section on data type rules (see “Data Typing Rules” on page 6-6). In that
way, you can avoid introducing data type errors that prevent your model from
running to completion or simulating at all.

Data Types Supported by Simulink

Simulink supports all built-in MATLAB data types except int64 and uint64.
The term built-in data type refers to data types defined by MATLAB itself as
opposed to data types defined by MATLAB users. Unless otherwise specified,
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the term data type in the Simulink documentation refers to built-in data
types. The following table lists the built-in MATLAB data types supported
by Simulink.

Name Description

double Double-precision floating point
single Single-precision floating point
int8 Signed 8-bit integer

uint8 Unsigned 8-bit integer

int16 Signed 16-bit integer

uint16 Unsigned 16-bit integer

int32 Signed 32-bit integer

uint32 Unsigned 32-bit integer

Besides the built-in types, Simulink defines a boolean (1 or 0) type, instances
of which are represented internally by uint8 values. Many Simulink

blocks also support fixed-point data types. See “Blocks—Alphabetical

List” in the online Simulink reference for information on the data types
supported by specific blocks for parameter and input and output values. If
the documentation for a block does not specify a data type, the block inputs
or outputs only data of type double.

Fixed-Point Data

Simulink allows you to create models that use fixed-point numbers to
represent signals and parameter values. Use of fixed-point data can reduce
the memory requirements and increase the speed of code generated from

a model.

To simulate a fixed-point model, you must have the Simulink Fixed Point
product installed on your system. If Simulink Fixed Point is not installed on
your system, you can simulate a fixed-point model as a floating-point model
by enabling automatic conversion of fixed-point data to floating-point data
during simulation. See “Fixed-Point Settings Interface” on page 6-4 for more
information. If you do not have Simulink Fixed Point installed and do not
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enable automatic conversion of fixed-point to floating-point data, Simulink
displays an error when you try to simulate a fixed-point model.

You can edit a model containing fixed-point blocks without Simulink Fixed
Point. However, you must have Simulink Fixed Point to

Update a Simulink diagram (Ctrl+D) containing fixed-point data types

Run a model containing fixed-point data types

® Generate code from a model containing fixed-point data types

Log the minimum and maximum values produced by a simulation

® Automatically scale the output of a model using the autoscaling tool

Fixed-Point Settings Interface

Most of the functionality in the Fixed-Point Settings interface is for use with

the Simulink Fixed Point product. However, even if you do not have Simulink
Fixed Point, you can use the Fixed-Point Settings interface to perform a data
type override that allows you to work with a fixed-point model.

If you do not have Simulink Fixed Point, you can work with a model
containing Simulink blocks with fixed-point settings by doing the following:

1 Access the Fixed-Point Settings interface from the model by selecting
Tools > Fixed-Point Settings.

2 Set the Logging mode parameter to Force off model wide.

3 Set the Data type override parameter to True doubles or True singles
model wide.

This procedure allows you to share fixed-point Simulink models among people
in your company who may or may not have Simulink Fixed Point.

Block Support for Data and Numeric Signal Types

All Simulink blocks accept signals of type double by default. Some blocks
prefer boolean input and others support multiple data types on their inputs.
See "Simulink Blocks" in “Simulink Reference” for information on the data
types supported by specific blocks for parameter and input and output values.
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If the documentation for a block does not specify a data type, the block inputs
or outputs only data of type double.

Specifying Block Parameter Data Types

When entering block parameters whose data type is user-specifiable, use
the syntax

type(value)

to specify the parameter, where type is the name of the data type and value
is the parameter value. The following examples illustrate this syntax.

Name Description

single(1.0) Specifies a single-precision value of 1.0

int8(2) Specifies an 8-bit integer of value 2

int32(3+21i) Specifies a complex value whose real and imaginary
parts are 32-bit integers

You can specify any MATLAB built-in data type supported by Simulink as the
data type of a parameter (see “Data Types Supported by Simulink” on page
6-2. You cannot specify fixed-point data types as parameter data types.

Note You do not need to assign a data type to a parameter. If you do not
specify a data type, the block assigns a data type to the parameter. The block
chooses the most efficient data type consistent with the type of computation
that the block performs, the data types of its inputs and outputs, and the data
types of other parameters.

Creating Signals of a Specific Data Type

You can introduce a signal of a specific data type into a model in any of the
following ways:

® Load signal data of the desired type from the MATLAB workspace into your
model via a root-level Inport block or a From Workspace block.
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® Create a Constant block in your model and set its parameter to the desired
type.

e Use a Data Type Conversion block to convert a signal to the desired data
type.

Displaying Port Data Types

To display the data types of ports in your model, select Port Data Types from
the Simulink Format menu. Simulink does not update the port data type
display when you change the data type of a diagram element. To refresh the
display, press Ctrl+D.

Data Type Propagation

Whenever you start a simulation, enable display of port data types, or refresh
the port data type display, Simulink performs a processing step called data
type propagation. This step involves determining the types of signals whose
type is not otherwise specified and checking the types of signals and input
ports to ensure that they do not conflict. If type conflicts arise, Simulink
displays an error dialog that specifies the signal and port whose data types
conflict. Simulink also highlights the signal path that creates the type conflict.

Note You can insert typecasting (data type conversion) blocks in your model
to resolve type conflicts. See “Typecasting Signals” on page 6-7 for more
information.

Data Typing Rules

Observing the following rules can help you to create models that are typesafe
and, therefore, execute without error:

® Signal data types generally do not affect parameter data types, and vice
versa.

A significant exception to this rule is the Constant block, whose output data
type is determined by the data type of its parameter.
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e Ifthe output of a block is a function of an input and a parameter, and the
input and parameter differ in type, Simulink converts the parameter to the
input type before computing the output.

See “Typecasting Parameters” on page 6-8 for more information.
® In general, a block outputs the data type that appears at its inputs.

Significant exceptions include Constant blocks and Data Type Conversion
blocks, whose output data types are determined by block parameters.

¢ Virtual blocks accept signals of any type on their inputs.

Examples of virtual blocks include Mux and Demux blocks and
unconditionally executed subsystems.

* The elements of a signal array connected to a port of a nonvirtual block
must be of the same data type.

® The signals connected to the input data ports of a nonvirtual block cannot
differ in type.

¢ Control ports (for example, Enable and Trigger ports) accept any data type.
® Solver blocks accept only double signals.

® Connecting a non-double signal to a block disables zero-crossing detection
for that block.

Enabling Strict Boolean Type Checking

By default, Simulink detects but does not signal an error when it detects
that double signals are connected to blocks that prefer boolean input. This
ensures compatibility with models created by earlier versions of Simulink that
support only double data type. You can enable strict Boolean type checking
by clearing the Implement logic signals as boolean data option on the
Optimization panel of the Configuration Parameters dialog box (see
“Implement logic signals as boolean data (vs. double)” on page 9-59.

Typecasting Signals

Simulink displays an error whenever it detects that a signal is connected
to a block that does not accept the signal’s data type. If you want to create
such a connection, you must explicitly typecast (convert) the signal to a type
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that the block does accept. You can use the Data Type Conversion block to
perform such conversions.

Typecasting Parameters

In general, during simulation, Simulink silently converts parameter data
types to signal data types (if they differ) when computing block outputs that
are a function of an input signal and a parameter. The following exceptions
to this rule occur:

¢ Ifthe signal data type cannot represent the parameter value, Simulink
halts the simulation and signals an error.

Consider, for example, the following model.

winta (1) =>L> o5
Constant Gain Display
Gain : "Fain"
Gain=int32[255]

SaturateDnintegerdverflow=on

This model uses a Gain block to amplify a constant input signal. Computing
the output of the Gain block requires computing the product of the input
signal and the gain. Such a computation requires that the two values

be of the same data type. However, in this case, the data type of the
signal, uint8 (unsigned 8-bit word), differs from the data type of the gain
parameter, int32 (signed 32-bit integer). Thus computing the output of the
Gain block entails a type conversion.

When making such conversions, Simulink always casts the parameter type
to the signal type. Thus, in this case, Simulink must convert the Gain
block’s gain value to the data type of the input signal. Simulink can make
this conversion only if the input signal’s data type (uint8) can represent
the gain. In this case, Simulink can make the conversion because the gain
is 255, which is within the range of the uint8 data type (0 to 255). Thus,
this model simulates without error. However, if the gain were slightly
larger (for example, 256), Simulink would signal an out-of-range error if
you attempted to simulate the model.



Working with Data Types

e Ifthe signal data type can represent the parameter value but only at
reduced precision, Simulink optionally issues a warning message and
continues the simulation (see “Detect precision loss” on page 9-77).

Consider, for example, the following model.

uint8 (1) 4%“”“3 :: e UPIE

Gonstant Gain Displawy

In this example, the signal type accommodates only integer values, while
the gain value has a fractional component. Simulating this model causes
Simulink to truncate the gain to the nearest integral value (2) and issue a
loss-of-precision warning. On the other hand, if the gain were 2.0, Simulink
would simulate the model without complaint because in this case the
conversion entails no loss of precision.

Note Conversion of an int32 parameter to a float or double can entail a loss
of precision. The loss can be severe if the magnitude of the parameter value
is large. If an int32 parameter conversion does entail a loss of precision,
Simulink issues a warning message.
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Simulink allows you to create entities called data objects that specify values,
data types, tunability, value ranges, and other key attributes of block outputs
and parameters. You can assign such objects to workspace variables and
use the variables in Simulink dialog boxes to specify parameter and signal
attributes. This allows you to make model-wide changes to parameter and
signal specifications simply by changing the values of a few variables. In
other words, Simulink objects allow you to parameterize the specification

of a model’s data attributes.

Note This section uses the term data to refer generically to signals and
parameters.

Simulink allows you to create various types of data objects, each intended to
be used to specify a particular type of data attribute or set of data attributes,
such as a data item’s type or value. The rest of this section describes features
and procedures for working with data objects that apply to all data objects
regardless of type. For information on working with specific kinds of data
object, see “Data Object Classes” in the online Simulink reference.

About Data Object Classes

Simulink uses objects called data classes to define the properties of specific
types of data objects. The classes also define functions, called methods, for
creating and manipulating instances of particular types of objects. Simulink
provides a set of built-in classes for specifying specific types of attributes
(see “Data Object Classes” for information on these built-in classes). Some
MathWorks products based on Simulink, such as Real-Time Workshop, also
provide classes for specifying data attributes specific to their applications. See
the documentation for those products for information on the classes they
provide. You can also create subclasses of some of these built-in classes to
specify attributes specific to your applications (see “Subclassing Simulink
Data Classes” on page 6-23).

Simulink uses memory structures called packages to store the code and data
that implement data classes. The classes provided by Simulink reside in the
Simulink package. Classes provided by products based on Simulink reside in
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packages provided by those products. You can create your own packages for
storing the classes that you define.

Class Naming Convention
Simulink uses dot notation to name classes:

PACKAGE . CLASS

where CLASS is the name of the class and PACKAGE is the name of the
package to which the class belongs, for example, Simulink.Parameter. This
notation allows you to create and reference identically named classes that
belong to different packages. In this notation, the name of the package is
said to qualify the name of the class.

Note Class and package names are case sensitive. You cannot, for example,
use A.B and a.b interchangeably to refer to the same class.

About Data Object Methods

Data classes define functions, called methods, for creating and manipulating
the objects that they define. You can use either dot notation or function
notation to invoke a method. For example, suppose class A defines a method
called setName that assigns a name to an instance of A. Further, suppose
the MATLAB workspace contains an instance of A assigned to the variable
obj. Then, you can use either of the following statements to assign the name
'foo' to obj:

obj.setName('foo');
setName(obj, 'foo');
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Constructors

Every data class defines a method for creating instances of that class. The
name of the method is the same as the name of the class. For example, the

name of the Simulink.Parameter class’s constructor is Simulink.Parameter.

The constructors defined by Simulink data classes take no arguments.

The value returned by a constructor depends on whether its class is a handle

class or a value class. The constructor for a handle class returns a handle
to the instance that it creates if the class of the instance is a handle class;
otherwise, it returns the instance itself (see “Handle Versus Value Classes”

on page 6-15.

Using the Model Explorer to Create Data Objects
You can use the Model Explorer (see “The Model Explorer” on page 8-2) as

well as MATLAB commands to create data objects. To use the Model Explorer,
first select the workspace in which you want to create the object in the Model

Explorer’s Model Hierarchy pane.

F& Model Explorer

Eile Edit Yiew Tools Add Help

=10 ]

D¢t mex BH<%HFf0 [ @n 483 nraza

JJSearch: Iby Block Type ;l Type: IFcn ;I %’ Search
Model Higrarchy Contents of: Baze Waorkspace Base Workspace

ulink B oot

=i

ze Workspace

| Mame | Valuel DataT_l,lpeI Dimension

s ] 2l

| Contents |§earchﬂesults |

The base [MATLAB) work space containg variables
that are visible to all Simulink. models. Theze variables

cah be uzed to parameterize certain model, black and

signal parameters.

Eewvert

Help | Apply

e
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Then, select the type of the object that you want to create (e.g., Simulink
Parameter or Simulink Signal) from the Model Explorer’s Add menu
or from its toolbar. Simulink creates the object, assigns it to a variable in
the selected workspace, and displays its properties in the Model Explorer’s
Contents and Dialog panes.

& Model Explorer i : -3 x|
Eile Edit Yiew Tools Add Help

D¢t mex BH<%HFf0 [ @n 483 nraza
JJSearch: Iby Block Type ;l Type: IFcn ;I Search |

Madel Higrarchy Conterts of: Baze Workspace Simulink_Parameter: Faram

E‘E‘ ulink Dt | Name IVaIuel DataTypel Dimenzi | Yalue: I[] ﬂ

= daikenace [i‘:’i] Param [ [rata type: laulo— Urits: l_

Dimensions: I[I]::I]]— Complexity: IE
Minirnum: Arf I airnuarn: IrLILI

— i L

| Contents | Search Results | Bevert | Help | Apply |
4

If the type of object you want to create does not appear on the Add menu,
select Find Custom from the menu. Simulink searches the MATLAB path
for all data object classes derived from Simulink class on the MATLAB path,
including types that you have created, and displays the result in a dialog box.

Object name(s]:
Object class: I Simulink. Parameter LI
| 0K I Cancel |

Select the type of object (or objects) that you want to create from the Object
Class list and enter the names of the workspace variables to which you want
the objects to be assigned in the Object name(s) field. Simulink creates the
specified objects and displays them in the Model Explorer’s Contents pane.
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About Object Properties

Object properties are variables associated with an object that specify
properties of the entity that the object represents, for example, the size of a
data type. The object’s class defines the names, value types, default values,
and valid value ranges of the object’s properties.

Changing Object Properties

You can use either the Model Explorer (see “Using the Model Explorer to
Change an Object’s Properties” on page 6-14) or MATLAB commands to

change a data object’s properties (see “Using MATLAB Commands to Change
Workspace Data” on page 3-90).

Using the Model Explorer to Change an Object’s Properties

To use the Model Explorer to change an object’s properties, select the
workspace that contains the object in the Model Explorer’s Model Hierarchy
pane. Then select the object in the Model Explorer’s Contents pane.

The Model Explorer displays the object’s property dialog box in its Dialog
pane (if the pane is visible).

& Model Explorer i ] 3
File Edit Wiew Tools Add Help
D émax[BHERf0[@n4m][enaz2|
”Ssarch |hy Block Tupe =] Type: IFcn =l %’ Search
Model Hierarchy IEﬂntants of. Base Woarkspace Simulink_Parameter: Param
: Simulink. Roat =
SR Y Mame | Value | DataT ype | Dimensions | | Yalue: I[]
- i Base Workspace 4 B | i |
ket ata bype: ‘auto hits:
= Bhlvdn £ Sig ale -
Dimensiors:  [[0x0] Complesite [real
Mirimum:— [nt Mainum: inf
Cade generation option:
J Starage class: IAutn ﬂ
Customize Contents Alias I
B ™ Cunent Properties
I &ll Properties e
I~ Fixed-Paint Properties e
F e 5 L
4 | _.I LContents I Search Results Hevert Help | el |
v
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You can configure the Model Explorer to display some or all of the object’s
properties in the Contents pane (see “Customizing the Contents Pane” on
page 8-6. To edit a property, click its value in the Contents or Dialog pane.
The value is replaced by a control that allows you to change the value.

Using MATLAB Commands to Change an Object’s Properties
You can also use MATLAB commands to get and set data object properties.
Use the following dot notation in MATLAB commands and programs to get
and set a data object’s properties:

VALUE = OBJ.PROPERTY;
OBJ.PROPERTY = VALUE;

where OBJ is a variable that references either the object if it is an instance
of a value class or a handle to the object if the object is an instance of a
handle class (see “Handle Versus Value Classes” on page 6-15), PROPERTY is
the property’s name, and VALUE is the property’s value. For example, the
following MATLAB code creates a data type alias object (i.e., an instance of
Simulink.AliasType) and sets its base type to uint8:

gain= Simulink.AliasType;
gain.DataType = 'uint8';

You can use dot notation recursively to get and set the properties of objects
that are values of other object’s properties, e.g.,

gain.RTWInfo.StorageClass = 'ExportedGlobal’;

Handle Versus Value Classes

Simulink data object classes fall into two categories: value classes and handle
classes.

About Value Classes

The constructor for a value class (see “Constructors” on page 6-12) returns
an instance of the class and the instance is permanently associated with the
MATLAB variable to which it is initially assigned. Reassigning or passing
the variable to a function causes MATLAB to create and assign or pass a copy
of the original object.
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For example, Simulink.NumericType is a value class. Executing the following
statements

>> x = Simulink.NumericType;
>> y X;

creates two instances of class Simulink.NumericType in the workspace, one
assigned to the variable x and the other to y.

About Handle Classes

The constructor for a handle class returns a handle object. The handle can be
assigned to multiple variables or passed to functions without causing a copy
of the original object to be created. For example, Simulink.Parameter class
is a handle class. Executing

>> x = Simulink.Parameter;
>>y = X;

creates only one instance of Simulink.Parameter class in the MATLAB
workspace. Variables x and y both refer to the instance via its handle.

A program can modify an instance of a handle class by modifying any variable
that references it, e.g., continuing the previous example,

>> x.Description = 'input gain';
>> y.Description

ans =
input gain

Most Simulink data object classes are value classes. Exceptions include
Simulink.Signal and Simulink.Parameter class.

You can determine whether a variable is assigned to an instance of a class
or to a handle to that class by evaluating it at the MATLAB command line.
MATLAB appends the text (handle) to the name of the object class in the
value display, e.g.,

>> gain = Simulink.Parameter
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gain =

Simulink.Parameter (handle)
RTWInfo: [1x1 Simulink.ParamRTWInfo]

Description: "'
DocUnits: "'
Min: -Inf
Max: Inf
Value: []

DataType: 'auto'
Complexity: 'real'’
Dimensions: [0 0]

Copying Handle Classes

Use the copy method of a handle class to create copies of instances of that
class. For example, Simulink.ConfigSet is a handle class that represents
model configuration sets. The following code creates a copy of the current
model’s active configuration set and attaches it to the model as an alternate
configuration geared to model development.

activeConfig = getActiveConfigSet(gcs);
develConfig = activeConfig.copy;
develConfig.Name = 'develConfig';
attachActiveConfigSet(gcs, develConfig);

Saving and Loading Data Obijects

You can use the MATLAB save command to save data objects in a MAT-file
and the MATLAB load command to restore them to the MATLAB workspace
in the same or a later session. Definitions of the classes of saved objects must
exist on the MATLAB path for them to be restored. If the class of a saved
object acquires new properties after the object is saved, Simulink adds the new
properties to the restored version of the object. If the class loses properties
after the object is saved, Simulink restores only the properties that remain.
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Using Data Objects in Simulink Models

You can use data objects in Simulink models as parameters and signals.
Using data objects as parameters and signals allows you to specify simulation
and code generation options on an object-by-object basis.

Creating Persistent Data Objects

To create parameter and signal objects that persist across Simulink sessions,
first write a script that creates the objects or create the objects with the
Simulink Data Explorer (see “Subclassing Simulink Data Classes” on page
6-23) or at the command line and save them in a MAT-file (see “Saving

and Loading Data Objects” on page 6-17). Then use either the script or a
load command as the PreLoadFcn callback routine for the model that uses
the objects. For example, suppose you save the data objects in a file named
data_objects.mat and the model to which they apply is open and active.
Then, entering the following command

set_param(gcs, 'PreLoadFcn', 'load data objects');

at the MATLAB command line sets load data objects as the model’s
preload function. This in turn causes the data objects to be loaded into the
model workspace whenever you open the model.

Data Object Wizard

The Data Object Wizard allows you to determine quickly which model data
are not associated with data objects and to create and associate data objects
with the data.

To use the wizard to create data objects:

1 Select Tools > Data Object Wizard from the Model Editor’s tool bar.

The Data Object Wizard appears.
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<) Data Dbject Wizard M= B

Analyzes the model specified helow and finds its unresolved data
ohjects and data types that will he created

| Object Hame | Class | Package

Check Al | Uricheck Al

Chooze package for selected data ohjects: ISimuIink - I Apply Package |
Mocel narne: |¢dp Browse. .. |

Find option:
¥ Rootingputs [+ States ¥ Block outputs ¥ Alis=s types
[ Root outputz [ Dats stores [V Parameters

Firel | Createl Cancell Help |

2 Enter, if necessary, the name of the model you want to search in the
wizard’s Model name field.

By default the wizard displays the name of the model from which you
opened the wizard. You can enter the name of another model in this field.
If the model is not open, the wizard opens the model.

3 In Find options, uncheck any of the data object types that you want the
search to ignore.

The search options include:
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Option Description
Root Named signals from root-level input ports
inputs
Root Named signals from root-level output ports
outputs
States States associated with any instances of the following
discrete block types:
Discrete Filter
Discrete State-Space
Discrete-Time Integrator
Discrete Transfer Fen
Discrete Zero-Pole
Memory
Unit Delay
Data Data stores (see “Working with Data Stores” on page 3-95 )
stores
Block Named signals emitted by non-root-level blocks.
outputs
Parameters ¢ Parameters of any instances of the following block types:
Constant
Gain
Lookup Table
Lookup Table (2-D)
Relay
e Stateflow data with a Scope of Parameter.
See Bringing Simulink Parameters into Stateflow for
more information.
Alias Data whose data type is a registered custom data type.
types This option applies only if you are generating code from
the model. See Creating Data Objects with Data Object
Wizard in the Real-Time Workshop Embedded Coder
documentation for more information,
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4 Click the wizard’s Find button.

The wizard displays the search results in the data objects table.

<) Data Dbject Wizard M= B

Unresolved data ohjects and data types found in analyzed model
Select each data object and data type you wish to create for the

model:  wgp

| Object Hame | Class | Package
[ = Zignal Sirmulink
=2 Signal Simulink

Check All | Uncheck Al

Chooze package for selected data objects: ISimuIink - I Apply Package |
Mocel narne: |¢dp Browse. .. |

Find option:
¥ Rootingputs [+ States ¥ Block outputs ¥ Alis=s types
[ Root outputz [ Dats stores [V Parameters

Createl Cancell Help |

5 Check the data for which you want the wizard to create data objects.

6 If you want the wizard to use data object classes from a package other than
Simulink’s standard class package to create the data objects, select the
package from the Choose package for selected data objects list and
then select Apply Package to confirm your choice.

7 Click Create.
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The wizard creates data objects of the appropriate class for the data
selected in the search results table.

Note Use the Model Explorer to view and edit the created data objects.
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Subclassing Simulink Data Classes

The Simulink Data Class Designer allows you to create subclasses of some
Simulink classes. To define a class with the Data Class Designer, you enter
the package, name, parent class, properties, and other characteristics of the
class in a dialog box. The Data Class Designer then generates P-code that
defines the class. You can also use the Data Class Designer to change the
definitions of classes that it created, for example, to add or remove properties.

Note You can use the Data Class Designer to create custom storage classes.
See the “Real-Time Workshop User’s Guide” for information on custom
storage classes.
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Creating a Data Object Class
To create a class with the Data Class Designer:

1 Select Data class designer from the Simulink Tools menu.
The Data Class Designer dialog box appears.

<) Simulink Data Class Designer =] E3

rUser-defined package

Fackage name:

|MvData LI e | Copy | Renamel Remave |
Farent directory (location of @directory):
Id:l\-’\fokk

Classes | Enumerated Property Types | Custom Storage Classes |

Class name:
--- Mone selected - LI [ ey | Sy | Eename | Bermoye |
Derived from: | Mone selected --- LI | Mone selected — LI

Froperies of this class {inherited propedies disabled):

Froperty Mame | Froperty Type | Factary Value {optional) | [ ey

f
[Ers/r

Bermoye

Hds

Class initialization {optional): Insert comments 1o assistin whiting classinitalization

I(I |>

| |

== Canfirm changesl Reload packagesl
Help | Close |
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2 Select the name of the package in which you want to create the class from
the Package name list.

Do not create a class in any of the Simulink built-in packages, i.e., packages
in matlabroot/toolbox/simulink. See “Creating a Class Package” on
page 6-33 for information on creating your own class packages.

3 Click the New button on the Classes pane of the Data Class Designer
dialog box.

4 Enter the name of the new class in the Class name field on the Classes
pane.

Note The name of the new class must be unique in the package to which
the new class belongs. Class names are case sensitive. For example,
Simulink considers Signal and signal to be names of different classes.

5 Press Enter or click OK on the Classes pane to create the specified class
in memory.

6 Select a parent class for the new class (see “Specifying a Parent for a Class”
on page 6-27).

7 Define the properties of the new class (see “Defining Class Properties” on
page 6-28).

8 If necessary, create initialization code for the new class (see “Creating
Initialization Code” on page 6-32).
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9 Click Confirm changes.

Simulink displays the Confirm changes pane.

<) Simulink Data Class Designer =] E3
~Packages to write {only includes modified packages)
Package name Parent directary Write all |
MyOhjects dOrk \rite selected |
Add parent directory to MATLAB path: [Yes - permanently LI
~Packages to remave
Package name Parent directony | | Remove all I
Remaove selected |
== Back |
Help | Close |

10 Click Write all or select the package containing the new class definition

and click Write selected to save the new class definition.

You can also use the Classes pane to perform the following operations.

Copy a class. To copy a class, select the class in the Classes pane and click
Copy. Simulink creates a copy of the class under a slightly different name.
Edit the name, if desired, click Confirm changes, and click Write all or,
after selecting the appropriate package, Write selected to save the new class.

Rename a class. To rename a class, select the class in the Classes pane
and click Rename. The Class name field becomes editable. Edit the field
to reflect the new name. Save the package containing the renamed class,

using the Confirm changes pane.
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Remove a class from a package. To remove a class definition from the
currently selected package, select the class in the Classes pane and click
Remove. Simulink removes the class from the in-memory definition of the
class. Save the package that formerly contained the class.

Specifying a Parent for a Class

To specify a parent for a class:

1 Select the name of the class from the Class name field on the Classes

pane.

2 Select the package name of the parent class from the left-hand Derived

from list box.

Class name:

LI N |

|Signa|

Copy

| Rename | Remaove |

Derived from: | Mone selected ---
- Mone selected ---

Fropeties of th2

|z| | Mone selected ---

|

Froperty M| ASAP2

tory Walue {optional)

| N

SimulinkDemos
MyQbjects

3 Select the parent class from the

p
Diovwen

Remaove

d3

right-hand Derived from list.

Class name:
|Signa| LI e | Copy | Rename | Remoave |
Derived from: |Simu|ink LI |- Mone selected - |z|

Froperies of this class {inherited properies disabled):

Froperty Name | Froperty Type | Fact

- Mone selected ---
Farameter

CustomParameter
CustomSignal
CustomRTwinfo
CustomStorageClassAttributes

Remove |
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Simulink displays properties of the selected class derived from the parent
class in the Properties of this class field.

Class name:
|signa| LI Mew | Copy | Rename | Remove |
Detived from: |Simulink =/ .|signal d|
Froperies of this class {inherited properies disabled):

Froperty Name Froperty Type Factary Value {optionaly [ ey |
RTWinfo hiandle = T

Diovwen

d3

Remaove

Simulink grays the inherited properties to indicate that they cannot be
redefined by the child class.

4 Save the package containing the class.

Defining Class Properties
To add a property to a class:

1 Select the name of the class from the Class name field on the Classes
pane.

2 Click the New button next to the Properties of this class field on the
Classes pane.

Simulink creates a property with a default name and value and displays
the property in the Properties of this class field.

Froperies of this class {inherited properies disabled):

Property Mame Praperty Type Factory Value (optional) TS
RTvInfo famdle [~ 5
oo .

Diovwen |
Remaove |
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3 Enter a name for the new property in the Property Name column.

Note The property name must be unique to the class. Unlike class names,
property names are not case sensitive. For example, Simulink treats Value
and value as referring to the same property.

4 Select the data type of the property from the Property Type list.

The list includes built-in property types and any enumerated property
types that you have defined (see “Defining Enumerated Property Types” on
page 6-30).

5 If you want the property to have a default value, enter the default value in
the Factory Value column.

The default value is the value the property has when an instance of
the associated class is created. The initialization code for the class can
override this value (see “Creating Initialization Code” on page 6-32 for
more information).

The following rules apply to entering factory values for properties:

* Do not use quotation marks when entering the value of a string property.
Simulink treats the value that you enter as a literal string.

® The value of a MATLAB array property can be any expression that
evaluates to an array, cell array, structure, or object. Enter the
expression exactly as you would enter the value on the command line,
for example, [0 1; 1 0]. Simulink evaluates the expression that you
enter to check its validity. Simulink displays a warning message if
evaluating the expression results in an error. Regardless of whether an
evaluation error occurs, Simulink stores the expression as the factory
value of the property. This is because an expression that is invalid at
define time might be valid at run-time.

® You can enter any expression that evaluates to a numeric value as the
value of a double or int32 property. Simulink evaluates the expression
and stores the result as the property’s factory value.

6 Save the package containing the class with new or changed properties.
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Defining Enumerated Property Types

An enumerated property type is a property type whose value must be one of
a specified set of values, for example, red, blue, or green. An enumerated
property type is valid only in the package that defines it.

To create an enumerated property type:

1 Select the Enumerated Property Types pane of the Data Class

Designer.

Classes Enurmerated Property Types | Custom Storage Classes |

Froperty type name:

|—--N0nese|ected--- LI [ ey | Sy Eename | Bermoye I

Enumerated strings {one per line):
= ARl |

Ll

| |

NOTE:
- Enter one enumerated string per line.
- Do not enclose strings inside single gquotes.

2 Click the New button next to the Property type name field.

Simulink creates an enumerated type with a default name.

Froperty type name:

MNewPropertyTypel Ok | Cancel | Eenarme | Eemnye |

Change the default name in the Property type name field to the desired
name for the property.

The currently selected package defines an enumerated property type and
the type can be referenced only in the package that defines it. However,
the name of the enumerated property type must be globally unique. There
cannot be any other built-in or user-defined enumerated property with the
same name. If you enter the name of an existing built-in or user-defined
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enumerated property for the new property, Simulink displays an error
message.

Click the OK button.

Simulink creates the new property in memory and enables the
Enumerated strings field on the Enumerated Property Types pane.

Enter the permissible values for the new property type Enumerated
strings field, one per line.

For example, the following Enumerated strings field shows the
permissible values for an enumerated property type named Color.

Froperty type name:

|Co|0r LI e | Copy | Renamel Removel
Enumerated strings {one per line):

red 1= Apply |
hilue

green

=
< 12

6 Click Apply to save the changes in memory.

7 Click Confirm changes. Then click Write all to save this change.

You can also use the Enumerated Property Type pane to copy, rename, and
remove enumerated property types.

Click the Copy button to copy the currently selected property type.
Simulink creates a new property that has a new name, but has the same
value set as the original property.

Click the Rename button to rename the currently selected property type.

The Property name field becomes editable. Edit the field to reflect the
new name.

Click the Remove button to remove the currently selected property.
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Don’t forget to save the package containing the modified enumerated property
type.

Creating Initialization Code

You can specify code to be executed when Simulink creates an instance of a
data object class. To specify initialization code for a class, select the class from
the Class name field of the Data Class Designer and enter the initialization
code in the Class initialization field.

The Data Class Designer inserts the code that you enter in the Class
initialization field in the class instantiation function of the corresponding
class. Simulink invokes this function when it creates an instance of this class.
The class instantiation function has the form

function h = ClassName(varargin)

where h is the handle to the object that is created and varargin is a cell array
that contains the function’s input arguments.

By entering the appropriate code in the Data Class Designer, you can cause
the instantiation function to perform such initialization operations as

® Error checking

® Loading information from data files

® Overriding factory values

¢ Initializing properties to user-specified values

For example, suppose you want to let a user initialize the ParamName property

of instances of a class named MyPackage.Parameter. The user does this by
passing the initial value of the ParamName property to the class constructor:

Kp = MyPackage.Parameter('Kp');



Subclassing Simulink Data Classes

The following code in the instantiation function would perform the required
initialization:

switch nargin
case 0

% No input arguments - no action
case 1

% One input argument

h.ParamName = varargin{1};
otherwise

warning('Invalid number of input arguments');
end

Creating a Class Package
To create a new package to contain your classes:

1 Click the New button next to the Package name field of the Data Class
Designer.

FPackage name:

|Simu|inkDemos LI [ ey Copy Rename Remaove

Farent directory (location of @directory):

Ic:ImatIab‘ttoolbox’tsimulinMSimdemos

Simulink displays a default package name in the Package name field.

Fackage name:

MNewPackagel Ok | Cancel | Renamel Eemnye |

2 Edit the Package name field to contain the package name that you want.

Fackage name:

|MyData| j Ok | Cancel | Renamel Rermove |

3 Click OK to create the new package in memory.
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4 In the package Parent directory field, enter the path of the directory
where you want Simulink to create the new package.

Fackage name:

|MyData LI e | Copy | Renamel Remoave |

Farent directory (location of @directory):

Id:‘t\-’\fork

Simulink creates the specified directory, if it does not already exist, when
you save the package to your file system in the succeeding steps.

5 Click the Confirm changes button on the Data Class Designer.

Simulink displays the Packages to write panel.

Fackages towrite {(only includes modified packages)

Package name Parent directory Write all |

MyData diOrk \irite selected |

Add parent directory to MATLAB path: |Yes - permanently LI

6 To enable use of this package in the current and future sessions, ensure that
the Add parent directory to MATLAB path box is selected (the default).

This adds the path of the new package’s parent directory to the MATLAB
path.

7 Click Write all or select the new package and click Write selected to
save the new package.

You can also use the Data Class Designer to copy, rename, and remove
packages.

Copying a package. To copy a package, select the package and click the
Copy button next to the Package name field. Simulink creates a copy of the
package under a slightly different name. Edit the new name, if desired, and
click OK to create the package in memory. Then save the package to make it
permanent.
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Renaming a package. To rename a package, select the package and click
the Rename button next to the Package name field. The field becomes
editable. Edit the field to reflect the new name. Save the renamed package.

Removing a package. To remove a package, select the package and click
the Remove button next to the Package name field to remove the package
from memory. Click the Confirm changes button to display the Packages
to remove panel. Select the package and click Remove selected to remove
the package from your file system or click Remove all to remove all packages
that you have removed from memory from your file system as well.
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Associating User Data with Blocks

6-36

You can use the Simulink set param command to associate your own data
with a block. For example, the following command associates the value of the
variable mydata with the currently selected block.

set_param(gcb, 'UserData', mydata)

The value of mydata can be any MATLAB data type, including arrays,
structures, objects, and Simulink data objects.

Use get_param to retrieve the user data associated with a block.

get param(gcb, 'UserData')

The following command causes Simulink to save the user data associated with
a block in the model file of the model containing the block.

set_param(gcb, 'UserDataPersistent', 'on');

Note If persistent UserData for a block contains any Simulink data objects,
the directories containing the definitions for the classes of those objects must
be on the MATLAB path when you open the model containing the block.




Modeling with Simulink

The following sections provides tips and guidelines for creating Simulink

models.
Modeling Equations (p. 7-2) How to use Simulink blocks to model
mathematical equations.
Avoiding Invalid Loops (p. 7-6) How to avoid creating invalid loops
in your model.
Tips for Building Models (p. 7-8) Tips on creating efficient, accurate

models of a dynamic system.
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One of the most confusing issues for new Simulink users is how to model
equations. Here are some examples that might improve your understanding
of how to model equations.

Converting Celsius to Fahrenheit
To model the equation that converts Celsius temperature to Fahrenheit

T, = 9/5(T,) + 32

First, consider the blocks needed to build the model:

® A Ramp block to input the temperature signal, from the Sources library

® A Constant block to define a constant of 32, also from the Sources library

A Gain block to multiply the input signal by 9/5, from the Math library

A Sum block to add the two quantities, also from the Math library

A Scope block to display the output, from the Sinks library

Next, gather the blocks into your model window.

> F O]

Ramp

Gain

Fum Scope

Constant

Assign parameter values to the Gain and Constant blocks by opening
(double-clicking) each block and entering the appropriate value. Then, click
the Close button to apply the value and close the dialog box.



Modeling Equations

Now, connect the blocks.

L —p——fr O
Ram : +
r Fain
Sum Scope

Constant

Y

The Ramp block inputs Celsius temperature. Open that block and change the
Initial output parameter to 0. The Gain block multiplies that temperature
by the constant 9/5. The Sum block adds the value 32 to the result and
outputs the Fahrenheit temperature.

Open the Scope block to view the output. Now, choose Start from the
Simulation menu to run the simulation. The simulation runs for 10 seconds.

Modeling a Continuous System
To model the differential equation

x(E)y = —2x(E)+ wit)

where u(?) is a square wave with an amplitude of 1 and a frequency of 1
rad/sec. The Integrator block integrates its input x” to produce x. Other blocks
needed in this model include a Gain block and a Sum block. To generate a
square wave, use a Signal Generator block and select the Square Wave form
but change the default units to radians/sec. Again, view the output using a
Scope block. Gather the blocks and define the gain.

In this model, to reverse the direction of the Gain block, select the block, then
use the Flip Block command from the Format menu. To create the branch
line from the output of the Integrator block to the Gain block, hold down

the Ctrl key while drawing the line.
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For more information, see “Drawing a Branch Line” on page 3-15. Now you
can connect all the blocks.

oood " o7
oo Ll ¥ 1 ¥
ol o 1 ]
. Ll
Signal =
Generator Sum Integrator Scope

An important concept in this model is the loop that includes the Sum block,
the Integrator block, and the Gain block. In this equation, x is the output of
the Integrator block. It is also the input to the blocks that compute x°, on
which it is based. This relationship is implemented using a loop.

The Scope displays x at each time step. For a simulation lasting 10 seconds,
the output looks like this:

<) Scope =] B3
l@mopp ABB B L &

The equation you modeled in this example can also be expressed as a transfer
function. The model uses the Transfer Fen block, which accepts u as input
and outputs x. So, the block implements x/u. If you substitute sx for x” in
the above equation, you get

sx = —2x4u
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Solving for x gives

x = ulls+2

or,
xfu = 1=+ 20

The Transfer Fcn block uses parameters to specify the numerator and

denominator coefficients. In this case, the numerator is 1 and the denominator

is s+2. Specify both terms as vectors of coefficients of successively decreasing
powers of s.

In this case the numerator is [1] (or just 1) and the denominator is [1 2].

oooo u 1 %
(=] =] - —
2

Signal Transfer Fen Scope
Generator

¥

The results of this simulation are identical to those of the previous model.
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Avoiding Invalid Loops
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Simulink allows you to connect the output of a block directly or indirectly
(i.e., via other blocks) to its input, thereby, creating a loop. Loops can be
very useful. For example, you can use loops to solve differential equations
diagramatically (see “Modeling a Continuous System” on page 7-3) or model
feedback control systems. However, it is also possible to create loops that
cannot be simulated. Common types of invalid loops include:

® Loops that create invalid function-call connections or an attempt to modify
the input/output arguments of a function call

o Self-triggering subsystems and loops containing non-latched triggered
subsystems

® Loops containing action subsystems

The Subsystem Examples block library in the Ports & Subsystems library
contains models that illustrates examples of valid and invalid loops involving
triggered and function-call subsystems. Examples of invalid loops include
the following models:

® simulink/Ports&Subsystems/sl_subsys semantics/Triggered
subsystem/sl _subsys_trigerri

® simulink/Ports&Subsystems/sl_subsys semantics/Triggered
subsystem/sl _subsys_trigerr2

® simulink/Ports&Subsystems/sl_subsys_semantics/Function-call
systems/sl subsys_fcncallerr3

You might find it useful to study these examples to avoid creating invalid
loops in your own models.

Detecting Invalid Loops
To detect whether your model contains invalid loops, select Update diagram

from the model’s Edit menu. If the model contains invalid loops, Simulink
highlights the loops
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H

[+
Dizcrete Pulse
Generator

¥ ¥
In1d Ot 1 In1d Ot 1
trigss1 A trigss2
@4

and displays an error message in the Simulation Diagnostics Viewer.
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Tips for Building Models

Here are some model-building hints you might find useful:

Memory issues
In general, the more memory, the better Simulink performs.
Using hierarchy

More complex models often benefit from adding the hierarchy of subsystems
to the model. Grouping blocks simplifies the top level of the model and can
make it easier to read and understand the model. For more information, see
“Creating Subsystems” on page 3-30. The Model Browser provides useful

information about complex models (see “The Model Browser” on page 8-22).

Cleaning up models

Well organized and documented models are easier to read and understand.
Signal labels and model annotations can help describe what is happening
in a model. For more information, see “Signal Names” on page 5-47 and
“Annotating Diagrams” on page 3-20.

Modeling strategies

If several of your models tend to use the same blocks, you might find it
easier to save these blocks in a model. Then, when you build new models,
just open this model and copy the commonly used blocks from it. You can
create a block library by placing a collection of blocks into a system and
saving the system. You can then access the system by typing its name in
the MATLAB Command Window.

Generally, when building a model, design it first on paper, then build

it using the computer. Then, when you start putting the blocks together
into a model, add the blocks to the model window before adding the lines
that connect them. This way, you can reduce how often you need to open
block libraries.



Exploring, Searching, and
Browsing Models

The following sections describe tools that enable you to quickly navigate to
any point in a model and find and modify objects in a model.

The Model Explorer (p. 8-2) How to use the Model Explorer
to find, display, and modify model
contents.

The Finder (p. 8-16) How to use the Simulink Finder

to locate blocks, states, and other
objects in a model, using search
criteria that you specify.

The Model Browser (p. 8-22) How to navigate quickly to any point
in a model’s block hierarchy.
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The Model Explorer

The Model Explorer allows you to quickly locate, view, and change elements of
a Simulink model or Stateflow chart. To display the Model Explorer, select
Model Explorer from the Simulink View menu or select an object in the

block diagram and select Explore from its context menu. The Model Explorer
appears.

Main toolbar Search toolbar

& Model Explorer
File Edit Wiew Tools Add Help

b smaxmMcssHsO an sksgaza

JJSearch: Iby Elock Type LI Type: IFc:n LI %‘éh

Model Hierarchy | Contents of: wdp Model Properties
E--@S%ﬂulink Raat I Mame I BlockTupe I MaskType | SampleTime | Port Main I Callbacks I Histary
o i Base Workspace ﬁ Model Workspace
Configuration Preferences 668 Configuration (Active] Model Informsz
@ Code for vdp Source file: hnigk
@ Advice for vdp Last Saved: Mondu
= Fen q Created On:  Fri fug
E’ Mare Infa Iz Modified: no
E’ Mare Infa3 Model Version: 1.2
1 Mu 1
I Mux
=1 Product R
=l Scope i]
F] Sum q |,
A | » Al
Contents I Search Results I Bevert | Help
Model Hierarchy pane (ontents pane Dialog pane

The Model Explorer includes the following components:

* Model Hierarchy pane (see “Model Hierarchy Pane” on page 8-3)

* Contents pane (see “Contents Pane” on page 8-5)

Dialog pane (see “Dialog Pane” on page 8-10)

Main toolbar (see “Main Toolbar” on page 8-10)

Search bar (see “Search Bar” on page 8-12)
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You can use the Model Explorer’s View menu to hide the Dialog pane and
the toolbars, thereby making more room for the other panes.

Setting the Model Explorer’s Font Size

To increase the size of the font used by the Model Explorer to display text,
select Increase font size from the Model Explorer’s View menu or type
Ctrl+. To decrease the font size, select Decrease font size from the menu or
type Ctrl-. The change remains in effect across Simulink sessions.

Note Increasing or decreasing the Model Explorer’s font size also
correspondingly increases or decreases the font size used by Simulink dialog
boxes.

Model Hierarchy Pane

The Model Hierarchy pane displays a tree-structured view of the Simulink
model hierarchy.

Model Hierarchy

-] Simulink Root

Base Woarkspace

& Configuration Preferences

1

Model Woarkspace
-8 Configuration (Active)
- §h Code for sf_car
- % Advice for sf_car
-[Fz]Engine
-] Threshold Calculation
- User Inputs
-[Fvehicle
=By shift_logic
*}--Elgear_state
i--ElseIection_state
=Pz transmission

- Torque Converter

----- feltransmission ratio
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Simulink Root

The first node in the view represents the Simulink root. Expanding the root
node displays nodes representing the MATLAB workspace (the Simulink base
workspace) and each model and library loaded in the current session.

Base Workspace

This node represents the MATLAB workspace. The MATLAB workspace is
the base workspace for Simulink models. Variables defined in this workspace
are visible to all open Simulink models, i.e., to all models whose nodes appear
beneath the Base Workspace node in the Model Hierarchy pane.

Configuration Preferences

If you check the Show Configuration Preferences option on the Model
Explorer’s View menu, the expanded Simulink Root node also displays a
Configuration Preferences node. Selecting this node displays the preferred
model configuration (see “Configuration Sets” on page 9-29) for new models
in the adjacent panes. You can change the preferred configuration by editing
the displayed settings and using the Model Configuration Preferences
dialog box to save the settings (see “Model Configuration Preferences Dialog
Box” on page 9-35).

Model Nodes

Expanding a model node displays nodes representing the model’s configuration
sets (see “Configuration Sets” on page 9-29), top-level subsystems, model
references, and Stateflow charts. Expanding a node representing a subsystem
displays its subsystems, if any. Expanding a node representing a Stateflow
chart displays the chart’s top-level states. Expanding a node representing

a state shows its substates.

Displaying Node Contents

To display the contents of an object displayed in the Model Hierarchy
pane (e.g., a model or configuration set) in the adjacent Contents pane,
select the object. To open a graphical object (e.g., a model, subsystem, or
chart) in an editor window, right-click the object. A context menu appears.
Select Open from the context menu. To open an object’s properties dialog,
select Properties from the object’s context menu or from the Edit menu.
See “Configuration Sets” on page 9-29 for information on using the Model
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Hierarchy pane to delete, move, and copy configuration sets from one model
to another.

Expanding Model References

To expand a node representing a model reference (see “Referencing Models”
on page 3-52), you must first open the referenced model. To do this, right-click
on the node to display its context menu, then select Open Model from the
menu. Simulink opens the model to which the reference refers, displays a
node for it in the Model Hierarchy pane, and make all references to the
model expandable. You cannot edit the contents of a reference node, however.
To edit the referenced model, you must expand its node.

Contents Pane

The Contents pane displays either of two tabular views selectable by tabs.
The Contents tab displays the contents of the object selected in the Model
Hierarchy pane. The Search Results tab displays the results of a search
operation (see “Search Bar” on page 8-12) .

Model Hierarchy | Contents of: wdp

E--E‘Simulink Foat I N ame I BlockType | MaskType SampleTimeI Part ~
ﬁ Base Workspace ﬁ Model Workspace
: -%Eonfiguration Preferences % Configuration (Active]

@ Code for wdp
--ﬁModeIW’orkspace @ Advice for vdp
--%Eonfiguration [Active] =1 Fen R

- @ Code for vdp E’ More Infa
- @Advice for wdp E’ Mare Infa3 T
E----E’More Info 4 | —’I—I
5----5!\‘10@ Imfad

Contents Igearch Results I

In both views, the table rows correspond to objects (e.g., blocks or states);
the table columns, to object properties (e.g., name and type). The table cells
display the values of the properties of the objects contained by the object
selected in the Model Hierarchy pane or found by a search operation.

The objects and properties displayed in the Contents pane depend on the
type of object (e.g., subsystem, chart, or configuration set) selected in the
Model Hierarchy pane. For example, if the object selected in the Model
Hierarchy pane is a model or subsystem, the Contents pane by default
displays the name and type of the top-level blocks contained by that model or
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subsystem. If the selected object is a Stateflow chart or state, the Contents
pane by default shows the name, scope, and other properties of the events and
data that make up the chart or state.

Customizing the Contents Pane

The Model Explorer’s View menu allows you to control the type of objects and
properties displayed in the Contents pane.

To display only object names in the Contents pane, uncheck the Show
Properties item on the View menu.

To customize the set or properties displayed in the Contents pane, select
Customize Contents from the View menu or click the Customize
Contents button on the Model Explorer’s main toolbar (see “Main Toolbar”
on page 8-10). The Customize Contents pane appears. Use the pane to
select the properties you want the Contents pane to display.

4

To specify the types of subsystem or chart contents displayed in the
Contents pane, select List View Options from the View menu. A menu
of object types appears. Check the types that you want to be displayed (e.g.,
Blocks and Named Signals/Connections or All Simulink Objects

for models and subsystems).

Reordering the Contents Pane

The Contents pane by default displays its contents in ascending order by
name. To order the contents in ascending order by any other displayed
property, click the head of the column that displays the property. To change
the order from ascending to descending, or vice versa, click the head of the
property column that determines the current order.
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Customize Contents Pane

The Customize Contents pane allows you to select the properties that the
Contents pane displays for the object selected in the Model Hierarchy
pane. When visible, the pane appears in the lower-left corner of the Model
Explorer window.

E& Model Explorer

File Edit Wiew Tools Add Help

D[ s max EMEL:H 7@ B@m 45

JJ Search: Iby Property 'V alue
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Customize Contents gProduct 1
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I Fixed Point Properties Ele2
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Splitter

Customize Contents pane

A splitter divides the Customize Contents pane from the Model Hierarchy
pane above it. Drag the splitter up or down to adjust the relative size of the

two panes.

The Customize Contents pane contains a tree-structured property list. The
list’s top-level nodes group object properties into the following categories:

® Current Properties

Properties that the Contents pane currently displays.

® Suggested Properties

Properties that Simulink suggests that the Contents pane should display,
based on the type of object selected in the Model Hierarchy pane and
the contents of the selected object.

® All Properties
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Properties of the contents of all models displayed in the Model Explorer
thus far in this session.

Fixed Point Properties

Fixed-point properties of blocks.

By default, the properties currently displayed in the Contents pane are
the suggested properties for the currently selected model. The Customize
Contents pane allows you to perform the following customizations:

To display additional properties of the selected model, expand the All
Properties node, if necessary, and check the desired properties.

To delete some but not all properties from the Contents pane, expand the
Current Properties node, if necessary, and uncheck the properties that
you do not want to appear in the Contents pane.

To delete all properties from the Contents pane (except the selected
object’s name), uncheck Current Properties.

To restore the properties suggested for the current model, uncheck Current
Properties and check Suggested Properties.

To add or remove fixed-point block properties from the Contents pane,
check or uncheck Fixed Point Properties.
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Marking Nonexistent Properties

Some of the properties that the Contents pane is configured to display may
not apply to all the objects currently listed in the Contents pane. You can
configure the Model Explorer to indicate the inapplicable properties.

To do this, select Mark Nonexistent Properties from the Model Explorer’s
View menu. The Model Explorer now displays dashes for the values of
properties that do not apply to the objects displayed in the Contents pane.
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Changing Property Values

You can change modifiable properties displayed in the Contents pane (e.g.,
a block’s name) by editing the displayed value. To edit a displayed value,
first select the row that contains it. Then click the value. An edit control
replaces the displayed value (e.g., an edit field for text values or a pull-down
list for a range of values). Use the edit control to change the value of the
selected property.

To assign the same property value to multiple objects displayed in the
Contents pane, select the objects and then change one of the selected objects
to have the new property value. The Model Explorer assigns the new property
value to the other selected objects as well.
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Dialog Pane

The Dialog pane displays the dialog view of the object selected in the
Contents pane, e.g., a block or a configuration subset. You can use the Dialog
pane to view and change the selected object’s properties. To show or hide this
pane, select the Show Dialog View menu from the Model Explorer’s View
menu or the Show Dialog View button on the Model Explorer’s main toolbar
(see “Main Toolbar” on page 8-10).

Main Toolbar

The Model Explorer’s main toolbar appears near the top of the Model Explorer
window under the Model Explorer’s menu.

& Model Explorer
File Edit Wiew Tools Add Help

[DE[smax EMEw:H70 D0 4h||kraza

JJ Search: Iby Block Type LI Type: IFc:n LI % Search
tModel Hierarchy | | [
- [EF]Simuiink Roat
ﬁ Ba-
| Main foolbar

The toolbar contains buttons that select commonly used Model Explorer
commands:

Button | Usage

D Create a new model.
Ij: Open an existing model.
Cut the objects (e.g., variables) selected in the Contents pane
-H:' from the object (e.g., a workspace) selected in the Model
Hierarchy pane. Save a copy of the object on the system
clipboard.
B Copy the objects selected in the Contents pane to the system
clipboard.
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Button [ Usage
Paste objects from the clipboard into the object selected in the
E Model Explorer’s Model Hierarchy pane.
W Delete the objects selected in the Contents pane from the object

selected in the Model Hierarchy pane.

Add a MATLAB variable to the workspace selected in the Model
Hierarchy pane.

Add a Simulink.Parameter object to the workspace selected in
the Model Hierarchy pane.

Add a Simulink.Signal object to the workspace selected in the
Model Hierarchy pane.

Add a configuration set to the model selected in the Model
Hierarchy pane.

Add a Stateflow datum to the machine or chart selected in the
Model Hierarchy pane.

Add a Stateflow event to the machine or chart selected in the
Model Hierarchy pane or to the state selected in the Model
Explorer.

Add a code generation target to the model selected in the Model
Hierarchy pane.

Turn the Model Explorer’s Dialog pane on or off.

Customize the Model Explorer’s Contents pane.

Bring the MATLAB desktop to the front.

Display the Simulink Library Browser.
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To show or hide the main toolbar, select Main Toolbar from the Model
Explorer’s View menu.

Search Bar

The Model Explorer’s search bar allows you to select, configure, and initiate
searches of the object selected in the Model Hierarchy pane. It appears at
the top of the Model Explorer window.

Search bar

F& Model Explorer (= ]
File Edit WView Tools Add Help
— Ty r— - 7
D@ smax BN fFONDR 4R aza
”Search:lbyBlockType jType:|In’regra’r@ j % Search ‘
Model Hierarchy | Contents of: wdp
E!--EEISimulink Foot |Name |EllockType ﬂ
ﬁBangorkspace  ModelWorkspace
@ Configuration Preferences | Configuration (Active)
= S o oo
& Bllst_car % Advice farvdp
o _>l_|
Contents |Search Results |
A

To show or hide the search bar, check or uncheck Search Bar in the Model
Explorer’s View menu.

The search bar includes the following controls:

Select search fype. Specily search criteria. Start search.
“Search: Iby Block Type j Type: IInTegra‘ror j % Search

Select search options.

Search Type
Specifies the type of search to be performed. Options include:
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by Property Value

Search for objects whose property matches a specified value. Selecting
this search type causes the search bar to display controls that allow you
to specify the name of the property, the value to be matched, and the type
of match (equals, less than, greater than, etc.).

by Property Name

Search for objects that have a specified property. Selecting this search type
causes the search bar to display a control that allows you to specify the
target property’s name by selecting from a list of properties that objects in
the search domain can have.

by Block Type

Search for blocks of a specified block type. Selecting this search type
causes the search bar to display a block type list control that allows you
to select the target block type from the types contained by the currently
selected model.

for Library Links

Searches for library links in the current model.

by Class

Searches for Simulink objects of a specified class.

for Model References

Searches a model for references to other models.

for Fixed Point

Searches a model for all blocks that support fixed-point computations.
by Dialog Prompt

Searches a model for all objects whose dialogs contain a specified prompt.
by String

Searches a model for all objects in which a specified string occurs.

Search Options

Specifies options that apply to the current search. The options include:
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® Search Current System and Below

Search the current system and the subsystems that it includes directly
or indirectly.

® | ook Inside Masked Subsystems
Search includes masked subsystems.
® | ook Inside Linked Subsystems
Search includes linked subsystems.
® Match Whole String

Do not allow partial string matches, e.g., do not allow sub to match
substring.

® Match Case
Consider case when matching strings, e.g., Gain does not match gain.
® Regular Expression

The Model Explorer considers a string to be matched as a regular
expression.

® Evaluate Property Values During Search

This option applies only for searches by property value. If enabled, the
option causes the Model Explorer to evaluate the value of each property
as a MATLAB expression and compare the result to the search value.
If disabled (the default), the Model Explorer compares the unevaluated
property value to the search value.

® Refine Search

Causes the next search operation to search for objects that meet both the
original and new search criteria (see “Refining a Search” on page 8-15).

Search Button

Initiates the search specified by the current settings of the search bar on the
object selected in the Model Explorer’s Model Hierarchy pane. The Model
Explorer displays the results of the search in the tabbed Search Results
pane.
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Search Results Pane

& Model Explorer (= ]
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Contents | Search Results |

You can edit the results displayed in the Search Results pane. For example,
to change all objects found by a search to have the same property value, select
the objects in the Search Results pane and change one of them to have the

new property value.

Refining a Search

To refine the previous search, check the Refine Search option on the search
bar’s Search Options menu. A Refine button replaces the Search button

on the search bar. Use the search bar to define new search criteria and then
click the Refine button. The Model Explorer searches for objects that match

the previous search criteria and the new criteria.
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The Finder

The Finder locates blocks, signals, states, or other objects in a model. To
display the Finder, select Find from the Edit menu. The Find dialog box
appears.

) Find : vdp =] B3

—Filteroptions —_Search criteria
: Find |
Look for |Se|ec| Basic | Advanced |
B simulink objects & Find what Help |
W stateflow objects @ | = F— |
b

I=| Bearch hiock dialog parameters

™ Match case IContains word vI

—Startin system

™ Lookinside masked systems

™ Lookinside linked systems |vdp LI

Use the Filter options (see “Filter Options” on page 8-18) and Search
criteria (see “Search Criteria” on page 8-18) panels to specify the
characteristics of the object you want to find. Next, if you have more than
one system or subsystem open, select the system or subsystem where you
want the search to begin from the Start in system list. Finally, click the
Find button. Simulink searches the selected system for objects that meet the
criteria you have specified.
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Any objects that satisfy the criteria appear in the results panel at the bottom

of the dialog box.

) Find : vdp
—Filter options

Look for |Se|ec|
B simulink ohjects
B stateflow objects

™ Lookinside masked systems

—Search criteria

IS[=] E3

Basic | Advanced |
Find what:
o <]

™ Search block dialog parameters

I~
IContains wotd |

[~ Match case

—Startin system

Find I
Help |
[ sad |

Cancel

@ Block  Mux

Found 2 object(=)

wdp

™ Lookinside linked systems |vdp LI
Type | MName | FParent | Source | Destination
0 Black My wdp

You can display an object by double-clicking its entry in the search results
list. Simulink opens the system or subsystem that contains the object (if

necessary) and highlights and selects the object. To sort the results list, click
any of the buttons at the top of each column. For example, to sort the results
by object type, click the Type button. Clicking a button once sorts the list in
ascending order, clicking it twice sorts it in descending order. To display an

object’s parameters or properties, select the object in the list. Then press the
right mouse button and select Parameter or Properties from the resulting

context menu.
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Filter Options

The Filter options panel allows you to specify the kinds of objects to look for
and where to search for them.

—Filter options
Look for | Select

W simulink objects ¥
|— & Annotations I~
|— & Blocks I~
L& Signals I~

G_Szte;;‘t";zmms < E Objedt type list
|— & Transitions I~
— & Junctions I~
|— & Events I~
- & Data I~
L& Targets I~

1 | ]

™ Lookinside masked systems

[™ Look inside linked systems

Object type list
The object type list lists the types of objects that Simulink can find. By
clearing a type, you can exclude it from the Finder’s search.

Look inside masked subsystem

Selecting this option causes Simulink to look for objects inside masked
subsystems.

Look inside linked systems

Selecting this option causes Simulink to look for objects inside subsystems
linked to libraries.

Search Criteria

The Search criteria panel allows you to specify the criteria that objects must
meet to satisfy your search request.
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Basic

The Basic panel allows you to search for an object whose name and,
optionally, dialog parameters match a specified text string. Enter the search
text in the panel’s Find what field. To display previous search text, select the
drop-down list button next to the Find what field. To reenter text, click it

in the drop-down list. Select Search block dialog parameters if you want
dialog parameters to be included in the search.

Advanced

The Advanced panel allows you to specify a set of as many as seven
properties that an object must have to satisfy your search request.

Basic Advanced |

Select Froperty Value
{nane)
{nane)
{nane)
{nane)
{nane)
{nane)
{nane)

LHENENENENENE

e e o

To specify a property, enter its name in one of the cells in the Property
column of the Advanced pane or select the property from the cell’s property
list. To display the list, select the down arrow button next to the cell. Next
enter the value of the property in the Value column next to the property
name. When you enter a property name, the Finder checks the check box next
to the property name in the Select column. This indicates that the property
is to be included in the search. If you want to exclude the property, clear

the check box.

Match case

Select this option if you want Simulink to consider case when matching search
text against the value of an object property.
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Other match options
Next to the Match case option is a list that specifies other match options

that you can select.
® Match whole word

Specifies a match if the property value and the search text are identical
except possibly for case.

® Contains word
Specifies a match if a property value includes the search text.
® Regular expression

Specifies that the search text should be treated as a regular expression
when matched against property values. The following characters have
special meanings when they appear in a regular expression.

Character Meaning

S

Matches start of string.

$ Matches end of string.

Matches any character.

\ Escape character. Causes the next character to have its
ordinary meaning. For example, the regular expression
\.. matches .a and .2 and any other two-character
string that begins with a period.

* Matches zero or more instances of the preceding
character. For example, ba* matches b, ba, baa, etc.

+ Matches one or more instances of the preceding
character. For example, ba+ matches ba, baa, etc.

[1 Indicates a set of characters that can match the current
character. A hyphen can be used to indicate a range

of characters. For example, [a-zA-Z0-9 ]+ matches
foo_bar1 but not foo$bar. A ~ indicates a match
when the current character is not one of the following
characters. For example, [ “0-9] matches any character
that is not a digit.




The Finder

Character Meaning

\w Matches a word character (same as [a-z_A-Z0-9]).

\W Matches a nonword character (same as ["a-z_A-Z0-9]).
\d Matches a digit (same as [0-9]).

\D Matches a nondigit (same as [~0-9]).

\s Matches white space (same as [ \t\r\n\f]).

\S Matches nonwhite space (same as [~ \t\r\n\f]).
\<WORD\ > Matches WORD where WORD is any string of word

characters surrounded by white space.
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The Model Browser
The Model Browser enables you to

® Navigate a model hierarchically
® Open systems in a model

® Determine the blocks contained in a model

Note The browser is available only on Microsoft Windows platforms.

To display the Model Browser, select Model Browser Options > Model
Browser from the Simulink View menu.
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The model window splits into two panes. The left pane displays the browser, a
tree-structured view of the block diagram displayed in the right pane.
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Note The Browser initially visible preference causes Simulink to open
models by default in the Model Browser. To set this preference, select
Preferences from the Simulink File menu.

The top entry in the tree view corresponds to your model. A button next to the
model name allows you to expand or contract the tree view. The expanded
view shows the model’s subsystems. A button next to a subsystem indicates
that the subsystem itself contains subsystems. You can use the button to

list the subsystem’s children. To view the block diagram of the model or

any subsystem displayed in the tree view, select the subsystem. You can

use either the mouse or the keyboard to navigate quickly to any subsystem
in the tree view.

Navigating with the Mouse

Click any subsystem visible in the tree view to select it. Click the + button
next to any subsystem to list the subsystems that it contains. Click the button
again to contract the entry.

Navigating with the Keyboard

Use the up/down arrows to move the current selection up or down the tree
view. Use the left/right arrow or +/- keys on your numeric keypad to expand
an entry that contains subsystems.

Showing Library Links

The Model Browser can include or omit library links from the tree view
of a model. Use the Simulink Preferences dialog box to specify whether
to display library links by default. To toggle display of library links, select
Show Library Links from the Model browser Options submenu of the
Simulink View menu.

Showing Masked Subsystems

The Model Browser can include or omit masked subsystems from the tree
view. If the tree view includes masked subsystems, selecting a masked
subsystem in the tree view displays its block diagram in the diagram view.
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Use the Simulink Preferences dialog box to specify whether to display
masked subsystems by default. To toggle display of masked subsystems,
select Look Under Masks from the Model browser Options submenu
of the Simulink View menu.
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The following sections explain how to use Simulink to simulate a dynamic

system.

Simulation Basics (p. 9-2)

Specifying a Simulation Start and
Stop Time (p. 9-6)

Choosing a Solver (p. 9-7)

Importing and Exporting Simulation
Data (p. 9-17)

Configuration Sets (p. 9-29)

Configuration Parameters Dialog
Box (p. 9-37)

Diagnosing Simulation Errors
(p. 9-101)

Improving Simulation Performance
and Accuracy (p. 9-105)

Running a Simulation
Programmatically (p. 9-107)

How to start, suspend, stop, interact
with, and diagnose errors in a
simulation.

How to specify the start and stop
time for a simulation.

How to select the optimal solver for
simulating a model.

How to specify options for importing
and exporting simulation data to the
MATLAB workspace.

How to specify interchangeable
sets of simulation configuration
parameters for a model.

How to use the Configuration
Parameters dialog box to specify a
simulation configuration.

How to use the Simulation
Diagnostics Viewer to diagnose
simulation errors.

Tips on improving simulation
performance and accuracy.
How to run a simulation from a

program or the MATLAB command
line.
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You can simulate a Simulink model at any time simply by clicking the Start
button on the Model Editor displaying the model (see “Starting a Simulation”
on page 9-3). However, before starting the simulation, you may want to
specify various simulation options, such as the simulation’s start and stop
time and the type of solver used to solve the model at each simulation time
step. Specifying simulation options is called configuring the model. Simulink
enables you to create multiple model configurations, called configuration sets,
modify existing configuration sets, and switch configuration sets with a click
of a mouse button (see “Configuration Sets” on page 9-29 for information on
creating and selecting configuration sets).

Once you have defined or selected a model configuration set that meets your
needs, you can start the simulation. Simulink then runs the simulation from
the specified start time to the specified stop time. While the simulation is
running, you can interact with the simulation in various ways, stop or pause
the simulation (see “Pausing or Stopping a Simulation” on page 9-4), and
launch simulations of other models. If an error occurs during a simulation,
Simulink halts the simulation and pops up a diagnostic viewer that helps you
to determine the cause of the error.

Controlling Execution of a Simulation

The Simulink graphical interface includes menu commands and toolbar
buttons that enable you to start, stop, and pause a simulation.

Note This sections explains how to run a simulation interactively. See
“Running a Simulation Programmatically” on page 9-107 for information on
running a simulation from a program or the MATLAB command line.
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Starting a Simulation

To start execution of a model, select Start from the model editor’s Simulation
menu or click the Start button on the model’s toolbar.

File Edit WYiew Simulation Format Tools Help
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To start and stop the simulation, use the *Start/Stop®
sakection in the *Simulation” pulldown meanu
Ready 100 [ [ |odets v

You can also use the keyboard shortcut, Ctrl+T, to start the simulation.

Note A common mistake that new Simulink users make is to start a
simulation while the Simulink block library is the active window. Make sure
your model window is the active window before starting a simulation.

Simulink starts executing the model at the start time specified on the

Configuration Parameters dialog box. Execution continues until the
simulation reaches the final time step specified on the Configuration
Parameters dialog box, an error occurs, or you pause or terminate the
simulation (see “Configuration Parameters Dialog Box” on page 9-37).
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While the simulation is running, a progress bar at the bottom of the model
window shows how far the simulation has progressed. A Stop command
replaces the Start command on the Simulation menu. A Pause command
appears on the menu and replaces the Start button on the model toolbar.
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Your computer beeps to signal the completion of the simulation.

Pausing or Stopping a Simulation

Select the Pause command or button to pause the simulation. Simulink
completes execution of the current time step and suspends execution of the
simulation. When you select Pause, the menu item and button change to
Continue. (The button has the same appearance as the Start button).
You can resume a suspended simulation at the next time step by choosing
Continue.

To terminate execution of the model, select the Stop command or button.
The keyboard shortcut for stopping a simulation is Ctrl+T, the same as for
starting a simulation. Simulink completes execution of the current time step
before terminating the model. Subsequently selecting the Start command
or button restarts the simulation at the first time step specified on the
Configuration Parameters dialog box.
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If the model includes any blocks that write output to a file or to the workspace,
or if you select output options on the Configuration Parameters dialog box,
Simulink writes the data when the simulation is terminated or suspended.

Interacting with a Running Simulation

You can perform certain operations interactively while a simulation is
running. You can

® Modify some configuration parameters, including the stop time and the
maximum step size

® (Click a line to see the signal carried on that line on a floating (unconnected)
Scope or Display block

® Modify the parameters of a block, as long as you do not cause a change in
= Number of states, inputs, or outputs
= Sample time
= Number of zero crossings
= Vector length of any block parameters
= Length of the internal block work vectors
= Dimension of any signals
You cannot make changes to the structure of the model, such as adding or
deleting lines or blocks, during a simulation. If you need to make these kinds

of changes, you need to stop the simulation, make the change, then start the
simulation again to see the results of the change.
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Specifying a Simulation Start and Stop Time

Simulink simulations start by default at 0.0 seconds and end at 10.0 seconds.
The Solver configuration pane allows you to specify other start and stop
times for the currently selected simulation configuration. See “Solver Pane”
on page 9-38 for more information.

Note Simulation time and actual clock time are not the same. For example,
running a simulation for 10 seconds usually does not take 10 seconds. The
amount of time it takes to run a simulation depends on many factors, including
the model’s complexity, the solver’s step sizes, and the computer’s speed.
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Choosing a Solver

A solver is a Simulink software component that determines the next time step
that a simulation needs to take to meet target accuracy requirements that you
specify. Simulink provides an extensive set of solvers, each adept at choosing
the next time step for specific types of applications. The following sections
explain how to choose the solver best suited to your application.

® “Choosing a Solver Type” on page 9-7
® “Choosing a Fixed-Step Solver” on page 9-8
® “Choosing a Variable-Step Solver” on page 9-13

For information on tailoring the selected solver to your model, see “Improving
Simulation Accuracy” on page 9-106.

Choosing a Solver Type

Simulink divides solvers into two types: fixed-step and variable-step. Both
types of solvers compute the next simulation time as the sum of the current
simulation time and a quantity known as the step size. With a fixed-step
solver, the step size remains constant throughout the simulation. By contrast,
with a variable-step solver, the step size can vary from step to step, depending
on the model’s dynamics. In particular, a variable-step solver reduces the
step size when a model’s states are changing rapidly to maintain accuracy
and increases the step size when the system’s states are changing slowly in
order to avoid taking unnecessary steps. The Type control on the Simulink
Solver configuration pane allows you to select either of these two types of
solvers (see “Solver Pane” on page 9-38).

The choice between the two types depends on how you plan to deploy your
model and the model’s dynamics. If you plan to generate code from your
model and run the code on a real-time computer system, you should choose a
fixed-step solver to simulate the model. This is because real-time computer
systems operate at fixed-size signal sample rates. A variable-step solver may
cause the simulation to miss error conditions that can occur on a real-time
computer system.

If you do not plan to deploy your model as generated code, the choice between
a variable-step and a fixed-step solver depends on the dynamics of your model.
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If your model’s states change rapidly or contain discontinuities, a variable-step
solver can shorten the time required to simulate your model significantly.
This is because, for such a model, a variable-step solver can require fewer
time steps than a fixed-step solver to achieve a comparable level of accuracy.

The following model illustrates how a variable-step solver can shorten
simulation time for a multirate discrete model.
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This model generates outputs at two different rates, every 0.5 second and
every 0.75 second. To capture both outputs, the fixed-step solver must take a
time step every 0.25 second (the fundamental sample time for the model).

[0.0 0.25 0.5 0.75 1.0 1.25 ...]

By contrast, the variable-step solver need take a step only when the model
actually generates an output.

[0.0 0.5 0.75 1.0 1.5 2.0 2.25 ...]

This significantly reduces the number of time steps required to simulate the
model.

The variable-step discrete solver uses zero-crossing detection (see
“Zero-Crossing Detection” on page 1-19) to handle continuous signals.
Simulink uses this solver by default if you specify a continuous solver and
your model has no continuous states.

Choosing a Fixed-Step Solver

When the Type control of the Solver configuration pane is set to fixed-step,
the configuration pane’s Solver control allows you to choose one of the set
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of fixed-step solvers that Simulink provides. The set of fixed-step solvers
comprises two types of solvers: discrete and continuous.

About the Fixed-Step Discrete Solver

The fixed-step discrete solver computes the time of the next time step by
adding a fixed step size to the time of the current time. The accuracy and
length of time of the resulting simulation depends on the size of the steps
taken by the simulation: the smaller the step size, the more accurate the
results but the longer the simulation takes. You can allow Simulink to choose
the size of the step size (the default) or you can choose the step size yourself.
If you allow Simulink to choose the step size, Simulink sets the step size to
the fundamental sample time of the model if the model has discrete states
or to the result of dividing the difference between the simulation start and
stop time by 50 if the model has no discrete states. This choice assures that
the simulation will hit every simulation time required to update the model’s
discrete states at the model’s specified sample times

The fixed-step discrete solver has a fundamental limitation. It cannot be
used to simulate models that have continuous states. That’s because the
fixed-step discrete solver relies on a model’s blocks to compute the values of
the states that they define. Blocks that define discrete states compute the
values of those states at each time step taken by the solver. Blocks that define
continuous states, on the other hand, rely on the solver to compute the states.
Continuous solvers perform this task. You should thus select a continuous
solver if your model contains continuous states.

Note If you attempt to use the fixed-step discrete solver to update or simulate
a model that has continuous states, Simulink displays an error message.
Thus, updating or simulating a model is a quick way to determine whether it
has continuous states.

About Fixed-Step Continuous Solvers

Simulink provides a set of fixed-step continuous solvers that, like the
fixed-step discrete solver, compute the simulation’s next time by adding a
fixed-size time step to the current time. In addition, the continuous solvers
employ numerical integration to compute the values of a model’s continuous

9-9
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states at the current step from the values at the previous step and the values
of the state derivatives. This allows the fixed-step continuous solvers to
handle models that contain both continuous and discrete states.

Note In theory, a fixed-step continuous solver can handle models that
contain no continuous states. However, that would impose an unnecessary
computational burden on the simulation. Consequently, Simulink always
uses the fixed-step discrete solver for a model that contains no states or only
discrete states, even if you specify a fixed-step continuous solver for the model.

Simulink provides two distinct types of fixed-step continuous solvers: explicit
and implicit solvers. Explicit solvers (see “Explicit Fixed-Step Continuous

Solvers” on page 9-10) compute the value of a state at the next time step as an
explicit function of the current value of the state and the state derivative, e.g.,

X(n+1) = X(n) + h * DX(n)

where X is the state, DX is the state derivative, and h is the step size. An
implicit solver (see “Implicit Fixed-Step Continuous Solvers” on page 9-12)
computes the state at the next time step as an implicit function of the state
and the state derivative at the next time step, e.g.,

X(n+1) - X(n) - h*DX(n+1) = 0

This type of solver requires more computation per step than an explicit solver
but is also more accurate for a given step size. This solver thus can be faster
than explicit fixed-step solvers for certain types of stiff systems.

Explicit Fixed-Step Continuous Solvers. Simulink provides a set of explicit
fixed-step continuous solvers. The solvers differ in the specific integration
technique used to compute the model’s state derivatives. The following table
lists the available solvers and the integration techniques they use.

Solver Integration Technique
odel Euler’s Method
ode2 Heun’s Method
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Solver Integration Technique

ode3 Bogacki-Shampine Formula

ode4 Fourth-Order Runge-Kutta (RK4) Formula
odeb Dormand-Prince Formula

The integration techniques used by the fixed-step continuous solvers trade
accuracy for computational effort. The table lists the solvers in order of the
computational complexity of the integration methods they use from least
complex (ode1) to most complex (ode5).

As with the fixed-step discrete solver, the accuracy and length of time of a
simulation driven by a fixed-step continuous solver depends on the size of the
steps taken by the solver: the smaller the step size, the more accurate the
results but the longer the simulation takes. For any given step size, the more
computationally complex the solver, the more accurate the simulation.

If you specify a fixed-step solver type for a model, Simulink sets the solver’s
model to ode3, i.e., it chooses a solver capable of handling both continuous
and discrete states with moderate computational effort. As with the discrete
solver, Simulink by default sets the step size to the fundamental sample time
of the model if the model has discrete states or to the result of dividing the
difference between the simulation start and stop time by 50 if the model has
no discrete states. This assures that the solver will take a step at every
simulation time required to update the model’s discrete states at the model’s
specified sample rates. However, it does not guarantee that the default solver
will accurately compute a model’s continuous states or that the model cannot
be simulated in less time with a less complex solver. Depending on the
dynamics of your model, you may need to choose another solver and/or sample
time to achieve acceptable accuracy or to shorten the simulation time.

9-11
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Implicit Fixed-Step Continuous Solvers. Simulink provides one solver in
this category: ode14x. This solver uses a combination of Newton’s method
and extrapolation from the current value to compute the value of a model
state at the next time step. Simulink allows you to specify the number of
Newton’s method iterations and the extrapolation order that the solver uses
to compute the next value of a model state (see “Fixed-Step Solver Options” on
page 9-43). The more iterations and the higher the extrapolation order that
you select, the greater the accuracy but also the greater the computational
burden per step size.

Choosing a Fixed-Step Continuous Solver

Any of the fixed-step continuous solvers in Simulink can simulate a model
to any desired level of accuracy, given enough time and a small enough step
size. Unfortunately, in general, it is not possible, or at least not practical, to
decide a priori which solver and step size combination will yield acceptable
results for a model’s continuous states in the shortest time. Determining the
best solver for a particular model thus generally requires experimentation.

Here is the most efficient way to choose the best fixed-step solver for your
model experimentally. First, use one of the variable-step solvers to simulate
your model to the level of accuracy that you desire. This will give you an
idea of what the simulation results should be. Next, use ode1 to simulate
your model at the default step size for your model. Compare the results of
simulating your model with ode1 with the results of simulating with the
variable-step solver. If the results are the same within the specified level of
accuracy, you have found the best fixed-step solver for your model, namely
ode1. That’s because ode1 is the simplest of the Simulink fixed-step solvers
and hence yields the shorted simulation time for the current step size.

If ode1 does not give accurate results, repeat the preceding steps with the
other fixed-step solvers until you find the one that gives accurate results with
the least computational effort. The most efficient way to do this is to use a
binary search technique. First, try ode3. If it gives accurate results, try ode2.
If ode2 gives accurate results, it is the best solver for your model; otherwise,
oded is the best. If ode3 does not give accurate results, try ode5. If ode5
gives accurate results, try ode4. If ode4 gives accurate results, select it as the
solver for your model; otherwise, select ode5.
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If ode5 does not give accurate results, reduce the simulation step size and
repeat the preceding process. Continue in this way until you find a solver that
solves your model accurately with the least computational effort.

Choosing a Variable-Step Solver

When the Type control of the Solver configuration pane is set to
variable-step, the configuration pane’s Solver control allows you to choose
one of the set of variable-step solvers that Simulink provides. As with
fixed-step solvers in Simulink, the set of variable-step solvers comprises a
discrete solver and a subset of continuous solvers. Both types compute the
time of the next time step by adding a step size to the time of the current
time that varies depending on the rate of change of the model’s states. The
continuous solvers, in addition, use numerical integration to compute the
values of the model’s continuous states at the next time step. Both types of
solvers rely on blocks that define the model’s discrete states to compute the
values of the discrete states that each defines.

The choice between the two types of solvers depends on whether the blocks
in your model defines states and, if so, the kind of states that they define. If
your model defines no states or defines only discrete states, you should select
the discrete solver. In fact, if a model has no states or only discrete states,
Simulink will use the discrete solver to simulate the model even if the model
specifies a continuous solver.

About Variable-Step Continuous Solvers

Simulink variable-step solvers vary the step size during the simulation,
reducing the step size to increase accuracy when a model’s states are changing
rapidly and increasing the step size to avoid taking unnecessary steps when
the model’s states are changing slowly. Computing the step size adds to the
computational overhead at each step but can reduce the total number of steps,
and hence simulation time, required to maintain a specified level of accuracy
for models with rapidly changing or piecewise continuous states.

Simulink provides the following variable-step continuous solvers:
® ode45 is based on an explicit Runge-Kutta (4,5) formula, the

Dormand-Prince pair. It is a one-step solver; that is, in computing y (t,), it
needs only the solution at the immediately preceding time point, y(t ;). In
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general, ode45 is the best solver to apply as a first try for most problems.
For this reason, ode45 is the default solver used by Simulink for models
with continuous states.

ode23 is also based on an explicit Runge-Kutta (2,3) pair of Bogacki and
Shampine. It can be more efficient than ode45 at crude tolerances and in
the presence of mild stiffness. 0de23 is a one-step solver.

ode113 is a variable-order Adams-Bashforth-Moulton PECE solver. It can
be more efficient than ode45 at stringent tolerances. ode113 is a multistep
solver; that is, it normally needs the solutions at several preceding time
points to compute the current solution.

ode15s is a variable-order solver based on the numerical differentiation
formulas (NDFs). These are related to but are more efficient than the
backward differentiation formulas, BDFs (also known as Gear’s method).
Like ode113, ode15s is a multistep method solver. If you suspect that a
problem is stiff, or if ode45 failed or was very inefficient, try ode15s.

0de23s is based on a modified Rosenbrock formula of order 2. Because it is
a one-step solver, it can be more efficient than ode15s at crude tolerances.
It can solve some kinds of stiff problems for which ode15s is not effective.

ode23t is an implementation of the trapezoidal rule using a “free”
interpolant. Use this solver if the problem is only moderately stiff and you
need a solution without numerical damping.

ode23tb is an implementation of TR-BDF2, an implicit Runge-Kutta
formula with a first stage that is a trapezoidal rule step and a second stage
that is a backward differentiation formula of order two. By construction,
the same iteration matrix is used in evaluating both stages. Like ode23s,
this solver can be more efficient than ode15s at crude tolerances.

Note For a stiff problem, solutions can change on a time scale that is very
short compared to the interval of integration, but the solution of interest
changes on a much longer time scale. Methods not designed for stiff
problems are ineffective on intervals where the solution changes slowly
because they use time steps small enough to resolve the fastest possible
change. Jacobian matrices are generated numerically for ode15s and
ode23s. For more information, see Shampine, L. F., Numerical Solution of
Ordinary Differential Equations, Chapman & Hall, 1994.
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Specifying Variable-Step Solver Error Tolerances

The solvers use standard local error control techniques to monitor the error at
each time step. During each time step, the solvers compute the state values
at the end of the step and also determine the local error, the estimated error
of these state values. They then compare the local error to the acceptable
error, which is a function of the relative tolerance (rtol) and absolute tolerance
(atol). If the error is greater than the acceptable error for any state, the solver
reduces the step size and tries again:

® Relative tolerance measures the error relative to the size of each state. The
relative tolerance represents a percentage of the state’s value. The default,
le-3, means that the computed state is accurate to within 0.1%.

o Absolute tolerance is a threshold error value. This tolerance represents the
acceptable error as the value of the measured state approaches zero.

The error for the ith state, e, is required to satisfy
e, = maxirtol = |.1;I-|,a,£o.f:-3
The following figure shows a plot of a state and the regions in which the

acceptable error is determined by the relative tolerance and the absolute
tolerance.
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If you specify auto (the default), Simulink sets the absolute tolerance for
each state initially to 1e-6. As the simulation progresses, Simulink resets the
absolute tolerance for each state to the maximum value that the state has
assumed thus far times the relative tolerance for that state. Thus, if a state
goes from 0 to 1 and reltol is le-3, then by the end of the simulation the
abstol is set to 1le-3 also. If a state goes from 0 to 1000, then the abstol is
set to 1.
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If the computed setting is not suitable, you can determine an appropriate
setting yourself. You might have to run a simulation more than once to
determine an appropriate value for the absolute tolerance.

The Integrator, Transfer Fcn, State-Space, and Zero-Pole blocks allow you

to specify absolute tolerance values for solving the model states that they
compute or that determine their output. The absolute tolerance values that
you specify for these blocks override the global settings in the Configuration
Parameters dialog box. You might want to override the global setting in this
way, if the global setting does not provide sufficient error control for all of your
model’s states, for example, because they vary widely in magnitude.
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Importing and Exporting Simulation Data

Simulink allows you to import input signal and initial state data from the
MATLAB workspace and export output signal and state data to the MATLAB
workspace during simulation. This capability allows you to use standard or
custom MATLAB functions to generate a simulated system’s input signals
and to graph, analyze, or otherwise postprocess the system’s outputs. See the
following sections for more information:

* “Importing Data from the MATLAB Workspace” on page 9-17

e “Exporting Data to the MATLAB Workspace” on page 9-22
* “‘Importing and Exporting States” on page 9-24

Importing Data from the MATLAB Workspace

Simulink can apply input from a model’s base workspace to the model’s
top-level input ports during a simulation run. To specify this option, select the
Input box in the Load from workspace area of the Data Import/Export
pane (see “Data Import/Export Pane” on page 9-48). Then, enter an external
input specification (see “Importing Data Arrays” on page 9-17) in the adjacent
edit box and click Apply.

The input data can take any of the following forms:

® array—see “Importing Data Arrays” on page 9-17

® time expression—see “Using a MATLAB Time Expression to Import Data”
on page 9-18

® structure-see “Importing Data Structures” on page 9-19
® time series—see “Importing Time-Series Data” on page 9-21

Simulink linearly interpolates or extrapolates input values as necessary if the
Interpolate data option is selected for the corresponding Inport.

Importing Data Arrays

This import format consists of a real (noncomplex) matrix of data type double.
The first column of the matrix must be a vector of times in ascending order.
The remaining columns specify input values. In particular, each column
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represents the input for a different Inport block signal (in sequential order)
and each row is the input value for the corresponding time point.

The total number of columns of the input matrix must equal n + 1, where n is
the total number of signals entering the model’s input ports.

The default input expression for a model is [t,u] and the default input
format is Array. So if you define t and u in the base workspace, you need only
select the Input option to input data from the model’s base workspace. For
example, suppose that a model has two input ports, one of which accepts two
signals and the other of which accepts one signal. Also, suppose that the base
workspace defines u and t as follows:

t = (0:0.1:1)";
[sin(t), cos(t), 4*cos(t)];

c
I

Note The array input format allows you to load only real (noncomplex) scalar
or vector data of type double. Use the structure format to input complex data,
matrix (2-D) data, and/or data types other than double.

Using a MATLAB Time Expression to Import Data

You can use a MATLAB time expression to import data from the MATLAB
workspace. To use a time expression, enter the expression as a string (i.e.,
enclosed in single quotes) in the Input field of the Data Import/Export
pane. The time expression can be any MATLAB expression that evaluates to a
row vector equal in length to the number of signals entering the model’s input
ports. For example, suppose that a model has one vector Inport that accepts
two signals. Furthermore, suppose that timefcn is a user-defined function
that returns a row vector two elements long. The following are valid input
time expressions for such a model:

"[3*sin(t), cos(2*t)]'
"4*timefcn(w*t)+7"
Simulink evaluates the expression at each step of the simulation, applying the

resulting values to the model’s input ports. Note that Simulink defines the
variable t when it runs the simulation. Also, you can omit the time variable
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in expressions for functions of one variable. For example, Simulink interprets
the expression sin as sin(t).

Importing Data Structures

Simulink can read data from the workspace in the form of a structure whose
name is specified in the Input text field. You can import structures that
include only signal data or both signal and time data.

Importing signal-and-time data structures. To import structures that
include both signal and time data, select the Structure with time option on
from the Format list on the Data Import/Export pane. The input structure
must have two top-level fields: time and signals. The time field contains a
column vector of the simulation times. The signals field contains an array of
substructures, each of which corresponds to a model input port.

Each signals substructure must contain two fields named values and
dimensions, respectively. The values field must contain an array of inputs
for the corresponding input port where each input corresponds to a time point
specified by the time field. The dimensions field specifies the dimensions of
the input. If each input is a scalar or vector (1-D array) value, the dimensions
field must be a scalar value that specifies the length of the vector (1 for a
scalar). If each input is a matrix (2-D array), the dimensions field must be a
two-element vector whose first element specifies the number of rows in the
matrix and whose second element specifies the number of columns.

Note You must set the Port dimensions parameter of the Inport to be the
same value as the dimensions field of the corresponding input structure. If
the values differ, Simulink stops and displays an error message when you try
to simulate the model.

If the inputs for a port are scalar or vector values, the values field must be
an M-by-N array where M is the number of time points specified by the time
field and N is the length of each vector value. For example, the following code
creates an input structure for loading 11 time samples of a two-element signal
vector of type int8 into a model with a single input port:

9-19



9 Running Simulations

9-20

a.time = (0:0.1:1)';

cl = int8([0:1:10]");

c2 = int8([0:10:100]"');
a.signals(1).values = [c1 c2];
a.signals(1).dimensions = 2;

To load this data into the model’s input port, you would select the Input option
on the Data Import/Export pane and enter a in the input expression field.

If the inputs for a port are matrices (2-D arrays), the values field must be an
M-by-N-by-T array where M and N are the dimensions of each matrix input
and T is the number of time points. For example, suppose that you want

to input 51 time samples of a 4-by-5 matrix signal into one of your model’s
input ports. Then, the corresponding dimensions field of the workspace
structure must equal [4 5] and the values array must have the dimensions
4-by-5-by-51.

As another example, consider the following model, which has two inputs.

In1

Seope

In2

Suppose that you want to input a sine wave into the first port and a cosine
wave into the second port. To do this, define a vector, a, as follows, in the
base workspace:

a.time = (0:0.1:1)"';
a.signals(1).values = sin(a.time);
a.signals(1).dimensions = 1;
a.signals(2).values = cos(a.time);
a.signals(2).dimensions = 1;

Select the Input box for this model, enter a in the adjacent text field, and
select StructureWithTime as the I/O format.
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Importing Signal-Only Structures. The Structure format is the same as
the Structure with time format except that the time field is empty. For
example, in the preceding example, you could set the time field as follows:

a.time = []

In this case, Simulink reads the input for the first time step from the first
element of an input port’s value array, the value for the second time step from
the second element of the value array, etc.

Per-Port Structures. This format consists of a separate structure-with-time
or structure-without-time for each port. Each port’s input data structure

has only one signals field. To specify this option, enter the names of the
structures in the Input text field as a comma-separated list, in1, in2,...,
inN, where in1 is the data for your model’s first port, in2 for the second input
port, and so on.

Importing Time-Series Data

Any root-level Inport block can import data specified by a time-series object
(see Simulink.Timeseries) residing in the MATLAB workspace. In addition,
any root-level input port defined by a bus object (see Simulink.Bus) can
import data from a time-series array object (see Simulink.TSArray) that has
the same structure as the bus object.

This capability allows you to import data logged by a previous simulation run
(see “Logging Signals” on page 5-34). For example, suppose that you have a
model that references several other models. You could use data logged from
the inputs of the referenced models when simulating the top model as inputs
for the referenced models simulated by themselves. This allows you to test
the referenced models independently of the top model and each other.

To import data from time-series and time-series array objects, enter a
comma-separated list of variables or expressions that evaluate to the objects
in the Input edit field on the Data Import/Export pane of the Configuration
Parameters dialog box (see “Configuration Parameters Dialog Box” on page
9-37). Each item in the Input list corresponds to one of the model’s root-level
input ports, with the first item corresponding to the first root-level input port,
the second to the second root-level input port, and so on.
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Exporting Data to the MATLAB Workspace

You can specify return variables by selecting the Time, States, and/or
Output check boxes in the Save to workspace area of this dialog box pane.
Specifying return variables causes Simulink to write values for the time,
state, and output trajectories (as many as are selected) into the workspace.

To assign values to different variables, specify those variable names in the
fields to the right of the check boxes. To write output to more than one
variable, specify the variable names in a comma-separated list. Simulink
saves the simulation times in the vector specified in the Save to workspace
area.

Note Simulink saves the output to the workspace at the base sample rate of
the model. Use a To Workspace block if you want to save output at a different
sample rate.

The Save options area enables you to specify the format and restrict the
amount of output saved.

Format options for model states and outputs are listed below.

Format Options

Array. If you select this option, Simulink saves a model’s states and outputs
in a state and output array, respectively.

The state matrix has the name specified in the Save to workspace area (for
example, xout). Each row of the state matrix corresponds to a time sample
of the model’s states. Each column corresponds to an element of a state. For
example, suppose that your model has two continuous states, each of which
is a two-element vector. Then the first two elements of each row of the state
matrix contains a time sample of the first state vector. The last two elements
of each row contain a time sample of the second state vector.

The model output matrix has the name specified in the Save to workspace
area (for example, yout). Each column corresponds to a model output port,
each row to the outputs at a specific time.
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Note You can use array format to save your model’s outputs and states only
if the outputs are either all scalars or all vectors (or all matrices for states),
are either all real or all complex, and are all of the same data type. Use the
Structure or StructureWithTime output formats (see “Structure with time”
on page 9-23) if your model’s outputs and states do not meet these conditions.

Structure with time. If you select this format, Simulink saves the model’s
states and outputs in structures having the names specified in the Save to
workspace area (for example, xout and yout).

The structure used to save outputs has two top-level fields: time and signals.
The time field contains a vector of the simulation times. The signals field
contains an array of substructures, each of which corresponds to a model
output port. Each substructure has four fields: values, dimensions, label,
and blockName. The values field contains the outputs for the corresponding
output port. If the outputs are scalars or vectors, the values field is a
matrix each of whose rows represents an output at the time specified by the
corresponding element of the time vector. If the outputs are matrix (2-D)
values, the values field is a 3-D array of dimensions M-by-N-by-T where
M-by-N is the dimensions of the output signal and T is the number of output
samples. If T = 1, MATLAB drops the last dimension. Therefore, the values
field is an M-by-N matrix. The dimensions field specifies the dimensions of
the output signal. The label field specifies the label of the signal connected to
the output port or the type of state (continuous or discrete). The blockName
field specifies the name of the corresponding output port or block with states.

The structure used to save states has a similar organization. The states
structure has two top-level fields: time and signals. The time field contains
a vector of the simulation times. The signals field contains an array

of substructures, each of which corresponds to one of the model’s states.
Each signals structure has four fields: values, dimensions, label, and
blockName. The values field contains time samples of a state of the block
specified by the blockName field. The label field for built-in blocks indicates
the type of state: either CSTATE (continuous state) or DSTATE (discrete state).
For S-Function blocks, the label contains whatever name is assigned to the
state by the S-Function block.
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The time samples of a state are stored in the values field as a matrix of
values. Each row corresponds to a time sample. Each element of a row
corresponds to an element of the state. If the state is a matrix, the matrix is
stored in the values array in column-major order. For example, suppose that
the model includes a 2-by-2 matrix state and that Simulink logs 51 samples
of the state during a simulation run. The values field for this state would
contain a 51-by-4 matrix where each row corresponds to a time sample of the
state and where the first two elements of each row correspond to the first
column of the sample and the last two elements correspond to the second
column of the sample.

Note Simulink can read back simulation data saved to the workspace in the
Structure with time output format. See “Importing signal-and-time data
structures” on page 9-19 for more information.

Structure. This format is the same as the preceding except that Simulink
does not store simulation times in the time field of the saved structure.

Per-Port Structures. This format consists of a separate structure-with-time
or structure-without-time for each output port. Each output data structure
has only one signals field. To specify this option, enter the names of

the structures in the Output text field as a comma-separated list, out1,
out2,..., outN, where out1 is the data for your model’s first port, out2

for the second input port, and so on.

Importing and Exporting States

Simulink allows you to import the initial values of a system’s states, i.e., its
initial conditions, at the beginning of a simulation and save the final values
of the states at the end of the simulation. This feature allows you to save a
steady-state solution and restart the simulation at that known state.

Saving Final States

To save the final values of a model’s states, checkFinal states in the Save to
workspace area of the Data Import/Export pane and enter a name in the

adjacent edit field. Simulink saves the states in a workspace variable having
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the specified name. The saved data has the format that you specify in the
Save options area of the Data Import/Export pane.

When saving states from a referenced model in the structure-with-time

format, Simulink adds a boolean subfield named inReferencedModel to the
signals field of the saved data structure. This field’s value is true (1) if the
signals field records the final state of a block that resides in the submodel,

e.g.,

>> xout.signals(1)
ans =

values: [101x1 double]
dimensions: 1
label: 'DSTATE'
blockName: [1x66 char]
inReferencedModel: 1

If the signals field records a submodel state, its blockName subfield contains a
compound path comprising a top model path and a submodel path. The top
model path is the path from the model root to the Model block that references
the submodel. The submodel path is the path from the submodel root to the
block whose state the signals field records. The compound path uses a |
character to separate the top and submodel paths, e.g.,

>> xout.signals(1).blockName
ans =

sldemo_mdlref basic/CounterA|sldemo_mdlref counter/Previous Output

Loading Initial States

To load states, check Initial state in the Load from workspace area of the
Data Import/Export pane and specify the name of a variable that contains
the initial state values, for example, a variable containing states saved from a
previous simulation. The initial values specified by the workspace variable
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override the initial values specified by the model itself, i.e., the values
specified by the initial condition parameters of those blocks in the model
that have states.

Note You must use the structure or structure-with-time format to initialize
the states of a top model and the models that it references.

Limiting Output

Saving data to the workspace can slow down the simulation and consume
memory. To avoid this, you can limit the number of samples saved to the
most recent samples or you can skip samples by applying a decimation
factor. To set a limit on the number of data samples saved, select the check
box labeled Limit data points to last and specify the number of samples
to save. To apply a decimation factor, enter a value in the field to the right
of the Decimation label. For example, a value of 2 saves every other point
generated.

Specifying Output Options

The Output options list on the Data Import/Export configuration pane
(“Data Import/Export Pane” on page 9-48) enables you to control how much
output the simulation generates. You can choose from three options:

® Refine output
® Produce additional output

® Produce specified output only

Refining Output

The Refine output choice provides additional output points when the
simulation output is too coarse. This parameter provides an integer number
of output points between time steps; for example, a refine factor of 2 provides
output midway between the time steps, as well as at the steps. The default
refine factor is 1.

To get smoother output, it is much faster to change the refine factor instead of
reducing the step size. When the refine factor is changed, the solvers generate
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additional points by evaluating a continuous extension formula at those
points. Changing the refine factor does not change the steps used by the solver.

The refine factor applies to variable-step solvers and is most useful when you
are using ode45. The ode45 solver is capable of taking large steps; when
graphing simulation output, you might find that output from this solver is not
sufficiently smooth. If this is the case, run the simulation again with a larger
refine factor. A value of 4 should provide much smoother results.

Note This option helps the solver to locate zero crossings (see “Zero-Crossing
Detection” on page 1-19).

Producing Additional Output

The Produce additional output choice enables you to specify directly those
additional times at which the solver generates output. When you select this
option, Simulink displays an Qutput times field on the Data Import/Export
pane. Enter a MATLAB expression in this field that evaluates to an additional
time or a vector of additional times. The additional output is produced using a
continuous extension formula at the additional times. Unlike the refine factor,
this option changes the simulation step size so that time steps coincide with
the times that you have specified for additional output.

Producing Specified Output Only

The Produce specified output only choice provides simulation output
only at the specified output times. This option changes the simulation step
size so that time steps coincide with the times that you have specified for
producing output. This choice is useful when you are comparing different
simulations to ensure that the simulations produce output at the same times.
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Comparing Output Options
A sample simulation generates output at these times:

0, 2.5, 5, 8.5, 10

Choosing Refine output and specifying a refine factor of 2 generates output
at these times:

0, 1.25, 2.5, 3.75, 5, 6.75, 8.5, 9.25, 10

Choosing the Produce additional output option and specifying [0:10]
generates output at these times

o, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10

and perhaps at additional times, depending on the step size chosen by the
variable-step solver.

Choosing the Produce specified output only option and specifying [0:10]
generates output at these times:

o, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10
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Configuration Sets

A configuration set is a named set of values for a model’s parameters, such
as solver type and simulation start or stop time. Every new model is created
with a default configuration set, called Configuration, that initially specifies
default values for the model’s parameters. You can subsequently create and
modify additional configuration sets and associate them with the model. The
sets associated with a model can each specify different values for any given
model parameter.

Configuration Set Components
A configuration set comprises groups of related parameters called components.

Every configuration set includes the following components:

® Solver

¢ Data Import/Export

® Optimization

® Diagnostics

® Hardware Implementation

® Model Referencing

Some Simulink-based products, such as Real-Time Workshop, define

additional components. If such a product is installed on your system, the
configuration set also contains the components that it defines.

The Active Set

Only one of the configuration sets associated with a model is active at any
given time. The active set determines the current values of the model’s model
parameters. Changing the value of a parameter in the Model Explorer
changes its value in the active set. Simulink allows you to change the
active set at any time (except when executing the model). In this way, you
can quickly reconfigure a model for different purposes, e.g., testing and
production, or apply standard configuration settings to new models.
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Displaying Configuration Sets

To display the configuration sets associated with a model, open the Model
Explorer (see “The Model Explorer” on page 8-2). The configuration sets
associated with the model appear as gear-shaped nodes in the Model
Explorer’s Model Hierarchy pane.

(onfiguration Set

E& Model Explorer (=] 9]
File Edit Yiew Tools Add Help

[D@[smaxEMEN:s0 @0 4n||[ewaza
JJSearch: Iby Elock Type LI Type: IFCD/I LI % Search ‘

Model Hierarchy | Contents of: wdp/Configuration
- [E8]Simuiink Root
ﬁ Base Workspace
E"ngp D ata Import/E wpork
ﬁModeIW’orkspace & Dptimization
%Eonfiguration [Active] @ Diagnostics
@Eodg for wdp 8 Hardware Implementation
: @Adwce for wdp & Model Referencing IfOutDfD ate0rStucturalChange
;----%’Morelnfo & Real Time warkshop
P Moare Info3
4] I i

.| Contents Igearch Results I

4

The Model Explorer’s Contents pane displays the components of the selected
configuration set. The Model Explorer’s Dialog pane display a dialog for

setting the parameters of the selected group (see “Configuration Parameters
Dialog Box” on page 9-37).

Activating a Configuration Set

To activate a configuration set, right-click the configuration set’s node to
display the node’s context menu, then select Activate from the context menu.
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Copying, Deleting, and Moving Configuration Sets

You can use edit commands on the Model Explorer’s Edit or context menus
or object drag-and-drop operations to delete, copy, or move configuration sets
among models displayed in the Model Explorer’s Model Hierarchy pane.

For example, to copy a configuration set, using edit commands:

1 Select the configuration set that you want to copy in the Model Hierarchy
pane.

2 Select Copy from the Model Explorer’s Edit menu or the configuration
set’s context menu or press Ctrl+C.

3 Select the model in which you want to create the copy

Note You can create a copy in the same model as the original.

4 Select Paste from the Model Explorer’s Edit menu or from the model’s
context menu or press Ctrl+V.

To copy the configuration set, using object drag-and-drop, hold the Ctrl key
and the right mouse button down and drag the configuration set’s node

to the node of the model in which you want to create the copy. To move a
configuration set from one model to another, using drag-and-drop, hold the
Ctrl key and the left mouse button down and drag the configuration set’s node
to the node of the destination model.

Note You cannot move or delete a model’s active configuration set.

Copying Configuration Set Components
To copy a configuration set component from one configuration set to another:

1 Select the component in the Model Explorer’s Contents pane.

2 Select Copy from the Model Explorer’s Edit menu or the component’s
context menu or press Ctrl+C.
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3 Select the configuration set into which you want to copy the component.

4 Select Paste from the Model Explorer’s Edit menu or the component’s
context menu or press Ctrl+C.

Note The copy replaces the component of the same name in the destination
configuration set. For example, if you copy the Solver component of
configuration set A and paste it into configuration set B, the copy replaces
B’s existing Solver component.

Creating Configuration Sets
To create a new configuration set, copy an existing configuration set.

Setting Values in Configuration Sets

To set the value of a parameter in a configuration set, select the configuration
set in the Model Explorer and then edit the value of the parameter on the
corresponding dialog in the Model Explorer’s dialog view.

Configuration Set API

Simulink provides an application program interface (API) that permits you
to create and manipulate configuration sets from the command line or in a
MAT-file or M-file. The API includes the Simulink.ConfigSet data object
class and the following model construction commands:

® attachConfigSet

® getConfigSet

® getConfigSets

® setActiveConfigSet

® getActiveConfigSet

These commands, along with the methods and properties of

Simulink.ConfigSet class, allows an M-file program to create and modify
configuration sets, attach configuration sets to a model, and set a model’s
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active configuration set. For example, to create a configuration set from
scratch at the command line, enter

cfg_set = Simulink.ConfigSet

The default name of the new configuration set is Configuration. To change
the name, execute

cfg_set.Name = 'name'’
where name is the set’s new name.

Use get_param and set_param to get and set the value of a parameter in a
configuration set. For example, to specify the Simulink fixed-step discrete
solver in the configuration set, execute

set_param(cfg_set, 'Solver', 'FixedStepDiscrete')

To save the configuration set in a MAT-file, execute

save mat_file cfg_set

where mat_file is the name of the MAT-file. To load the configuration set,
execute

load mat_file

To prevent or allow a user to change the value of a parameter in a
configuration set, execute

setPropEnabled(cfg_set, 'param’, [0 | 1])

where param is the name of the parameter. To attach a configuration set to
a model, execute

attachConfigSet (model, cfg_set)
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where model is the model name (in quotes) or object. To get a model’s active
configuration set, execute

cfg_set = getActiveConfigSet (model)

To get a configuration set’s full name (e.g., 'engine/Configuration'), execute

getFullName (cfg_set)

To set a model’s active set, execute

setActiveConfigSet (model, 'cfg_set_name')

where cfg_set_name is the configuration set’s name.

Model Configuration Dialog Box
The Model Configuration dialog box appears when you select a model
configuration in the Model Explorer.

Confi ion P - wdp/C
Model Configuration

The Canfiguration is a set of ‘Configuration Components' that individually define specific
seftings for a particular model's execution (simulation) and/or deployment (code
generation. A given madel can havs more than one Configuiation associated with it
Different Configuations can be custemized for the different phases of model
development. The "Active’ Configuration is used for curient operation simulation or code
generatian) on the madel. Only one Configuration is active at a time

Configuration Name: ‘Configuration’
Associated Model:  vdp
Is Active: yes

Name: [Configuration

Simulation mode: [ nomal |

Desciption

Fevert Help Apply

N

The dialog box has the following fields.
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Name

Name of the configuration. You can change the name of the configuration
by editing this field.

Simulation mode

The simulation mode used to simulate the model in this configuration. The
options are normal (“Simulation Basics” on page 9-2), accelerator (see “The
Simulink Accelerator” on page 13-2), or external mode (see the “Real-Time
Workshop User’s Guide”).

Description
A description of this configuration. You can use this field to enter information
pertinent to using this configuration.

Model Configuration Preferences Dialog Box

The Model Configuration Preferences dialog box allows you to specify the
settings for the configuration parameters of newly created models. The dialog
box appears when you select Configuration Preferences under the Simulink
Root node in the Model Hierarchy pane of the Model Explorer.

Configuration Parameters: DefaultBlockDiagram/Configuration Preferences

Model Configuration Preferences

The Canfiguration Preferences under Simulink Fiact is the template for the
configuration set of new models created. Within this MATLAB session, any changes
made in this configuration st will sutomatically propagats ta the configuiation set of &
new model created alfterwards. Saved preferences will be automatically loaded inta
memory at the start of next MATLA session.

Name: [Configuration Preferences

Simulation mode: [ nomal =

Desciption

Save preferences | Restoreto default preferences | Azstore to saved preferences
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The dialog box has the following fields.

Name

Name of the model preferences configuration. You can change the name of
the configuration by editing this field.

Simulation mode

The preferred mode used to simulate a model. The options are normal
(“Simulation Basics” on page 9-2), accelerator (see “The Simulink
Accelerator” on page 13-2), or external mode (see the “Real-Time Workshop
User’s Guide”).

Description
A description of the model configuration preferences. You can use this field
to enter information pertinent to the preferences.

Save Preferences
Select this button to save the current configuration preferences.

Restore to Default Preferences

Select this button to restore the default configuration settings for creating
new models.

Restore to Saved Preferences

Select this button to restore the preferences to the settings in effect the last
the preferences were saved. This option overrides any changes that you have
made to the preferences since the beginning of the session or since the last
time the preferences were restored.
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Configuration Parameters Dialog Box

The Configuration Parameters dialog box allows you to modify settings for
a model’s active configuration set (see “Configuration Sets” on page 9-29).

Note You can also use the Model Explorer to modify settings for the active
configuration set as well as for any other configuration set. See “The Model
Explorer” on page 8-2 for more information.

To display the dialog box, select Configuration Parameters from the model
editor’s Simulation or context menu. The dialog box appears.

Select: — Simulation time
= Start time: {0.0 Stop time: |2U
a [mport/E sport
-0 Ptlmlzat,mn —Solver optiohs
[=- Diagrostics
- Sampls Time Type: | Variable-step | Solver: | oded5 (Dormand-Prince) =l
Data Intggrlty M ax step size: Iauto Relative tolerance: I‘I &3
i Corrverzian _ _
L. Cannectivity Min step size: Iauto Absolute tolerance: I‘I ef
Cormpatibility Initial step size: Iauto
- hodel Referencing .
- £ trol: i
- Hardware [mplementation #10 CI033INg Gontra I Use local settings LI
- M odel Referencing

The dialog box groups the controls used to set the configuration parameters
into various categories. To display the controls for a specific category, click the
category in the Select tree on the left side of the dialog box.

See the following sections for information on how to use the various categories
of controls to set configuration parameters for the active configuration set:

® “Solver Pane” on page 9-38

* “Data Import/Export Pane” on page 9-48

e “ Optimization Pane” on page 9-53

* “Diagnostics Pane” on page 9-67

¢ “Hardware Implementation Pane” on page 9-92

9-37



9 Running Simulations

® “Model Referencing Pane” on page 9-96

In most cases, Simulink does not immediately apply a change that you have
made with a control. To apply a change, you must click either the OK or
the Apply button at the bottom of the dialog box. The OK button applies
all the changes you made and dismisses the dialog box. The Apply button
applies the changes but leaves the dialog box open so that you can continue
to make changes.

Note Each of the controls on the Configuration Parameters dialog box
correspond to a configuration parameter that you can set via the sim and
simset commands. “Model Parameters” in "Model and Block Parameters" in
“Simulink Reference” lists these parameters. This section also specifies for
each configuration parameter the Configuration Parameters dialog box
prompt of the control that sets it. This allows you to determine the model
parameter corresponding to a control on the Configuration Parameters
dialog box.

Solver Pane

The Solver configuration parameters pane allows you to specify a simulation
start and stop time and select and configure a solver for a particular
simulation configuration.

r— Simulation time:

Start time: [0.0 Stap time: |20

—Salver options

Type: I Yarnable-step ;I Solver: I oded5 [Dormand-Prince) LI
b aw step size: Iaulo Relative tolerance: |1 &3

Min step size: Iauto Abszolute tolerance: |1 ek

Initial step size: Iaulo

Zero crozzing contral: I Usze local settings LI

The Solver pane contains the following control groups.

9-38



Configuration Parameters Dialog Box

Simulation time

This control group enables you to specify the simulation start and stop time.
It contains the following controls.

Start time. Specifies the simulation start time. The default start time is
0.0 seconds.

Stop time. Specifies the simulation stop time. The default stop time is 10.0
seconds. Specify inf to cause the simulation to run until you pause or stop it.

Simulation time and actual clock time are not the same. For example, running
a simulation for 10 seconds usually does not take 10 seconds. The amount

of time it takes to run a simulation depends on many factors, including the
model’s complexity, the solver’s step sizes, and the computer’s speed.

Solver Options

The Solver options controls group allows you to specify the type of solver to
be used and simulation options specific to that solver.

—Solver optiohs
Type: IValiabIe-step LI Solver: I oded5 [Dormand-Frince) LI
I aw step size: Iauto Relative tolerance: I‘I o]
Min step size: Iauto Absolute tolerance; I‘I ef
Imitial step size: Iauto
Zeqo crozsing contral: | lJze local settings ;I

The contents of the group depends on the solver type.

General Solver Options
The follow options always appear.

Type. Specifies the type of solver to be used to solve the currently selected
model, either Fixed-step or Variable-step. See “Choosing a Solver Type”
on page 9-7 and “Improving Simulation Performance and Accuracy” on page
9-105 for information on how to choose the solver type that best suits your
application.
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Solver. Specifies the solver used to simulate this configuration of the current
model. The associated pull-down list displays available solvers of the type
specified by the Type control. To specify another solver of the specified

type, select the solver from the pull-down list. See “Choosing a Fixed-Step
Solver” on page 9-8 and “Choosing a Variable-Step Solver” on page 9-13 for
information on how to choose the solvers listed in the Solver list.

The other controls that appear in this group depend on the type of solver
you have selected.

Variable-Step Discrete Solver Options
The following options appear when you select the Simulink variable-step
discrete solver.

Salver options
Type: I Wariable-step LI Salver: I dizcrete [no continuous states) LI
Max step size: Iauto
Zera crozzing contral: I |Jze local settings LI

Max step size. Appears only if the solver Type is Variable-step. Specifies
the largest time step the selected variable-step solver can take. The default
auto causes Simulink to choose the model’s shortest sample time as the
maximum step size.

Zero crossing control. Enables zero-crossing detection during variable-step
simulation of the model. For most models, this speeds up simulation by
enabling the solver to take larger time steps. If a model has extreme dynamic
changes, disabling this option can speed up the simulation but can also
decrease the accuracy of simulation results. See “Zero-Crossing Detection”
on page 1-19 for more information.

You can override this optimization on a block-by-block basis for the following
types of blocks:

Abs Integrator Step
Backlash MinMax Switch
Dead Zone Relay Switch Case
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Enable Relational Operator Trigger
Hit Crossing Saturation
If Sign

To override zero-crossing detection for an instance of one of these blocks, open
the block’s parameter dialog box and uncheck the Enable zero crossing
detection option. You can enable or disable zero-crossing selectively for
these blocks only if you have selected the Use local settings setting of the
Zero crossing control control on the Solver pane of the Configuration
Parameters dialog box.

Variable-Step Continuous Solver Options

The following options appear when you select any of the Simulink
variable-step continuous solvers.

—Solver optionz
Type: IVariabIe-step ;I Soalver: I oded5 [Darmand-Prince] LI
Max step size: Iauto Relative tolerance: |1 &3
Min gtep size: Iauto Absolute tolerance: |1 ef
Initial step gize: Iauto
Zero crossing control: I |Jze local settings ;I

Max step size. Specifies the largest time step the solver can take. The
default is determined from the start and stop times. If the stop time equals
the start time or is inf, Simulink chooses 0.2 sec. as the maximum step size.
Otherwise, it sets the maximum step size to

t —

h _ stop start
max 50

Generally, the default maximum step size is sufficient. If you are concerned
about the solver’s missing significant behavior, change the parameter to
prevent the solver from taking too large a step. If the time span of the
simulation is very long, the default step size might be too large for the solver
to find the solution. Also, if your model contains periodic or nearly periodic
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behavior and you know the period, set the maximum step size to some fraction
(such as 1/4) of that period.

In general, for more output points, change the refine factor, not the maximum
step size. For more information, see “Output options” on page 9-51.

Initial step size. By default, the solver selects an initial step size by
examining the derivatives of the states at the start time. If the first step size
is too large, the solver might step over important behavior. The initial step
size parameter is a suggested first step size. The solver tries this step size but
reduces it if error criteria are not satisfied.

Min step size. This option appears only for variable-step continuous solvers.
Specifies the smallest time step the selected variable-step solver can take. If
the solver needs to take a smaller step to meet error tolerances, it issues a
warning indicating the current effective relative tolerance. This parameter
can be either a real number greater than zero or a two-element vector where
the first element is the minimum step size and the second element is the
maximum number of minimum step size warnings to be issued before issuing
an error. Setting the second element to zero results in an error the first time
the solver must take a step smaller than the specified minimum. This is
equivalent to changing the minimum step size violation diagnostic to error
on the Diagnostics pane. Setting the second element to -1 results in an
unlimited number of warnings. This is also the default if the input is a scalar.
The default values for this parameter are a minimum step size on the order of
machine precision and an unlimited number of warnings.

Relative tolerance. Relative tolerance for this solver (see “Specifying
Variable-Step Solver Error Tolerances” on page 9-15).

Absolute tolerance. Absolute tolerance for this solver (see “Specifying
Variable-Step Solver Error Tolerances” on page 9-15).

Maximum order. This option appears only if you select the ode15s solver,
which is based on NDF formulas of orders one through five. Although the
higher order formulas are more accurate, they are less stable. If your model is
stiff and requires more stability, reduce the maximum order to 2 (the highest
order for which the NDF formula is A-stable). As an alternative, you can try
using the ode23s solver, which is a lower order (and A-stable) solver.
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Solver reset method. This option appears only if you select one of the
following solvers:

e odel5s
® ode23t
e ode23tb

Its setting controls the solver behavior at solver reset (e.g., after detecting
a zero crossing) as follows:

Setting Reset Behavior

Robust The solver recomputes the Jacobian matrix needed by the
integration step at every solver reset.

Fast The solver does not recompute the Jacobian matrix at a solver

reset.

The fast setting speeds simulation. However, it can result in incorrect
solutions in some cases. If you suspect that the simulation is giving incorrect
results, try the robust setting. If there is no difference in simulation results
between the fast and robust settings, revert to the fast setting.

Fixed-Step Solver Options
The following options appear when you choose one of the Simulink fixed-step

solvers.

—Solver optiohs

Tupe: I Fined-step j Solver; I aded [Bogacki-Shanping) j
Periodic zample time constraint: I Uncanstrained ﬂ
Fined-step size [fundamental sample time); Iauto

Tazking mode for periodic zample times: I Auta ﬂ

™ Higher pricrity walue indicates higher tazsk, priority

[ Automatically handle data transfers between tasks
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Periodic sample time constraint. Allows you to specify constraints on the
sample times defined by this model. During simulation, Simulink checks to
ensure that the model satisfies the constraints. If the model does not satisfy
the specified constraint, Simulink displays an error message. The contents
of the Solver options group changes depending on the options selected.
The options are

Unconstrained

No constraints. Selecting this option causes Simulink to display a field for
entering the solver step size.

See “Fixed step size (fundamental sample time)” on page 9-45 for a
description of this field.

Ensure sample time independent

Check to ensure that this model can inherit its sample times from a model
that references it without altering its behavior. Models that specify a
step size (i.e., a base sample time) cannot satisfy this constraint. For this
reason, selecting this option causes Simulink to hide the group’s step size
field (see “Fixed step size (fundamental sample time)” on page 9-45).

Specified

Check to ensure that this model operates at a specified set of prioritized
periodic sample times.

Selecting this option causes Simulink to display additional controls for
specifying prioritized sample times and sample time priority options.

—Solver optiohs

Type: | Fived-step x| Solver. I disrete [no continuous states) |

Periodic sample time constraint: I Specified LI

Sample time properties: I

T azking mode for periodic zample times: I At j
¥ Higher priority value indicates higher task pricrity

[ automatically handle data transfers between tazsks
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See below for a description of these additional controls.

Fixed step size (fundamental sample time). Specifies the step size used
by the selected fixed-step solver. Entering auto (the default) in this field
causes Simulink to choose the step size. If the model specifies one or more
periodic sample times, Simulink chooses a step size equal to the least common
denominator of the specified sample times. This step size, known as the
fundamental sample time of the model, ensures that the solver will take a
step at every sample time defined by the model. If the model does not define
any periodic sample times, Simulink chooses a step size that divides the total
simulation time into 50 equal steps.

Sample time properties. Specifies and assigns priorities to the sample
times that this model implements. Enter an Nx3 matrix in this field whose
rows specify the sample times specified by this model in order from fastest
rate to slowest rate.

Note If the model’s fundamental rate differs from the fastest rate specified by
the model (see “Determining Step Size for Discrete Systems” on page 1-35),
you should specify the fundamental rate as the first entry in the matrix
followed by the specified rates in order from fastest to slowest.

The row for each sample time should have the form

[period, offset, priority]

where period is the sample time’s period of a sample time, offset is the
sample time’s offset, and priority is the execution priority of the real-time
task associated with the sample rate, with faster rates receiving higher
priorities. For example, the following entry

[fo.t, o, 10]; [0.2, O, 11]; [0.3, O, 12]]

declares that this model should specify three sample times, whose
fundamental sample time is 0.1 second, and assigns priorities of 10, 11, and
12 to the sample times. This example assumes that for this model, higher
priority values indicate lower priorities, i.e., the Higher priority value
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indicates higher task priority option is not selected (see “Higher priority
value indicates higher task priority” on page 9-47).

Note If your model operates at only one rate, you can enter the rate as a
three-element vector in this field, e.g., [0.1, 0, 10].

When updating a model, Simulink checks the sample times defined by the
model against this field. If the model defines more or fewer sample times than
this field specifies, Simulink displays an error message.

Note If you select Unconstrained as the Periodic sample time constraint,
Simulink assigns a priority of 40 to the model’s base sample rate. If the
Higher priority value indicates higher task priority option is selected
(see “Higher priority value indicates higher task priority” on page 9-47),
Simulink assigns priorities 39, 38, etc., to subrates of the base rate; otherwise,
it assigns priorities 41, 42, 43, etc., to the subrates. Continuous rate is
assigned a higher priority than is the discrete base rate no matter whether
you select Specified or Unconstrained as the Periodic sample time
constraint.

Tasking mode for periodic sample times. Specifies one of the following
options:

® MultiTasking

This mode issues an error if it detects an illegal sample rate transition
between blocks, that is, a direct connection between blocks operating at
different sample rates. In real-time multitasking systems, illegal sample
rate transitions between tasks can result in a task’s output not being
available when needed by another task. By checking for such transitions,
multitasking mode helps you to create valid models of real-world
multitasking systems, where sections of your model represent concurrent
tasks.

Use the Rate Transition block to eliminate illegal rate transitions from
your model. For more information, see “Models with Multiple Sample
Rates” for more information.
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® SingleTasking

This mode does not check for sample rate transitions among blocks. This
mode is useful when you are modeling a single-tasking system. In such
systems, task synchronization is not an issue.

® Auto

This option causes Simulink to use single-tasking mode if all blocks operate
at the same rate and multitasking mode if the model contains blocks
operating at different rates.

Higher priority value indicates higher task priority. If checked, this
option indicates that the real-time system targeted by this model assigns

a higher priority to tasks with higher priority values. This in turn causes
Simulink Rate Transition blocks to treat asynchronous transitions between
rates with lower priority values to rates with higher priority values as
low-to-high rate transitions. If unchecked (the default), this option indicates
that the real-time system targeted by this model assigns a higher priority to
tasks with lower priority values. This in turn causes Simulink Rate Transition
blocks to treat asynchronous transitions between rates with lower priority
values to rates with higher priority values as high-to-low rate transitions. See
the Real-Time Workshop documentation for more information on this option.

Automatically handle data transfers between tasks. If checked, this
option causes Simulink to insert hidden Rate Transition blocks where rate
transitions occur between blocks. Simulink adds these blocks configured to

¢ Ensure data integrity during data transfer

® Ensure deterministic data transfer
See “Rate Transition Block Options” for further details.

The next two options appear only if you select the ode14x solver (see “Implicit
Fixed-Step Continuous Solvers” on page 9-12).

Extrapolation Order. Extrapolation order used by the ode14x solver
to compute a model’s states at the next time step from the states at the
current time step. The higher the order, the more accurate but the more
computationally intensive is the solution per step size.
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Number Newton’s iterations. Number of Newton’s method iterations used
by the odel4x solver to compute a model’s states at the next time step from
the states at the current time step. The more iterations, the more accurate
but the more computationally intensive is the solution per step size.

Data Import/Export Pane

The Data Import/Export pane allows you to import and export data to
the MATLAB workspace. To display the pane, select Data Import/Export
from the Select tree of the Configuration Parameters dialog box or select
a configuration set (see “Configuration Sets” on page 9-29) in the Model
Explorer and display the configuration’s Data Import/Export subset.

—Load from workspace

I~ Input: |[
I~ Iitial state: |

—Save to workspace

[~ Time: Jtout
[~ States: |;r.out
™ Output: I;.'out

[~ Final states: |;r_F|naI
[+ Signal logging: |Iogsout

I~ Inspect signal logs when simulation is paused/stopped

—Save options
I~ Limit data points to last: |1CCC Decimation: I‘I
Format: I Amay j
Cutput options: I Refine output ;I Refine factor: I‘I

This pane includes the following groups of options.

® “Load from workspace” on page 9-49
* “Save to workspace” on page 9-49

® “Save options” on page 9-50
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Load from workspace

This group contains controls that enable you to specify options for importing
data from the MATLAB workspace.

Load from workspace

™ Input: I[t, u]

[ Initial state: IHInitiaI

It includes the following controls.

Input. A MATLAB expression that specifies the data to be imported from the
MATLAB workspace. See “Importing Data from the MATLAB Workspace” on
page 9-17 for information on how to use this field.

Initial state. A MATLAB expression that specifies the initial values of a
model’s states. See “Importing and Exporting States” on page 9-24 for more
information.

Save to workspace

This group contains controls that enable you to specify options for exporting
data to the MATLAB workspace.

—Save to workspace

[~ Time: Itout
[~ States: Ixout
[ Output: I;.'out

[~ Final states: |xFinaI
¥ Signal logging: ||ogsout

[ Inspect signal logs when simulation is paused/stopped

It includes the following controls.

Time. Name of the MATLAB variable to be used to store simulation time
data to be exported during simulation.
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States. Specifies the name of a MATLAB variable to be used to store state
data exported during a simulation. See “Importing and Exporting States”
on page 9-24 for more information.

Output. Name of the MATLAB variable to be used to store signal data
exported during this simulation. See “Exporting Data to the MATLAB
Workspace” on page 9-22 for more information.

Final states. Specifies the name of a MATLAB variable to be used to store
the values of this model’s states at the end of a simulation. See “Importing
and Exporting States” on page 9-24 for more information.

Signal logging. Globally enables or disables signal logging for this model.
The adjacent edit field specifies the name of the signal logging object used to
record logged signal data in the MATLAB workspace. See “Logging Signals”
on page 5-34 for more information.

Inspect signals when simulation is stopped/paused. Checking this
option causes Simulink to display logged signals in the MATLAB Time
Series Tools viewer at the end of a simulation or whenever you pause the
simulation. If this option is unchecked, you must select Tools > Inspect
logged signals from the model editor’s menu bar to display logged signals in
the Time Series Tools viewer.

Save options

This group contains controls that allow you to specify options for saving (and
reloading) data from the MATLAB workspace.

Save options

I~ Limit data points to last: |1 ] Decimation: I‘I
Farmat: I Array ;I

Output options: I Frefite output j Refine factar: I‘I

It includes the following controls.
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Limit data points to last. Limits the number of data points exported to the
MATLAB workspace to N, the number specified in the adjacent edit field. At
the end of the simulation, the MATLAB workspace contains the last N points
generated by the simulation.

Decimation. If specified, Simulink outputs only every N points, where N is
the specified decimation factor.

Format. Specifies the format of state and output data saved to or loaded from
the MATLAB workspace. The options are

® Array

The format of the data is a matrix each row of which corresponds to a
simulation time step.

® Structure with time

The format of the data is a structure that has two fields: a time field and

a signals field. The time field contains a vector of simulation times. The
signals field contains a substructure for each model input port (for imported
data) or output port (for exported data). Each port substructure contains
signal data for the corresponding port.

® Structure

The format of the data is a structure that contains substructures for each
port. Each port substructure contains signal data for the corresponding
port.

See “Importing and Exporting Simulation Data” on page 9-17 for more
information on these formats.

Output options. Options for generating additional output signal data.

Note These options appear only if the model specifies a variable-step solver
(see “Solver Pane” on page 9-38).
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The options are

® Refine output

Output data between as well as at simulation times steps. Selecting this
option causes the Refine factor edit field to appear below this control
(see “Refine factor” on page 9-52). Use this field to specify the number of
points to generate between simulation time steps. For more information,
see “Refining Output” on page 9-26.

® Produce additional output

Produce additional output at specified times. Selecting this option causes
the Output times field to appear. Use this field to specify the simulation
times at which Simulink should generate additional output.

® Produce specified output

Produce output only at specified times. Selecting this option causes the
Output times field to appear. Use this field to specify the simulation times
at which Simulink should generate output.

Refine factor. This field appears when you select Refine output as the
value of Qutput options. It specifies how many points to generate between
time steps. For example, a refine factor of 2 provides output midway between
the time steps, as well as at the steps. The default refine factor is 1. For more
information, see “Refining Output” on page 9-26.

Note Simulink ignores this option for discrete models. This is because the
value of data between time steps is undefined for discrete models.

Output times. This field appears when you select Produce additional
output or Produce specified output as the value of Output options.
Use this field to specify times at which Simulink should generate output in
addition to or instead of at the simulation steps taken by the solver used
to simulate the model.



Configuration Parameters Dialog Box

Note Discrete models define outputs only at major time steps. Therefore,
Simulink logs output for discrete models only at major time steps. If the
Output times field specifies other times, Simulink displays a warning
message at the MATLAB command line.

Optimization Pane

The Optimization pane allows you to select various options that improve
simulation performance and the performance of code generated from this
model. This pane contains a panel of optimizations that apply both to
simulation and to code generated from the model.

Simulation and code generation

¥ Block reduction optimization ¥ Conditional input branch execution

v Implement logic signals a5 boolean data vz double). [+ Signal storage reuse

™ Inline parameters Configure ... |

Application ifespan [days) Iinf

“Block reduction optimization” on page 9-55

“Conditional input branch execution” on page 9-56

“Inline parameters” on page 9-57

“Implement logic signals as boolean data (vs. double)” on page 9-59
® “Signal storage reuse” on page 9-59

e “Application lifespan (days)” on page 9-60
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When Real-Time Workshop is installed on your system, this pane also
contains a panel of optimizations that apply only to code generation.

—LCode generation

—Signal
¥ Enable local block outputs ¥ Reuse block outputs
I lgnore integer downcasts in folded expressions ¥ Inling invariant signals

¥ Eliminate superfluous temporary variables [Expression folding)

Loop unrolling threshold: |5

—Integer and fixed-paint

I~ Remove code from floating-point to integer corversions that wiaps out-of-range values

“Enable local block outputs” on page 9-60

“Ignore integer downcasts in folded expressions” on page 9-60

“Eliminate superfluous temporary variables (Expression folding)” on page
9-61

“Reuse block outputs” on page 9-61

“Inline invariant signals” on page 9-61

“Loop unrolling threshold” on page 9-62

* “Remove code from floating-point to integer conversions that wraps
out-of-range values” on page 9-63

The following pane contains Stateflow-related code generation optimizations:

Stateflow
[ Use bitzets for storing state configuration [ Minimize array reads using temporan variables

™ Use hitsets for storing boolean data

e “Use bitsets for storing state configuration” on page 9-64
e “Use bitsets for storing boolean data” on page 9-64

* “Minimize array reads using temporary variables” on page 9-65
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Note These optimizations appear only when Real-Time Workshop and
Stateflow are both installed on your system and the model includes
Stateflow charts or Embedded MATLAB Function blocks. The settings
you make for the Stateflow options also apply to all Embedded MATLAB
Function blocks in the model. Note that you do not need a Stateflow license
to use Embedded MATLAB Function blocks.

Block reduction optimization

Replaces a group of blocks with a synthesized block, thereby speeding up
execution of the model.

This option performs the following kinds of block reduction optimizations.

Accumulator folding. Simulink reduces block diagrams that represent
accumulators to a single block.

Redundant Type Conversion Removal. Removes unnecessary type
conversion blocks. For example, this optimization will remove an int type
conversion block whose input and output are of type int.

Dead Branch Elimination. Eliminates any block that exists on a dead
branch of the block diagram, i.e., a branch whose execution does not affect
the simulation. A block must meet the following conditions to be considered
part of a dead branch:

® The block is in a branch that ends with a block that performs no operation
during simulation or in the generated code, for example, a Terminator
block or a disabled Assertion block. Note that whether a block performs an
operation can depend on whether the model is being simulated or used to
generate code or on model settings. For example, a Scope block performs no
operation in code generated from a model and hence a branch that ends
in a Scope block can be a dead branch for the purposes of code generation,
although not for simulation.

® The block is not in any other branch.

® The block does not modify signal storage.
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Consider the following model:

In1 i
Gain Terminator *‘\\

~~ Dead branch

e (T

. Out1
Gainl

The upper branch of this model’s block diagram has no effect on the output.
Dead branch optimization therefore eliminates the Gain block from the
compiled model.

Real-Time Workshop similarly eliminates the code path that includes the
dead branch from the code generated for the model:

/* Model output function */
static void untitled output(int_T tid)

{

/* local block i/o variables */

/* Outport: '<Root>/Outi1' incorporates:
* Gain: '<Root>/Gaint'
* Inport: '<Root>/In1'
*/
untitled Y.Out1 = untitled U.In1 * untitled P.Gain1_Gain;
}

Conditional input branch execution

This optimization applies to models containing Switch and Multiport Switch
blocks. When enabled, this optimization executes only the blocks required
to compute the control input and the data input selected by the control
input at each time step for each Switch or Multiport Switch block in the
model. Similarly, code generated from the model by Real-Time Workshop
executes only the code needed to compute the control input and the selected
data input. This optimization speeds simulation and execution of code
generated from the model.
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At the beginning of the simulation or code generation, Simulink examines
each signal path feeding a switch block data input to determine the portion of
the path that can be optimized. The optimizable portion of the path is that
part of the signal path that stretches from the corresponding data input back
to the first block that is a nonvirtual subsystem, has continuous or discrete
states, or detects zero crossings.

Simulink encloses the optimizable portion of the signal path in an invisible
atomic subsystem. During simulation, if a switch data input is not selected,
Simulink executes only the nonoptimizable portion of the signal path
feeding the input. If the data input is selected, Simulink executes both

the nonoptimizable and the optimizable portion of the input signal path.
See “Expression Folding” in “Real-Time Workshop User’s Guide” for more
information.

Inline parameters

By default you can modify (“tune”) many block parameters during simulation
(see “Tunable Parameters” on page 1-8). Selecting this option makes all
parameters nontunable by default. Making parameters nontunable allows
Simulink to move blocks whose outputs depend only on block parameter
values outside the simulation loop, thereby speeding up simulation of the
model and execution of code generated from the model. When this option is
selected, Simulink disables the parameter controls of the block dialog boxes
for the blocks in your model to prevent you from accidentally modifying the
block parameters.

Note Simulating a model containing references to other models requires that
this setting be off. However, you can still tune parameters of models that
contain model references, using Simulink.Parameter objects (see “Model
Referencing and the Inline Parameters Optimization” on page 3-56 for more
information).

If this option is not selected, Real-Time Workshop generates a global variable
declaration for each parameter and uses the variable wherever the generated
code needs the parameter’s value. User-supplied code can change the value of
the parameter at run-time by assigning a value to the variable.
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If this option is selected, Real-Time Workshop inserts the actual value of the
parameter as a constant expression wherever the generated code needs the
value. If the value of a parameter is a constant in the model, the Real-Time
Workshop inserts the constant in the generated code. If the value is a
workspace variable or MATLAB expression, Real-Time Workshop evaluates
the variable or expression and inserts the result as a constant expression in
the generated code. User-supplied code cannot change the value of inlined
parameters at run-time because they appear as constants in the generated
code.

Note If a model contains Model blocks, Inline parameters must be on for it
and all models it references. If a top model or a referenced model does not
have Inline parameters on, Simulink temporarily enables this option while
generating code, then turns it off again when the build completes. That is, the
model is left in its previous state and need not be resaved.

Simulink allows you to override the Inline parameters option for parameters
whose values are defined by variables in the MATLAB workspace. To specify
that such a parameter remain tunable, specify the parameter as global in
the Model Parameter Configuration dialog box (see “Model Parameter
Configuration Dialog Box” on page 9-66). To display the dialog box, click the
adjacent Configure button. To tune a global parameter, change the value of
the corresponding workspace variable and select Update Diagram (Ctrl+D)
from the Simulink Edit menu.

Note You cannot tune inlined parameters in code generated from a model.
However, when simulating a model, you can tune an inlined parameter if
its value derives from a workspace variable. For example, suppose that

a model has a Gain block whose Gain parameter is inlined and equals a,
where a is a variable defined in the model’s workspace. When simulating
the model, Simulink disables the Gain parameter field, thereby preventing
you from using the block’s dialog box to change the gain. However, you can
still tune the gain by changing the value of a at the MATLAB command line
and updating the diagram.
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Implement logic signals as boolean data (vs. double)

Causes blocks that accept Boolean signals to require Boolean signals. If this
option is off, blocks that accept inputs of type boolean also accept inputs of
type double. For example, consider the following model.

A
|
AND
2 ™
Lagical Displsoy
1 Cpemtor
E

This model connects signals of type double to a Logical Operator block, which
accepts inputs of type boolean. If the Boolean logic signals option is on,
this model generates an error when executed. If the Boolean logic signals
option is off, this model runs without error.

Note Setting this option off allows the current version of Simulink to run
models that were created by earlier versions of Simulink that supported only
signals of type double. On the other hand, setting this option on reduces the
memory requirements of generated code, because a Boolean signal typically
requires one byte of storage compared to eight bytes for a double signal.

Signal storage reuse

Causes Simulink to reuse memory buffers allocated to store block input and
output signals. If this option is off, Simulink allocates a separate memory
buffer for each block’s outputs. This can substantially increase the amount of
memory required to simulate large models, so you should select this option
only when you need to debug a model. In particular, you should disable signal
storage reuse if you need to

® Debug a C-MEX S-function
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® Use a Floating Scope or a Display block with the Floating display option
selected to inspect signals in a model that you are debugging

Simulink opens an error dialog if Signal storage reuse is enabled and you
attempt to use a Floating Scope or floating Display block to display a signal
whose buffer has been reused.

Application lifespan (days)

Specifies the lifespan in days of the system represented by this model. This
value and the simulation step size determine the data type used by fixed-point
blocks to store absolute time values. Simulink evaluates this parameter first
against the model workspace. If this does not resolve the parameter, Simulink
then evaluates it against the base workspace.

Enable local block outputs

Causes the generated code to declare block output signals as local variables if
possible. If this option is not selected or it is not possible to declare an output
as a local variable, the generated code declares the output as a global variable.

Note The check box for this option is enabled only if signal storage reuse is
selected (see “Signal storage reuse” on page 9-59).

See “Signal Storage, Optimization, and Interfacing” in “Real-Time Workshop
User’s Guide” for more information.

Ignore integer downcasts in folded expressions

This option specifies how Real-Time Workshop should handle 8-bit
operations on 16-bit microprocessors and 8- and 16-bit operations on 32-bit
microprocessors. To ensure consistency between simulation and code
generation, the results of 8 and 16-bit integer expressions must be explicitly
downcast. Selecting this option improves code efficiency by avoiding casts
of intermediate variables. See “Expression Folding Options” in “Real-Time
Workshop User’s Guide” for more information.
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Eliminate superfluous temporary variables (Expression folding)

Enables expression folding (see “Using and Configuring Expression Folding"
in the “Real-Time Workshop User’s Guide”).

Reuse block outputs

When the Reuse block output check box is selected (the default) Real-Time
Workshop reuses signal memory whenever possible. When Reuse block output
is cleared, signals are stored in unique locations.

Note Reuse block output is available only when the Signal storage reuse
check box is selected.

See “Signal Storage, Optimization, and Interfacing” in “Real-Time Workshop
User’s Guide” for further information (including generated code example) on
Reuse block output and other signal storage options.

Inline invariant signals

This option applies only if inline parameters is enabled (see “Inline
parameters” on page 9-57). If you select this option, Real-Time Workshop
uses numeric constants instead of variables to represent invariant signals in
generated code. An invariant signal is a signal that does not change during
simulation. Consider, for example, the following model:

Constantt

The signal s3 is an invariant signal. This option uses a numeric constant, 9,
to represent the value of this signal in the generated code.
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Loop unrolling threshold

Specifies the array size at which Real-Time Workshop begins to use a for loop
instead of separate assignment statements to assign values to the elements of
a signal or parameter array. The default threshold is 5.

For example, consider the following model:

]

Sine Wiawe Gain Soope

The gain parameter of the Gain block is the vector myGainVec.

Assume that the loop unrolling threshold value is set to the default, 5, and
that you have a 10-element vector to myGainVec:

myGainVec = [1:10];

The generated code declares a 10-element vector variable,
myGainVec_P.Gain_Gain[], in the Parameters_model data structure. The
size of the gain array exceeds the loop unrolling threshold. Therefore, the
code generated for the Gain block uses a for loop, as shown in the following
code fragment:

{
int32 T if;

/* Gain: '<Root>/Gain' */
for(i1=0; i1<10; i1++) {
myGainVec_B.Gain_f[i1] = rtb_foo *
myGainVec_P.Gain_Gain[i1];
}
}

If myGainVec is declared as

myGainVec = [1:3];
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an array of three elements, myGainVec P.Gain_Gain[], is declared in the
Parameters_model data structure. The size of the gain array is below the loop
unrolling threshold. The generated code consists of inline references to each
element of the array, as in the code fragment below:

/* Gain: '<Root>/Gain' */

myGainVec_B.Gain_f[0] = rtb_foo * myGainVec_P.Gain_Gain[O0];
myGainVec_B.Gain_f[1] rtb_foo * myGainVec_P.Gain_Gain[1];
myGainVec_B.Gain_f[2] rtb_foo * myGainVec_P.Gain_Gain[2];

See the “Target Language Compiler Reference Guide” for more information
on loop unrolling.

Remove code from floating-point to integer conversions that
wraps out-of-range values

This option causes Real-Time Workshop to remove code that ensures that
execution of the generated code produces the same results as simulation when
out-of-range conversions occur. This reduces the size and increases the speed
of the generated code at the cost of potentially producing results that do not
match simulation in the case of out-of-range values.

Note Enabling this option affects code generation results only for out-of-range
values and hence cannot cause code generation results to differ from
simulation results for in-range values.

Consider using this option if code efficiency is critical to your application and
the following conditions are true for at least one block in the model:

* Computing the block’s outputs or parameters involves converting
floating-point data to integer or fixed-point data

® The block’s Saturate on integer overflow option is disabled:
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The following code fragment shows the code generated for a conversion with
this option disabled

_fixptloweringO = (rtb_Switch[i1] + 9.0) / 0.09375;
_fixptlowering1 = fmod(_fixptlowering0 >= 0.0 ?
floor(_fixptloweringO)
ceil(_fixptlowering0), 4.2949672960000000E+009);
if(_fixptloweringl < -2.1474836480000000E+009) {
_fixptlowering1 += 4.2949672960000000E+009;
} else if(_fixptloweringl >= 2.1474836480000000E+009) {
_fixptlowering1l -= 4.2949672960000000E+009;

}
cg_in_0_20 0O[i1] = (int32_T)_fixptloweringi;

Note The code generator uses the fmod function to handle out-of-range
conversion results.

The code generated for the conversion when you select this optimization
follows:

cg_in_0 20 0[i1] = (int32_T)((rtb_Switch[i1] + 9.0) / 0.09375);

Use bitsets for storing state configuration

Enabling this option specifies that bitsets be used for storing state
configuration variables. This can significantly reduce the amount of memory
required to store the variables. However, it can increase the amount of
memory required to store target code if the target processor does not include
instructions for manipulating bitsets.

Use bitsets for storing boolean data

Enabling this option specifies that bitsets be used for storing Boolean data.
This can significantly reduce the amount of memory required to store Boolean
variables. However, it can increase the amount of memory required to

store target code if the target processor does not include instructions for
manipulating bitsets.
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Minimize array reads using temporary variables

In certain microprocessors, global array read operations are more expensive
than accessing a temporary variable on stack. Using this option minimizes
array reads by using temporary variables when possible.

For example, the generated code

a[i] = foo();

if(a[i]<10 && a[i]>1) {
y = a[i]+5;

Yelse{

z = a[i];

}

now becomes

a[i] = foo();

temp al[i];

if(temp<10 && temp>1) {
y = temp+5;

telse{
z = temp;

}
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Model Parameter Configuration Dialog Box

The Model Parameter Configuration dialog box allows you to override
the Inline parameters option (see “Inline parameters” on page 9-57) for
selected parameters.

) Model Parameter Configuration: vdp |- (O] =]
—Description

Define the global ftunable) parameters for your model. These parametears affect:
1. the simulation by providing the ability to tune parameters during execution, and
2. the generated code by enabling access to parameters by other modules.

—Source list — Global {funahle) parameters
MATLABR warkspace :I | Mame | Storage class Storage trpe qualifier
MName
1|balance
2|gain

Refresh list | Add totakle >>| [ ey | Rermove |

OK | Cancel | Help | Apply |

Note Simulink ignores the settings of this dialog box if a model contains
references to other models. However, you can still tune parameters of such
models, using Simulink.Parameter objects (see “Model Referencing and the
Inline Parameters Optimization” on page 3-56 for more information).

The dialog box has the following controls.
Source list. Displays a list of workspace variables. The options are

® MATLAB workspace
List all variables in the MATLAB workspace that have numeric values.
® Referenced workspace variables

List only those variables referenced by the model.
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Refresh list. Updates the source list. Click this button if you have added a
variable to the workspace since the last time the list was displayed.

Add to table. Adds the variables selected in the source list to the adjacent
table of tunable parameters.

New. Defines a new parameter and adds it to the list of tunable parameters.
Use this button to create tunable parameters that are not yet defined in the
MATLAB workspace.

Note This option does not create the corresponding variable in the MATLAB
workspace. You must create the variable yourself.

Storage class. Used for code generation. See “Real-Time Workshop User’s
Guide” for more information.

Storage type qualifier. Used for code generation. See “Real-Time Workshop
User’s Guide” for more information.

Diagnostics Pane

The Diagnostics configuration parameters pane enables you to specify what
diagnostic action Simulink should take, if any, when it detects an abnormal
condition during compilation or simulation of a model.

Select: [~ Solver

- Solver Algebraic loop: I warning LI
----Datfa |.mp.0[t.-'lEHpD[t Minimize algebraic loop: I warning LI
.. Optimization
; Block priority violation: I wWarning LI
Sample Time Min step size violation: I warning LI
- [Data [nkegrity sl i -
- Conversion Unzpecified inkheritability of zample timne: I warning ;I
i Connectivity Solver data inconzistency: I hane LI
i Compatibility Automatic solver parameter selection: I o LI

L. Model Referencing
The options are typically to do nothing or to display a warning or an error

message (see “Diagnosing Simulation Errors” on page 9-101). A warning
message does not terminate a simulation, but an error message does.
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The pane displays groups of controls corresponding to various categories of
abnormal conditions that can occur during a solution. To display controls for
a specific category, left-click the category in the Categories list on the left
side of the Diagnostics pane. To display controls for additional categories,
left-click the categories while pressing the Ctrl key on your keyboard. See the
following sections for information on using the controls on the Diagnostics
pane:

® “Solver Diagnostics” on page 9-68

* “Sample Time Diagnostics” on page 9-73

® “Data Validity Diagnostics” on page 9-74

® “Conversion Diagnostics” on page 9-80

® “Connectivity Diagnostics” on page 9-81

® “Compatibility Diagnostics” on page 9-84

® “Model Reference Diagnostics” on page 9-88

Solver Diagnostics

This control group enables you to specify the diagnostic action that Simulink
should take when it detects a solver-related error.

—Salver
Algebraic loop: | Waming
Minimize algebraic loop: I waming
Black priorty viclation: I Waming
Min step size violation: I waming

Unspecified inhertability of sample time: I Waming

Salver data inconsistency: I none

Automatic solver parameter selection: I none

Ll fLe e fLefLefLefled

Extraneous discrete dervative signals: I emor

Algebraic loop. Simulink detected an algebraic loop while compiling the
model. See “Algebraic Loops” on page 1-24 for more information. If you set
this option to Error, Simulink displays an error message and highlights
the portion of the block diagram that comprises the loop (see “Highlighting
Algebraic Loops” on page 1-26).
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Minimize algebraic loop. Specifies diagnostic action to take if you have
requested that Simulink attempt to remove algebraic loops involving a
specified subsystem (see “Eliminating Algebraic Loops” on page 1-27) and an
input port of that subsystem has direct feedthrough. If the port is involved
in an algebraic loop, Simulink can remove the loop only if at least one other
input port in the loop lacks direct feedthrough.

Block priority violation. Simulink detected a block priority specification
error while compiling the model.

Min step size violation. The next simulation step is smaller than the
minimum step size specified for the model. This can occur if the specified
error tolerance for the model requires a step size smaller than the specified
minimum step size. See “Min step size” on page 9-42 and “Maximum order”
on page 9-42 for more information.

Unspecified inheritability of sample time. Specifies diagnostic action to
be taken if this model contains S-functions that do not specify whether they
preclude this model from inheriting their sample times from a parent model.
Simulink checks for this condition only if the solver used to simulate this
model is a fixed-step discrete solver and the periodic sample time constraint
for the solver is set to ensure sample time independence (see “Periodic sample
time constraint” on page 9-44).

Solver data inconsistency. Consistency checking is a debugging tool that
validates certain assumptions made by Simulink ODE solvers. Its main use is
to make sure that S-functions adhere to the same rules as Simulink built-in
blocks. Because consistency checking results in a significant decrease in
performance (up to 40%), it should generally be set to none. Use consistency
checking to validate your S-functions and to help you determine the cause of
unexpected simulation results.

To perform efficient integration, Simulink saves (caches) certain values from
one time step for use in the next time step. For example, the derivatives at the
end of a time step can generally be reused at the start of the next time step.
The solvers take advantage of this to avoid redundant derivative calculations.

Another purpose of consistency checking is to ensure that blocks produce

constant output when called with a given value of ¢ (time). This is important
for the stiff solvers (ode23s and ode15s) because, while calculating the

9-69



9 Running Simulations

9-70

Jacobian matrix, the block’s output functions can be called many times at the
same value of ¢.

When consistency checking is enabled, Simulink recomputes the appropriate
values and compares them to the cached values. If the values are not the
same, a consistency error occurs. Simulink compares computed values for
these quantities:

® Qutputs
® Zero crossings
® Derivatives

e States

Automatic solver parameter selection. Specifies diagnostic action to
take if Simulink changes a solver parameter setting. For example, suppose
that you simulate a discrete model that specifies a continuous solver and
warning as the setting for this diagnostic. In this case, Simulink changes the
solver type to discrete and displays a warning message about this change at
the MATLAB command line.

Extraneous discrete derivative signals. A discrete signal appears to pass
through a Model block to the input of a block with continuous states, such as
an Integrator block. Simulink cannot determine with certainty the minimum
rate at which it needs to reset the solver to solve this model accurately.
Consequently, if this diagnostic is set to Error, Simulink halts when compiling
this model and displays an error. If this diagnostic is set to None or Warning,
Simulink resets the solver whenever the value of the discrete signal changes.
This ensures accurate simulation of the model, assuming that the discrete
signal really is the source of the signal entering the block with continuous
states. However, if the discrete signal is not the actual source of the signal
entering the block with continuous states, resetting the solver at the rate the
discrete signal changes can lead to the solver being reset more frequently
than necessary, thus unnecessarily slowing down the simulation.
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The following model illustrates the rationale for this diagnostic.

I - 1
[ L] )5 » in out =53 > S

A Integrator ouet
Sample Time: 1 9

In this model, it is possible, but not certain, that signal S passes through

the Model block and enters the Integrator block. The signal emerging from
the Model block is labeled S? to indicate that it is not possible, simply from
examining the top model alone, to determine that its source actually is S.
Because S is the sum of a continuous and a discrete signal, discontinuities
occur in S at the sample rate of its discrete component, A, i.e., once a second of
simulation time.
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Assuming that the source of S? really is S, Simulink would have to reset the
solver once a second to solve the top model accurately. However, examination
of the referenced model reveals that the source of S? is actually X.

(1) ){5 P
in
Gain Display
g
out
C
|J'L|
L
D
Sample Time: 2
s o 3 (D
Outl
A Integrator

Sample Time: 1

V

B

Note that X, like S, is the sum of a continuous and a discrete signal. However,
the discontinuities in X occur every two seconds, half the rate at which
discontinuities occur in S. Consequently, to simulate the top model accurately,
Simulink needs to reset the solver only every two seconds. However, because
the content of the model referenced by the Model block is inaccessible to
Simulink when it compiles the top model, preparatory to simulating it,
Simulink cannot determine the minimum rate at which it needs to reset the
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solver to solve this model. Consequently, if this diagnostic is set to Error,
Simulink displays an error if you try to update or simulate this model. If this
diagnostic is set to None or Warning, Simulink resets the solver whenever
the value of S changes, i.e., twice as often as necessary to solve the model
accurately.

Sample Time Diagnostics

This control group enables you to specify the diagnostic action that Simulink
should take when it detects a compilation error related to model sample times.

—Sample Time
Source block specifies -1 sample time: I waming LI
Discrete used as continuous: I waming LI
Multitask: rate transition: I emor ;I
Single task rate transition: I none LI
Tasks with equal priority: I waming LI
Enforce sample times specified by Signal Specification blocks I waming ;I

Source block specifies -1 sample time. A source block (e.g., a Sine Wave
block) specifies a sample time of -1.

Discrete used as continuous. The Unit Delay block, which is a discrete
block, inherits a continuous sample time from the block connected to its input.

Multitask rate transition. An invalid rate transition occurred between
two blocks operating in multitasking mode (see “Tasking mode for periodic
sample times” on page 9-46).

Single task rate transition. A rate transition occurred between two blocks
operating in single-tasking mode (see “Tasking mode for periodic sample
times” on page 9-46).

Tasks with equal priority. One asynchronous task of the target represented
by this model has the same priority as another of the target’s asynchronous
tasks. This option must be set to Error if the target allows tasks having the
same priority to preempt each other.
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Enforce sample times specified by Signal Specification blocks. The
sample time of the source port of a signal specified by a Signal Specification
block differs from the signal’s destination port.

Data Validity Diagnostics

This control group enables you to specify the diagnostic action that Simulink
should take when it detects a condition that could compromise the integrity of
data defined by the model.

—Data Validity

—Signals
Signal resolution: I Explicit and wam implicit ;I Detect overflow: Im
Division by singular matrix: I none LI Inf or MaM block output: Im
Underspecified data types: I none ;I it prefic for identifiers; | emor -

—Parameters
Detect downcast: I efmor j Detect overflow: I emor LI
Detect underflow: I none ;I Detect precision loss: I waming ;I

—Diata Store Memory Block

Detect read before write: I Use local settings j Muttitask data store: I waming VI

Detect write after read: I Use local settings ;I Duplicate data store names: I nane vI
Detect write after write: I Use local settings j

—Debugging
Amay bounds exceeded: I nane LI
Model Verfication block enabling: I Use local settings ;I

This group contains the following subgroups.

® “Signal Validity Diagnostics” on page 9-75

e “Parameter Validity Diagnostics” on page 9-76

e “Data Store Validity Diagnostics” on page 9-78

* “Debugging Data Validity Diagnostics” on page 9-79
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Signal Validity Diagnostics
The following group of data validity diagnostics pertains to signals.

Signals

Signal resolution: I BExplicit and wam implicit ;l Detect overflaw: I Waming "I
Division by singular matric: I none LI Inf or MaM block output: I none vI
Underspecified data types: I nane LI "nt" prefic for identifiers: I emor VI

Signal resolution. Specifies how Simulink resolves signals to
Simulink.Signal objects in the MATLAB workspace. The options are

Explicit and warn implicit

Try to resolve every signal or discrete state that has a name to a
Simulink.Signal object having the same name. Display a warning
message if a signal or state resolves implicitly to a signal object, i.e.,

a signal object with the same name as the signal or state exists in the
MATLAB workspace but the model does not specify that the signal or state
should resolve to a signal object.

Explicit and implicit

Try to resolve every signal or discrete state that has a name to a
Simulink.Signal object having the same name regardless of whether the
model specifies that the signal or state should resolve to a signal object.

Explicit only

Try to resolve every signal or discrete state that the model specifies should
resolve to a Simulink.Signal object in the MATLAB workspace.

Note Use the Signal Properties dialog box (see “Signal Properties Dialog
Box” on page 5-38) to specify explicit resolution for signals. Use the State
Properties dialog boxes of blocks that have discrete states, e.g., the
Discrete-Time Integrator block, to specify explicit resolution for discrete
states.
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Division by singular matrix. The Product block detected a singular matrix
while inverting one of its inputs in matrix multiplication mode.

Underspecified data types. Simulink could not infer the data type of a
signal during data type propagation.

Detect overflow. The value of a signal or parameter is too large to be
represented by the signal or parameter’s data type.

Inf or NaN block output. The value of a block output is Inf or NaN at
the current time step.

"ri" prefix for identifiers. The default setting causes code generation to
terminate with an error if it encounters a Simulink object name, e.g., the
name of a parameter or block or signal, that begins with rt. This is intended
to prevent inadvertent clashes with generated identifiers whose names begins
with rt.

Parameter Validity Diagnostics
The following group of data validity diagnostics pertains to parameters.

Parameters
Detect downcast: I emor LI Detect overflow: I emor ll
Detect underflow: I naone ;l Detect precision loss: I Waming LI

Detect downcast. Computation of the output of the block required
converting the parameter’s specified type to a type having a smaller range
of values (e.g., from uint32 to uint8). This diagnostic applies only to named
tunable parameters.

Detect overflow. Simulink has encountered a parameter whose data type’s
range is not large enough to accommodate the parameter’s ideal value, i.e.,
the ideal value is either too large or too small to be represented by the data
type. For example, suppose that the parameter’s ideal value is 200 and its
data type is uint8. Overflow occurs in this case because the maximum value
that uint8 can represent is 127.
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Note that parameter overflow differs from parameter precision loss, which
occurs when the ideal parameter value is within the range of the data type
and scaling being used, but cannot be represented exactly.

Both parameter overflow and precision loss are quantization errors, and the
distinction between them can be a fine one. The Detect overflow diagnostic
reports all quantization errors greater than one bit. For very small parameter
quantization errors, precision loss will be reported rather than an overflow
when

(Max + Slope) 2 V4,4, > (Min — Slope)

where

Max is the maximum value representable by the parameter data type

Min is the minimum value representable by the parameter data type
® Slope is the slope of the parameter data type (slope = 1 for integers)

® V. ,eu 18 the ideal value of the parameter

L

Detect parameter underflow. Simulink has encountered a parameter
whose data type does not have enough precision to represent the parameter’s
ideal value because the ideal value is too small. As a result, casting the ideal
value to the data type causes the parameter’s modeled value to become zero,
i.e., to differ from its ideal value.

Detect precision loss. Simulink has encountered a parameter whose data
type does not have enough precision to represent the parameter’s value
exactly. As a result, the modeled value differs from the ideal value.

Note that parameter precision loss differs from parameter overflow, which
occurs when the range of the parameter’s data type, i.e., that maximum
value that it can represent, is smaller than the ideal value of the parameter.
Both parameter overflow and precision loss are quantization errors, and
the distinction between them can be a fine one. The Detect Parameter
overflow diagnostic reports all parameter quantization errors greater than
one bit. For very small parameter quantization errors, precision loss will be
reported rather than an overflow when
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(Max + Slope) 2 V4,41 > (Min — Slope)

where

Max is the maximum value representable by the parameter data type.
Min is the minimum value representable by the parameter data type.
Slope is the slope of the parameter data type (slope = 1 for integers).

V. seas 18 the full-precision, ideal value of the parameter.

L

Data Store Validity Diagnostics

The following group of data validity diagnostics pertains to data stores defined
by Data Story Memory blocks and by Simulink.Signal objects (see “Working
with Data Stores” on page 3-95).

Diata Store Memory Block

Detect read before write: I Use local settings LI Multitask data store: I Waming "I
Detect write after read: I Lz local settings ;l Duplicate data store names: I none vI

Detect write after write: I lse local settings ;I

Detect read before write. The model is attempting to read data from a
data store in which it has not stored data in this time step. This option has
the following settings:

Use local settings

For each data store defined by a Data Store Memory block, use the setting
specified by the block. This option disables the diagnostic for global data
stores (i.e., data stores defined by Simulink.Signal objects).

Disable All

Disables this diagnostic for all data stores accessed by the model.
Enable All As Warnings

Displays diagnostic as a warning at the MATLAB command line.
Enable All As Errors

Halts the simulation and displays the diagnostic an error dialog box.
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Detect write after read. The model is attempting to store data in a data
store after previously reading data from it in the current time step. This
diagnostic has the same options as the previous diagnostic.

Detect write after write. The model is attempting to store data in a data
store twice in succession in the current time step. This diagnostic has the
same options as the previous diagnostic.

Multitask data store. One task reads data from a Data Store Memory
block to which another task writes data. Such a situation is safe only if one of
the tasks cannot interrupt the other, e.g., the data store is a scalar and the
writing task uses an atomic copy operation to update the store or the target
does not allow the tasks to preempt each other. You should therefore disable
this diagnostic, i.e., set it to none, only if the application warrants it, e.g.

the application uses a cyclic scheduler that prevents tasks from preempting
each other.

Duplicate data store names. The model contains multiple Data Store
Memory blocks that specify the same data store name.

Debugging Data Validity Diagnostics
The following group of data validity diagnostics pertains to model debugging.

Debugging
Amray bounds exceeded: I naone LI
Madel Verfication block enabling: I lze local settings j

Array bounds exceeded. This option causes Simulink to check whether a
block writes outside the memory allocated to it during simulation. Typically
this can happen only if your model includes a user-written S-function that
has a bug. If enabled, this check is performed for every block in the model
every time the block is executed. As a result, enabling this option slows down
model execution considerably. Thus, to avoid slowing down model execution
needlessly, you should enable the option only if you suspect that your model
contains a user-written S-function that has a bug. See “Writing S-Functions”
for more information on using this option.
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Model Verification block enabling. This parameter allows you to enable
or disable model verification blocks in the current model either globally or
locally. Select one of the following options:

® Use local settings

Enables or disables blocks based on the value of the Enable assertion
parameter of each block. If a block’s Enable assertion parameter is on,
the block is enabled; otherwise, the block is disabled.

® Enable all

Enables all model verification blocks in the model regardless of the settings
of their Enable assertion parameters.

® Disable all

Disables all model verification blocks in the model regardless of the settings
of their Enable assertion parameters.

Conversion Diagnostics

This control group enables you to specify the diagnostic action that Simulink
should take when it detects a data type conversion problem while compiling
the model.

Type Conversion

Unnecessary type conversions: I none ;I
Vectar/matrix block input conversion: I none ;I
32-bit integer to single precision float conversion: I Waming :I

Unnecessary type conversions. A Data Type Conversion block is used
where no type conversion is necessary.

Vector/matrix block input conversion. A vector-to-matrix or
matrix-to-vector conversion occurred at a block input (see “Vector or Matrix
Input Conversion Rules” on page 5-18).

32-bit integer to single precision float conversion. A 32-bit integer
value was converted to a floating-point value. Such a conversion can result
in a loss of precision.
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Connectivity Diagnostics

This control group enables you to specify the diagnostic action that Simulink
should take when it detects a problem with block connections while compiling
the model.

— Connectivity

—Signals
Signal label mismatch: I none LI
Unconnected block input porks; I warning ;I
Unconnected block output ports:l warning LI
Unconnected line: I warhing LI

—Buzes
Unspecified bus object at raat Outpart black: I warhing LI
Element name mismatch: I none ;I
Mus blocks used to create bus signals I none LI

—Function calls
Iralid function-call connection:l errar LI
Contest-dependent inputs: I Uze local settings LI

Signal label mismatch. The simulation encountered virtual signals that
have a common source signal but different labels (see “Virtual Signals” on
page 5-6).

Unconnected block input ports. Model contains a block with an
unconnected input.

Unconnected block output ports. Model contains a block with an
unconnected output.

Unconnected line. Model contains an unconnected line.
Unspecified bus object at root Outport block. Specifies diagnostic action
to take while generating a simulation target for a referenced model if any of

the model’s root Outport blocks is connected to a bus but does not specify a
bus object (see Simulink.Bus).
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Element name mismatch. Specifies diagnostic action to take if the name of
a bus element does not match the name specified by the corresponding bus
object. You can use this diagnostic along with bus objects to ensure that your
model meets bus element naming requirements imposed by some blocks, such
as the Switch block.

Mux blocks used to create bus signals. This diagnostic detects use of
Mux blocks to create buses. The diagnostic considers a signal created by a Mux
block to be a bus if the signal meets either or both of the following conditions:

® A Bus Selector block individually selects one or more of the signal’s
elements (as opposed to the entire signal).

® The signal’s components have differing data types, numeric types (complex
or real), dimensionality, storage classes (see “Real-Time Workshop”
for information on storage classes), or sampling modes (see the Signal
Processing Blockset documentation for information on frame-based
sampling).

The diagnostic has the following options:

e error

This option enforces the following “strict bus® behavior during model
editing, updating, and simulation:

= A Mux block with more than one input is allowed to output only a vector
signal. A Mux block with only one input is allowed to output only a
scalar, vector, or matrix signal. Simulink displays all nonscalar Mux
outputs as wide signals.

= The dialog boxes for Bus Creator and Bus Selector blocks allow you
to select input signals created by Mux blocks but not the individual
elements of those signals. For example, suppose that the bus connected
to a Bus Selector includes a vector signal created by a Mux block. The
Bus Selector allows you to select the vector signal but not any of its
elements.

If this option detects a Mux block that violates strict bus behavior while
updating or simulating the model, it halts the model update or simulation
and displays a message in the Simulink Diagnostic Viewer. The message
identifies the offending Mux block.
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warning

This option does not enforce strict bus behavior. However, if it detects a
Mux block that creates a bus during model update or simulation, it displays
a message in the MATLAB Command Window that identifies the offending
block. It does this for the first ten Mux blocks that it encounters that
violate strict bus behavior.

none

Disables checking for Mux blocks used to create buses. This is the default
setting for this diagnostic.

Note You can avoid strict bus behavior errors and warnings by using
slreplace_mux to remove Mux blocks that violate strict bus behavior from
your model. Before executing the command, you should set this diagnostic
to warning or none.

Invalid function call connection. Simulink has detected an incorrect use
of a function-call subsystem in your model (see the "Function-call systems"
examples in the Simulink “Subsystem Semantics” library for examples of
invalid uses of function-call subsystems). Disabling this error message can
lead to invalid simulation results.

Context-dependent inputs. Controls whether Simulink displays a warning
if it has to compute any of a function-call subsystem’s inputs directly or
indirectly during execution of a call to a function-call subsystem (see the
"Function-call systems" examples in the Simulink "Subsystem Semantics"
library for examples of such function-call subsystems). The options are

Use local settings

Causes Simulink to issue a warning only if the corresponding diagnostic is
selected on the function-call subsystem’s parameters dialog box (see the
documentation for the Subsystem block’s parameter dialog box for more
information).

Enable all

Enables this diagnostic for all function-call subsystems in this model.
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® Disable all

Disable this diagnostic for all function-call subsystems in this model.

Compatibility Diagnostics

This control group enables you to specify the diagnostic action that Simulink
should take when it detects an incompatibility between this version of
Simulink and the model when updating or simulating the model.

Compatibility

S-function upgrades needed: I nane LI
W Check undefined subsystem initial output
W Check preactivation output of execution context

v Check runtime output of efecution contest

S-function upgrade needed. A block was encountered that has not been
upgraded to use features of the current release.

Check undefined subsystem initial output. Display a warning if the
model contains a conditionally executed subsystem in which a block with a
specified initial condition (e.g., a Constant, Initial Condition, or Delay block)
drives an Outport block with an undefined initial condition, i.e., the Outport
block’s Initial output parameter is set to [].

Models with such subsystems can produce initial results (i.e., before initial
activation of the conditionally executed subsystem) in the current release that

differ from initial results produced in Release 13 or earlier releases.

Consider for example the following model.
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This model does not define the initial condition of the triggered subsystem’s
output port.

The following figure compares the superimposed output of this model’s Step
block and the triggered subsystem in Release 13 and the current release.

Release 13 Current Release

Notice that the initial output of the triggered subsystem differs between the
two releases. This is because Release 13 and earlier releases use the initial
output of the block connected to the output port (i.e., the Constant block) as
the triggered subsystem’s initial output. By contrast, this release outputs 0
as the initial output of the triggered subsystem because the model does not
specify the port’s initial output.

Check preactivation output of execution context. Display a warning if
the model contains a block that meets the following conditions:

The block produces nonzero output for zero input (e.g., a Cosine block).

The block is connected to an output of a conditionally executed subsystem.

The block inherits its execution context from that subsystem.

The Outport to which it is connected has an undefined initial condition, i.e.,
the Outport block’s Initial output parameter is set to [].

Models with blocks that meet these criteria can produce initial results (i.e.,
before the conditionally executed subsystem is first activated in the current
release that differ from initial results produced in Release 13 or earlier
releases.
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Consider for example the following model.
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The following figure compares the superimposed output of the Pulse
Generator and cos block in Release 13 and the current release.

Current Release

Release 13

Note that the initial output of the cos block differs between the two releases.
This is because in Release 13, the cos block belongs to the execution context
of the root system and hence executes at every time step whereas in the
current release, the cos block belongs to the execution context of the triggered
subsystem and hence executes only when the triggered subsystem executes.

Check run-time output of execution context. Display a warning if the
model contains a block that meets the following conditions:

® The block has a tunable parameter.
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® The block is connected to an output of a conditionally executed subsystem.

® The block inherits its execution context from that subsystem.

e The Outport to which it is connected has an undefined initial condition, i.e.,
the Outport block’s Initial output parameter is set to [].

Models with blocks that meet these criteria can produce results when the
parameter is tuned in the current release that differ from results produced in
Release 13 or earlier releases.

Consider for example the following model.
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In this model, the tunevar S-function changes the value of the Gain block’s k
parameter and updates the diagram at simulation time 7 (i.e., it simulates

tuning the parameter).
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The following figure compares the superimposed output of the model’s Pulse
Generator block and its Gain block in Release 13 and the current release.

Release 13 Current Release

Note that the output of the Gain block changes at time 7 in Release 13 but
does not change in the current release. This is because in Release 13, the Gain
block belongs to the execution context of the root system and hence executes
at every time step whereas in the current release, the Gain block belongs to
the execution context of the triggered subsystem and hence executes only
when the triggered subsystem executes, i.e., at times 5, 10, 15, and 20.

Model Reference Diagnostics

This control group enables you to specify the diagnostic action that Simulink
should take when it detects in incompatibility between this version of
Simulink and the model while when updating or simulating the model.

Salver I Sample Time I Data Integrity | Conversion I Connectivity | Compatibility | Model Referencing

Model block version mismatch: I none
Port and parameter mizmatch; I hiore
I odel configuration mismatch: I nake

Itwwalid root Inpart/ Outpart Black connection: I FicneE

[EXEN{EREN|EY

Unsupported data logging: I warning

Model block version mismatch. Specifies the diagnostic action to take
during loading or updating of this model when Simulink detects a mismatch
between the version of the model used to create or refresh a Model block in
this model and the referenced model’s current version. The options are

® none (the default)
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® warning
Refresh the Model block and report a warning message.
® error

Display an error message but do not refresh the Model block.

If you have enabled displaying of referenced model version numbers on Model
blocks for this model (see “Displaying Referenced Model Version Numbers”
on page 3-68), Simulink displays a version mismatch on the Model block icon
as, for example: Rev:1.0 != 1.2,

Port and parameter mismatch. Specifies the diagnostic action to take
during model loading or updating when Simulink detects a mismatch between
the I/O ports of a Model block in this model and the root-level I/O ports of the
model it references or between the parameter arguments recognized by the
Model block and the parameter arguments declared by the referenced model.
The options are

® none (the default)
® warning
Refresh the out-of-date Model block and report a warning message.
® error
Display an error message but do not refresh the out-of-date Model block.
Model block icons can display a message indicating port or parameter

mismatches. To enable this feature, select Block display > Model block I/0
mismatch from the parent model’s Format menu.

Model configuration mismatch. Specifies the diagnostic action to take
if the configuration parameters of a model referenced by this model do not
match this model’s configuration parameters or are inappropriate for a
referenced model. The default action is none. Set this diagnostic to warning
or error if you suspect that an inappropriate or mismatched configuration
parameter may be causing your model to give the wrong result.
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Invalid root Inport/Outport block connection. Specifies the diagnostic
action to take during code generation if Simulink detects invalid internal
connections to this model’s root-level Output port blocks.

When this option is set to error, Simulink reports an error if any of the
following types of connections appear in this model.

® A root Output port is connected directly or indirectly to more than one
nonvirtual block port, for example:

GHain

® A root Output port is connected to a root Inport block, a Ground block, or
a nondata port (e.g, a state port).

- »(_1)
In1 Cutl

i L&D

Ground Qutz

NED

Qutd
—
In2 z1

Dizcrete -Time
Integrator

® Two root Outport blocks cannot be connected to the same block port.

[ 1
In1 Cutl

GHain
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® An Outport block cannot be connected to some elements of a block output
and not others.

® An Outport block cannot be connected more than once to the same element.

s ¢ ML

Gain Outl

If you select none (the default), Simulink silently inserts blocks to satisfy
the constraints wherever possible. In a few cases (such as function-call
feedback loops), the inserted blocks may introduce delays and thus may
change simulation results.

If you select warning, Simulink warns you that a connection constraint has
been violated and attempts to satisfy the constraint by inserting hidden
blocks.

Auto-inserting hidden blocks to eliminate root I/O problems stops at
subsystem boundaries. Therefore, you may need to manually modify models
with subsystems that violate any of the above constraints.

Unsupported data logging. Specifies the diagnostic action to take if
this model contains To Workspace blocks or Scope blocks with data logging
enabled. The default action warns you that Simulink does not support use
of these blocks to log data from referenced models. See “Logging Referenced
Model Signals” on page 5-35 for information on how to log signals from a
reference to this model. See “Simulink Reference” for more information.
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Hardware Implementation Pane

This pane applies to models of computer-based systems, such as embedded
controllers. It allows you to specify the characteristics of the hardware to be
used to implement the system represented by this model. This in turn enables
simulation of the model to detect error conditions that could arise on the
target hardware, such as hardware overflow.

—Embedded hardware [simulation and code generation)

Device type: | Unspecified [azsume 32-bit Generic) LI

Mumber of bits: char: Ia zhort: I‘I B iiit: |32
long: |32 native word size; |32

Eyte ordering: I Urnzpecified

Signed integer divizion rounds to: I Undefined

[¥ Shift right on a sighed integer as arithmetic shift

—Emulation hardware [code generation only)

¥ More

This pane contains the following groups of controls.

Embedded hardware

This group of controls enables you to specify the characteristics of the
hardware that will be used to implement the production version of the system
represented by this model. (See “Emulation hardware” on page 9-94 for
information on specifying the characteristics of hardware used to emulate the
production hardware.) This group includes the following controls.

Device type. Specifies the type of hardware that will be used to implement
the production version of the system represented by this model. The adjacent
list lists types of hardware that Simulink knows about and hence does not
require you to enter their characteristics. If your production hardware does
not match any of the listed types, select Unspecified (assume 32-bit
Generic) ifit has the characteristics of a generic 32-bit microprocessor;
otherwise, Custom.



Configuration Parameters Dialog Box

Number of bits. This group of controls specifies the length in bits of C data
types supported by the selected device type. Simulink disables these controls
if it knows the data type lengths for the selected device type.

Native word size. Specifies the word length in bits of the selected
production hardware device type. Simulink disables this field if it knows the
word length of the selected device type.

Signed integer division rounds to. Specifies how an ANSI C conforming
compiler used to compile code for the production hardware rounds the result
of dividing one signed integer by another to produce a signed integer quotient.
The options are

e Zero

If the ideal quotient is between two integers, the compiler chooses the
integer that is closest to zero as the result.

® Floor

If the ideal quotient is between two integers, the compiler chooses the
integer that is closest to negative infinity as the result.

® Undefined
The compiler’s rounding behavior is undefined if either or both operands

are negative.

The following table illustrates the compiler behavior specified by these
options.

Ideal
N D N/D Zero Floor Undefined
33 4 8.25 8 8 8
-33 4 -8.25 -8 -9 -8 or -9
33 -4 -8.25 -8 -9 -8 or -9
-33 -4 8.25 8 8 -8 or -9

The setting of this option affects only generation of code from the model
(see “Real-Time Workshop User’s Guide” for information on how this option
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affects code generation). Use the Round integer calculations toward
parameter settings on your model’s blocks to simulate the rounding behavior
of the C compiler that you intend to use to compile code generated from the
model. This setting appears on the Signal data type pane of the parameter
dialog boxes of blocks that can perform signed integer arithmetic, such as
the Product and Sum blocks.

Shift right on a signed integer as arithmetic shift. Select this option if
the C compiler implements a signed integer right shift as an arithmetic right
shift. An arithmetic right shift fills bits vacated by the right shift with the
value of the most significant bit, which indicates the sign of the number in
twos complement notation. It is equivalent to dividing the number by 2. This
setting affects only code generation.

Byte ordering. Specifies the significance of the first byte of a data word
of the target hardware. Select Big Endian if the first byte is the most
significant, Little Endian if it is the least significant, or Unspecified if
the significance is unknown. This setting affects only code generation. See
“Real-Time Workshop User’s Guide” for more information.

Emulation hardware

This group of controls allows you to specify the characteristics of hardware
used to test code generated from this model.

Emulation hardware [code generation only]
’7 ¥ Mone

Initially, this group of controls has only one control.
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None. If checked, this check box specifies that the hardware used to test
the code generated from this model is the same as the production hardware
or has the same characteristics. If you plan to use emulation hardware

that has different characteristics, deselect this check box. This causes
Simulink to expand the group to display controls that allow you to specify the
characteristics of the emulation hardware.

—Emulation hardware [code generation only)
[ More
Device ype: | Unzpecified [assume 32-bit Generic) ﬂ

Murnber of Bits: char IS short: |1 [ int: |32
long: |32 nhative word size: |32

Byte ordering: I Urzpecified ﬂ
Signed integer division rounds ta: I |Undefined :I

¥ | Shift right on a sighed integer as anthmetic shift

The additional controls are identical to the ones used to specify the
characteristics of the target hardware for your system. See “Embedded
hardware” on page 9-92 for information on using these controls.
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Model Referencing Pane

The Model Referencing pane allows you to specify options for including
other models in this model and this model in other models and for building
simulation and code generation targets.

Model Referencing

—Rebuild options for all referenced models

Febuild options: | Always rebuild targets ﬂ

— Options for referencing this mode!

Tatal number of instances dlowed per top madel: | Multiple :I

Madel dependencies:

% Specify the model dependencies az a cell aray of lle names. The dependencies
automatically include the model.mdl and linked libray . mdl files. For files

not on the MATLAE path, uze abzolute paths; prefis $MDL to a file path if the
path iz relative to the location of the mdl file; wildcards are allowed; use a "%’

to comment out a line; uge .. to continue linez. Faor example,

{Devwfork\parameters mat', "SMD Lsndbvars mat',
Dok masksh® m'}

S8R B G e

[~ Pass szalar root inputs by valus

[ Minimize algebraic loop occurmences

Note The option descriptions use the term this model to refer to the model
that you are configuring and the term referenced model to designate models
referenced by this model.

The pane includes controls for specifying options for

¢ Including other models in this model (see “Rebuild options for all referenced
models” on page 9-97)

¢ Including the current model in other models (see “Options for referencing
this model” on page 9-98)
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Rebuild options for all referenced models

This group allows you to specify rebuild options for models directly or
indirectly referenced by this model. It includes the following controls.

Rebuild targets. This control specifies whether to rebuild simulation

and Real-Time Workshop targets for referenced models before updating,
simulating, or generating code from this model. This includes models
indirectly referenced by this model. The options, in order from safe and slow
to fast and risky, are

® Always rebuild targets

Always rebuild all targets referenced by this model before simulating,
updating, or generating code from it.

e If any changes detected (the default)

Rebuild the target for a referenced model if Simulink detects any changes
of any kind in the target’s dependencies. The dependencies include

= The referenced model’s model file

= Block library files used by the referenced model

= Targets of models referenced by the referenced model

= S-functions and associated TLC files used by the referenced model

= User-specified dependencies (see “Model dependencies” on page 9-99)
= Workspace variables used by the referenced model

This also checks for changes in the compiled form of the referenced model.
Checking the compiled model can detect some changes that occur even in
dependencies that you do not specify.

e If any changes in known dependencies detected

Rebuild a target if Simulink detects any changes in known target
dependencies (see above) since the target was last built. This option ignores
cosmetic changes, such as annotation changes, in the referenced model and
in any block library dependencies, thus preventing unnecessary rebuilds.
However, before selecting it, you should be certain that you have specified
every user-created dependency (e.g., M-files or MAT-files) for this model

to ensure that all targets that need to be rebuilt are rebuilt. Otherwise,
invalid simulation results may occur.
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Note that this option cannot detect changes in unspecified dependencies,
such as M-files used to initialize block masks. If you suspect that a model
has such unknown dependencies, you can still guarantee valid simulation
by selecting the Always rebuild targets or the If any changes
detected option.

Never rebuild targets

Never rebuild targets before simulating or generating code from this model.
If you are certain that your targets are up-to-date, you can use this option
to avoid time-consuming target dependency checking when simulating,
updating, or generating code from a model. Use this option with caution
because it may lead to invalid results if referenced model targets are not in
fact up-to-date.

Note It is a good idea to use the Always rebuild targets option before
deployment of a model to assure that all the model reference targets are
up-to-date.

Never rebuild targets diagnostic. This control appears only if you select
the Never rebuild targets option. It allows you to specify the diagnostic
action that Simulink should take if it detects a target that needs to be rebuilt.
The options are

Error if targets require rebuild (the default)
Warn if targets require rebuild
None

Selecting None bypasses dependency checking, and thus enables faster
updating, simulation, and code generation, but can cause models that are
not up-to-date to malfunction or generate incorrect results.

Options for referencing this model

This group of controls specifies options for including this model in other
models. It includes the following controls.
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Total number of instances allowed per top model. This option allows
you to specify how many references to this model (i.e., the model you are
configuring) can safely occur in another model. The options are

® One
® Multiple (the default)

® None

If you specify None, and a reference to this model occurs in another model
(including its model references), Simulink displays an error when you try to
simulate or update the root model. Simulink similarly displays an error,

if you specify One and multiple references to this model occur in a root
model (including its model references). If you specify multiple and Simulink
determines that for some reason this model cannot be multiply referenced,
Simulink displays an error when the model that references it is compiled or
simulated. This occurs even if the model is referenced only once.

Model dependencies. Specifies files on which this model relies. They are
typically MAT-files and M-files used to initialize parameters and to provide
data.

Specify the dependencies as a cell array of strings, where each cell array
entry is the filename or path of a dependent file. These filenames may include
spaces and must include file extensions (e.g.,.m,.mat, etc.).

Prefix the token $MDL to a dependency to indicate that the path to the
dependency is relative to the location of this model file.

If Simulink cannot find a specified dependent file when you update or simulate
a model that references this model, Simulink displays a warning.

Pass scalar root inputs by value. Checking this option causes a model
that calls (i.e., references) this model to pass this model’s scalar inputs by
value. Otherwise, the calling model passes the inputs by reference, i.e., it
passes the addresses of the inputs rather than the input values.

Passing roots by value allows this model to read its scalar inputs from register
or local memory which is faster than reading the inputs from their original
locations. However, this option can lead to incorrect results if the model’s root
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scalar inputs can change within a time step. This can happen, for instance, if
this model’s inputs and outputs share memory locations (e.g., as a result of a
feedback loop) and the model is invoked multiple times in a time step (i.e.,
by a Function-Call Subsystem). In such cases, this model sees scalar input
changes that occur in the same time step only if the inputs are passed by
reference. That is why this option is off by default. If you are certain that this
model is not referenced in contexts where its inputs can change within a time
step, select this option to generate more efficient code for this model.

Note Selecting this option can affect reuse of code generated for subsystems.
See “Real-Time Workshop User’s Guide” for more information.

Minimize algebraic loop occurrences. Checking this option causes
Simulink to try to eliminate algebraic loops involving this model from models
that reference it. Enabling this option disables conditional input branch
optimization for simulation and the Real-Time Workshop single update/output
function optimization for code generation. See “Eliminating Algebraic Loops”
on page 1-27 for more information.
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Diagnosing Simulation Errors

If errors occur during a simulation, Simulink halts the simulation, opens the

subsystems that caused the error (if necessary), and displays the errors in the
Simulation Diagnostics Viewer. The following section explains how to use the
viewer to determine the cause of the errors.

Simulation Diagnostics Viewer

The viewer comprises an Error Summary pane and an Error Message pane.

=10l ]

Wiewy  Font Size
Message Source Reported by Summary
[ WEiock error  |Actuatarh’- .. [Simulink Errar evaluating parameter 'Denaminatar' in black 11 4040t e
@ Blockerror  Gain3 =g Ulink Error ewaluating parameter 'Gain'in block 1 4fAircraft Dynarn
@ Blockerrar  Alpha-sens... Simu Errar evaluating parameter ‘Denaminatar’ in black f14Cant
@ Blockerror  G-gustma.. Simulink ror evaluating parameter ‘Mumerator' in block 1 4/Dryden
@ Blockerrar  Q-gustmo.. Simulink Errd™egaluating parameter ‘Denaminatar’ in black 1 4D
@ Blockerror  Gain Simulink Error evaltslipg parameter 'Gain'in block T14iGain' Undefir
Sl Black errar  Gaini Sirmulink Errar evaluating tecameter 'Gain' in black 11 4/Gain " IUnd_efI;|
1 r
e

& 1 4ractuator Model
Error evaluating parameter 'Tenominatar'in block 1 4fActuator Model’ Undefined fu

orvariahle Ta'

~ (lick to display
error source.

Cpen | Help | Close |

Error Summary Pane

The upper pane lists the errors that caused Simulink to terminate the
simulation. The pane displays the following information for each error.

Message. Message type (for example, block error, warning, log)

Source. Name of the model element (for example, a block) that caused the
error
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Reported by. Component that reported the error (for example, Simulink,
Stateflow, Real-Time Workshop, etc.)

Summary. Error message, abbreviated to fit in the column

You can remove any of these columns of information to make more room for
the others. To remove a column, select the viewer’s View menu and uncheck
the corresponding item.

Error Message Pane

The lower pane initially contains the contents of the first error message listed
in the top pane. You can display the contents of other messages by clicking
their entries in the upper pane.

In addition to displaying the viewer, Simulink opens (if necessary) the
subsystem that contains the first error source and highlights the source.

ZJuntitled * 1Ol x|

File Edit Wiew Simulation Format Tools Help

DSE&E BB D pEL €|

. irtd intd 1 double
10 =
e int3 b double E

Constant Gain Integratar Scope

Fl100% [ [ |ode4s v

You can display the sources of other errors by clicking anywhere in the error
message in the upper pane, by clicking the name of the error source in the
error message (highlighted in blue), or by clicking the Open button on the
viewer.

Changing Font Size

To change the size of the font used to display errors, select Font Size from
the viewer’s menu bar. A menu of font sizes appears. Select the desired font
size from the menu.
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Creating Custom Simulation Error Messages

The Simulation Diagnostics Viewer displays the output of any instance of the
MATLAB error function executed during a simulation, including instances
invoked by block or model callbacks or S-functions that you create or that are
executed by the MATLAB Fecn block. Thus, you can use the MATLAB error
function in callbacks and S-functions or in the MATLAB Fecn block to create
simulation error messages specific to your application.

For example, in the following model,

WATLAB —
Function

Constant check_signal Diizp lay

the MATLAB Fcn block invokes the following function:

function y=check_signal(x)
if x<0
error('Signal is negative.');
else
y=X;
end

Executing this model displays an error message in the Simulation Diagnostics
Viewer.

i Simulation Diagnostics: test_error - |EI|5|
“ieww  Font Size

Message Source Fepored by Summary
[* WEIock error  [check_sign.. [Simulink Errorin MATLAB Function block te..

4 |+

0 test_erroricheck_signal

Errarin MATLAB Function block test errarfcheck signal'while evaluating
expression: Error using === check_signal

Signal is negative

Open | Help | Close |
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Including Hyperlinks in Error Messages
You can include hyperlinks to blocks, text files, directories.

Object Links. To include a hyperlink to a block, path, or directory, include
the item’s path in the error message enclosed in quotation marks, e.g.,

error ('Error evaluating parameter in block "mymodel/Mu""')

displays a text hyperlink to the block Mu in the current model in the error
message. Clicking the hyperlink displays the block in the model window.

error ('Error reading data from "c:/work/test.data"')

displays a text hyperlink to the file test.data in the error message.
Clicking the link displays the file in your preferred MATLAB editor.

error ('Could not find data in directory "c:/work"')

displays a text hyperlink to the c:/work directory. Clicking the link opens a
system command window (shell) and sets its working directory to c: /work.

Note The text hyperlink is enabled only if the corresponding block exists
in the current model or if the corresponding file or directory exists on the
user’s system.
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Improving Simulation Performance and Accuracy

Simulation performance and accuracy can be affected by many things,
including the model design and choice of configuration parameters.

The solvers handle most model simulations accurately and efficiently with
their default parameter values. However, some models yield better results
if you adjust solver parameters. Also, if you know information about your
model’s behavior, your simulation results can be improved if you provide
this information to the solver.

Speeding Up the Simulation

Slow simulation speed can have many causes. Here are a few:

® Your model includes a MATLAB Fcn block. When a model includes a
MATLAB Fecn block, the MATLAB interpreter is called at each time step,
drastically slowing down the simulation. Use the built-in Fen block or
Math Function block whenever possible.

® Your model includes an M-file S-function. M-file S-functions also cause
the MATLAB interpreter to be called at each time step. Consider either
converting the S-function to a subsystem or to a C-MEX file S-function.

® Your model includes a Memory block. Using a Memory block causes the
variable-order solvers (ode15s and ode113) to be reset back to order 1 at
each time step.

¢ The maximum step size is too small. If you changed the maximum step
size, try running the simulation again with the default value (auto).

® Did you ask for too much accuracy? The default relative tolerance (0.1%
accuracy) is usually sufficient. For models with states that go to zero, if
the absolute tolerance parameter is too small, the simulation can take too
many steps around the near-zero state values. See the discussion of error
in “Maximum order” on page 9-42.

® The time scale might be too long. Reduce the time interval.

® The problem might be stiff, but you are using a nonstiff solver. Try using
ode15s.
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* The model uses sample times that are not multiples of each other. Mixing
sample times that are not multiples of each other causes the solver to take
small enough steps to ensure sample time hits for all sample times.

* The model contains an algebraic loop. The solutions to algebraic loops are
iteratively computed at every time step. Therefore, they severely degrade
performance. For more information, see “Algebraic Loops” on page 1-24.

® Your model feeds a Random Number block into an Integrator block. For
continuous systems, use the Band-Limited White Noise block in the
Sources library.

Improving Simulation Accuracy

To check your simulation accuracy, run the simulation over a reasonable time
span. Then, either reduce the relative tolerance to le-4 (the default is 1e-3)
or reduce the absolute tolerance and run it again. Compare the results of
both simulations. If the results are not significantly different, you can feel
confident that the solution has converged.

If the simulation misses significant behavior at its start, reduce the initial step
size to ensure that the simulation does not step over the significant behavior.

If the simulation results become unstable over time,

® Your system might be unstable.

® Ifyou are using ode15s, you might need to restrict the maximum order to
2 (the maximum order for which the solver is A-stable) or try using the
ode23s solver.

If the simulation results do not appear to be accurate,

* For a model that has states whose values approach zero, if the absolute
tolerance parameter is too large, the simulation takes too few steps around
areas of near-zero state values. Reduce this parameter value or adjust it
for individual states in the Integrator dialog box.

¢ If reducing the absolute tolerances does not sufficiently improve the
accuracy, reduce the size of the relative tolerance parameter to reduce the
acceptable error and force smaller step sizes and more steps.
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Running a Simulation Programmatically

Entering simulation commands in the MATLAB Command Window or from
an M-file enables you to run unattended simulations. You can perform
Monte Carlo analysis by changing the parameters randomly and executing
simulations in a loop. You can use either the sim command or the set_param
command to run a simulation programmatically. Both are described below.

Using the sim Command
The full syntax of the command that runs the simulation is

[t,x,y] = sim(model, timespan, options, ut);

Only the model parameter is required. Parameters not supplied on the
command are taken from the Configuration Parameters dialog box settings.

For detailed syntax for the sim command, see the documentation for the sim
command. The options parameter is a structure that supplies additional
configuration parameters, including the solver name and error tolerances.
You define parameters in the options structure using the simset command
(see simset). The configuration parameters are discussed in “Configuration
Sets” on page 9-29.

Using the set_param Command

You can use the set_param command to start, stop, pause, or continue
a simulation, or update a block diagram. The format of the set param
command for this use is

set_param('sys', 'SimulationCommand', 'cmd')

where 'sys' is the name of the system and 'cmd' is 'start’', 'stop’,
'pause’, 'continue’, or 'update’.
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Similarly, you can use the get_param command to check the status of a
simulation. The format of the get _param command for this use is

get param('sys', 'SimulationStatus')

Simulink returns 'stopped', 'initializing', 'running’', 'paused’,
'updating', 'terminating', and 'external' (used with Real-Time
Workshop).



Analyzing Simulation
Results

The following sections explain how to use Simulink tools for analyzing the
results of simulations.

Viewing Output Trajectories (p. 10-2) Explains how to display your output
directories.

Linearizing Models (p. 10-4) Describes functions that extract
a linear state-space model from a
Simulink model.

Finding Steady-State Points (p. 10-7) How to use the Simulink trim
command to determine steady-state
points of a system represented by a
Simulink model.
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Viewing Output Trajectories

Output trajectories from Simulink can be plotted using one of three methods:

® Feed a signal into either a Scope or an XY Graph block.
® Write output to return variables and use MATLAB plotting commands.

® Write output to the workspace using To Workspace blocks and plot the
results using MATLAB plotting commands.

Using the Scope Block

You can display output trajectories on a Scope block during simulation as
illustrated by the following model.

1
I I B
=+
Step Transfer Fen Scope

The display on the Scope shows the output trajectory. The Scope block enables
you to zoom in on an area of interest or save the data to the workspace.

The XY Graph block enables you to plot one signal against another.

Using Return Variables

By returning time and output histories, you can use MATLAB plotting
commands to display and annotate the output trajectories.

Out

Step Transter Fon

The block labeled Out is an Outport block from the Ports & Subsystems
library. The output trajectory, yout, is returned by the integration solver. For
more information, see “Data Import/Export Pane” on page 9-48.



Viewing Output Trajectories

You can also run this simulation from the Simulation menu by specifying
variables for the time, output, and states on the Data Import/Export pane
of the Configuration Parameters dialog box. You can then plot these
results using

plot(tout,yout)

Using the To Workspace Block

The To Workspace block can be used to return output trajectories to the
MATLAB workspace. The following model illustrates this use:

1

—— — EE— W
=+

Step Transfer Fon To Wotkspace

® o

Clodk Tao Wokspace

The variables y and t appear in the workspace when the simulation is
complete. You store the time vector by feeding a Clock block into a To
Workspace block. You can also acquire the time vector by entering a variable
name for the time on the Data Import/Export pane of the Configuration
Parameters dialog box, for menu-driven simulations, or by returning it using
the sim command (see “Data Import/Export Pane” on page 9-48 for more
information).

The To Workspace block can accept an array input, with each input element’s
trajectory stored in the resulting workspace variable.
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Linearizing Models

Simulink provides the 1inmod, 1inmod2, and dlinmod functions to extract
linear models in the form of the state-space matrices A, B, C, and D.
State-space matrices describe the linear input-output relationship as

Ax+Bu
Cx+Du

y

where x, u, and y are state, input, and output vectors, respectively. For
example, the following model is called 1mod.

Wz}

[ ——-{+ 1
>
In - EER e
Sum Flant v
1
=+1
Faedback

To extract the linear model of this Simulink system, enter this command.

[A,B,C,D] = linmod('1lmod")

A =
-2 -1 -1
1 0 0
0 1 -1
B =
’
0
0
C =
0 1 0
0 0 -1
D =
0
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Inputs and outputs must be defined using Inport and Outport blocks from
the Ports & Subsystems library. Source and sink blocks do not act as inputs
and outputs. Inport blocks can be used in conjunction with source blocks,
using a Sum block. Once the data is in the state-space form or converted
to an LTI object, you can apply functions in the Control System Toolbox for
further analysis:

e Conversion to an LTI object
sys = ss(A,B,C,D);

® Bode phase and magnitude frequency plot
bode (A,B,C,D) or bode(sys)

® Linearized time response

step(A,B,C,D) or step(sys)
impulse(A,B,C,D) or impulse(sys)
1sim(A,B,C,D,u,t) or lsim(sys,u,t)

You can use other functions in the Control System Toolbox and Robust Control
Toolbox for linear control system design.

When the model is nonlinear, an operating point can be chosen at which to
extract the linearized model. The nonlinear model is also sensitive to the
perturbation sizes at which the model is extracted. These must be selected to
balance the tradeoff between truncation and roundoff error. Extra arguments
to 1inmod specify the operating point and perturbation points.

paral = xpert;
[A,B,C,D] = linmod('sys', x, u, pert, parail)

For discrete systems or mixed continuous and discrete systems, use the
function dlinmod for linearization. This has the same calling syntax as
linmod except that the second right-hand argument must contain a sample
time at which to perform the linearization.
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10-6

Linearization Using the ‘v5’ Algorithm

Using linmod with the 'v5' option to linearize a model that contains
Derivative or Transport Delay blocks can be troublesome. Before linearizing,
replace these blocks with specially designed blocks that avoid the problems.
These blocks are in the Simulink Extras library in the Linearization
sublibrary.

You access the Extras library by opening the Blocksets & Toolboxes icon:

® For the Derivative block, use the Switched derivative for linearization.

¢ For the Transport Delay block, use the Switched transport delay for
linearization. (Using this block requires that you have the Control System
Toolbox.)

When using a Derivative block, you can also try to incorporate the derivative
term in other blocks. For example, if you have a Derivative block in series
with a Transfer Fen block, it is better implemented (although this is not
always possible) with a single Transfer Fcn block of the form

=
5+ a

In this example, the blocks on the left of this figure can be replaced by the
block on the right.

— it — ] =




Finding Steady-State Points

Finding Steady-State Points

The Simulink trim function uses a Simulink model to determine steady-state
points of a dynamic system that satisfy input, output, and state conditions
that you specify. Consider, for example, this model, called 1mod.

>

wi2]
O " (1)
In - 2425+ o
Sum Flant
1
s+
Feedbacdck

You can use the trim function to find the values of the input and the states
that set both outputs to 1. First, make initial guesses for the state variables
(x) and input values (u), then set the desired value for the output (y).

x = [0; 0; 0];
:O;
y = [1; 1]

[

Use index variables to indicate which variables are fixed and which can vary.

ix = [1; % Don't fix any of the states
iu = [1; % Don't fix the input
iy = [1;2]; % Fix both output 1 and output 2
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Invoking trim returns the solution. Your results might differ because of
roundoff error.

[x,u,y,dx] = trim('lmod',x,u,y,ix,iu,1iy)
X:
0.0000
1.0000
1.0000
u:
2
y:
1.0000
1.0000
dx =
1.0e-015 *
-0.2220
-0.0227
0.3331

Note that there might be no solution to equilibrium point problems. If that
is the case, trim returns a solution that minimizes the maximum deviation
from the desired result after first trying to set the derivatives to zero. For a
description of the trim syntax, see trim in “Simulink Reference”.
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Subsystems

This section explains how to create custom user interfaces (masks) for

Simulink subsystems.

About Masks (p. 11-2)

Masked Subsystem Example
(p. 11-6)

Masking a Subsystem (p. 11-12)

Mask Editor (p. 11-14)

Linking Mask Parameters to Block
Parameters (p. 11-31)

Creating Dynamic Dialogs for
Masked Blocks (p. 11-32)

An overview of masked subsystems
that introduces you to key concepts.

Introduces you to masking by
taking you step-by-step through
the creation of a simple masked
subsystem.

General procedure for masking
subsystems.

Detailed description of the Mask
Editor.

How to link a mask’s parameters to
the parameters of blocks behind the
mask.

How to create a mask that changes
its appearance based on the options
that a user selects.
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About Masks

A mask is a custom user interface for a subsystem that hides the subsystem’s
contents, making it appear to the user as an atomic block with its own icon
and parameter dialog box. The Simulink Mask Editor enables you to create a
mask for any subsystem. Masking a subsystem allows you to

® Replace the parameter dialogs of a subsystem and its contents with a
single parameter dialog with its own block description, parameter prompts,
and help text

® Replace a subsystem’s standard icon with a custom icon that depicts its
purpose

® Prevent unintended modification of subsystems by hiding their contents
behind a mask

® Create a custom block by encapsulating a block diagram that defines the
block’s behavior in a masked subsystem and then placing the masked
subsystem in a library

Note You can also mask S-Function and Model blocks. The instructions for
masking Subsystem blocks apply to S-Function and Model blocks as well
except where noted.

Mask Features
Masks can include any of the following features.

Mask Icon

The mask icon replaces a subsystem’s standard icon, i.e., it appears in a block
diagram in place of the standard icon for a subsystem block. Simulink uses
MATLAB code that you supply to draw the custom icon. You can use any
MATLAB drawing command in the icon code. This gives you great flexibility
in designing an icon for a masked subsystem.
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Mask Parameters

Simulink allows you to define a set of user-settable parameters for a masked
subsystem. Simulink stores the value of a parameter in the mask workspace
(see “Mask Workspace” on page 11-4) as the value of a variable whose name
you specify. These associated variables allow you to link mask parameters to
specific parameters of blocks inside a masked subsystem (internal parameters)
such that setting a mask parameter sets the associated block parameter (see
“Linking Mask Parameters to Block Parameters” on page 11-31).

Note If you intend to allow the user to specify the model referenced by a
masked Model block or a Model block in a masked subsystem, you must
ensure that the mask requires that the user specify the model name as a
literal value rather than as a workspace variable. This is because Simulink
updates model reference targets before evaluating block parameters. The
recommended way to force the user to specify the model name as a literal is
to use a pop-up control on the mask to specify the model name. See “Pop-Up
Control” on page 11-25 for more information.

Mask Parameter Dialog Box

The mask parameter dialog box contains controls that enable a user to set
the values of the masks parameters and hence the values of any internal
parameters linked to the mask parameters.

The mask parameter dialog box replaces the subsystem’s standard parameter
dialog box, i.e., clicking on the masked subsystem’s icon causes the mask
dialog box to appear instead of the standard parameter dialog box for a
Subsystem block

Note Use the 'mask’' option of the open_system command to open a block’s
mask dialog box at the MATLAB command line or in an M program.

You can customize every feature of the mask dialog box, including which
parameters appear on the dialog box, the order in which they appear,
parameter prompts, the controls used to edit the parameters, and the
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parameter callbacks (code used to process parameter values entered by the
user).

Mask Initialization Code

The initialization code is MATLAB code that you specify and that Simulink
runs to initialize the masked subsystem at the start of a simulation run.
You can use the initialization code to set the initial values of the masked
subsystem’s mask parameters.

Mask Workspace

Simulink associates a workspace with each masked subsystem that you
create. Simulink stores the current values of the subsystem’s parameters in
the workspace as well as any variables created by the block’s initialization
code and parameter callbacks. You can use model and mask workspace
variables to initialize a masked subsystem and to set the values of blocks
inside the masked subsystem, subject to the following rules.

® A block parameter expression can refer only to variables defined in the
mask workspaces of the subsystem or nested subsystems that contain the
block or in the model’s workspace.

e A valid reference to a variable defined on more than one level in the model
hierarchy resolves to the most local definition.

For example, suppose that model M contains masked subsystem A, which
contains masked subsystem B. Further suppose that B refers to a variable
x that exists in both A’s and M’s workspaces. In this case, the reference
resolves to the value in A’s workspace.

* A masked subsystem’s initialization code can refer only to variables in
its local workspace.

® The mask workspace of a Model block is not visible to the model that
it references. Any variables used by the referenced model must resolve

to workspaces defined in the referenced model or to the base (i.e., the
MATLAB) workspace.
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Creating Masks

See “Masking a Subsystem” on page 11-12 for an overview of the process of
creating a masked subsystem. See “Masked Subsystem Example” on page
11-6 for an example of the process.
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Masked Subsystem Example

This simple subsystem models the equation for a line, y = mx + b.

Elmasking_example _10] =]
File Edit WYiew Simulation Format Tools Help -
DEE& ’

BEf

Fl100% odeds

Ordinarily, when you double-click a Subsystem block, the Subsystem block
opens, displaying its blocks in a separate window. The mx + b subsystem
contains a Gain block, named Slope, whose Gain parameter is specified as m,
and a Constant block, named Intercept, whose Constant value parameter is
specified as b. These parameters represent the slope and intercept of a line.

This example creates a custom dialog box and icon for the subsystem. One
dialog box contains prompts for both the slope and the intercept. After you
create the mask, double-click the Subsystem block to open the mask dialog
box. The mask dialog box and icon look like this:

Block Parameters: mx + b

| Mask diakog box

— SampleM azkedBlock [maszk)

Models the equation for a line, y = mx + b.
The glope and intercept are mask block parameters.

=
F

Slope:
3
|| : Block icon
ntercept:
E]
QK I Cancel | Help | Apply | >|Z|>

A user enters values for Slope and Intercept in the mask dialog box.
Simulink makes these values available to all the blocks in the underlying
subsystem. Masking this subsystem creates a self-contained functional unit
with its own application-specific parameters, Slope and Intercept. The mask
maps these mask parameters to the generic parameters of the underlying
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blocks. The complexity of the subsystem is encapsulated by a new interface
that has the look and feel of a built-in Simulink block.

To create a mask for this subsystem, you need to
® Specify the prompts for the mask dialog box parameters. In this example,
the mask dialog box has prompts for the slope and intercept.

® Specify the variable name used to store the value of each parameter.

¢ Enter the documentation of the block, consisting of the block description
and the block help text.

® Specify the drawing command that creates the block icon.

® Specify the commands that provide the variables needed by the drawing
command (there are none in this example).

Creating Mask Dialog Box Prompts

To create the mask for this subsystem, select the Subsystem block and choose
Mask Subsystem from the Edit menu.
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This example primarily uses the Mask Editor’s Parameters pane to create
the masked subsystem’s dialog box.

<} Mask editor :Subsystem -3 %]

lcan Farameters

Initialization l Documentation l

Dialog parameters

Eromg! | variabe | Tye |EvaluateTunabie|
Slape: m |edit ﬂ - v
Intercept b |edit ﬂ v v

SUSIN =

Options for selected parameter
Popups (one perling): Indialog: & v

Callback: j

Unmask Ok | Cancel | Help | Apply |

The Mask Editor enables you to specify these attributes of a mask parameter:

* Prompt, the text label that describes the parameter

® Control type, the style of user interface control that determines how
parameter values are entered or selected

® Variable, the name of the variable that stores the parameter value

Generally, it is convenient to refer to masked parameters by their prompts.
In this example, the parameter associated with slope is referred to as the
Slope parameter, and the parameter associated with intercept is referred to
as the Intercept parameter.

The slope and intercept are defined as edit controls. This means that the user
types values into edit fields in the mask dialog box. These values are stored in
variables in the mask workspace. Masked blocks can access variables only
in the mask workspace. In this example, the value entered for the slope is
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assigned to the variable m. The Slope block in the masked subsystem gets the
value for the slope parameter from the mask workspace.

This figure shows how the slope parameter definitions in the Mask Editor
map to the actual mask dialog box parameters.

Dislog parameters Block Parameters: mx + b
— Sampletd askedBlock [mask]
Prampt Wariahle Type Models the equation for a line, v = mx + b.
Slope: m edit - The glope and intercept are mask block parameters.
Intercept \ b i = - Paramet
\ Slope:
IE

Intercept:

E]
oK I Cancel | Help | Apply |

After you create the mask parameters for slope and intercept, click OK. Then
double-click the Subsystem block to open the newly constructed dialog box.
Enter 3 for the Slope and 2 for the Intercept parameter.
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Creating the Block Description and Help Text

The mask type, block description, and help text are defined on the
Documentation pane. For this sample masked block, the pane looks like

this.
Mask editor : mx+b _ ol x|
Ican I Parameters I Inttizlization Documentation |
Mask type | |
“SampleMaskedBlock
e ——— arn
________'_‘_‘—'—-—-—..L ELE] % + b
~Mask description P Sampletd azkedBlock [mazk]
odelz the equation for a line, y=mx+h, S/_” Models the equ_ation far a line, v = mx + b.
The slope and intercept are masked block parameters= The glope and intercept are mask block parameters.
P '
Slope:
IE
Intercept:
~Mask help I21
Erter the slope tm) and intercept () in the ’—I
] ]__M
lock dislog parameter figlds. Ok Lancy T elp | £
IThe block generstes y for a diven input x.

Unrask | Ok | Cancel | Help | Apply |

Creating the Block Icon

So far, we have created a customized dialog box for the mx + b subsystem.
However, the Subsystem block still displays the generic Simulink subsystem
icon. An appropriate icon for this masked block is a plot that indicates the
slope of the line. For a slope of 3, that icon looks like this.

/
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The block icon is defined on the Icon pane. For this block, the Icon pane
looks like this.

<} Mask editor :Subsystem ;Iglﬂ

lcon

Farameters l Initialization Documentation l

leon aptions Drawing commands
Frame blot([0 11,00 nl+(m<0)] Drawing commands

Wigible -
Transparency

Opague -

Rotation « lcon properfies
Fixed A
Units

Mormalized = :

Examples of drawing commands

Command |pm:t,_label (label specific ports) ﬂ

Syntax port_label{output’, 1, %%

Unmask| Ok | Cancel | Help | Apply |

The drawing command

plot ([0 1],[0 m]+(m<0))

plots a line from (0,0) to (1,m). If the slope is negative, Simulink shifts the
line up by 1 to keep it within the visible drawing area of the block.

The drawing commands have access to all the variables in the mask
workspace. As you enter different values of slope, the icon updates the slope
of the plotted line.

Select Normalized as the Drawing coordinates parameter, located at the
bottom of the list of icon properties, to specify that the icon be drawn in a
frame whose bottom-left corner is (0,0) and whose top-right corner is (1,1).
See “Icon Pane” on page 11-16 for more information.
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Masking a Subsystem
To mask a subsystem:

1 Select the subsystem.

2 Select Edit mask from the Edit menu of the model window or from the
block’s context menu. (Right-click the subsystem block to display its
context menu.)

The Mask Editor appears.

Mask editor : Subsystem ;Iglil

Parameters I Initialization I Documentation I

rloon options Dravving command:

Frame

I Wigible hd l
Transparency

I Opague - l

Rotation

I Fixed hd l

Units

I Autoscale W l

Examples of drawing commam:

Corntmamcd I port_label (label specific ports) v|

Syrtax  port_labell'output’, 1, )

Unrask | Ok | Cancel | Help | Apply |

See “Mask Editor” on page 11-14 for a detailed description of the Mask
Editor.

3 Use the Mask Editor’s tabbed panes to perform any of the following tasks.

® Create a custom icon for the masked subsystem (see “Icon Pane” on page
11-16).

® Create parameters that allow a user to set subsystem options (see “Mask
Editor” on page 11-14).
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¢ Initialize the masked subsystem’s parameters

® (Create online user documentation for the subsystem

4 Click Apply to apply the mask to the subsystem or OK to apply the mask
and dismiss the Mask Editor.
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Mask Editor

The Mask Editor allows you to create or edit a subsystem’s mask. To open
the Mask Editor, select the subsystem’s block icon and then select Edit Mask
from the Edit menu of the model window containing the subsystem’s block.
The Mask Editor appears.

Mask editor : Subsystem ;IQIEI

Parameters I Inttialization I Documentation I

rlcon options

Drranwving cormmatc

Frame

I Wizible hd l
Transparency

I Cpacjue hd l

Rotation

I Fixed hd l

Units

I Autozcale W l

rExamples of drawing commanc:

Cottma I port_label (label specific ports) v|

Syrtax  port_label'output’, 1, sy

Untazk | Ok | Cancel | Help | Apply |

The Mask Editor contains a set of tabbed panes, each of which enables you to
define a feature of the mask:

® The Icon pane enables you to define the block icon (see “Icon Pane” on
page 11-16).

¢ The Parameters pane enables you to define and describe mask dialog box
parameter prompts and name the variables associated with the parameters
(see “Parameters Pane” on page 11-19).

¢ The Initialization pane enables you to specify initialization commands
(see “Initialization Pane” on page 11-26).
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The Documentation pane enables you to define the mask type and specify
the block description and the block help (see “Documentation Pane” on
page 11-28).

Five buttons appear along the bottom of the Mask Editor:

The Unmask button deactivates the mask and closes the Mask Editor.
The mask information is retained so that the mask can be reactivated.

To reactivate the mask, select the block and choose Create Mask. The
Mask Editor opens, displaying the previous settings. The inactive mask
information is discarded when the model is closed and cannot be recovered.

The OK button applies the mask settings on all panes and closes the Mask
Editor.

The Cancel button closes the Mask Editor without applying any changes
made since you last clicked the Apply button.

The Help button displays the contents of this section.

The Apply button creates or changes the mask using the information that
appears on all masking panes. The Mask Editor remains open.

To see the system under the mask without unmasking it, select the Subsystem
block, then select Look Under Mask from the Edit menu. This command
opens the subsystem. The block’s mask is not affected.
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lcon Pane

The Mask Editor’s Icon pane enables you to create icons that can contain
descriptive text, state equations, images, and graphics.

Mask editor : Subsystem ;Iglil

Parameters I Initialization I Documentation I

rloon options Dravwing comrman:

Frame

I “izible - l
Transparency P Commands that draw the block icon

I Opague - l

Ratation Parameters iLui control the icon

[ Ficea ~| - appearance

Units

I Autoscale W l

4

Examples of drawing commam: i E)(um pIeS Of dl‘uwing
Command I port_lahel ({label specific ports) LI communds you can use

” todraw the block kon
Syntax  port_labelioutput’, 1, Sy

Unrask | Ok | Cancel | Help | Apply |

The Icon pane contains the following controls.

Drawing commands

This field allows you to enter commands that draw the block’s icon. Simulink
provides a set of commands that can display text, one or more plots, or show
a transfer function (see "Mask Icon Drawing Commands") in “Simulink
Reference”). You must use these commands to draw your icon. Simulink
executes the drawing commands in the order in which they appear in this
field. Drawing commands have access to all variables in the mask workspace.

This example demonstrates how to create an improved icon for the mx + b
sample masked subsystem discussed earlier in this section:
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pos = get param(gcb, 'Position');

width = pos(3) - pos(1); height = pos(4) - pos(2);

x = [0, width];

if (m >=0), y = [0, (m*width)]; end

if (m<0), vy [height, (height + (m*width))]; end

These initialization commands define the data that enables the drawing
command to produce an accurate icon regardless of the shape of the block.
The drawing command that generates this icon is plot(x,y).

Examples of drawing commands

This panel illustrates the usage of the various icon drawing commands
supported by Simulink. To determine the syntax of a command, select the
command from the Command list. Simulink displays an example of the
selected command at the bottom of the panel and the icon produced by the
command to the right of the list.

Icon options
These controls allow you to specify the following attributes of the block icon.

Frame. The icon frame is the rectangle that encloses the block. You can
choose to show or hide the frame by setting the Frame parameter to Visible
or Invisible. The default is to make the icon frame visible. For example, this
figure shows visible and invisible icon frames for an AND gate block.

—— =D

Visible Invisible

Transparency. The icon can be set to Opaque or Transparent, either
hiding or showing what is underneath the icon. Opaque, the default, covers
information Simulink draws, such as port labels. This figure shows opaque
and transparent icons for an AND gate block. Notice the text on the
transparent icon.

— ——
— AND |——
— D ——
Opague Transparent

11-17



11 Creating Masked Subsystems

Rotation. When the block is rotated or flipped, you can choose whether to
rotate or flip the icon or to have it remain fixed in its original orientation. The
default is not to rotate the icon. The icon rotation is consistent with block port
rotation. This figure shows the results of choosing Fixed and Rotates icon
rotation when the AND gate block is rotated.

vy Yy

=

Fixed Rotates

Units. This option controls the coordinate system used by the drawing
commands. It applies only to plot and text drawing commands. You can
select from among these choices: Autoscale, Normalized, and Pixel.

ma (), mas ) 11 block width, blods heighl
min (2, min(}y a, 0,0
Autoscale Mormalized Pixel

® Autoscale scales the icon to fit the block frame. When the block is resized,
the icon is also resized. For example, this figure shows the icon drawn
using these vectors:

X=[02349];Y=1[46235 8];

v

The lower-left corner of the block frame is (0,3) and the upper-right corner
is (9,8). The range of the x-axis is 9 (from 0 to 9), while the range of the
y-axis is 5 (from 3 to 8).

e Normalized draws the icon within a block frame whose bottom-left corner
is (0,0) and whose top-right corner is (1,1). Only X and Y values between
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0 and 1 appear. When the block is resized, the icon is also resized. For
example, this figure shows the icon drawn using these vectors:

X=1[1.0.2 .3 .4 .9]; Y=1.4 .6 .3 .5 .8];

e

e Pixel draws the icon with X and Y values expressed in pixels. The icon
is not automatically resized when the block is resized. To force the icon to
resize with the block, define the drawing commands in terms of the block
size.

Parameters Pane

The Parameters pane allows you to create and modify masked subsystem
parameters (mask parameters, for short) that determine the behavior of the

masked subsystem.

Mask editor : Subsystem ;Iglil

Initialization I Documentation I

Dislog parameter

Prompt | “ariahle Type Evaluste | Tunahble

o e | |

~Options for selected parameter

Popups (one per linel:  Indislod [ Shoyy parameter ™ [Enable parameter:

Dialog
callback:

Unrask | Ok | Cancel | Help | Apply |

The Parameters pane contains the following elements:
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¢ The Dialog parameters panel allows you to select and change the major
properties of the mask’s parameters (see “Dialog Parameters Panel” on
page 11-20).

* The Options for selected parameter panel allows you to set additional
options for the parameter selected in the Dialog parameters panel.

® The buttons on the left side of the Parameters pane allow you to add,
delete, and change the order of appearance of parameters on the mask’s
parameter dialog box (see “Dialog Parameters Panel” on page 11-20).

Dialog Parameters Panel
Lists the mask’s parameters in tabular form. Each row displays the major
attributes of one of the mask’s parameters.

Prompt. Text that identifies the parameter on a masked subsystem’s dialog
box.

Block Parameters: mx + b

Dislog parameters

- — Sampletd askedBlock [mask]
| T iclishle Ui Models the equation for a line, y = mx + b.
|Slope: L m edit = The glope and intercept are mask block parameters.
|Ir'|terc:ept L \ ] edit h P '
™~ & Slope:

IE

Intercept:

E]

oK I Cancel | Help | Apply |

Variable. Name of the variable that stores the parameter’s value in the
mask’s workspace (see “Mask Workspace” on page 11-4). You can use this
variable as the value of parameters of blocks inside the masked subsystem,
thereby allowing the user to set the parameters via the mask dialog box.

Note Simulink does not distinguish between uppercase and lowercase letters
in mask variable names. For example, Simulink treats gain, GAIN, and Gain
as the same name.
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Type. Type of control used to edit the value of this parameter. The control
appears on the mask’s parameter dialog box following the parameter prompt.
The button that follows the type name in the Parameters pane pops up a list
of the controls supported by Simulink (see “Control Types” on page 11-23). To
change the current control type, select another type from the list.

Evaluate. If checked, this option causes Simulink to evaluate the expression
entered by the user before it is assigned to the variable. Otherwise, Simulink
treats the expression itself as a string value and assigns it to the variable.
For example, if the user enters the expression gain in an edit field and the
Evaluate option is checked, Simulink evaluates gain and assigns the result
to the variable. Otherwise, Simulink assigns the string 'gain' to the variable.
See “Check Box Control” on page 11-24 and “Pop-Up Control” on page 11-25
for information on how this option affects evaluation of the parameters.

If you need both the string entered and the evaluated value, clear the
Evaluate option. To get the value of a base workspace variable entered as
the literal value of the mask parameter, use the MATLAB evalin command
in the mask initialization code. For example, suppose the user enters the
string 'gain' as the literal value of the mask parameter k where gain is the
name of a base workspace variable. To obtain the value of the base workspace
variable, use the following command in the mask’s initialization code:

value = evalin('base', k)

Tunable. Selecting this option allows a user to change the value of the mask
parameter while a simulation is running.

Note Simulink ignores this setting if the block being masked is a source block,
i.e., the block has outputs but no input ports. In such a case, even if this option
is selected, you cannot tune the parameter while a simulation is running. See
“Changing Source Block Parameters” on page 4-9 for more information.

Options for Selected Parameter Panel

This panel allows you to set additional options for the parameter selected in
the Dialog parameters table.
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Show parameter. The selected parameter appears on the masked block’s
parameter dialog box only if this option is checked (the default).

Enable parameter. Clearing this option grays the selected parameter’s
prompt and disables its edit control. This means that the user cannot set
the value of the parameter.

Popups. This field is enabled only if the edit control for the selected
parameter is a pop-up. Enter the values of the pop-up control in this field,
each on a separate line.

Callback. Enter MATLAB code that you want Simulink to execute when a
user applies a change to the selected parameter, i.e., selects the Apply or OK
button on the mask dialog box. You can use such callbacks to create dynamic
dialogs, i.e., dialogs whose appearance changes, depending on changes to
control settings made by the user, e.g., enabling an edit field when a user
checks a check box (see “Creating Dynamic Dialogs for Masked Blocks” on
page 11-32 more information).

The callback can create and reference variables only in the block’s base
workspace. If the callback needs the value of a mask parameter, it can use
get_param to obtain the value, e.g.,

if str2num(get_param(gcb, 'g'))<0
error('Gain is negative.')
end

Parameter Buttons

The following sections explain the purpose of the buttons that appear on the
Parameters pane in the order of their appearance from the top of the pane.
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Add Button. Adds a parameter to the mask’s parameter list. The newly
created parameter appears in the adjacent Dialog parameters table.

Mask editor : Subsystem

lcon Perameters | inialization | Documentation |

Dislog parameters

i Prompt “ariahle Type
/ edit e
New parameter 4
3

Delete Button. Deletes the parameter currently selected in the Dialog
parameters table.

Up Button. Moves the currently selected parameter up one row in the Dialog
parameters table. Dialog parameters appear in the mask’s parameter dialog
box (see “Mask Parameter Dialog Box” on page 11-3) in the same order in
which they appear in the Dialog parameters table. This button (and the
next) thus allows you to determine the order in which parameters appear

on the dialog box.

Down Button. Moves the currently selected parameter down one row in
the Dialog parameters table and hence down one position on the mask’s
parameter dialog box.

Control Types

Simulink enables you to choose how parameter values are entered or selected.
You can create three styles of controls: edit fields, check boxes, and pop-up
controls. For example, this figure shows the parameter area of a mask dialog
box that uses all three styles of controls (with the pop-up control open).

=
F

Frequency: — Ed“ COI'I"OI

I Show label Check box conirol

Calar: | red

Pop-up control

green
yellow
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Edit Control

An edit field enables the user to enter a parameter value by typing it into
a field. This figure shows how the prompt for the sample edit control was
defined.

Dislog parameters

“ariahble Type Ewvaluste | Tuhable
it -
Irtercept b edit 2

o o

The value of the variable associated with the parameter is determined by
the Evaluate option.

Evaluate Value
On The result of evaluating the expression entered in the field
Off The actual string entered in the field

Check Box Control

A check box enables the user to choose between two alternatives by selecting
or deselecting a check box. This figure shows how the sample check box
control is defined.

Dialog parameters

Prompt ariable Type Evaluste | Tunable
Saturate =t checkbosx - [l v

The value of the variable associated with the parameter depends on whether
the Evaluate option is selected.

Evaluated
Control State Value Literal Value
Selected 1 ‘on'
Unselected 0 "off'




Mask Editor

Pop-Up Control

A pop-up enables the user to choose a parameter value from a list of possible
values. Specify the values in the Popups field on the Parameters pane (see
“Popups” on page 11-22). The following example shows a pop-up parameter.

Dislog parameters

Prommpt

Type Evaluate Turakle

Options for selected parameter

Popups (one per linel. 10 di8lod (7 Show parameter [+ Enable parameter
red
blue
I reen

Dialog
callback:

The value of the variable associated with the parameter (Color) depends
on the item selected from the pop-up list and whether the Evaluate option
is checked (on).

Evaluate Value

On Index of the value selected from the list, starting with 1.
For example, if the third item is selected, the parameter
value is 3.

Off String that is the value selected. If the third item is
selected, the parameter value is 'green'.

Changing Default Values for Mask Parameters in a Library
To change default parameter values in a masked library block:

1 Unlock the library.

2 Open the block to access its dialog box, fill in the desired default values,
and close the dialog box.

3 Save the library.
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When the block is copied into a model and opened, the default values appear
on the block’s dialog box.

For more information, see “Working with Block Libraries” on page 4-34.

Initialization Pane

The Initialization pane allows you to enter MATLAB commands that
initialize the masked subsystem.

<) Mask editor : mx+b ;Iglil

Iconl Parameters Initislization | Documentationl

Dialog varisbles

—

rInitialization commancd

I~ Allasy lkrary block to modify its conternts

Unrask | Ok | Cancel | Help | Apply |

Simulink executes the initialization commands when you

® Load the model
e Start a simulation or update the model’s block diagram

® Make changes to the block diagram that affect the appearance of the block,
such as rotating the block

* Apply any changes to the block’s dialog that affect the block’s appearance
or behavior, such as changing the value of a mask parameter on which the
block’s icon drawing code depends
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Note Do not use initialization code to create dynamic mask dialogs, i.e.,
dialogs whose appearance or control settings change depending on changes
made to other control settings. Instead, use the mask callbacks provided
specifically for this purpose (see “Creating Dynamic Dialogs for Masked
Blocks” on page 11-32 for more information).

The Initialization pane includes the following controls.

Dialog variables

The Dialog variables list displays the names of the variables associated
with the subsystem’s mask parameters, i.e., the parameters defined in the
Parameters pane. You can copy the name of a parameter from this list and
paste it into the adjacent Initialization commands field, using the Simulink
keyboard copy and paste commands. You can also use the list to change the
names of mask parameter variables. To change a name, double-click the
name in the list. An edit field containing the existing name appears. Edit
the existing name and press Enter or click outside the edit field to confirm
your changes.

Initialization commands

Enter the initialization commands in this field. You can enter any valid
MATLAB expression, consisting of MATLAB functions, operators, and
variables defined in the mask workspace. Initialization commands cannot
access base workspace variables. Terminate initialization commands with a
semicolon to avoid echoing results to the Command Window.
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Allow library block to modify its contents

This check box is enabled only if the masked subsystem resides in a library.
Checking this block allows the block’s initialization code to modify the
contents of the masked subsystem, i.e., it lets the code add or delete blocks
and set the parameters of those blocks. Otherwise, Simulink generates an
error when a masked library block tries to modify its contents in any way. To
set this option at the MATLAB prompt, select the self-modifying block and
enter the following command.

set_param(gcb, 'MaskSelfModifiable', 'on');

Then save the block.

Debugging Initialization Commands
You can debug initialization commands in these ways:

® Specify an initialization command without a terminating semicolon to echo
its results to the Command Window.

® Place a keyboard command in the initialization commands to stop
execution and give control to the keyboard. For more information, see the
help text for the keyboard command.

e Enter either of these commands in the MATLAB Command Window:

dbstop if error
dbstop if warning

If an error occurs in the initialization commands, execution stops and you
can examine the mask workspace. For more information, see the help text
for the dbstop command.

Documentation Pane

The Documentation pane enables you to define or modify the type,
description, and help text for a masked block.



Mask Editor

This figure shows how fields on the Documentation pane correspond to the
mx + b sample mask block’s dialog box.

Mask editor : mx+b ;Iglil

Iconl Parametersl Inttizlization Documentation |

Mask type
’V Block Parameters: mx + b
ISampleMaskedalock ‘\. SampleMaskedBlock (mask]
- o Models the equation for a line, v = mx + b.
Mask description _,'JThe slope and intercept are mask block parameters.

odels the equation for & ling, y=rx+h. “"”/ P
The slope and intercept are masked block parameters.

E]

Cocd | |
Erter the slope tm) and intercept () in the —
lock dislog parameter fields. “,’,/

IThe block generstes y for a diven input x.

Unrask | Ok Cancel | Help | Apply |

Mask Type Field

The mask type is a block classification used only for purposes of
documentation. It appears in the block’s dialog box and on all Mask Editor
panes for the block. You can choose any name you want for the mask type.
When Simulink creates the block’s dialog box, it adds (“mask”) after the mask
type to differentiate masked blocks from built-in blocks.

Mask Description Field

The block description is informative text that appears in the block’s dialog box
in the frame under the mask type. If you are designing a system for others to
use, this is a good place to describe the block’s purpose or function.

Simulink automatically wraps long lines of text. You can force line breaks
by using the Enter or Return key.
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Block Help Field

You can provide help text that is displayed when the Help button is clicked on
the masked block’s dialog box. If you create models for others to use, thisis a
good place to explain how the block works and how to enter its parameters.

You can include user-written documentation for a masked block’s help. You
can specify any of the following for the masked block help text:

e URL specification (a string starting with http:, www, file:, ftp:, or
mailto:)

* web command (launches a browser)
® eval command (evaluates a MATLAB string)

e HTML-tagged text to be displayed in a Web browser

Simulink examines the first line of the masked block help text. If Simulink
detects a URL specification, for example,

http://www.mathworks.com

or

file:///c:/mydir/helpdoc.html

Simulink displays the specified file in the browser. If Simulink detects a web
command, for example,

web([docroot '/My Blockset Doc/' get param(gcb, 'MaskType')...
".html'])

or an eval command, for example,
eval('!Word My_Spec.doc')
Simulink executes the specified command. Otherwise, Simulink displays

the contents of the Block Help field, which can include HTML tags, in the
browser.
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Linking Mask Parameters to Block Parameters

The variables associated with mask parameters allow you to link mask
parameters with block parameters. This in turn allows a user to use the mask
to set the values of parameters of blocks inside the masked subsystem.

To link the parameters, open the block’s parameter dialog box and enter an
expression in the block parameter’s value field that uses the mask parameter.
The mx + b masked subsystem, described earlier in this chapter, uses this
approach to link the Slope and Intercept mask parameters to corresponding
parameters of a Gain and Constant block, respectively, that reside in the
subsystem.

— Sampletd askedBlock [mask]

Models the equation for a line, y = mx + b.
The glope and intercept are mask block parameters.

Mask =
Workspace (S

calar or vector gain. v = k."u

=
F

P Gain:
ISIope: -
3 -T
» M
Intercept: QK I Cancel Help !
E] ~—

QK i "Sanc:elg Help | Applyl

Block Parameters: Intercept

Constant
’70 utput & constant,
P '

A b Constant value:

QK I Cancel | Help | |

You can use a masked block’s initialization code to link mask parameters
indirectly to block parameters. In this approach, the initialization code
creates variables in the mask workspace whose values are functions of the
mask parameters and that appear in expressions that set the values of
parameters of blocks concealed by the mask.
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Simulink allows you to create dialogs for masked blocks whose appearance
changes in response to user input. Features of masked dialog boxes that can
change in this way include

® Visibility of parameter controls

Changing a parameter can cause the control for another parameter to
appear or disappear. The dialog expands or shrinks when a control appears
or disappears, respectively.

¢ Enabled state of parameter controls

Changing a parameter can cause the control for another parameter to be
enabled or disabled for input. Simulink grays a disabled control to indicate
visually that it is disabled.

e Parameter values

Changing a parameter can cause related parameters to be set to
appropriate values.

Creating a dynamic masked dialog entails using the mask editor in
combination with the set _param command. Specifically, you use the Mask
Editor to define the dialog’s parameters, both static and dynamic. For each
dynamic parameter, you enter a callback function that defines the dialog’s
response to changes to that parameter (see “Callback” on page 11-22). The
callback function can in turn use the set_param command to set mask dialog
parameters that affect the appearance and settings of other controls on the
dialog (see “Setting Masked Block Dialog Parameters” on page 11-32). Finally,
you save the model or library containing the masked subsystem to complete
the creation of the dynamic masked dialog.

Setting Masked Block Dialog Parameters

Simulink defines a set of masked block parameters that define the current
state of the masked block’s dialog. You can use the mask editor to inspect
and set many of these parameters. The Simulink get param and set_param
commands also let you inspect and set mask dialog parameters. The
advantage? The set param command allows you to set parameters and hence
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change a dialog’s appearance while the dialog is open. This in turn allows you
to create dynamic masked dialogs.

For example, you can use the set_param command in mask callback functions
to be invoked when a user changes the values of user-defined parameters.
The callback functions in turn can use set_param commands to change the
values of the masked dialog’s predefined parameters and hence its state, for
example, to hide, show, enable, or disable a user-defined parameter control.

Predefined Masked Dialog Parameters
Simulink associates the following predefined parameters with masked dialogs.

MaskCallbacks

The value of this parameter is a cell array of strings that specify callback
expressions for the dialog’s user-defined parameter controls. The first cell
defines the callback for the first parameter’s control, the second for the second
parameter control, etc. The callbacks can be any valid MATLAB expressions,
including expressions that invoke M-file commands. This means that you can
implement complex callbacks as M-files.

You can use either the mask editor or the MATLAB command line to specify
mask callbacks. To use the mask editor to enter a callback for a parameter,
enter the callback in the Callback field for the parameter.

The easiest way to set callbacks for a mask dialog at the MATLAB command
is to first select the corresponding masked dialog in a model or library window
and then to issue a set_param command at the MATLAB command line. For
example, the following code

set_param(gchb, 'MaskCallbacks',{'parmi_callback', '',...
'parm3_callback'});

defines callbacks for the first and third parameters of the masked dialog for

the currently selected block. To save the callback settings, save the model or
library containing the masked block.
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MaskDescription

The value of this parameter is a string specifying the description of this block.
You can change a masked block’s description dynamically by setting this
parameter in a mask callback.

MaskEnables

The value of this parameter is a cell array of strings that define the enabled
state of the user-defined parameter controls for this dialog. The first cell
defines the enabled state of the control for the first parameter, the second for
the second parameter, etc. A value of 'on' indicates that the corresponding
control is enabled for user input; a value of 'off' indicates that the control
is disabled.

You can enable or disable user input dynamically by setting this parameter in
a callback. For example, the following command in a callback

set_param(gchb, 'MaskEnables',{'on','on','off'});

would disable the third control of the currently open masked block’s dialog.
Simulink colors disabled controls gray to indicate visually that they are
disabled.

MaskPrompts

The value of this parameter is a cell array of strings that specify prompts
for user-defined parameters. The first cell defines the prompt for the first
parameter, the second for the second parameter, etc.

MaskType

The value of this parameter is the mask type of the block associated with
this dialog.

MaskValues

The value of this parameter is a cell array of strings that specify the values of
user-defined parameters for this dialog. The first cell defines the value for the
first parameter, the second for the second parameter, etc.
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MaskVisibilities

The value of this parameter is a cell array of strings that specify the visibility
of the user-defined parameter controls for this dialog. The first cell defines
the visibility of the control for the first parameter, the second for the second
parameter, etc. A value of 'on' indicates that the corresponding control is
visible; a value of 'off' indicates that the control is hidden.

You can hide or show user-defined parameter controls dynamically by setting
this parameter in the callback for a control. For example, the following
command in a callback

set_param(gch, 'MaskVisibilities',{'on','off','on'});
would hide the control for the currently selected block’s second user-defined

mask parameter. Simulink expands or shrinks a dialog to show or hide a
control, respectively.
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Simulink Debugger

The following sections tell you how to use the Simulink debugger to pinpoint

bugs in a model:

Introduction (p. 12-2)

Using the Debugger’s Graphical
User Interface (p. 12-3)

Using the Debugger’s
Command-Line Interface (p. 12-10)

Getting Online Help (p. 12-12)

Starting the Debugger (p. 12-13)

Starting a Simulation (p. 12-14)

Running a Simulation Step by Step
(p. 12-15)

Setting Breakpoints (p. 12-22)

Displaying Information About the
Simulation (p. 12-28)

Displaying Information About the
Model (p. 12-32)

Overview of the debugger.

How to use the debugger’s graphical
user interface.

How to debug from the MATLAB
command line.

How to get help on debugger
commands.

How to start a simulation from the
debugger.

How to start a simulation in debug
mode.

How to run a simulation step by step.

How to set breakpoints at blocks and
time steps.

How to display information about
the current simulation.

How to display information about
the model being debugged.
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Introduction

The Simulink debugger allows you to run a simulation method by method,
stopping the simulation after each method, to examine the results of executing
that method. This allows you to pinpoint problems in your model to specific
blocks, parameters, or interconnections.

Note Methods are functions that Simulink uses to solve a model at each time
step during the simulation. Blocks are made up of multiple methods. “Block
execution” in this documentation is shorthand notation for “block methods
execution.” Block diagram execution is a multi-step operation that requires
execution of the different block methods in all the blocks in a diagram at
various points during the process of solving a model at each time step during
simulation, as specified by the simulation loop.

The Simulink debugger has both a graphical and a command-line user
interface. The graphical interface allows you to access the debugger’s most
commonly used features. The command-line interface gives you access to all
the debugger’s capabilities. If both interfaces enable you to perform a task,
the documentation shows you first how to use the graphical interface, then
the command-line interface, to perform the task.
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Using the Debugger’s Graphical User Interface

Select Debug from a model window’s Tools menu to display the Simulink
debugger’s graphical interface.

<} Simulink debugger :vdp ;Iglll

B2 g B0 % 00 | e 0w | o || o b s |
Break Paints | Simulation Loop | Outputs | sorted List | status |
rBreakiDisplay points ——————————————— -

Elocks |‘D-|£ K % [

Welcome to the Simulink debugger.

Click on Start/Continue button to debug the model.

It stops before the initialization stage of the simulation
loop. The command line debugger is also actiwve in the
Command Window. It is recommended that debugging actions
be issued in the graphical debugger or the command line
debugger, but not both to avoid synchronization problems.

Remaove selected pointl

r Break on conditions
[ Zero crossings

r Step size limited by state Use the F1 key or the Help button for additional help.

T R R

[T Minor tirme steps
™ MaM values

Break attime :I

ikl

| |

The following topics describe the major components of the debugger’s
graphical user interface:

“Toolbar” on page 12-4

e “Breakpoints Pane” on page 12-5

¢ “Simulation Loop Pane” on page 12-6
® “Outputs Pane” on page 12-7

e “Sorted List Pane” on page 12-8

® “Status Pane” on page 12-9
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Toolbar
The debugger toolbar appears at the top of the debugger window.

Toolb oar
< Simulink debugger :vdp i =100 x|
T I A PP S e A

BreakPaints | imulation Loap | outputs | sortedList | status |
 BreakiDisplay points ———————

Blocks |'D-|£

D

Welcome to the Simulink debugger.

Click on Htart/Continue button to debug the model.

It stops before the initialization stage of the simulation
loop. The command line debugger iz also actiwve in the
Command Window. It is recommended that debugging actions
be issued in the graphical debugger or the command line
debugger, but not both to avoid synchronization problems.

Remoave selected pointl

r Break on conditions
™ Zero crossings

r Step size limited hy state Use the F1 key or the Help button for additional help.

T W W W &

™ Minor time steps

™ MaMwalues

el

Break attime :I
| | >

From left to right, the toolbar contains the following command buttons:

Button Purpose

i Step into next method (see “Stepping Commands” on
page 12-16 for more information on this and the following
stepping commands).

o Step over next method.

(% Step out of current method.

[%, Step to first method at start of next time step.
o Step to next block method.

- Start or continue the simulation.

Pause the simulation.
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Button Purpose

- Stop the simulation.

o Break before the selected block.

s Display inputs and outputs of the selected block when
executed.

o= Display current inputs and outputs of selected block.

s Toggle animation mode on or off (see “Animation Mode”
on page 12-18). The slider next to this button controls the
animation rate.

0 Display help for the debugger.

Close |

Close the debugger.

Breakpoints Pane

To display the Breakpoints pane, select the Break Points tab on the
debugger window.

Breﬂk pOinfS <} Simulink debugger :vdp i _Io ill
pane E“EJE“?EM|>||-‘-H:EW E¢EDT.J‘....‘..5|?
Break Points | Sirmulation Loop | Outputs | Sorted List | Status I

NgreakDisplay points

Blocks IiD-IgDJ i 5 W

Welcome to the Jimulink debugger.

Click on Starc/Continue button to debuy the model.
It stops before the initialization stage of the simulation
loop. The command line debugger iz also active in the

Remaove selected point

rBreakon conditions

[~ Zero crossings

™ step size limited by state
™ Minar time steps

[ Mak values

Break attime : =
il I

Command Window. It is recommended that debugging actions
be issued in the graphical debugger or the command line
debugger, but not both to avoid synchronization problews.

e R

Use the F1 key or the Help button for additional help.
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The Breakpoints pane allows you to specify block methods or conditions
at which to stop a simulation. See “Setting Breakpoints” on page 12-22 for

more information.

Note The debugger grays out and disables the Breakpoints pane when
its animation mode is selected (see “Animation Mode” on page 12-18). This
prevents you from setting breakpoints and indicates that animation mode

ignores existing breakpoints.

Simulation Loop Pane

To display the Simulation Loop pane, select the Simulation Loop tab on

the debugger window.

Simulation Loop pane

E'JEJE'“EEM‘» ] l“ﬂ'zﬂz‘—'ﬂ—'

<} Simulink debugger :vdp

=10l x|

o ST s | 2 cose |

Break Points

Simulation Loap |

Outputs | sorted List | status |

Methaod |‘D-| IDJ -]
™ =0 0:6 Prod
E|—|vdp . Simulatel Il E [ 1 ro
H]_ (=ldebug [5):
—wdp. tart r 1 Data of 0:6 Product block 'wdp/Product’
™ é—RootSystem.Starir z K
Scope. Start [ 1 N 1 0:7 Gain
(=ldebug [B6):
Fen.Stare r 4 Data of 0:7 Gain block 'wdp/Mu':
Product. Star [~ 5 B
Gain.Start [ 5 [TH =10 1 0:8 Sum.
(=ldebug [@7):
- T 7
Sun. Srar r Data of 0:8 Sum block 'wdp/5um': -
wdp. Initialize - g n‘ _>|_I

The Simulation Loop pane contains three columns:

® Method
® Breakpoints

e ID
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Method Column

The Method column lists the methods that have been called thus far in the
simulation as a method tree with expandable/collapsible nodes. Each node
of the tree represents a method that calls other methods. Expanding a node
shows the methods that the block method calls. Block method names are
hyperlinks. Clicking a block method name highlights the corresponding block
in the model diagram. Block method names are underlined to indicate that
they are hyperlinks.

Whenever the simulation stops, the debugger highlights the name of the
method where the simulation has stopped as well as the methods that directly
or indirectly invoked it. The highlighted method names visually indicate the
current state of the simulator’s method call stack.

Breakpoints Column

The breakpoints column consists of check boxes. Selecting a check box sets a
breakpoint at the method whose name appears to the left of the check box.
See “Setting Breakpoints from the Simulation Loop Pane” on page 12-24

for more information.

Note The debugger grays out and disables this column when its animation
mode is selected (see “Animation Mode” on page 12-18). This prevents you
from setting breakpoints and indicates that animation mode ignores existing
breakpoints.

ID Column

The ID column lists the IDs of the methods listed in the Methods column.
See “Method ID” on page 12-10 for more information.

Outputs Pane
To display the Outputs pane, select the Qutputs tab on the debugger window.
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<} Simulink debugger :vdp = |EI|1| UUiPU'S pane
53 Fay B v |3 g — I F———
fsd fag B E_"v‘,u»u‘ L [ ‘4}54}3‘4} = R 5‘ ?  Close |/
Break Points  Sirnulation Loop | Outputs | Sorted List | Status | y
Method [« m | |
N [TH = 0 ] 0:8 od
vdp. Simulate
E—‘H]Ii—l r E (aldebug BE5):
—wdp. Start r 1| Ipata of 0:6 Product block 'védProduct!
é—RootSystem.Starir z K
Scope.Start [T 3 [TM =0 10:7 Gain
(aldebug BE6):
Fen. Start r 4 Data of 0:7 Gain block 'wdp/Mu':
Product. Star [~ 5 B
Gain.Start [ g | [[TH =20 10:8 Sun.
(aldebug BE7):
Sum.Stare [T 7 Data of 0:8 Sum block 'wdp/Sum': =
wdp. Initialize - g A‘I I _’I—I

The Outputs pane displays the same debugger output that would appear in the
MATLAB Command Window, if the debugger were running in command-line
mode. The output includes the debugger command prompt and the inputs,
outputs, and states of the block at whose method the simulation is currently
paused (see “Block Data Output” on page 12-16). The command prompt
displays current simulation time and the name and index of the method in
which the debugger is currently stopped (see “Block ID” on page 12-10).

Sorted List Pane

To display the Sorted List pane, select the Sorted List tab on the debugger

window.
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<} Simulink debugger :vdp

E’”Eu&”tiw‘r ] -“Dg}z‘q}"ii:

=10l %] Sorted List pane

5 ‘ ? Close |

{u]
(=1

Break Points Simulation Loop | Outputs Sorted List | Status | ,
Method |‘D-| IDJ il
E-vdp. simlate r E ---- Sorted list for 'wdp' [9 nonviatus
H]— o:0 'wdpsxl' (Integrator
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0:4 'wdp/Ecope! (Scope)
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The Sorted List pane displays the sorted lists for the model being debugged.

See “Displaying a Model’s Sorted Lists” on page 12-32 for more information.

Status Pane

To display the Status pane, select the Status tab on the debugger window.

Status pane

<} Simulink debugger :vdp

E‘J'E:JE‘“EEM‘r I -‘ﬂ;};‘q}'

5| 2

0

g [ 3]

Close |

Break Points Simulation Loop |

outouts | ShriedList  Status |

éFRoot,System. Start [
dcope, Start [T
Fon. Start [
Product. Starc [©
Gain. Start [
Hum, Start Il

wdp. Initialize Il

Method |*D-I ID
Current simulation time
E|—|vdp. Simulate [}
E-wdp. Start - Stop in minor times steps

W= ;o e oW o~ =

Default command to execute on return/enter :

Break at zero crossing ewvents
Break when step size is limiting by a state:
Time break point

Ereak on non-finice (Nal,Inf) wvalues
Display lewel for disp, trace, probe
Solver trace lewvel

Llgebraic loop tracing lewel
inimation Mode

'4|‘

1 0 (MajorTimeStep)

: dizabled
: dizabled

: dizabled

: dizabled

: 1 (i/o, states)
H)

H)

: off

Tatep in™

disabled

o

The Status pane displays the values of various debugger options and other

status information.
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Using the Debugger’s Command-Line Interface

In command-line mode, you control the debugger by entering commands

at the debugger command line in the MATLAB Command Window. The
debugger accepts abbreviations for debugger commands. See “Simulink
Debugger Commands — Alphabetical List” in the online Simulink reference
for a list of command abbreviations and repeatable commands. You can repeat
some commands by entering an empty command (i.e., by pressing the Enter
key) at the MATLAB command line.

Method ID

Some Simulink commands and messages use method IDs to refer to methods.
A method ID is an integer assigned to a method the first time it is invoked
in a simulation. The debugger assigns method indexes sequentially, starting
with O for the first method invoked in a debugger session.

Block ID

Some Simulink debugger commands and messages use block IDs to refer to
blocks. Simulink assigns block IDs to blocks while generating the model’s
sorted lists during the compilation phase of the simulation. A block ID has the
form sid:bid where sid is an integer identifying the system that contains
the block (either the root system or a nonvirtual subsystem) and bid is the
position of the block in the system’s sorted list. For example, the block index
0:1 refers to the first block in the model’s root system. The slist command
shows the block ID for each block in the model being debugged.

Accessing the MATLAB Workspace

You can enter any MATLAB expression at the sldebug prompt. For example,
suppose you are at a breakpoint and you are logging time and output of your
model as tout and yout. Then the following command

(sldebug ...) plot(tout, yout)
creates a plot. You cannot display the value of a workspace variable whose

name is partially or entirely the same as that of a debugger command by
entering it at the debugger command prompt. You can, however, use the
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MATLAB eval command to work around this problem. For example, use
eval('s') to determine the value of s rather then s(tep) the simulation.
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You can get online help on using the debugger by clicking the Help button on
the debugger’s toolbar or by pressing the F1 key when the text cursor is in a
debugger panel or text field. Clicking the Help button displays help for the
debugger in the MATLAB Help browser.

Help button

<) Simulink debugger :vdp _|E||1||
7 B 1 A
EJEJE[ED‘D‘FIII‘-'D-EDE-D- = o ? Close
BreakPoints | gimuiation Loop | outous | soted List | status |
rBreakiDisplay points ———————————————————— -
Elocks |'D-|£ E
% Welcome to the Simulink debugger.
2.
% Click on Start/Continue button to debug the model.
% It stops before the initialization stage of the sinulation
Rerove selected pDintl % loop. The command line debugger iz also active in the
% Command Window. It is recommended that debugoging actions
~ Break on conditians % be issued in the graphical debugger or the command line
X % debugger, but not both to avoid synchronization problems.
™ Zero crossings N
r Step size limited by state % Use the FL key or the Help button for additional help.
™ Minor time steps
™ Mabl values |
-
Break attime |
I 1 [

Pressing the F1 key displays help for the debugger panel or text field that
currently has the keyboard input focus. In command-line mode, you can get
a brief description of the debugger commands by typing help at the debug
prompt.
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Starting the Debugger

You can start the debugger either from a model window or from the MATLAB
command line. To start the debugger from a model window, select Debugger
from the model window’s Tools menu. The debugger’s graphical user interface
appears (see “Using the Debugger’s Graphical User Interface” on page 12-3).

To start the debugger from the MATLAB Command Window, enter either a
sim command or the sldebug command. For example, either the command

sim('vdp',[0,10],simset('debug','on'))
or the command

sldebug 'vdp'

loads the Simulink demo model vdp into memory, starts the simulation, and
stops the simulation at the first block in the model’s execution list.

Note When running the debugger in graphical user interface (GUI) mode,
you must explicitly start the simulation. See “Starting a Simulation” on page
12-14 for more information.
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Starting a Simulation
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To start the simulation, click the Start/Continue button on the debugger’s
toolbar.

tart/Continue button

<} Simulink debugger :vdp : ; =10l =]
-
By 7 o T Rl
EJEJEEED’D‘*"-“DEDE-D- rF‘\D...........S‘? Close
BreakFoints | Simulation Loop | outouts | sortedList | status |
- BreakDisplay points————————————————— -
Blocks |'D-I£ K
5 Welcome to the Fimulink debugger.
=
% Click on Start/Continue button to debug the model.
% It stops before the initialization stage of the simalation
Remuove selected pointl % loop. The command line debugger is also active in the
% Command Window. It is recommended that debugging actions
- Break an conditians % be issued in the graphical debugger or the command line
i 5 debugger, but not both to avoid synchronization problems.
™ Zero crossings N
I Step size lirited by state = TUsze the Fl key or the Help button for additional help.
™ Minortime staps
™ MNah values _
Break attime ~
| q e

The simulation starts and stops at the first simulation method to be executed.
It displays the name of the method in its Simulation Loop pane and in the
current method annotation on the Simulink block diagram. At this point, you
can set breakpoints, run the simulation step by step, continue the simulation
to the next breakpoint or end, examine data, or perform other debugging
tasks. The following sections explain how to use the debugger’s graphical
controls to perform these debugging tasks.

Note When you start the debugger in GUI mode, the debugger’s
command-line interface is also active in the MATLAB Command Window.
However, you should avoid using the command-line interface, to prevent
synchronization errors between the graphical and command-line interfaces.
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Running a Simulation Step by Step

The Simulink debugger provides various commands that let you advance

a simulation from the method where it is currently suspended (the next
method) by various increments (see “Stepping Commands” on page 12-16).
For example, you can advance the simulation into or over the next method,
or out of the current method, or to the top of the simulation loop. After each
advance, the debugger displays information that enables you to determine
the point to which the simulation has advanced and the results of advancing
the simulation to that point.

For example, in GUI mode, after each step command, the debugger highlights
the current method call stack in the Simulation Loop pane. The call

stack comprises the next method and the methods that invoked the next
method either directly or indirectly. The debugger highlights the call stack
by highlighting the names of the methods that make up the call stack in

the Simulation Loop pane.

Break Points Simulation Loap |

Hethod |‘D-| ID J

E|—|vdp . Gimulate - E
1

Z

3

4

=
EHRootiysten. Star

Scope.Start
Fon. Start

-
-
-
-
44— Next method

In command-line mode, you can use the where command to display the
method call stack. If the next method is a block method, the debugger points
the debug pointer at the block corresponding to the method (see “Debug
Pointer” on page 12-20 for more information). If the block of the next method
to be executed resides in a subsystem, the debugger opens the subsystem and
points to the block in the subsystem’s block diagram.
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Block Data Output

After executing a block method, the debugger prints any or all of the following
block data in the debugger Output panel (in GUI mode) or in the MATLAB
Command Window (in command-line mode):

e Un = v

where v is the current value of the block’s nth input.

Yn = v

where v is the current value of the block’s nth output.
CSTATE = v

where v is the value of the block’s continuous state vector.
DSTATE = v

where v is the value of the blocks discrete state vector.

The debugger also displays the current time, the ID and name of the next
method to be executed, and the name of the block to which the method applies
in the MATLAB Command Window. The following example illustrates typical
debugger outputs after a step command.

Corent fime  Next methad

a/ --------------------------------------------- %

[Tm = 2.009509145207664e-005 | 0:2 tegrator.Outputs 'wvdp/x2'
[sldebug B44;:

Data of 0:2 Integrator block 'wdp/x2':

U =[-2]

= [-4.0190182904153282e -005]

CSTATE = [-4.0190182904153282e -005]

=
I

[Tm = 2.009509145207664e-005 ] 0:3 Outport.Cutputs 'wvdp/Out2'

Stepping Commands

Command-line mode provides the following commands for advancing a
simulation incrementally:



Running a Simulation Step by Step

Command

Advances the simulation...

step [in into]

Into the next method, stopping at the first method
in the next method or, if the next method does not
contain any methods, at the end of the next method

step over To the method that follows the next method, executing
all methods invoked directly or indirectly by the next
method

step out To the end of the current method, executing any
remaining methods invoked by the current method

step top To the first method of the next time step (i.e., the top

of the simulation loop)

step blockmth

To the next block method to be executed, executing all
intervening model- and system-level methods

next

Same as step over

Buttons in the debugger toolbar allow you to access these commands in GUI

mode.

Next Block
St Step Out  Method

ol

E?"E:;JE:‘“['.F’?.,D*D‘P Il l‘*ﬂ-gﬂg

Step Over Step Top

wo 5| 9

S [ I I I R R B

e

Clicking a button has the same effect as entering the corresponding command
at the debugger command line.

Continuing a Simulation

In GUI mode, the Stop button turns red when the debugger suspends

the simulation for any reason. To continue the simulation, click the
Start/Continue button. In command-line mode, enter continue to continue
the simulation. By default, the debugger runs the simulation to the next

12-17



12 Simulink Debugger

12-18

breakpoint (see “Setting Breakpoints” on page 12-22) or to the end of the
simulation, whichever comes first.

Animation Mode

In animation mode, the Start/Continue button or the continue command
advances the simulation method by method, pausing after each method, to
the first method of the next major time step. While running the simulation in
animation mode, the debugger uses its debug pointer (see “Debug Pointer”
on page 12-20) to indicate on the block diagram which block method is being
executed at each step. The moving pointer providing a visual indication of the
progress of the simulation.

Note When animation mode is enabled, the debugger does not allow you to
set breakpoints and ignores any breakpoints that you set when animating the
simulation.

To enable animation when running the debugger in GUI mode, click the
Animation Mode toggle button on the debugger’s toolbar.

Animotion Mode

|

w0/ 5“?

|

Animofion Rote

E‘:"EEJE_"E?E,W‘F 1] l“ﬂ'zﬂz‘—’ﬂ—’

The slider on the debugger toolbar allows you to increase or decrease the
delay between method invocations and hence to slow down or speed up the
animation rate. To disable animation mode when running the debugger in
GUI mode, toggle the Animation Mode button on the toolbar.

To enable animation when running the debugger in command-line mode,
enter the animate command at the MATLAB command line. The animate
command’s optional delay parameter allows you to specify the length of



Running a Simulation Step by Step

the pause between method invocations (1 second by default) and thereby
accelerate or slow down the animation. For example, the command

animate 0.5

causes the animation to run at twice its default rate. To disable animation
mode when running the debugger in command-line mode, enter

animate stop

at the MATLAB command line.

Running a Simulation Nonstop

The run command lets you run a simulation to the end of the simulation,
skipping any intervening breakpoints. At the end of the simulation, the
debugger returns you to the MATLAB command line. To continue debugging
a model, you must restart the debugger.

Note The GUI mode does not provide a graphical version of the run command.
To run the simulation to the end, you must first clear all breakpoints and
then click the Start/Continue button.
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Debug Pointer

Whenever the debugger stops the simulation at a method, it displays a debug
pointer on the block diagram of the model being debugged.

=loix|
File Edit Views Simulation Format Tools Help
Ol H&| %=z o 8 [Nomal <]l Rm A A

| Block pointer

Next method box

*’7 0:1 Qutpert.Qutputs B van der Pol Equation /
/ B 12}
u
cn d =
u

Method i
The van dar Pol Equation S ethod tile
(Coubkclizkon the *?* for mom infa) Double-click
: herm for
Simulink Help

To star and stop the simulation, uss the *Star/Stop®
salection in the *Simulation” pulldawn menu

Running [100% [T=0.000 |ode4s

BN

The debug pointer is an annotation that indicates the next method to be
executed when simulation resumes. It consists of the following elements:
® Next method box

® Block pointer

e Method tile

Next Method Box

The next method box appears in the upper-left corner of the block diagram. It
specifies the name and ID of the next method to be executed.

Block Pointer

The block pointer appears when the next method is a block method. It
indicates the block on which the next method operates.
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Method Tile

The method tile is a rectangular patch of color that appears when the next
method is a block method. The tile overlays a portion of the block on which
the next method executes. The color and position of the tile on the block
indicate the type of the next block method as follows.

Nutpus
U{“fjg;e Maijor Time Step
[dark grezn)

o Nutputs
Derivatives Minar Time Skp

[arange) [green)
Tem G | Start [magenta)
EMQ U0ssings Initialize [blve)

[light blue) et

In animation mode, the tiles persist for the length of the current major time
step and a number appears in each tile. The number specifies the number
of times that the corresponding method has been invoked for the block thus
far in the time step.
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The Simulink debugger allows you to define stopping points in a simulation
called breakpoints. You can then run a simulation from breakpoint to
breakpoint, using the debugger’s continue command. The debugger lets

you define two types of breakpoints: unconditional and conditional. An
unconditional breakpoint occurs whenever a simulation reaches a method that
you specified previously. A conditional breakpoint occurs when a condition
that you specified in advance arises in the simulation.

Breakpoints are useful when you know that a problem occurs at a certain
point in your program or when a certain condition occurs. By defining

an appropriate breakpoint and running the simulation via the continue
command, you can skip immediately to the point in the simulation where the
problem occurs.

Setting Unconditional Breakpoints
You can set unconditional breakpoints from the

® Debugger toolbar
¢ Simulation Loop pane

¢ MATLAB Command Window (command-line mode only)

Setting Breakpoints from the Debugger Toolbar

To set a breakpoint on a block’s methods, select the block and then click the
Breakpoint button on the debugger toolbar.

Brenkpaint

!

E;"EEJE_JEED'D‘P- Il I‘q}g}z

SO R et



Setting Breakpoints

The debugger displays the name of the selected block in the Break/Display
points panel of its Breakpoints pane.

~BreakiDisplay points

Blocks §

Remove selected point

Note Clicking the Breakpoint button on the toolbar sets breakpoints on the
invocations of a block’s methods in major time steps. To enable breakpoints in
minor time steps, you must select the debugger’s Minor time steps option
(see “Breaking in Minor Time Steps” on page 12-27).

You can temporarily disable the breakpoints on a block by deselecting the
check box in the breakpoints column of the panel. To clear the breakpoints on
a block and remove its entry from the panel, select the entry and then click
the Remove selected point button on the panel.

Note You cannot set a breakpoint on a virtual block. A virtual block is a block
whose function is purely graphical: it indicates a grouping or relationship
among a model’s computational blocks. The debugger warns you if you
attempt to set a breakpoint on a virtual block. You can obtain a listing of

a model’s nonvirtual blocks, using the slist command (see “Displaying a
Model’s Nonvirtual Blocks” on page 12-34).
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Setting Breakpoints from the Simulation Loop Pane

To set a breakpoint at a particular invocation of a method displayed in the
Simulation Loop pane, select the check box next to the method’s name in
the breakpoint column of the pane.

Break Points Simulation Loap |

HMethod |‘D-| o |

E-wdp. Outputs. Invari— 152}
l—RootSys tem, Outp [~ 16
EHwdp. SimulationLoop| [© 17

ntearacp B | 4— Breakpoint
Outport. [ 21
Integrat|[” 2z
Outport. [ 23
Scope.u™ 24
Fen. Outh [ 25
Product. [© 26

To clear the breakpoint, deselect the check box.

Setting Breakpoints from the MATLAB Command Window
In command-line mode, use the break and bafter commands to set

breakpoints before or after a specified method, respectively. Use the clear
command to clear breakpoints.

Setting Conditional Breakpoints

You can use either the Break on conditions panel of the debugger’s
Breakpoints pane

~Break on conditions

[~ Zero crossings

™ Step size limited by state
[~ minortime steps

I Mak values

Break attime :I
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or the following commands (in command-line mode) to set conditional
breakpoints.

Command Causes Simulation to Stop

tbreak [t] At a simulation time step
minor At methods invoked in minor time steps
nanbreak At the occurrence of an underflow or overflow (NaN) or

infinite (Inf) value

xbreak When the simulation reaches the state that determines
the simulation step size

zcbreak When a zero crossing occurs between simulation time steps

Setting Breakpoints at Time Steps

To set a breakpoint at a time step, enter a time in the debugger’s Break at
time field (GUI mode) or enter the time using the tbreak command. This
causes the debugger to stop the simulation at the Outputs.Major method of
the model at the first time step that follows the specified time. For example,
starting vdp in debug mode and entering the commands

tbreak 2
continue

causes the debugger to halt the simulation at the vdp.Outputs.Major method
of time step 2.078 as indicated by the output of the continue command.

[TM = 2.078784598291364 ] vdp.Outputs.Major
(sldebug @18):

Breaking on Nonfinite Values

Selecting the debugger’s NaN values option or entering the nanbreak
command causes the simulation to stop when a computed value is infinite or
outside the range of values that can be represented by the machine running
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the simulation. This option is useful for pinpointing computational errors
in a Simulink model.

Breaking on Step-Size Limiting Steps

Selecting the Step size limited by state option or entering the xbreak
command causes the debugger to stop the simulation when the model uses a
variable-step solver and the solver encounters a state that limits the size of
the steps that it can take. This command is useful in debugging models that
appear to require an excessive number of simulation time steps to solve.

Breaking at Zero Crossings

Selecting the Zero crossings option or entering the zcbhreak command
causes the simulation to halt when Simulink detects a nonsampled zero
crossing in a model that includes blocks where zero crossings can arise. After
halting, Simulink displays the location in the model, the time, and the type
(rising or falling) of the zero crossing. For example, setting a zero-crossing
break at the start of execution of the zeroxing demo model,

sldebug zeroxing

[TM = O ] zeroxing.Simulate
(sldebug @0): zcbreak
Break at zero crossing events : enabled

and continuing the simulation

(sldebug @0): continue
results in a rising zero-crossing break at
[Tz = 0.2 ] [Hz = 0 ]

Detected 2 Zero Crossing Events 0:5:1R, 0:5:2R

[Tm = 0.4 ] zeroxing.ZeroCrossingDetectionLoop
(sldebug @45):



Setting Breakpoints

If a model does not include blocks capable of producing nonsampled zero
crossings, the command prints a message advising you of this fact.

Breaking in Minor Time Steps

To break at invocations of a block’s methods in minor time steps, select the
Minor time steps option on the debugger’s Break on conditions panel or
enter minor at the debugger command prompt.

Note For this option to take effect, you must previously or subsequently set
breakpoints on all the block’s methods, using either the Breakpoint button
on the debugger’s toolbar or the break gcb or bafter gcb command. This
option has no effect on breakpoints set on specific invocations of a block’s
methods set in either the Simulation Loop pane or via the break/bafter
m:id commands.
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The Simulink debugger provides a set of commands that allow you to display
block states, block inputs and outputs, and other information while running
a model.

Displaying Block 1/0

The debugger allows you to display block I/O by clicking the appropriate
buttons on the debugger toolbar

Wutth Bluck /0 Disploy Bluck 1/0

E;"EEJE_JEED'D‘P- Il I‘q}g}z

SO R et

or by entering the appropriate debugger command.

Command | Displays a Block’s 1/0

probe Immediately
disp At every breakpoint
trace Whenever the block executes

Displaying 1/0O of Selected Block

To display the I/O of a block, select the block and click I+ in GUI mode or
enter the probe command in command-line mode.

Command Description

probe Enter or exit probe mode. In probe mode, the debugger
displays the current inputs and outputs of any block
that you select in the model’s block diagram. Typing any
command causes the debugger to exit probe mode.
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Command Description

probe gcb Display I/0 of selected block.

probe s:b Print the I/O of the block specified by system number s
and block number b.

The debugger prints the current inputs, outputs, and states of the selected
block in the debugger Outputs pane (GUI mode) or the MATLAB Command
Window.

The probe command is useful when you need to examine the I/O of a block
whose I/0 is not otherwise displayed. For example, suppose you are using the
step command to run a model method by method. Each time you step the
simulation, the debugger displays the inputs and outputs of the current block.
The probe command lets you examine the I/O of other blocks as well.

Displaying Block 1/0 Automatically at Breakpoints

The disp command causes the debugger to display a specified block’s inputs
and outputs whenever it halts the simulation. You can specify a block either
by entering its block index or by selecting it in the block diagram and entering
gcb as the disp command argument. You can remove any block from the
debugger’s list of display points, using the undisp command. For example, to
remove block 0:0, either select the block in the model diagram and enter
undisp gcb or simply enter undisp 0:0.

Note Automatic display of block I/O at breakpoints is not available in the
debugger’s GUI mode.

The disp command is useful when you need to monitor the I/O of a specific
block or set of blocks as you step through a simulation. Using the disp
command, you can specify the blocks you want to monitor and the debugger
will then redisplay the I/O of those blocks on every step. Note that the
debugger always displays the I/O of the current block when you step through
a model block by block, using the step command. You do not need to use the
disp command if you are interested in watching only the I/O of the current
block.

12-29



12 Simulink Debugger

12-30

Watching Block 1/0

To watch a block, select the block and click =% in the debugger toolbar or
enter the trace command. In GUI mode, if a breakpoint exists on the block,
you can set a watch on it as well by selecting the check box for the block in
the watch column == of the Break/Display points pane. In command-line
mode, you can also specify the block by specifying its block index in the trace
command. You can remove a block from the debugger’s list of trace points
using the untrace command.

The debugger displays a watched block’s I/O whenever the block executes.
Watching a block allows you obtain a complete record of the block’s I/O
without having to stop the simulation.

Displaying Algebraic Loop Information

The atrace command causes the debugger to display information about a
model’s algebraic loops (see “Algebraic Loops” on page 1-24) each time they
are solved. The command takes a single argument that specifies the amount
of information to display.

Command | Displays for Each Algebraic Loop

atrace 0 No information

atrace 1 The loop variable solution, the number of iterations
required to solve the loop, and the estimated solution error

atrace 2 Same as level 1

atrace 3 Level 2 plus the Jacobian matrix used to solve the loop

atrace 4 Level 3 plus intermediate solutions of the loop variable
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Displaying System States

The states debug command lists the current values of the system’s states
in the MATLAB Command Window. For example, the following sequence of
commands shows the states of the Simulink bouncing ball demo (bounce)
after its first and second time steps.

sldebug bounce

[Tm=0 ] **Start** of system 'bounce' outputs
(sldebug @0:0 'bounce/Position'): states

Continuous state vector (value,index,name):

10 0 (0:0 'bounce/Position')
15 1 (0:5 'bounce/Velocity')
(sldebug @0:0 'bounce/Position'): next
[Tm=0.01 ] **Start** of system 'bounce' outputs

(sldebug @0:0 'bounce/Position'): states

Continuous state vector (value,index,name):
10.1495095 0 (0:0 'bounce/Position')
14.9019 1 (0:5 'bounce/Velocity')

Displaying Solver Information

The strace command allows you to pinpoint problems in solving a model’s
differential equations that can slow down simulation performance. Executing
this command causes the debugger to display solver-related information at
the MATLAB command line when you run or step through a simulation. The
information includes the sizes of the steps taken by the solver, the estimated
integration error resulting from the step size, whether a step size succeeded
(i.e., met the accuracy requirements that the model specifies), the times at
which solver resets occur, etc. If you are concerned about the time required
to simulate your model, this information can help you to decide whether the
solver you have chosen is the culprit and hence whether choosing another
solver might shorten the time required to solve the model.
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Displaying Information About the Model

In addition to providing information about a simulation, the debugger can
provide you with information about the model that underlies the simulation.

Displaying a Model’s Sorted Lists

In GUI mode, the debugger’s Sorted List pane displays lists of blocks for

a model’s root system and each nonvirtual subsystem. Each list lists the
blocks that the subsystems contains sorted according to their computational
dependencies, alphabetical order, and other block sorting rules. In
command-line mode, you can use the slist command to display a model’s
sorted lists.

---- Sorted list for 'vdp' [12 blocks, 9 nonvirtual blocks,
directFeed=0]

0:0 'vdp/Integratori' (Integrator)
'vdp/Outi' (Outport)
'vdp/Integrator2' (Integrator)
'vdp/Out2' (Outport)

'vdp/Fcn' (Fcn)
'vdp/Product' (Product)
'vdp/Mu' (Gain)
'vdp/Scope' (Scope)
"vdp/Sum' (Sum)

[eNelNeNolNolNolNolNo)
0N WOWND =

These displays include the block index for each command. You can thus
use them to determine the block IDs of the model’s blocks. Some debugger
commands accept block IDs as arguments.

Identifying Blocks in Algebraic Loops

If a block belongs to an algebraic list, the slist command displays an
algebraic loop identifier in the entry for the block in the sorted list. The
identifier has the form

algId=s#n

where s is the index of the subsystem containing the algebraic loop and n is
the index of the algebraic loop in the subsystem. For example, the following
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entry for an Integrator block indicates that it participates in the first algebraic
loop at the root level of the model.

0:1 'test/ss/I1' (Integrator, tid=0) [algId=0#1, discontinuity]

You can use the debugger’s ashow command to highlight the blocks and lines
that make up an algebraic loop. See “Displaying Algebraic Loops” on page
12-35 for more information.

Displaying a Block

To determine the block in a model’s diagram that corresponds to a particular
index, enter bshow s:b at the command prompt, where s:b is the block index.
The bshow command opens the system containing the block (if necessary) and
selects the block in the system’s window.

Displaying a Model’s Nonvirtual Systems

The systems command displays a list of the nonvirtual systems in the model
being debugged. For example, the Simulink clutch demo (clutch) contains
the following systems:

sldebug clutch

[Tm=0 ] **Start** of system 'clutch' outputs
(sldebug @0:0 'clutch/Clutch Pedal'): systems
0 "clutch’

1 'clutch/Locked'
2 'clutch/Unlocked’

Note The systems command does not list subsystems that are purely
graphical in nature, that is, subsystems that the model diagram represents
as Subsystem blocks but that Simulink solves as part of a parent system. In
Simulink models, the root system and triggered or enabled subsystems are
true systems. All other subsystems are virtual (that is, graphical) and hence
do not appear in the listing produced by the systems command.
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Displaying a Model’s Nonvirtual Blocks

The slist command displays a list of the nonvirtual blocks in a model. The
listing groups the blocks by system. For example, the following sequence of
commands produces a list of the nonvirtual blocks in the Van der Pol (vdp)
demo model.

sldebug vdp
[Tm=0 ] **Start** of system 'vdp' outputs
(sldebug @0:0 'vdp/Integratort'): slist
---- Sorted list for 'vdp' [12 blocks, 9 nonvirtual blocks,
directFeed=0]
0:0 'vdp/Integratori' (Integrator)
'vdp/Outi' (Outport)
'vdp/Integrator2' (Integrator)
'vdp/Out2' (Outport)
'vdp/Fcn' (Fcn)
"vdp/Product' (Product)
'vdp/Mu' (Gain)
'vdp/Scope' (Scope)
"vdp/Sum' (Sum)

[eNelNeNelNolNolNolNo)
O~NOO O WN =

Note The slist command does not list blocks that are purely graphical
in nature, that is, blocks that indicate relationships or groupings among
computational blocks.

Displaying Blocks with Potential Zero Crossings

The zclist command displays a list of blocks in which nonsampled zero
crossings can occur during a simulation. For example, zclist displays the
following list for the clutch sample model:

(sldebug @0:0 'clutch/Clutch Pedal'): zclist
2:3 "clutch/Unlocked/Sign' (Signum)
0:4 "clutch/Lockup Detection/Velocities Match' (HitCross)
0:10 "clutch/Lockup Detection/Required Friction
for Lockup/Abs' (Abs)
0:11 ‘clutch/Lockup Detection/Required Friction for
Lockup/ Relational Operator' (RelationalOperator)
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0:18 ‘clutch/Break Apart Detection/Abs' (Abs)

0:20 ‘clutch/Break Apart Detection/Relational Operator'
(RelationalOperator)

0:24 ‘clutch/Unlocked' (SubSystem)

0:27 ‘clutch/Locked' (SubSystem)

Displaying Algebraic Loops

The ashow command highlights a specified algebraic loop or the algebraic
loop that contains a specified block. To highlight a specified algebraic loop,
enter ashow s#n, where s is the index of the system (see “Identifying Blocks
in Algebraic Loops” on page 12-32) that contains the loop and n is the index
of the loop in the system. To display the loop that contains the currently
selected block, enter ashow gcb. To show a loop that contains a specified
block, enter ashow s:b, where s:b is the block’s index. To clear algebraic-loop
highlighting from the model diagram, enter ashow clear.

Displaying Debugger Status

In GUI mode, the debugger displays the settings of various debug options,
such as conditional breakpoints, in its Status panel. In command-line mode,
the status command displays debugger settings. For example, the following
sequence of commands displays the initial debug settings for the vdp model:

sim('vdp',[0,10],simset('debug','on'))
[Tm=0 ] **Start** of system 'vdp' outputs
(sldebug @0:0 'vdp/Integratori'): status
Current simulation time: O (MajorTimeStep)
Last command: ""
Stop in minor times steps is disabled.
Break at zero crossing events is disabled.
Break when step size is limiting by a state is disabled.
Break on non-finite (NaN,Inf) values is disabled.
Display of integration information is disabled.
Algebraic loop tracing level is at O.
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Simulink Accelerator

The Simulink Accelerator is a MathWorks product that accelerates the
simulation of Simulink models. The Simulink Accelerator comes with the
Simulink Profiler, a tool that collects, analyzes, and displays simulation
performance data. These tools enable you to minimize the time needed to
simulate Simulink models. You must install the Simulink Accelerator product
on your system to use either tool. See the following sections for information
on using these tools.

The Simulink Accelerator (p. 13-2) How to use the Simulink Accelerator
to speed up a simulation.

Profiler (p. 13-14) How to use the Simulink Profiler to
tune the performance of your model.
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The Simulink Accelerator speeds up the execution of Simulink models. The
Accelerator uses portions of Real-Time Workshop, a MathWorks product that
automatically generates C code from Simulink models, and your C compiler
to create an executable. Note that although the Simulink Accelerator takes
advantage of the Real-Time Workshop technology, Real-Time Workshop is not
required to run it. Also, if you do not have a C compiler installed on your
Windows PC, you can use the 1cc compiler provided by The MathWorks.

Note You must have the Simulink Accelerator product installed on your
system to use the Accelerator. The Accelerator uses the Real-Time Workshop
technology to generate the code used to accelerate the model. However, the
generated code is suitable only for acceleration of the model. If you want to
generate code for other purposes, you must use Real-Time Workshop.

Accelerator Limitations
The Simulink Accelerator has the following limitations.

® The Accelerator does not support models with algebraic loops. If the
Accelerator detects an algebraic loop in your model, it halts the simulation
and displays an error message.

® The Accelerator does not support models that pass array parameters to
M-File S-Functions that are not numeric, logical, or character arrays, are
sparse arrays, or that have more than two dimensions.

How the Accelerator Works

The Simulink Accelerator works by creating and compiling C code that
takes the place of the interpretive code that Simulink uses when in Normal
mode (that is, when Simulink is not in Accelerator mode). The Accelerator
generates the C code from your Simulink model and invokes the MATLAB
mex function to compile and dynamically link the generated code to Simulink.
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Note The MATLAB mex function uses the 1cc compiler by default to compile
the code generated by the Simulink Accelerator. An optimizing compiler,
such as Microsoft Visual C/C++ 7.1, can produce faster compiled code and
hence accelerate simulation still further. If you have such a compiler, you can
configure the mex command to use it. See the online help for mex for more
information.

The Simulink Accelerator removes much of the computational overhead
required by Simulink models when in Normal mode. It works by replacing
blocks that are designed to handle any possible configuration in Simulink
with compiled versions customized to your particular model’s configuration.
Through this method, the Accelerator is able to achieve substantial
improvements in performance for larger Simulink models. The performance
gains are tied to the size and complexity of your model. In general, as size
and complexity grow, so do gains in performance. Typically, you can expect a
2X-t0-6X gain in performance for models that use built-in Simulink blocks.

Note Blocks such as the Quantizer block might exhibit slight differences
in output on some systems because of slight differences in the numerical
precision of the interpreted and compiled versions of the model.

13-3



1 3 Simulink Accelerator

13-4

Running the Simulink Accelerator
To activate the Simulink Accelerator, select Accelerator from the

Simulation menu for your model. This picture shows the procedure using

the F14 flight control model.
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Alternatively, you can select Accelerator from the menu located on the

right-hand side of the toolbar.

To begin the simulation, select Start from the Simulation menu. When you

start the simulation, the Accelerator generates the C code and compiles it.

The Accelerator then does the following:

¢ Places the generated code in a subdirectory called modelname_accel rtw

(in this case, f14_accel rtw)

® Places a compiled MEX-file in the current working directory
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® Runs the compiled model

Note If your code does not compile, the most likely reason is that you have
not set up the mex command correctly. Run mex -setup at the MATLAB
prompt and select your C compiler from the list shown during the setup.

Handling Changes in Model Structure

After you use the Simulink Accelerator to simulate a model, the MEX-file
containing the compiled version of the model remains available for use in
later simulations. Even if you exit MATLAB, you can reuse the MEX-file in
later MATLAB or Simulink sessions.

If you alter the structure of your Simulink model, for example, by adding or
deleting blocks, the Accelerator automatically regenerates the C code and
updates (overwrites) the existing MEX-file.

Examples of model structure changes that require the Accelerator to rebuild
include

® Changing the method of integration

® Adding or deleting blocks or connections between blocks

® Changing the values of nontunable block parameters, for example, the
Initial seed parameter of the Random Number block (see “Tunable
Parameters” on page 1-8 for more information)

® Changing the number of inputs or outputs of blocks, even if the connectivity
is vectorized

¢ Changing the number of states in the model

¢ Changing function in the Trigonometric Function block

¢ Changing the signs used in a Sum block

¢ Adding a Target Language Compiler (TLC) file to inline an S-function

The Simulink Accelerator displays a warning when you attempt any
impermissible model changes during simulation. The warning does not stop
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the current simulation. To make the model alterations, stop the simulation,
make the changes, and restart.

Some changes are permitted in the middle of simulation. Simple changes
like adjusting the value of a Gain block do not cause a warning. When in
doubt, try to make the change. If you do not see a warning, the Accelerator
accepted the change.

Note The Simulink Accelerator does not display warnings that blocks
generate during simulation. Examples include divide-by-zero and integer
overflow. This is a different set of warnings from those discussed previously.

Increasing Performance of Accelerator Mode

In general, the Simulink Accelerator creates code optimized for speed with
most blocks available in Simulink. There are situations, however, where you
can further improve performance by adjusting your simulation or being aware
of Accelerator behavior. These include

¢ Configuration Parameters dialog box — To increase performance:

= Disable Solver data inconsistency and Array bounds exceeded
on the Diagnostics pane.

= Set Signal storage reuse on in the Optimization pane.

e Stateflow — The Accelerator is fully compatible with Stateflow, but it does
not improve the performance of the Stateflow portions of models. Disable
Stateflow debugging and animation to increase performance of models
that include Stateflow blocks.

e User-written S-functions — The Accelerator cannot improve simulation
speed for S-functions unless you inline them using the Target Language
Compiler. Inlining refers to the process of creating TLC files that direct
Real-Time Workshop to create C code for the S-function. This eliminates
unnecessary calls to the Simulink application program interface (API).

For information on how to inline S-functions, consult the Real-Time
Workshop Target Language Compiler Reference Guide, which is available
on the MathWorks Web site, at www.mathworks.com.
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e S-functions supplied by Simulink and blocksets — Although the Simulink
Accelerator is compatible with all the blocks provided with Simulink and
blocksets, it does not improve the simulation speed for M-file or C-MEX
S-Function blocks that do not have an associated inlining TLC file.

® Logging large amounts of data — If you use Workspace I/0, To Workspace,
To File, or Scope blocks, large amounts of data will slow the Accelerator
down. Try using decimation or limiting outputs to the last IV data points.

¢ Large models — In both Accelerator and Normal mode, Simulink can take
significant time to initialize large models. Accelerator speedup can be
minimal if run-times (from start to finish of a single simulation) are small.

Blocks That Do Not Show Speed Improvements

The Simulink Accelerator speeds up execution only of blocks from Simulink
and the Signal Processing Blockset. Further, the Accelerator does not improve
the performance of some blocks in Simulink and the Signal Processing
Blockset. The following sections list these blocks.

Simulink Blocks

* Display

* From File

* From Workspace

¢ Inport (root level only)
e MATLAB Fen

® Qutport (root level only)
® Scope

e To File

* To Workspace

¢ Transport Delay

® Variable Transport Delay
® XY Graph
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Signal Processing Blockset Blocks

® Biquadratic Filter

* Convolution

¢ Direct-Form II Transpose Filter
® Dyadic Analysis Filter Bank

¢ Dyadic Synthesis Filter Bank

¢ FIR Decimation

¢ FIR Interpolation

* FIR Rate Conversion

* From Wave Device

* From Wave File

® Integer Delay

® Variable Integer Delay

® Matrix Multiply

¢ Matrix To Workspace

® Triggered Signal To Workspace
® Triggered Signal From Workspace
® Time-Varying Direct-Form II Transpose Filter
* To Wave File

* To Wave Device

® Wavelet Analysis

® Wavelet Synthesis

® Zero Pad

User-Written S-Function Blocks

In addition, the Accelerator does not speed up user-written S-Function
blocks unless you inline them using the Target Language Compiler and
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set SS_OPTION_USE_TLC_WITH_ACCELERATOR in the S-function itself. See
“Controlling S-Function Execution” on page 13-12 for more information.

Using the Simulink Accelerator with the Simulink
Debugger

If you have large and complex models that you need to debug, the Simulink
Accelerator can shorten the length of your debugging sessions. For example,
if you need to set a time break that is very large, you can use the Accelerator
to reach the breakpoint more quickly.

To run the Simulink debugger while in Accelerator mode:

1 Select Accelerator from the Simulation menu, then enter

sldebug modelname

at the MATLAB prompt.
2 At the debugger prompt, set a time break:

tbreak 10000
continue

3 Once you reach the breakpoint, use the debugger command emode
(execution mode) to toggle between Accelerator and Normal mode.

that you must switch to Normal mode to step the simulation by blocks. You
must also switch to Normal mode to use the following debug commands:

* trace

® break

® zcbreak

® nanbreak

® minor

For more information on the Simulink debugger, see Chapter 12, “Simulink
Debugger”.
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Interacting with the Simulink Accelerator
Programmatically

Using three commands, set_param, sim, and accelbuild, you can control
the execution of your model from the MATLAB prompt or from M-files. This
section describes the syntax for these commands and the options available.

Controlling the Simulation Mode
You can control the simulation mode from the MATLAB prompt using

set_param(gcs, 'simulationmode’, 'mode"')

or

set_param(modelname, 'simulationmode’, 'mode')

You can use gcs ("get current system") to set parameters for the currently
active model (i.e., the active model window) and modelname if you want to
specify the model name explicitly. The simulation mode can be either normal
or accelerator.

Simulating an Accelerated Model
You can also simulate an accelerated model using

sim(gcs); % Blocks the MATLAB prompt until simulation complete

or

set_param(gcs, 'simulationcommand', 'start'); % Returns to the
MATLAB prompt
% immediately

o°

Again, you can substitute the modelname for gcs if you prefer to specify the
model explicitly.
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Building Simulink Accelerator MEX-Files Independent of
Simulation

You can build the Simulink Accelerator MEX-file without actually simulating
the model by using the accelbuild command, for example,

accelbuild f14

Creating the Accelerator MEX-files in batch mode using accelbuild allows
you to build the C code and executables prior to running your simulations.
When you use the Accelerator interactively at a later time, it does not need to
generate or compile MEX-files at the start of the accelerated simulations.

You can use the accelbuild command to specify build options such as turning
on debugging symbols in the generated MEX-file.

accelbuild f14 OPT_OPTS=-g

Comparing Performance
If you want to compare the performance of the Simulink Accelerator to

Simulink in Normal mode, use tic, toc, and the sim command. To run the
F14 example, use this code (make sure you’re in Normal mode).
tic,[t,x,y]l=sim('f14',1000);toc
elapsed_time =
14.1080
In Accelerator mode, this is the result.
elapsed_time =

6.5880

These results were achieved on a Windows PC with a 233 MHz Pentium
processor.

that for models with very short run times, the Normal mode simulation
might be faster, because the Accelerator checks at the beginning of any run
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to see whether it must regenerate the MEX-file. This adds a small overhead
to the run-time.

Customizing the Simulink Accelerator Build Process

Typically, no customization is necessary for the Simulink Accelerator build
process. However, because the Accelerator uses the same underlying
mechanisms as Real-Time Workshop to generate code and build the MEX-file,
you can use three parameters to control the build process:

AccelMakeCommand
AccelSystemTargetFile
AccelTemplateMakeFile

The three options allow you to specify custom Make command, System target,
and Template makefiles. Each of these parameters governs a portion of the
code generation process. Using these options requires an understanding of
how Real-Time Workshop generates code. For a description of the Make
command, the System target file, and Template makefile, see the “Real-Time
Workshop User’s Guide”, which is available on the MathWorks Web site,
www . mathworks.com.

The syntax for setting these parameters is

set_param(gcs, 'parameter', 'string')

or

set_param(modelname, 'parameter', 'string')

where gcs (“get current system”) is the currently active model and
'parameter’ is one of the three parameters listed above. Replace 'string'
with your string that defines a custom value for that parameter.

Controlling S-Function Execution

Inlining S-functions using the Target Language Compiler increases
performance when used with the Simulink Accelerator. By default, however,
the Accelerator ignores an inlining TLC file for an S-function, even though
the file exists.
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One example of why this default was chosen is a device driver S-Function
block for an I/0 board. The S-function TLC file is typically written to access
specific hardware registers of the I/O board. Because the Accelerator is not
running on a target system, but rather is a simulation on the host system, it
must avoid using the inlined TLC file for the S-function.

Another example is when the TLC file and MEX-file versions of an S-function
are not compatible in their use of work vectors, parameters, and/or
initialization.

If your inlined S-function is not complicated by these issues, you can direct the
Accelerator to use the TLC file instead of the S-function MEX-file by specifying
SS_OPTION_USE_TLC WITH ACCELERATORin the mdlInitializeSizes function
of the S-function. When set, the Accelerator uses the inlining TLC file and full
performance increases are realized. For example:

static void mdlInitializeSizes(SimStruct *S)

{
/* Code deleted */

ssSetOptions(S, SS_OPTION_USE_TLC_WITH_ACCELERATOR);
}
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The Simulink simulation profiler collects performance data while simulating
your model and generates a report, called a simulation profile, based on

the data. The simulation profile generated by the profiler shows you how
much time Simulink spends executing each function required to simulate
your model. The profile enables you to determine the parts of your model
that require the most time to simulate and hence where to focus your model
optimization efforts.

You must have the Simulink Accelerator product installed on your system to
use the profiler.

How the Profiler Works

The following pseudocode summarizes the execution model on which the
profiler is based.

Sim()
ModelInitialize().
ModelExecute()
for t = tStart to tEnd
Output ()
Update()
Integrate()
Compute states from derivs by repeatedly calling:
MinorQutput()
MinorDeriv ()
Locate any zero crossings by repeatedly calling:
MinorQutput()
MinorZeroCrossings ()
EndIntegrate
Set time t = tNew.
EndModelExecute
ModelTerminate
EndSim
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According to this conceptual model, Simulink executes a Simulink model
by invoking the following functions zero, one, or more times, depending on

the function and the model.

Function

Purpose

Level

sim

Simulate the model. This
top-level function invokes the
other functions required to
simulate the model. The time
spent in this function is the total
time required to simulate the
model.

System

ModelInitialize

Set up the model for simulation.

System

ModelExecute

Execute the model by invoking
the output, update, integrate,
etc., functions for each block at
each time step from the start to
the end of simulation.

System

Output

Compute the outputs of a block at
the current time step.

Block

Update

Update a block’s state at the
current time step.

Block

Integrate

Compute a block’s continuous
states by integrating the state
derivatives at the current time
step.

Block

MinorOutput

Compute a block’s output at a
minor time step.

Block

MinorDeriv

Compute a block’s state
derivatives at a minor time
step.

Block

MinorZeroCrossings

Compute a block’s zero-crossing
values at a minor time step.

Block
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Function Purpose Level

ModelTerminate Free memory and perform any System
other end-of-simulation cleanup.

Nonvirtual Subsystem Compute the output of a Block
nonvirtual subsystem (see
“Solvers” on page 1-17) at the
current time step by invoking
the output, update, integrate,
etc., functions for each block
that it contains. The time
spent in this function is the
time required to execute the
nonvirtual subsystem.

The profiler measures the time required to execute each invocation of these
functions and generates a report at the end of the model that describes how
much time was spent in each function.

Enabling the Profiler

To profile a model, open the model and select Profiler from the Simulink
Tools menu. Then start the simulation. When the simulation finishes,
Simulink generates and displays the simulation profile for the model in the
MATLAB Help browser.
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The Simulation Profile
Simulink stores the simulation profile in the MATLAB working directory.

[
) Help =] 3
File Edit ¥iew Go MWeb Window Help

| 4 ' *|§|Flndmpage. ﬂl
|Simu\inkPmﬂlerRepor‘t LI Add to Favorites

Summary | Function Details | Simulink Profiler Help | Clear Hilited Blocks

Simulink Profile Report: Summary

Report generated 11-5ep-2000 16:57:39

Total recorded time: 018s
MNumber of Block Methods: 13
MNumber of Internal Methods ol
Mumber of Nonvirtual Subsystem Methods: 4
Clock precision 0.010s

Function List

Name Time Calls Timefeall |Salf time Location (must use MATLAB Help browser to view)
sim 0.190 100.0% | 1 0.190000 0.000 | 0.0% vdp
ModelExecute 0.170 | 89.5% | 1 0.170000 0.070 36.8% vdip
Inteqrate 0.080 | 424% | 83 0001270 0010 5.3% vdp

wdp (MinorOutput) 0.050 | 26.3% | 408 0.000123 0.010  §3% wdp

MinorOutputs 0.050 | 263% | 408 0.000123 0.000  0.0% wdp

MinorDeriv 0.020 | 10.5% | 409 0.000043 0.010  53% wvdp

Outl {Dutput) 0.020 | 10.5% | 472 0.000042 0020 10.5% wdp/0utl =
Ready

The report has two sections: a summary and a detailed report.

Summary Section
The summary file displays the following performance totals.

Item Description

Total Recorded Time Total time required to simulate the model

Number of Block Methods | Total number of invocations of block-level
functions (e.g., Output())

Number of Internal Total number of invocations of system-level
Methods functions (e.g., ModelExecute)
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Item Description

Number of Nonvirtual Total number of invocations of nonvirtual
Subsystem Methods subsystem functions

Clock Precision Precision of the profiler’s time measurement

The summary section then shows summary profiles for each function invoked
to simulate the model. For each function listed, the summary profile specifies
the following information.

Item

Description

Name

Name of function. This item is a hyperlink. Clicking it
displays a detailed profile of this function.

Time

Total time spent executing all invocations of this function
as an absolute value and as a percentage of the total
simulation time

Calls

Number of times this function was invoked

Time/Call

Average time required for each invocation of this function,
including the time spent in functions invoked by this
function

Self Time

Average time required to execute this function, excluding
time spent in functions called by this function

Location

Specifies the block or model executed for which this
function is invoked. This item is a hyperlink. Clicking it
highlights the corresponding icon in the model diagram.
That the link works only if you are viewing the profile in
the MATLAB Help browser.
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Detailed Profile Section

This section contains detailed profiles for each function invoked to simulate
the model. Each detailed profile contains all the information shown in the
summary profile for the function. In addition, the detailed profile displays the
function (parent function) that invoked the profiled function and the functions
(child functions) invoked by the profiled function. Clicking the name of the
parent or a child function takes you to the detailed profile for that function.
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Using the Embedded
MATLAB Function Block

The Embedded MATLAB Function block lets you use MATLAB code in models
intended to be deployed as stand-alone executables generated by Real-Time
Workshop. The following sections explain how to use the block to create such

models.

Introduction to Embedded MATLAB
Function Blocks (p. 14-3)

Creating an Example Embedded
MATLAB Function (p. 14-7)

Debugging an Embedded MATLAB
Function (p. 14-20)

The Embedded MATLAB Function
Editor (p. 14-30)

Typing Function Arguments
(p. 14-40)

Sizing Function Arguments
(p. 14-46)

Parameter Arguments in Embedded
MATLAB Functions (p. 14-51)

Overview of the use of Embedded
MATLAB Function blocks in
Simulink.

How to create an example Simulink
model with an Embedded MATLAB
Function block that you program.

How to debug the Embedded
MATLAB function for the example
model you create in the previous
section.

Reference of operations available in
the Embedded MATLAB Editor.

How to specify argument types in
the Model Explorer.

How to specify argument sizes in the
Model Explorer.

How to pass Simulink parameters
and MATLAB variables as
arguments to an Embedded
MATLAB Function block.
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Local Variables in Embedded
MATLAB Functions (p. 14-53)

Functions in Embedded MATLAB
Functions (p. 14-58)

Reference of variable types
supported by Embedded MATLAB
Function blocks.

Rules for calling functions in the
MATLAB workspace and using their
return values.
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Introduction to Embedded MATLAB Function Blocks

This section introduces the Embedded MATLAB Function block in Simulink.
Use the following topics to get an overview of Embedded MATLAB Function
blocks, and how and why they are used in Simulink.

* “What Is an Embedded MATLAB Function Block?” on page 14-3

o “Why Use Embedded MATLAB Function Blocks?” on page 14-5

In “Creating an Example Embedded MATLAB Function” on page 14-7, you
build a model with an example Embedded MATLAB Function block.

Note For more information on fixed-point support in Embedded MATLAB,
refer to “Using the Fixed-Point Toolbox with Embedded MATLAB” in the
Fixed-Point Toolbox documentation.

What Is an Embedded MATLAB Function Block?

The Embedded MATLAB Function block contains a MATLAB function in a
Simulink model. The function accepts multiple input signals and produces
multiple output signals.
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You build the following model in “Creating an Example Embedded MATLAB
Function” on page 14-7:

Embedded MATLAB Function block

mean . .
Display f—— Simulink model
790 pofvals  stats
stdey TEI
Constant #  Embedded ~ -
~ MATLAE Function ™= Display1
-~ T
e
/
-~ ~
e
- ~
- -~
function [wean,stdev] = stats(vals)

% calculate a statistical mwean and a standard I
% deviation for the walues in wvals.

len = lengthivals): —— Embedded MATLAB function

mean = avg(vals, len):
atdev = sqgrti{sum|((vals-avgivals,len)).”2))/1len);
plot(vals,'-+']:

function mean = avglarray,size)
mean = sumiarray)/size:;

As in a MATLAB function, in the Embedded MATLAB Function block, you
can declare a local variable implicitly through assignment. The variable takes
its type and size from the context in which it is assigned. For example, the
following code line declares x to be a scalar variable of type double.

x = 1.54;

Once you define a variable, it cannot be redefined to any other type or size
in the function body. For example, you cannot declare x and reassign it as
follows:

X = 2.65; % OK: x is a scalar double
[x 2*x]; % Error: x cannot be changed to a vector

X
I

See “Declaring Local Variables Implicitly” on page 14-53 for detailed
descriptions and examples.
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In addition to supporting a rich subset of the MATLAB language, an
Embedded MATLAB Function block can call any of the following functions:

Subfunctions

Subfunctions are defined in the body of the Embedded MATLAB block. In
the preceding example, avg is a subfunction.

Embedded MATLAB run-time library functions

Embedded MATLAB run-time library functions are a subset of the
functions that you call in MATLAB. When you build your model with
Real-Time Workshop, these functions generate C code that conforms to
the memory and variable type requirements of embedded environments.
In the preceding example, length, sqrt, and sum are Embedded MATLAB
run-time library functions.

MATLAB functions

Function calls that cannot be resolved as subfunctions or Embedded
MATLAB run-time library functions are resolved in the MATLAB
workspace. These functions do not generate code; they execute only in the
MATLAB workspace during simulation of the model.

Why Use Embedded MATLAB Function Blocks?

There are many reasons to use Embedded MATLAB Function blocks in your
Simulink models. Here are just a few of them:

Embedded MATLAB Function blocks can build stand-alone
simulation applications — To support code generation in Real-Time
Workshop, the Embedded MATLAB Function block supports a subset of
MATLAB commands that generate efficient C code. If you limit the function
calls in Embedded MATLAB functions to subfunctions and Embedded
MATLAB run-time library functions, you can use Real-Time Workshop

to build simulation executables that execute without the MATLAB
environment.

Embedded MATLAB Function blocks have multiple inputs and
outputs — Unlike MATLAB Fcn blocks, which take a vector input of values
and support a single scalar output, the functions in Embedded MATLAB
Function blocks accept multiple inputs and return multiple outputs.
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¢ Embedded MATLAB Function blocks inherit Simulink input and
output signals — By default, both the size and type of input and output
signals to an Embedded MATLAB Function block are inherited from
Simulink signals. You can also choose to specify the size and type of
inputs and outputs explicitly in the Ports and Data Manager or Model
Explorer.

¢ Embedded MATLAB Function blocks have the full power of
MATLAB — Using Embedded MATLAB Function blocks, developers now
have access to a wide and growing variety of sophisticated mathematical
applications for the embedded environment. You can choose to limit the
function calls in Embedded MATLAB Function functions to subfunctions
and Embedded MATLAB run-time library functions that generate efficient
C code. However, for simulation applications you can call MATLAB
functions directly. You can also mix function calls between run-time library
functions and MATLAB functions.
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Creating an Example Embedded MATLAB Function

Use the following procedure topics to create a model with an Embedded
MATLAB Function block. In the process, learn how to use Embedded
MATLAB Function blocks in Simulink.

“Adding an Embedded MATLAB Function Block to a Model” on page 14-7 —
Start by creating a model with an Embedded MATLAB Function block.

“Programming the Embedded MATLAB Function” on page 14-9 — Use the
built-in diagnostics for Embedded MATLAB Function blocks to test for
syntax errors in the Embedded MATLAB function body.

“Checking the Function for Errors” on page 14-14 — Use the built-in
diagnostics for Embedded MATLAB Function blocks to test for syntax
errors in the Embedded MATLAB function body.

“Defining Inputs and Outputs” on page 14-17 — Define properties for the
input and output arguments of the Embedded MATLAB Function block
interface with the Ports and Data Manager or Model Explorer tool.

Adding an Embedded MATLAB Function Block to a
Model

Start by creating an empty Simulink model and filling it with an Embedded
MATLAB Function block, and other blocks necessary to complete the model.
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1 Create a new Simulink model and add an Embedded MATLAB Function

block to it from the User-Defined Function library of the Simulink library.

=10l x|

File Edit WYiew Simulation Format Tools Help

Embedded
WATLAE Function

Ready [118% [ [ |odets v

An Embedded MATLAB Function block has two names. The name in the
middle of the block is the name of the function you build for the Embedded
MATLAB Function block. Its name defaults to fcn. The name at the
bottom of the block is the name of the block itself. Its name defaults to
Embedded MATLAB Function.

The default Embedded MATLAB Function block has an input port and an
output port. The input port is associated with the input argument u, and
the output port is associated with the output argument y.

2 Add the following Source and Sink blocks to the model:

® From the Simulink Sources library, add a Constant block to the left of
the Embedded MATLAB Function block and set its value to the vector
[2 3 4 5].

® From the Simulink Sinks library, add two Display blocks to the right of
the Embedded MATLAB Function block.
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The model should now have the following appearance:

=10l x|

File Edit WYiew Simulation Format Tools Help

Dizplay

{9

Dizplay1

(2345 p qu fen a3

Ceonstant

Embedded
WATLAE Function

Ready [118% [ [ |odets v

3 In the Simulink window, from the File menu, select Save As and save
the model as call stats blocki.

Programming the Embedded MATLAB Function

You create a model with an Embedded MATLAB Function block in “Creating
an Example Embedded MATLAB Function” on page 14-7. Now you want to
add code to the block to define it as a function that takes a vector set of values
and calculates the mean and standard deviation for those values. Use the
following steps to program the function stats:

1 Ifnot already open, open the call stats block1 model that you save at
the end of “Adding an Embedded MATLAB Function Block to a Model” on
page 14-7, and double-click its Embedded MATLAB Function block fcn
to open it for editing.
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The Embedded MATLAB Editor appears.

«): Embedded MATLAB Editor - Block: call_stats_blockl /Embedded MATLAI _|EI|1|
File Edit Text Debug Tools ‘Window Help A X

N E| 2R« d@F S| r"m AREBRE B =Ru=N=lw)

1 function ¥ = foniu)
2 % This block supports an enmbeddable subset of the MATLAE language.
| % See the help menu for details.
4
S5- ¥v=uw
| Ready [tn 1 cal 4 4

The Embedded MATLAB Editor window is titled with the syntax <model
name>/<Embedded MATLAB Function block name> in its header. In this
example, the model name is call stats_block1, and the block name is
Embedded MATLAB Function, the name that appears at the bottom of the
Embedded MATLAB Function block in Simulink.

Inside the Embedded MATLAB Editor is an edit window for editing the
function that specifies the Embedded MATLAB Function block. A function
header with the function name fcn is at the top of the edit window. The
header specifies an argument to the function, u, and a return value, y.

Edit the function header line with the return values, function name, and
argument as follows:

function [mean,stdev] = stats(vals)

The Embedded MATLAB function stats calculates a statistical mean and
standard deviation for the values in the vector vals. The function header
declares vals to be an argument to the stats function and mean and stdev
to be return values from the function.

In the Embedded MATLAB Editor, from the File menu, select Save As
Model and save the model as call stats block2.
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Saving the model updates the Simulink window, which now has the
following appearance:

Input port Output ports

E!call_stats_hlockz

File Edit WYiew Simulation Fofmat Tools Help

DISEHS| s 2@ (2> sl [op ]| HBEBS e

=laix|

Dizplay
(2345 p o valz  state
e p [—
A
Ceonstant Embedded -
MA TLAE Function Dizplay1
Ready 118% odeds
%

Changing the function header of the Embedded MATLAB Function block

makes the following changes to the Embedded MATLAB Function block in
the Simulink model:

® The function name in the middle of the block changes to stats.
¢ The argument vals appears as an input port to the block.

® The return values mean and stdev appear as output ports to the block.
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4 In the Simulink window, complete connections to the Embedded MATLAB

Function block as shown.

E!call_stats_hlockz* ;Iglll

File Edit WYiew Simulation Format Tools Help

——]

mean -
Dizplay
(2345 ol vas ztats
[
Ceonstant Embedded -
MA TLAE Function Dizplay1
Ready [118% [ [ |odets v

5 In the Embedded MATLAB Editor, enter a line space after the function

header and replace the default comment line with the following comment
lines:

% calculates a statistical mean and a standard
% deviation for the values in vals.

You specify comments with a leading percent (%) character, just as you
do in MATLAB.

Enter a line space after the comments and replace the default function line
y = u; with the following:

len = length(vals);

The function length is an example of a built-in function supported by the
run-time function library for Embedded MATLAB Function blocks. This
length works just like the MATLAB function length. It returns the vector
length of its argument vals. However, when you simulate this model,
Simulink generates C code for this function in the simulation application.
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Callable functions supported for Embedded MATLAB Function blocks are
listed in the topic “Embedded MATLAB Run-Time Function Library”.

The variable 1len is a local variable that is automatically typed as a scalar
double because the Embedded MATLAB run-time library function, length,
returns a scalar of type double. If you want, you can declare len to have a
different type and size by changing the way you declare it in the function.
See “Declaring Local Variables Implicitly” on page 14-53 for details about
implicitly declaring local variables in an Embedded MATLAB Function
block.

By default, implicitly declared local variables like 1en are temporary. They
come into existence only when the function is called and cease to exist
when the function is exited. You can make implicitly declared variables for
a function persistent between calls by using the persistent statement.

See “Declaring Local Variables Implicitly” on page 14-53 for an example
using the persistent statement.

Enter the following lines to calculate the value of mean and stdev:

mean = avg(vals,len);
stdev = sqrt(sum(((vals-avg(vals,len))."2))/1len);

stats stores the mean and standard deviation values for the values in
vals in the variable mean and stdev, which are output by port to the
Display blocks in the Simulink model. The line that calculates mean calls a
subfunction, avg, that has not been defined yet. The line that calculates
stdev calls the Embedded MATLAB run-time library functions sqrt and
sum.

Enter the following line to plot the input values in vals.
plot(vals,'-+');

This line calls the function plot to plot the input values sent to stats
against their vector indices. Because the Embedded MATLAB run-time
library has no plot function, the Embedded MATLAB function cannot
resolve this call with a subfunction or an Embedded MATLAB run-time
function. Instead, it replaces this call with a call to the MATLAB plot
function in the generated code for the simulation target.
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See “Calling MATLAB Functions” on page 14-60 for more details on using
this mechanism to call MATLAB functions from Embedded MATLAB

functions.

9 Enter a line space followed by the following lines for the subfunction avg,

which is called in an earlier line.

function mean = avg(array,size)
mean = sum(array)/size;

These two lines define the subfunction avg. You are free to use subfunctions
in Embedded MATLAB function code with single or multiple return values,
just as you do in regular MATLAB functions.

The Embedded MATLAB Editor should now have the following
appearance:

<) Embedded MATLAB Editor - Block: call_stats_block2 /Embedded MATL i = |EI|1|
File Edit Text Debug Tools ‘Window Help A X

1 function [wean,stdev] = stats(vals)

2

3 % calculates a statistical mwean and a standard
4 % deviation for the walues in wvals.

5

6 — len = lengthiwvals):

7 - mean = avg(vals, len]:

8 - stdev = agrti(sumi|{vals-avg(vals, len)).”2))/1len);
9 - plotivals,'-+']:

i0

11 - function mean = avglarray,size)

12 - mean = sumiarray)/size;

| Embedded MaTLAE || Ernbedded MATLAS ><|

| Ready [tLn 1 cal 1 Y

10 Save the model again as call stats_block?2.

Checking the Function for Errors

Once you finish specifying an Embedded MATLAB Function block in its
Simulink model, use the built-in diagnostics of Embedded MATLAB Function
blocks to test for syntax errors with the following procedure:
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1 Ifnot already open, open the call stats block2 model that you save at
the end of “Programming the Embedded MATLAB Function” on page 14-9,
and double-click its Embedded MATLAB Function block stats to open it
for editing.

2 In the Embedded MATLAB Editor, click the Build tool to compile

and build the example Simulink model.

If errors are found, the Builder window lists them. Otherwise, nothing
happens.

3 For example, change the call to the subfunction avg to a call to a fictitious
subfunction aug and then compile to see the following result.

i stateflow Builder: call_stats_blockz _ Ol x|

Wigw  Font Size

_I Meszage Source Reported by Summary

@ CoderError ehil el Inference: The class of this variahle is unknown eML functio...
& CoderWar.. ebL el Inference: Function resolved in the MATLAB workspace and ..
@ CoderEror edL el Yariahle aug must be unambiguously written to befare use.e..
@ CoderEror edL el Errars occurred during parsing of eML function "eML'#1 7y

@ CoderEror call_stats_.. Coder

| |

& call_stats_plock
Parzsing successful for machine: "call stats_block™(#l6)

COpen | Help | Close |

Each detected error begins with a red button. In this case, rows 2, 4, 5, and
6 have a red button.
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4 Click the first error line to highlight it and display information for it.

1 stateflow Builder: call_stats_block2 i - |EI|1|

Views  Font Size

| Message | Source | Reported hyl SurmaEry |

@ Parselog call_stats ... Parse
erbror sebl  [eML  [inference: The of g iz unk ML functio...

@ Coderwar.. eML emL Inference: Function resalved in the MATLAE workspace and ..
@ CoderError eML emL Variable aug must he unambiguousty written to hefore use.e..
@ CoderError eML emL Errors occurred during parsing of eML funclion ‘eMLG17)
@ CoderEror call_stats_.. Coder
| |

L) |

Inference: The class of this wariable is unknown.

eML function 'eML' (£17.148.151), line 7, column S:
" ang

Open | Help | Cloze |

\Clitkru display offending line in Embedded MATLAB Editor

5 In the diagnostic message for the error appearing in the bottom pane of
the Build window, click the link.

The offending line appears highlighted in the Embedded MATLAB
Editor.

<) Embedded MATLAB Editor - Block: call_stats_block2/Emb =] ]
File Edit Text Debug Tools Window Help a X
D {BEB (B S@E - BRAQEH

1 function [mean,stdev] = stats(vals)

2

3 % waloulates a statistical mean and a standard

4 % deviation for the wvalues in wvals.

5

& — len = length{wals):

T - mean = aug(vals, len):

& - =stdev = sgrt(sum||(vals-avg(vals,len)).”2))/len);

9 - plot (vals, '-+'1:

10

11 - function mean = avy(array,size)

12 = mean = sum(array)/size;
o |

| Ready Ln 7 ol 14 y
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6 Correct the error and recompile.

Defining Inputs and Outputs

In the stats function header for the Embedded MATLAB Function block you
define in “Programming the Embedded MATLAB Function” on page 14-9, the
function argument vals is an input and mean and stdev are outputs. By
default, function inputs and outputs inherit their data type and size from the
Simulink signals attached to their ports. In this topic, you examine input
and output data for the Embedded MATLAB Function block to verify that

it inherits the correct type and size.

1 If not already open, open the call stats block2 model that you save at
the end of “Programming the Embedded MATLAB Function” on page 14-9,
and double-click its Embedded MATLAB Function block stats to open it
for editing.

2 In the Embedded MATLAB Editor, select Tools > Model Explorer to
open the Model Explorer.

The Model Explorer window appears, as shown.

F& Model Explorer =1olx|

File Edit Wiew Tools Add Help

[DF[smmx EMenis® @n 4+5]|eanEe s
[seerct [oy Biock Tope =] Tupe: [Constart x| [Z] Search

Model Hierarchy Contents ofcall_stats_block2/Embedded b | Embedded MATLAB Function

E‘--@S\mu\mk Foot Name:  Embedded MATLAR

Farent:  call stats block2
- BiBace Workspace [1]vals Input 1 inherked 1 yachine: (machinelcall stets block?
EI'H: call_stats_block2 [i%j] mean  Output 1 inherited

; Update methoc | ]
b T Model Warkspace [i] sidev Output 2 inhered peate methoct | Inherited a

%Ennfigulatinn [&ctive] Editor: [ Locked
@ Code for call_stats_block

| Namal Scope | Port | DalaTypa' Sizel

i Description
? Advice for call_stats_bloc
B8 [ Embedded MATLAR
Docurnent Link: |
KT I— |
q | _;I Contents I Search Results Bevert | Help | Apply |

#

You can use the Ports and Data Manager or Model Explorer to display
and define arguments for Embedded MATLAB Function blocks. Notice that
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the Embedded MATLAB Function block Embedded MATLAB is highlighted in
the left Model Hierarchy pane.

The Contents pane displays the argument vals and the return values
mean and stdev that you have already created for the Embedded MATLAB
Function block. Notice that vals is assigned a Scope of Input, which is
short for Input from Simulink. mean and stdev are assigned the Scope
of Output, which is short for Output to Simulink.

In the Contents pane of the Model Explorer window, click anywhere in
the row for vals to highlight it, as shown.

& Model Explorer =10
File Edit Wiew Tools Add Help

[ semx EMeEsi 0 @R 40][enraz

”Search' Iby Black Type j Type: IEonstant ;I @ Search |
I odel Hierarchy ICUntsnls of. call_stats_block2/Embedded b | Data vals
E\--@S\mu\ink Rioot Wame | Scope | Port | DataTupe | Size General IVa\ueAttnbules | Description I =

ﬁ Base Workspace
- gl call_stats_block2
H Maodel Workspace
é--%tonfigulation [Active)

Tnput 1 A
mean  Output 1 inherited
[14] sidev Output 2 inherited

Hame: Ivals
Parent: call stats block2/Embedded MATLABR
Scope: | Input x| Part |1

- & Cade for call_stats_block Type: Imheritad ] Urits: I
?Advice for call_stats_bloc ™ Complex
‘..M Embedded MATLAB

Fized-Point
’75tulelntsg5l. int16 'I Fraction length [

™ Lock output scaling againgt changes by the autose

Size: |-1 First index: IT'LI
i I _’I 4| | L4
P | _;I Contents | Search Resul Bevert | Help | Apply |
v
Inherited type Inherited size

The right pane displays the Data properties dialog box for vals. By
default, the type and size of input and output arguments are inherited from
the Simulink signals attached to each input or output port. Inheritance

of type is specified by setting Type to Inherited. Inheritance of size is
specified by setting Size to -1.

The actual inherited values for size and type are set during compilation
of the model, and are reported in the CompiledType and CompiledSize
columns of the Contents pane. You compile and build the model by clicking



Creating an Example Embedded MATLAB Function

the Build tool | &), which you do in “Checking the Function for Errors” on
page 14-14 to check the Embedded MATLAB function for errors.

If you want, you can specify the type of an input or output argument
directly by selecting a type in the Type field of the Data properties dialog
box, for example, double. You can also specify the size of an input or output
argument directly by entering an expression in the Size field of the Data
properties dialog box for the argument. For example, you can enter [2 3]
in the Size field to size vals as a 2-by-3 matrix. See “Typing Function
Arguments” on page 14-40 and “Sizing Function Arguments” on page 14-46
for more information on the expressions that you can enter for type and size.

Note The default first index for any arrays that you add to an Embedded
MATLAB Function block function is 1, just as it would be in MATLAB.
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In “Creating an Example Embedded MATLAB Function” on page 14-7, you
create and specify an example Simulink model with an Embedded MATLAB
Function block. You use this block to specify an Embedded MATLAB function
stats that calculates the mean and standard deviation for a set of input
values. In this section, you debug stats in the example model.

Use the following topics to learn how to debug an Embedded MATLAB
function in Simulink:

® “Debugging the Function in Simulation” on page 14-20 — Executes the
model in simulation and tests the Embedded MATLAB function stats.

* “Watching Function Variables During Simulation” on page 14-27 —
Describes tools that you can use to view the values of Embedded MATLAB
variables during simulation.

Debugging the Function in Simulation

You can debug your Embedded MATLAB Function block just like you can
debug a function in MATLAB. In simulation, you test your Embedded
MATLAB functions for run-time errors with tools similar to the MATLAB
debugging tools.

When you start simulation of your model, Simulink checks to see if the
Embedded MATLAB Function block has been built since creation, or since a
change has been made to the block. If not, it performs the build described in
“Checking the Function for Errors” on page 14-14. If no diagnostic errors are
found, Simulink begins the simulation of your model.

Use the following procedure to debug the stats Embedded MATLAB function
during simulation of the model:

1 Ifnot already open, open the call stats block2 model that you save at
the end of “Programming the Embedded MATLAB Function” on page 14-9,
and double-click its Embedded MATLAB Function block stats to open it
for editing in the Embedded MATLAB Editor.
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2 In the Embedded MATLAB Editor, in the left margin of line 6, click
the dash (-) character.

«): Embedded MATLAB Editor - Block: call_stats_block/Embedded MA =10l x|
File Edit Text Debug Tools ‘Window Help A X
Dz EH| 2R « (@ ¢ |E@E-s B0 E O

1 Ifunct,ion [thean, stdev] = stats(vals)

2

3 % calculates a statistical mean and a standard

4 % deviation for the wvalues in wvals.

5

& len = lengthiwvals):

7 mean = avg(vals, len):

8 atdev = sqgrti{sum|( | (vals-avg(vals,len)).”2))1/len);

9 plot(vals,'—-+']:

i0

11 - function mean = avglarray,size)

12 -1 mean = sumiarray)/size;

3

Ready \ [th 1 cal g 4

Breakpoint indicator

A small red ball appears in the margin of line 6, indicating that you have

set a breakpoint. You can also use the Set/Clear Breakpoint tool to
insert the breakpoint on the line where the cursor is positioned.
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3 Click the Start Simulation tool | to begin simulating the model.

If you get any errors or warnings, make corrections before you try to
simulate again. Otherwise, simulation pauses when execution reaches
the breakpoint you set. This is indicated by a small green arrow in the
left margin, as shown.

«): Embedded MATLAB Editor - Block: call_stats_block/Embedded 10l =|
File Edit Text Debug Tools ‘Window Help A X

1 function [mwean,stdev] = stats(vals)
2
3 % calculates a statistical mean and a standard
4 % deviation for the wvalues in wvals.
5
6 @ len = lengthivals);
7 - Amean = avg(vals, len) ;
8 - | stdev = agrt{sumi | {vals-avgi(vals,len)).”2))/len):
9 - | plot(vals,'—+']:
i0
11 - function mean = avglarray,size)
12 - |wean = sumiarray)/size:
t
RunPausedE\.ocked)(Debugging) |Ln 1 Cal 1 S

Execution pauses prior to next step

4 In the Embedded MATLAB Editor window, click the Step tool to
advance execution one line to line 7.

The execution arrow advances to line 7 of stats.

You can also step execution by entering dbstep at the Command Line
Debugger. See “Watching with the Command Line Debugger” on page 14-28
for a description of the Command Line Debugger in MATLAB.

Notice that line 7 calls the subfunction avg. If you click Step here,
execution advances to line 8, past the execution of the subfunction avg. To
track execution of the lines in the subfunction avg, you need to click the
Step In tool.
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5 Click the Step In tool 2l to advance execution to the first line of the called

subfunction avg, as shown.

« ) Embedded MATLAB Editor - Block: call_stats_block/Embedded =18l x|
File Edit Text Debug Tools ‘Window Help A X
D EH|i2Ro B4 B e R@0QERE O

1 function [mwean,stdev] = stats(vals)

2

3 % calculates a statistical mean and a standard

4 % deviation for the wvalues in wvals.

5

6 ® len = lengthiwvals):

7 - mean = avg(vals, len]:

8 - stdev = agrti(sumi|{vals-avgi(vals,len)).”2))/len):

9 - plotivals,'-+']:

i0

11 - function mean = avglarray,size)

12 - B mean = sumiarray)/size;

|RunPaused(Locked)(Debugging) |Ln 1 Cal 1

4

Once you are in a subfunction, you can use the Step or Step In tool to
advance execution. If the subfunction calls another subfunction, use the
Step In tool to step into it. If you want to execute the remaining lines of the

subfunction, click the Step Out tool
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6 Click the Step tool to execute the only line in the subfunction avg.

The subfunction avg finishes its execution, and you see a green arrow
pointing down under its last line as shown.

=lalx|
File Edit Text Debug Tools ‘Window Help A X
De | f2Ro « | 4B 4| BEEr " aREOQ0E OF

1 function [mwean,stdev] = stats(vals)

2

3 % calculates a statistical mean and a standard

4 % deviation for the wvalues in wvals.

5

6 ® len = lengthiwvals):

7 - mean = avg(vals, len]:

8 - stdev = agrti(sumi|{vals-avgi(vals,len)).”2))/len):

9 - plotivals,'-+']:

i0

11 - function mean = avglarray,size)

1z —'mean = sumiarray)/size;

1

|RunPausée!(Locked)(Debugging) |Ln 1 Cal 1 S

\ Subfunction completed

7 Click the Step tool to return to the function stats.

-« ): Embedded MATLAB Editor - Block: call_stats_block/Embedded MATI - |EI|1|
File Edit Text Debug Tools ‘Window Help A X

De | f2Ro « | 4B 4| BEEr " aREOQ0E OF
1 function [mwean,stdev] = stats(vals)
2
3 % calculates a statistical mean and a standard
4 % deviation for the wvalues in wvals.
5
6 ® len = lengthiwvals):
7 - mean = avg(vals, len]:
8 — & stdev = agrt(sum(|(vals-avgi(vals,len)).”2))/len):
9 - plotivals,'-+']:
i0
11 - function mean = avglarray,size)
12 - mean = sumiarray)/size:
Run Paused (Locked) (Debugging) Ln 1 Cal 1 S
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Execution advances to the line after to the call to the subfunction avg,
line 8.

8 Click Step twice to execute line 8 and the plot function in line 9.

The plot function executes in MATLAB, and you see the following plot.

<} Figure 1 10l =|

File Edit Wiew Insert Tools Web Desktop Window Help

DedsES FRQAO®(E(0E50

5

4.5 g

a6 B

24561 B

1 1.5 2 2.5 3 3.5 4
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In the Embedded MATLAB Editor, a green arrow points down under
line 9, indicating the completion of the function stats.

«): Embedded MATLAB Editor - Block: call_stats_block/Embedded M 10l =|
File Edit Text Debug Tools ‘Window Help A X

1 function [mwean,stdev] = stats(vals)
2
3 % calculates a statistical mean and a standard
4 % deviation for the wvalues in wvals.
5
6 ® len = lengthiwvals):
7 - mean = avg(vals, len]:
8 - stdev = agrti(sumi|{vals-avgi(vals,len)).”2))/len):
9 - o plot(vals,'—-+']:
i0
11 - function mean = avglarray,size)
12 - fmwean = sumiarray)/size:
L
Run Paused\.ocked) [Debugging) |Ln 1 Cal 1 S

Function completed arrow

9 Click the Continue tool to continue execution of the model.

At any point in a function, you can advance through the execution of the
remaining lines of the function with the Continue tool. If you are at the end
of the function, clicking the Step tool accomplishes the same thing.

You can also continue execution by entering dbcont at the Command Line
Debugger. See “Watching with the Command Line Debugger” on page 14-28
for a description of the Command Line Debugger in MATLAB.
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In the Simulink window, the computed values of mean and stdev now
appear in the Display blocks.

E!call_stats_hlock ;Iglll

File Edit WYiew Simulation Format Tools Help

mean po—
isplay
(22485 pofvals  stats
stdey T8
Constant Ernbadded -
WA TLAE Function Display
Rurining [1o02 [ [T=0.00 [wariablestepDiscrate v

10 In the Embedded MATLAB Editor, click the Exit Debug Mode tool
to stop simulation.

Watching Function Variables During Simulation

While you are simulating the function of an Embedded MATLAB Function
block, you can use several tools to keep track of variable values in the
function. These tools are described in the topics that follow.

Watching with the Interactive Display

To display the value of a variable in the function of an Embedded MATLAB
Function block during simulation, in the Embedded MATLAB Editor, place
the mouse cursor over the variable text and observe the pop-up display.
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For example, to watch the variable 1en during simulation, place the mouse
cursor over the text len in line 6 for at least a second. The value of 1en
appears adjacent to the cursor, as shown:

Display of value for variable 1en

«): Embedded MATLAP Editor - Block: call_stats_block/Embedde: 10l =|
File Edit Text Deffug Tools Window Help E 4

1 n [mean,stdev] = stats(vals)

2

3 ates a statistical mean and a standard

4 ion for the walues in wvals.

5

6@ l:[zn = lengthiwvals):

7 - mean = avg(vals, len]:

8 - stdev = agrti(sumi|{vals-avgi(vals,len)).”2))/len):

9 - o plot(vals,'—-+']:

11 - function mean = avglarray,size)
12 - mean = sumiarray)/size:
|RunPaused(Locked)(Debugging) |Ln 1 Cal 1 S

You can display the value for any variable in the Embedded MATLAB function
in this way, no matter where it appears in the function.

Watching with the Command Line Debugger

You can report the values for an Embedded MATLAB function variable
with the Command Line Debugger utility in the MATLAB window during
simulation. When you reach a breakpoint, press Enter in the MATLAB
window and the Command Line Debugger prompt, debug>>, appears. At
this prompt, you can see the value of a variable defined for the Embedded
MATLAB Function block by entering its name:

debug>> stdev
1.1180

debug>>
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The Command Line Debugger also provides the following commands during
simulation:

Command Description

dbstep Advance to next program step after a breakpoint is
encountered.

dbcont Continue execution to next breakpoint.

dbquit Stop simulation of the model. Press Enter after this
command to return the MATLAB prompt.

help Display help for command line debugging.

print x Display the value of the variable x. If x is a vector or

matrix, you can also index into x. For example, x(1,2).

save Saves all variables to the specified file. Follows the syntax
of the MATLAB save command. To retrieve variables to
the MATLAB base workspace, use load command after
simulation has been ended.

whos Display the size and class (type) of all variables in the
scope of the halted Embedded MATLAB Function block.

You can issue any other MATLAB command at the debug>> prompt, but the
results are executed in the workspace of the Embedded MATLAB Function
block. To issue a command in the MATLAB base workspace at the debug>>
prompt, use the evalin command with the first argument 'base’' followed by
the second argument command string, for example, evalin('base', 'whos').
To return to the MATLAB base workspace, use the dbquit command.

Watching with MATLAB

You can display the execution result of an Embedded MATLAB function line
by omitting the terminating semicolon. If you do, execution results for the
line are echoed to the MATLAB window during simulation.
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The Embedded MATLAB Function Editor

You edit an Embedded MATLAB function to specify its function header and
body. When you open an unspecified Embedded MATLAB function for editing,
it has the following default appearance in the Embedded MATLAB Editor:

Cut, Copy, und Poste

Creote ond Sove mod el Undo ond Redo Explorer/Define Variables  Updote Parts Debugging Tok  Close Function Editor
<} Embr:dded MATLAB Editor - Block: call_stuts_black /EmEeddea MA

Find & Reploce Build Simulation Undock Window :
File Eit Texk Deh o Tools

Ced)( o8B0 o#am | &5~ Bﬁ@@@l@)mmaﬂr

1 function [wean,stdev] = stats(vals)

2

& 3 ocalculates a statistical mean and a standard
4 % dewviation for the wvalues in wvals.

5

g - len = lengthiwvals):

7T - mean = avgl(wvals,len);

g - stdev = sgrti{suml((vals-avyg(vals, len)) .21/ len);
9 - plot {wvals, '—+']:

10

11 - function mean = avglarray,si=e)

12 = mean = sumlarray)/size;

Embedded MATLABZ = | Embedded MATLAES =

| Elmbelldded MATLAET =

F 9
R daﬂl \ Nn 1 ol & 4

\Breukpnints tolumn Tabs 1o disploy each [ooded Embedded MATLAB fun cfion
Line numbers column

This section provides the following topics to describe tools for editing
Embedded MATLAB functions in the Embedded MATLAB Editor:

¢ “Changing the Embedded MATLAB Editor” on page 14-31 — Tools to alter
the editor for the sake of convenience and utility
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e “Editing the Embedded MATLAB Function” on page 14-34 — Tools to edit
the contents of the function

® “Defining Embedded MATLAB Function Arguments” on page 14-36 —
Tools to go to in the Ports and Data Manager or Model Explorer tool
or the Simulink model to set the size, type, or source of an input or output

argument

e “Ports and Data Manager” on page 14-37 — Tool to use the Ports and
Data Manager to work with input trigger and function-call outputs

® “Debugging Embedded MATLAB Functions” on page 14-38 — Tools to
debug the Embedded MATLAB function during simulation of the model

Changing the Embedded MATLAB Editor

Use the tools described in the following topics to change the appearance of the
Embedded MATLAB Editor to add convenience and utility to its use.

Displaying Embedded MATLAB Function Windows

By default, if you have more than one Embedded MATLAB function loaded in
the Embedded MATLAB Editor, only the most recently loaded is displayed.
Editing windows for previously loaded functions are accessed individually
with tabs in the document bar. You can display the editing windows for all
loaded functions simultaneously with one of the following selections from the

Window menu:

Tool Button

Description

Tile

Tile all loaded Embedded MATLAB windows
into an adjustable matrix of windows. When
you select the option, an array of squares
representing the tiled windows is available
as a submenu. Select an appropriate array of
windows.

Left/Right Split

Display the selected window and the next most
recently loaded Embedded MATLAB function at
full height, side by side.
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Tool Button Description

Display the selected window and the next most
recently loaded Embedded MATLAB function at

Top/Bottom Split full width, top to bottom.

Display the loaded Embedded MATLAB functions
in separate cascading and overlapping windows

Float of the same size.

IEI Display the Embedded MATLAB function in

current focus at the full width and height of the

Maximize editor. This is the default setting.

[2] Create a separate editor for the function in
current focus. To redock the function back into
Undock Embedded the Embedded MATLAB Editor, from the
MATLAB Desktop menu of the undocked window, select
Dock <function_name>.

Moving the Document Bar

When you edit an Embedded MATLAB function, it is displayed as a window
in the Embedded MATLAB Editor. Because you can open more than one
Embedded MATLAB function in the Embedded MATLAB Editor, a tab is
added for the window in the document bar. Each tab contains the name of
an Embedded MATLAB Function block loaded for editing. By default, the
document bar appears at the bottom of the Embedded MATLAB Editor. If
you want to edit an Embedded MATLAB function not in focus, click its tab.

You can change the location of the document bar to appear at the top of, to the
left of, or to the right of the Embedded MATLAB function window, or you can
make it disappear altogether, as follows:

1 From the Desktop menu, select Document Bar.

In the resulting submenu, a dot appears in front of the current selection.
The default selection is Bottom.

2 From the resulting submenu, select Top, Bottom, Right, Left, or Hide.

14-32



The Embedded MATLAB Function Editor

Eliminating the Toolbar

By default, the Embedded MATLAB Editor has a toolbar with shortcuts to
tools that you can access from the menu. To eliminate the toolbar,

1 Select the Desktop menu.

The Toolbar option under Desktop is checked, to indicate the appearance
of the toolbar.

2 Under Desktop, select Toolbar.

The toolbar disappears.

3 Select the Desktop menu again.

The Toolbar option under Desktop is no longer checked. Select it to make
the toolbar visible again.

Setting Preferences

You can choose preferences for the Embedded MATLAB Editor, such as
font size, tab size, and so on, as follows:

1 From the File menu, select Preferences.

The MATLAB Preferences dialog box appears.

2 Change preferences in pages accessed only through the following nodes:

Fonts

Colors

Display (under Editor/Debugger)

Keyboard & Indenting (under Editor/Debugger)

Note The Embedded MATLAB Editor is a derivation of the MATLAB
editor you use to edit M-files in MATLAB. The preference changes that
you specify are made to the MATLAB editor.

14-33



14 Using the Embedded MATLAB Function Block

14-34

Editing the Embedded MATLAB Function

Use the tools in the following topics to edit an Embedded MATLAB function
in the Embedded MATLAB Editor:

Undoing and Redoing Operations

Tool Button Description
“ Undo the effects of the preceding operation.
Alternatively, from the Edit menu, select Undo.
Undo
cu Redo the effects of the most recently undone operation.
Alternatively, from the Edit menu, select Redo.
Redo

Comment and Uncomment Embedded MATLAB Function Lines
You can comment text or uncomment commented text as follows:

® To turn selected function text lines into commented text lines, from the
Text menu, select Comment.

® To turn selected comment text lines into function text lines, from the Text
menu, select UnComment.

Any text selected on a line, or the presence of the text cursor, selects the line.

Going to a Specified Line of the Embedded MATLAB Function

To place the text cursor at the beginning of a specified line, from the Edit
menu, select Go to Line. In the resulting dialog box, enter the line number
and click OK.

Searching for and Replacing Text in Embedded MATLAB
Functions

You can use the Find & Replace tool to search and replace text in the
Embedded MATLAB Editor as follows.



The Embedded MATLAB Function Editor

1 Click the Find & Replace toolbar button

The Find & Replace dialog box appears.

Find & Replace |
Find what: |xp0wr j Find I
Replace with: | xpower | Replace |

Loaok in: |Stateﬂ0w (eML)ﬂrst_eml_functionIChan.poly_val*j Replace All |
[ Match case [ Whale word [ Wrap around Close |

By default, the Look in field is set to search the current Embedded
MATLAB function, but you can select from any Embedded MATLAB
functions that you have open for editing.

2 Enter the text that you want to search for in the Find what field.

3 Modify the text you want to search for by checking any or all of the
following:

® Match case — The found text must match the case of the text in the
Find what field.

* Whole word — The found text must be a whole word and not part of a
larger word.

* Wrap around — Continue searching after reaching the bottom of the
editor. Otherwise, stop searching.

4 Enter the text that you want to substitute in the Replace with field.

5 Click the Find button to find a single occurrence of the text in the Find
what field.

If the text is present in the Embedded MATLAB Editor, it is highlighted
with a gray background.

6 Click the Replace button to replace highlighted text in the editor with the
text specified for the Replace with field.
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7 Click the Replace All button to replace every occurrence of the text
specified in the Find what field with the text specified for the Replace
with field.

Defining Embedded MATLAB Function Arguments

Once you edit the Embedded MATLAB function, you might need to set the
size, type, or source of an input or output argument. Do this in the Ports
and Data Manager, or the Simulink model, which you can enter from the
Embedded MATLAB Editor with the following tools:

Tool Button Description

Go to the Ports and Data Manager to
. add or modify arguments for the current
Explore/Define Data function. Alternatively, from the Tools

menu, select Edit Data/Ports. If you want
to use Model Explorer instead, from the
Tools menu, select Model Explorer. The
Ports and Data Manager and Model
Explorer tools allow you to perform the
same operations, with Ports and Data
Manager being restricted to this one block.

Displays the Embedded MATLAB function
in its native diagram without closing the

T

Goto Diagram Editor Embedded MATLAB Editor.

Updates the ports of the Embedded
MATLAB Function block with the latest

Update Ports changes made to the function argument
and return values without closing the
Embedded MATLAB Editor.

See “Defining Inputs and Outputs” on page 14-17 for an example of defining
an input argument for an Embedded MATLAB Function block.
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Ports and Data Manager

If you want to add or edit data in an Embedded MATLAB Function block,
open the Ports and Data Manager by clicking the Edit Data/Ports button in
the Embedded MATLAB Editor toolbar:

The Ports and Data Manager lets you add the following elements to an
Embedded MATLAB Function block:

Element Tool Description

Data ] You can add data of the following scopes:
¢ Parameter
¢ Input
® Qutput

Input trigger F An input trigger causes an Embedded

MATLAB Function block to execute when
a Simulink control signal changes or
through a Simulink block that outputs
function-call events.

You can add the following types of input
triggers:

¢ Rising edge
* Falling edge
e Either rising or falling edge

e Function call

Function call
output

fia

A function call output is a triggered
subsystem whose execution is determined
by logic internal to an S-function
instead of by the value of a signal. For
more information, see “Function-Call
Subsystems” in the online Simulink
reference.
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Debugging Embedded MATLAB Functions
Use the following tools during an Embedded MATLAB function debugging

session:
Tool Button Description
* A breakpoint indicator. To set a

breakpoint for a line of function code,
click the hyphen character (-) in the
breakpoints column for the line. A
breakpoint indicator appears in place
of the hyphen. Click the breakpoint
indicator to clear the breakpoint.

Check for errors and build a simulation
application (if no errors are found) for
the model containing this Embedded
MATLAB function.

Start Simulation

Start simulation of the model containing
the Embedded MATLAB function.
Alternatively, press F5, or, from the
Debug menu, select Start.

(=]

Stop Simulation

Stop simulation of the model containing
the Embedded MATLAB function. You
can also select Exit debug mode from
the Debug menu if execution is paused
at a breakpoint.

i

Pause Simulation

Temporarily stop execution during
simulation. To continue with execution,
click the Start Simulation tool .

£

Set/Clear Breakpoint

Set a new breakpoint or clear an existing
breakpoint for the selected Embedded
MATLAB code line. The presence of the
text cursor or highlighted text selects the
line.
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Tool Button

Description

3

Clear all set breakpoints in the
Embedded MATLAB function.

Clear All Breakpoints

'E Step through the execution of the next
Embedded MATLAB code line. This tool

Step steps past function calls and does not

enter called functions for line-by-line
execution. You can use this tool only after
execution has stopped at a breakpoint.
Alternatively, press F11, or, from the
Debug menu, select Step.

Step In

Step through the execution of the next
Embedded MATLAB code line. If the line
calls a subfunction, step into line-by-line
execution of the subfunction. You can use
this tool only after execution has stopped
at a breakpoint.

Step Out

Step out of line-by-line execution of the
current subfunction to the line after the
line that calls this subfunction. You can
use this tool only after execution has
stopped at a breakpoint.

See “Debugging the Function in Simulation” on page 14-20 for an example
using some of these debugging tools.
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Typing Function Arguments

In “Programming the Embedded MATLAB Function” on page 14-9, you create
two output arguments and an input argument for an Embedded MATLAB
Function block by entering them in its function header. This creates ports on
the Embedded MATLAB Function block that you can attach to Simulink
signals. You can select the type for each argument that you define for an
Embedded MATLAB Function block. By default, they are assigned the type
inherited. This means that type is assigned on the basis of the incoming or
outgoing Simulink signal. The following procedure describes how to use the
Model Explorer to type function arguments. You can also type function
arguments with the Ports and Data Manager tool.

Examine the type for an argument in the Model Explorer as follows:

1 From the Embedded MATLAB Editor, click the Explorer tool =,

The Model Explorer appears with the Embedded MATLAB Function
block highlighted in the Model Hierarchy pane on the left.

& Model Explorer =10l

File Edit Wiew Tools Add Help

D[+ maxEMENH70 Dn 4Rz
ﬂ Type: IEonstant LI % Search

JJ Search: |by Block Type

Model Hierarchy

-] Simulink Root
ﬁ Base Workspace

E--Ecall_stats_block

ﬁ Model Workspace

--%Eonfiguration [Active]

- @ Code for <model>

[ @ Advice for <model>

B8 O Embedded MATLAE Function

Contents of: call_statz_block/Embedde

I Namel Scope I F'ortI DataType | C
(4] mean  Output 1 inherited
[4] stdev  Output 2 inherited
[4] vals  Input 1 inherited

LContents |§earch Results |

Embedded MATLAB F

Mame:  Embedded MATLAR Function
Parent:  call stats block

Machine: [machine] call stats block

Update methad: I Inherited 'l
Editor: [~ Locked

Drescription:

Document Link: I

Eewvert | Help

Apply
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2 In the Contents pane, click on a data row to select it, as shown.

E& Model Explorer (=] ]
File Edit Wiew Tools Add Help
[D[smaxEMEnHZs0 D0 +n|enra=a
JJSearch: Ib_l,l Block Type j Type: IConstant LI % Search ‘
Model Hierarchy | Contents of: call_statz_block/Embedde Data vals
E--@Simulink Raoat I Namel Scope I F'ortl DataType | C General I Walue Attributes I Description I
é:gs:ﬁiﬁz[k‘jz:ie (4] mean  Output 1 ?nher?ted Mame: I\,.a|S

. stdev  Output 2 inherited Parent: call stats block/Embedded MATLAB Function

- W Madel Workspace vals Input 1 inherted S come: .

H . . . 4 pe: | Input | Port: |1

i --%Eonflguratlon [Active] )

--@Eode far <model: Type: Ilnhented LI Urits: |

@Advice far <model: I™ Comples

‘- [ Embedded MATLAB Function Fixed-Pairt

Lontents

Store integer: I intlE LI IFraction length LI IU_

™ Lock autput scaling against changes by the autoscali

Size: |-1 First index: |1

1 | 2|

Eewvert

DataType column —/ Type field

You specify the type of an argument in the Type field of the Data properties
pane, as shown. You can also specify it in the Contents pane of the Model
Explorer by clicking the cell in the Type column of the highlighted argument

row and editing it.

The type of the arguments in the preceding example is inherited. This
is the default type for all input and output data. Use the following topics
to determine whether you want to keep the inherited type or specify the

argument types yourself:

® “Inheriting Argument Data Types” on page 14-42 — Tell the Embedded
MATLAB Function block to inherit the argument type from Simulink.

® “Selecting Types for Arguments” on page 14-44— Select from a list of

supported data types.
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® “Specifying Argument Types with Expressions” on page 14-44 — Enter an
expression with the type operator that returns the type of an existing
variable.

Inheriting Argument Data Types

You can tell an Embedded MATLAB Function block to inherit the data type of
an argument from Simulink by selecting inherited in the Type field for that
data. In this case, the argument inherits its data type, including fixed-point
types, from the Simulink signal that is connected to it. See “Selecting Types
for Arguments” on page 14-44 for a list of supported data types.

Note An argument can also inherit its complexity (i.e., whether its value is a
real or complex number) from the Simulink signal that is connected to it. To
cause an argument to inherit its complexity, set the Complexity control on
the argument’s dialog box to inherited.

Once you build the model, the CompiledType column of the Model
Explorer gives the actual type used in the compiled simulation application.
To conveniently compile and build the model from the Embedded MATLAB

e

Editor, click the Build tool |
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In the following example, an Embedded Matlab Function block argument
inherits its data type from an input signal of type double.

& Model Explorer : % =10l

File Edit Wiew Tools Add Help

[D[smaxEMc%170 D0 +k|Exna= A

JJSearch: Ib_l,l Block Type LI Type: IConstant LI =] Search ‘

Model Hierarchy Contents of: call_stats_block/Embedded MATLAR Fu Data vals

E--E‘Simulink Raat I Namel Scope I F'ortI DataType | CompiledType Gieneral I Walue Attributes I Description
;----ﬁBaseW’orkspace (4] mean  Output 1 inherited Name: Ivals
Il_stats_block 1 P
= Egca S i) stdev Output 2 inherited Parent. call stats block/Embedded MATLAE
- BiModel Workspacs s Input 1 inherted dovible s |- -
-%Eonfiguration [Active] "
-@Eode for ¢model> Type: Iinherited vlUnlts
; -@Advice for <model> [ Complex
‘. [ Embedde unction ixed-Point
Embedded MATLAE F Fixed-P!

Store integer: I int16 'l I Fraction len

™ Lock output scaling against changes b

Size: |-1 First i

< |
LContents |§earch Results | Bevert | Help | pply
4

Actual compiled iypes'/

Inheriting the type of input data is successful in all cases. The inherited
type of output data is inferred from diagram actions that store values in the
specified output. In the preceding example, the variables mean and stdev
are computed from operations with double operands, which yield results of
type double. If the expected type in Simulink matches the inferred type,
inheritance is successful. In all other cases, a mismatch occurs during build
time.

Note Library Embedded MATLAB function blocks can have inherited data
types, sizes, and complexities like ordinary Embedded MATLAB function
blocks. However, all instances of the library block in a given model must
have inputs with the same properties.

14-43



14 Using the Embedded MATLAB Function Block

Selecting Types for Arguments

When you click on the down arrow of the Type field for an argument in its
Data properties dialog box or in its row element in the Model Explorer, a
selectable list of data types appears. You can directly specify the type of the
data by selecting one of the following types:

Data Type Description

double 64-bit double-precision floating point
single 32-bit single-precision floating point
int32 32-bit signed integer

int16 16-bit signed integer

int8 8-bit signed integer

uint32 32-bit unsigned integer

uint16 16-bit unsigned integer

uint8 8-bit unsigned integer

boolean Boolean (1 = true; 0 = false)

fixpt Fixed-point data

Specifying fixpt enables the Stored Integer and
Scaling fields in the adjacent Fixed-Point field
section, which are used to specify the fixed-point type.

For fixed-point data, if an input or output fixed-point
argument does not match its counterpart data in
Simulink, a mismatch error results.

inherited Inherit type of input or output data from Simulink.
See “Inheriting Argument Data Types” on page 14-42
for more details.

Specifying Argument Types with Expressions

You can specify the type of an argument with an expression that you enter in
the Type field of its Data properties dialog box as follows:

1 Click on the text area of the Type field to place a cursor in that field.
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2 Enter an expression with the type operator that returns the type of a
previously defined variable.

For example, if the variable x is already defined, enter type(x). In this
case, x can be another argument. x can be defined with any supported
type, including the type inherited.

In the following example, the local variable data is specified with a DataType
of type(vals). The input data vals inherits its type from a Constant block
whose output signal is set to the type uints8.

Click the Build tool to compile and build the model from the Embedded
MATLAB Editor. When the model is compiled, the actual type of data
appears in the CompiledType column in the Contents pane.

Compiled type of data

& Model Explorer (=] ]
File Edit Wiew Tools Add Help

[D[imax EME%H70 D0 +&||Exwa= A
JJSearch: Ib_l,l Block Type LI Type: IConstant LI @' Search { ‘
Model Hierarchy

-3 Simulink Root
ﬁ Base Workspace

Cantents af; c:all_stats_bloc:k.-"Embedde*TLAB Data data
General IVaIueAttributes I Diescription

H Mame: Idata

E"Egcall‘Stats‘b|°°k mean Output 1 inherited Parent: call stats block/Embedded MATLAE
"ﬁmd?' Workspace stdev Output 2 inherited Scope: [Local =]
-8 Configuration [Active) [ vals  Input 1 inherited e "
--@Eode for <model> Ype: Itype[vals] VI nitz
- @Advice for <model> [ Complex
- (M) Embedded MATLAR Fixed-Paint

Store integer: I int16 'l I Fraction len

™ Lock output scaling against changes b

Size: I First it

PTR— 2| |
LContents |§earch Results | Bevert | Help | pply
4
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Sizing Function Arguments

In “Programming the Embedded MATLAB Function” on page 14-9, you create
two output arguments and an input argument for an Embedded MATLAB
Function block by entering them in its function header. This creates ports on
the Embedded MATLAB Function block that you can attach to Simulink

signals.

You can examine or specify the size of an argument in the Model Explorer

as follows:

1 From the Embedded MATLAB Editor, click the Explorer tool =i

The Model Explorer appears with the Embedded MATLAB Function block
highlighted in the Model Hierarchy pane on the left.

E& Model Explorer

File Edit Wiew Tools Add Help

=10l x|

[D[smaxEMc%H70 0o +n[exa=a

JJ Search: |by Block Type

LI Type: IEonstant LI % Search

Model Hierarchy

= [£9]Simuiink Roat
ﬁ Base Workspace

E--Ecall_stats_block
ﬁ Model Workspace
--%Eonfiguration [Active]
- @ Code for call_statz_block
@ Advice for call_statz_block
& I Ermbedded MATLAB Function

Contents of: call_statz_block/Embedded MATLAI

Embedded MATLAB F

I Namel Scope I Fart I Sizel CompiledSize

Mame:  Embedded MATLAR Function

[i%i] mean  Output 1 -1
[i%i] stdev  Output 2 -1
[i%i] vals  Input 1 -1

K1 — 2+

LContents |§earch Results |

Parent:  call stats block
Machine: [machine] call stats block

Update methad: I Inherited 'l
Editor: [~ Locked

Drescription:

Document Link: I

Eewvert | Help | Lpply

4
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2 In the Contents pane, click a data row to select it.

& Model Explorer : (=] ]
File Edit Wiew Tools Add Help

[D[imax EMc%H70 an+k[sxa=a
JJSearch: Ib_l,l Block Type LI Type: IConstant LI % Search ‘

Contents of: call_statz_block/Embedded MATLAI Data vals

E..E‘sgnu"nk Foot I Namel i I Port I Sizel CompiedSize General I alue Attibutes I Description I
Base Workspace

E--Ecall_stats_block
ﬁ Model Workspace

Model Hierarchy

(4] mean  Output 1 B MName: Ivals

] stdev Output 2 -1 Parent: call stats block/Embedded MATLAR F

g Configuration (Active) - Scope: I Input jv Poit:
--@Eode for call_stats_block Type: Iinherited VI Units: [

@Advice for call_stats_block I™ Comples

‘. ] Embedded MATLAB Function i B

Store integer: I int1G 'l I Fraction lengtt

™ Lock output scaling against changes by H

Size: |-1 First indh

‘I I _’I 4 |

Contents | Sefich Results Revert | Help | Apply

v

|
Size column —/ Size field

You specify the size of an argument in the Model Explorer in the Size
field of the Data properties pane on the right. You can also specify it in
the Contents pane of the Model Explorer by clicking the cell in the Size
column of the highlighted argument row and editing it.

The size of the arguments in the preceding example is -1. This is the default
size for inputs and outputs. It specifies that the size of the argument is
inherited from the Simulink signal that connects to it. Use the following
topics to determine whether you want to keep the inherited size or size the
arguments yourself.

® “Inheriting Argument Sizes from Simulink” on page 14-48 — Tell the
Embedded MATLAB Function block to inherit the size of the argument
from the attached Simulink input or output.

® “Specifying Argument Sizes with Expressions” on page 14-49 — Use an
expression that evaluates to the correct size.
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Inheriting Argument Sizes from Simulink
You can tell an Embedded MATLAB Function block to inherit the size of an
argument from Simulink by entering a -1 in its Size field in the Model

Explorer. This is the default setting for arguments that you add in the
function header of an Embedded MATLAB Function block.

Once you compile the model, the CompiledSize column of the Model
Explorer gives the actual size used in the compiled simulation application.
To conveniently compile the model from the Embedded MATLAB Editor,

click the Build tool .

& Model Explorer =10l

File Edit Wiew Tools Add Help

D@ smmx EMcn:Hf0 D 4k 3oz a

JJSearch: Iby Elock Type LI Type: IEonstant LI % Search ‘

Contents of: call_statz_block/Embedded MATLAI Data vals
General IVaIueAttributes I Description I

Model Hierarchy
- [ Simulink Root

I Namel Scope I Fart I Sizel CompiledSize

é....ﬁBase Wwiorkspace 1] mean  Output 1 1 Name: Ivals
= Bhloalstas_biock 4] stdev Output 2 -1 Parent: call stats block/Embedded MATLAB F
i ﬁModeI Wwiorkspace : Scope. Im —
2 Configuration [Active) L -
@Eode for call_stats_block Type: Iinherited j' Units: [
f @Advice for call_stats_block [T Complex
‘... M) Embedded MATLAB Function Fix=d-Point

Store integer: I int1G 'l I Fraction lengtt

™ Lock output scaling against changes by H

Size: |-1 First indh

1 |

LContents Revert | Help | Lpply

4
Actual compiled size-/

Sizing of input arguments is complete for all cases. The size of an output
argument is the size of the value that is assigned to it. If the expected size
in Simulink does not match, a mismatch error occurs during compilation
of the model.
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Note No arguments with inherited sizes are allowed for Embedded MATLAB
Function blocks in a library.

Specifying Argument Sizes with Expressions

You specify the size of an argument or return value for an Embedded
MATLAB Function block in the Size field of the Model Explorer in [ row
column] format. For example, a value of [2 4] defines a 2-by-4 matrix. To
define a row vector of size 5, set the Size field to [1 5]. To define a column
vector of size 6, set the Size field to [6 1] or just 6. You can enter a MATLAB
expression for each [row column] element in the Size field. Each expression
can use one or more of the following:

® Numeric constants — For example, 1, 3, 7.54, and so on.

® Arithmetic operators — Restricted to +, -, *, and /.

® Parameter arguments — Embedded MATLAB Function block arguments
declared in the Model Explorer with the scope Parameter. These
arguments take their value from a Simulink parameter of the same name
for a parent subsystem or the MATLAB base workspace. See “Parameter
Arguments in Embedded MATLAB Functions” on page 14-51 for details.

e (Calls to the MATLAB functions min, max, and size

The following examples are valid expressions for the Size field for an
argument:

k+1
size(x)
min(size(y),k)

where k, x, and y are variables of scope Parameter.
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Once you build the model, the CompiledSize column of the Model Explorer
gives the actual size used in the compiled simulation application. In the
following example, the Embedded MATLAB Function block input argument

uin is sized by the expression x+y.

& Model Explorer

File Edit Wiew Tools Add Help

=10l x|

D seax ames 0 @n/+k[enaz A

JJ Search: |by Block Type

LI Type: IEonstant LI Search

Model Hierarchy

Contents of: em_specify_size/SubsystemdebL

-] Simulink Roct
ﬁ Base Workspace

E--Eem_specify_size

Input d 3
Output 1 double 1

; ﬁ Modz.el WD_'kSDaCPj Parameter double 1
£y Configuration [Active) Constant double 39 1

@ Code for em_specify_size :

@ Advice for em_specify_siz
E--ﬂSubS}lstem
Subspstem/etil

4

Data uin

General I Yalue Attribul

Mame: |uin

Parent: em specify_size.
Scope: | Input

Type: I double

™ Complex
Fixed-Paint

Store integer: I int1&

™ Lock output scaling

1 | || Contents |§earch Results I /

Actual compiled siza/

x is a local variable with scope Parameter that takes its value from the
parameter x for the masked subsystem containing the Embedded MATLAB
Function block. Its value is initialized to 2.1 (not shown). y is a local variable

of Constant scope initialized to 3.9. x+y is therefore 6.
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Parameter Arguments in Embedded MATLAB Functions

Parameter arguments for Embedded MATLAB Function blocks do not take
their value from a Simulink signal. Instead, they take their value from a
parameter of a parent Simulink masked subsystem or a variable in the
MATLAB base workspace. This allows you to pass a read-only constant in
Simulink to the Embedded MATLAB Function block.

Use the following procedure to add a parameter argument to a function for an
Embedded MATLAB Function block.

In the Embedded MATLAB Editor, add an argument to the function
header of the Embedded MATLAB Function block.

The name of the argument must be identical to the name of the masked
subsystem parameter or MATLAB variable that you want to pass to
the Embedded MATLAB Function block. For information on declaring
parameters for masked subsystems in Simulink, see “Mask Editor” on
page 11-14.

Bring focus to the Embedded MATLAB Function block in Simulink.

The new argument appears as a new input port in the Simulink diagram.

In the Embedded MATLAB Editor, click the Explore tool .

The Model Explorer appears with the Embedded MATLAB Function
block highlighted in the Model Hierarchy pane.

In the Contents pane, click anywhere in the row for the new argument to
highlight it.

In the highlighted row, click the entry in the Scope column and select
the value Parameter.

You can also make this change in the Scope field of the Data properties
dialog box on the far right.

After you apply the scope change in the Model Explorer, examine the
Embedded MATLAB Function block in Simulink.
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The new port no longer appears for the parameter argument.

Note Parameter arguments appear as arguments in the function header of
the Embedded MATLAB Function block to maintain MATLAB consistency.
This lets you test functions in an Embedded MATLAB Function block by
copying and pasting them to MATLAB.
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Local Variables in Embedded MATLAB Functions

Embedded MATLAB functions support a subset of MATLAB data types.
Normally, you declare function arguments in the Model Explorer and define
local variables implicitly in the function code. This section lists and describes
the data types supported in Embedded MATLAB functions for local variables
along with any exceptions or deviations from MATLAB behavior:

® “Declaring Local Variables Implicitly” on page 14-53 — How to create
variables for an Embedded MATLAB function that are not persistent by
default and how to use them

® “Declaring Local Complex Variables Implicitly” on page 14-55 — How to
create complex variables for an Embedded MATLAB function that is
nonpersistent by default and rules for their use

Declaring Local Variables Implicitly

You declare variables implicitly in Embedded MATLAB functions by
specifying constants and making initial assignments. By default, this type
of variable does not persist between function calls. It is recreated for each
function call and has no identity or value outside the Embedded MATLAB
function. You can, however, make this variable persistent with a persistent
statement at the top of the function body before the first use of the variable.
For example, to declare the variable abc persistent, enter the following line
right after the function header and comments:

persistent abc;

You declare variables implicitly in the function body of Embedded MATLAB
functions in the following ways:
* By using constants (for example, 3, 5.7, and so on)

Constants have the MATLAB type double.

® By declaring variables in an Embedded MATLAB function with a first
use in a simple assignment

The first use of a variable must initialize its value, its type, and its size.
For example, the following initial assignments declare variables in an
Embedded MATLAB function:
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14.7; %a is a scalar of type double.

a; %because a is of type double, so is b.

zeros(5,2); %c is a 5-by-2 array of 0 elements of type double.
C; %d is also a 5-by-2 array of 0 elements of type double.
[12345; 67 89 0]; e is a 5-by-2 array of type double.

The following rules apply to the use of variables that you declare implicitly in
the body of an Embedded MATLAB function:

® Variables that you declare in the body of an Embedded MATLAB function
disappear between calls, unless you declare them to be persistent between
calls with the persistent statement.

* You cannot set the size of a variable by a first use assignment with indexing.

In MATLAB, you can declare the size of a variable using indexing.

In Embedded MATLAB functions, this is not allowed. For example,
the following initial assignment is not allowed in Embedded MATLAB
functions:

g(3,2) = 14.6; %Not allowed for creating g.

%0K for assigning value once created

In MATLAB, the preceding example declares g to be a 3-by-2 array of
type double elements, in which the element g(3,2) is 14.6 and all other
elements are 0. In Embedded MATLAB functions, this statement is not
allowed.

® You can declare variables implicitly with first use typecast functions.

In the following example code, you declare y and z to be integers with the
following initial assignments:

X

y
z

15; %Because constants are of type double, so is x.
int16(3); %y is a constant of type int16.
uint8(x); %z is x (double type) cast to uint8.

® Variables cannot be resized or cast to a different type once the are created
in the function by a first use.

In the following example, the last two statements each flag an error:

X

2.75 %0K
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y = [1 2; 3 4] %0K
x = int16(x); %ERROR: cannot recast x
y = [1 2 3; 45 6] %SERROR: cannot resize y

Declaring Local Complex Variables Implicitly

Using complex variables in Embedded MATLAB functions differs, in part,
from the way in which complex variables are used in MATLAB. In MATLAB,
the identity of a variable as complex is an attribute of the variable. In
Embedded MATLAB functions, the identity of a variable as complex is part of
its assigned type. Use the following rules to specify and use complex variables
in Embedded MATLAB functions:

® You can declare a complex number in an Embedded MATLAB function
through assignment to a complex constant, as shown in the following
examples:

X
y

5 + 61i; %x is a complex number by assignment.
7 + 8j; %y is a complex number by assignment.

Note You can use the symbol i or j in specifying an imaginary constant.

You can also declare a complex number with the function complex, as
shown in the following example:

x = complex(5,6); %x is the complex number 5 + 61i.

® (Cases in which a function can return a complex number for a real argument
are handled individually for each function.

Generally, this can result in a complex result or a warning that the function
takes only arguments producing real results. For example, for negative
arguments, the function sqrt warns that only positive arguments are
allowed.

® Complex numbers obey the general Embedded MATLAB rule that once a
variable is typed and sized, it cannot be cast to another type or size.

In the following example, the variable x is declared complex and stays
complex:
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x
I

1 + 21i; %x is declared a complex variable
int16(x); %real and imaginary parts of y are int16
x = 3; %x now has the value 3 + 01i

<
I

Conflicts can occur from operations with real operands that can have
complex results. For example, the following code is flagged as an error:

z = 3; %sets type of z to double (real)
z 3 + 2i; %ERROR - cannot recast z to complex.

The following is a possible workaround that you can use if you know that a
variable can be assigned a complex number:

m
m

complex(3); %sets m to complex variable of value 3 + 0i
5 + 6.71i; %assigns a complex result to a complex number

In general, if an expression has a complex number or variable in it, its
result is a complex number, even if the result is 0.

For example, the following code produces the complex result z:

X =2 + 3i;
y =2 - 3ij;
z =Xx+y; %z is 4 + 01

In MATLAB, this code generates the real result z = 0. However, in
Embedded MATLAB, when code for z = x + y is generated, the types for x
and y are known, but their values are not. Because either or both operands
in this expression are complex, z is declared a complex variable requiring
storage for both a real and an imaginary part. This means that z has the
complex result 4 + 0i in Embedded MATLAB, not 4 as in MATLAB.

An exception to the preceding rule is a function call that takes complex
arguments but produces real results, as shown in the following examples:

y = real(x); %y is the real part of the complex number x.
y = imag(x); %y is the real-valued imaginary part of x.
y = isreal(x); %y is false (0) for a complex number x.
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Another exception is a function call that takes real arguments but produces
complex results, as shown in the following example:

z = complex(x,y); %z is a complex number for a real x and y.
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Embedded MATLAB Function blocks support three types of functions that
you can call in the body of the function: subfunctions, Embedded MATLAB
run-time library functions, and MATLAB functions. See the descriptions for
each of these Embedded MATLAB function call types in the following topics:

e “Calling Subfunctions in Embedded MATLAB Functions” on page 14-58

e “Calling Embedded MATLAB Run-Time Library Functions” on page 14-59
e “Calling MATLAB Functions” on page 14-60

Calling Subfunctions in Embedded MATLAB Functions

If you call a function in an Embedded MATLAB function, Simulink first
tries to resolve it as a subfunction of the Embedded MATLAB function.
Subfunctions are functions defined in the body of the Embedded MATLAB
function. They work the same way in Embedded MATLAB functions that
they do in MATLAB.
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In the section “Programming the Embedded MATLAB Function” on page
14-9, you define an Embedded MATLAB Function block with the subfunction
avg as shown.

<} Embedded MATLAE Editor - Block: call_stats_block2/Embedded MATLAB (=] 9]
File Edit Text Debug Tools ‘Window Help A X
NEHE 2B c|dd@+ (S BRAEQE EBEH0ESO
1 function [mwean,stdev] = stats(vals)
2
3 % calculates a statistical mean and a standard
4 % deviation for the wvalues in wvals.
5
6 — len = lengthiwvals):
7 - mean = avg(vals, len]:
= stdev = sgrt(sum| | (vals-avgivals, len) ).
9 - plotivals,'-+']:
i0
11 - function mean = avglarray,size)
12 - mean = sumiarray)/size;
e e L \
| Ready Ln 1 cal 1 \ \ Y

l

Definition of subfunction avg  Call to subfunction avg

You can include subfunctions for Embedded MATLAB functions just as you
would for ordinary MATLAB M-file functions. Subfunctions also can have
multiple arguments and returns using any Embedded MATLAB function
variable types and sizes. See "Subfunctions" in the MATLAB Programming
documentation for a full description of subfunctions in MATLAB.

Calling Embedded MATLAB Run-Time Library
Functions

If you call a function in an Embedded MATLAB Function block that cannot
be resolved as a subfunction, the Embedded MATLAB Function block
attempts to resolve it as a call to its own run-time library of functions. An
Embedded MATLAB run-time library function is identical to a MATLAB
or Fixed-Point Toolbox function of the same name. It produces efficient
embeddable generated C code. It also has the same name, same arguments
(with limitations), and the same functionality (with limitations) as its
MATLAB or Fixed-Point Toolbox counterpart. If you restrict your function
calls to Embedded MATLAB run-time library functions, you can use the
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code generated for an Embedded MATLAB function to build a stand-alone
executable that you can move to different platforms for execution.

Currently, the Embedded MATLAB run-time library supports functions for
a limited subset of MATLAB and Fixed-Point Toolbox functions. Supported
Embedded MATLAB run-time library functions are listed in “Embedded
MATLAB Run-Time Function Library” in the online Simulink Reference. In
addition to listing these functions, this section links to documentation for
the original function and lists any limitations of the Embedded MATLAB
library version.

For more information on fixed-point support in Embedded MATLAB, refer to
“Using the Fixed-Point Toolbox with Embedded MATLAB” in the Fixed-Point
Toolbox documentation.

Calling MATLAB Functions

During code generation for simulation targets, Embedded MATLAB functions
attempt to resolve a called function as a subfunction or function in the
Embedded MATLAB run-time library. If the called function is not found in
these areas, the function call is resolved as a call to a MATLAB function in
the MATLAB path. This applies to function calls of the following types only:

func(x) ;
y = func(x);

If a function call in an Embedded MATLAB function is resolved as a call to
a MATLAB function, you receive a diagnostic warning message when you
generate code for the simulation target. For example, if you insert the line

X = magic(4);
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in an Embedded MATLAB function, you receive the following diagnostic
warning:

i call_MATLAB_function_error - IEI Iil

‘Wigw  Font Size

| Message | Source | Reported by | Surmary |
& CoderWar.. edl script  Embedded... Function resolved in the MATLAE workspace and will only b...
Bel Coder YWar.. Embedded... fFunction resolved in the MATLAB warkspace and will anly b...
@ Parse Error v Stateflow Simulink Output Data &' #54) cannot be of MATLAB type.
@ Parse Error  call_MATLA. . Parse

4 |

0 call_MATLAB_function_errarfeML script
Function resolwved in the MATLAE workspace and will only be called during simulation.

Function 'eML script' (#47.136.144), line 6, column 5:
"magic (x)"

Open | Help | Close |

Notice that the warning includes a link to the offending line in the Embedded
MATLAB Editor.

Note If you want to use a MATLAB function instead of its counterpart in the
Embedded MATLAB run-time library, call the MATLAB function feval. This
function lets you call MATLAB functions indirectly in MATLAB by providing
a string name for the MATLAB function and a list of argument values. When
you convert existing MATLAB functions and scripts to Embedded MATLAB
functions, this feature lets you gradually migrate calls to MATLAB functions
to calls to Embedded MATLAB run-time library functions.

Generated Code for MATLAB Function Calls

Generated code in a simulation target for a call to a MATLAB function in
an Embedded MATLAB function includes only the call to the function. No
code is included for the called function itself. This means that the simulation
executable you build can execute only on a platform with MATLAB installed.
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For Real-Time Workshop and custom targets, calls to MATLAB functions are
not permitted. Simulation stops when you try to build the target and an error
message results. No code generation takes place at all.

Returning Values from MATLAB Functions
Function calls that are resolved in MATLAB have a return type of mxArray.

You can store variables in this return type by assignment. For example, the
line

X = magic(4);

stores a 4-by-4 array of type mxArray in x. You can pass this value to another
function resolved in MATLAB as an argument. However, the mxArray type
is not defined in Embedded MATLAB functions for operations with other
types. For example, the lines

X = zeros(4); //x is a 4-by-4 array of type double
y = magic(4); //y is a 4-by-4 array of type mxArray
z = x +vy; //Error: type mismatch!

receive the following run-time error:

[ s _loixi

iew  Fant Size

I Message I Source I Reparted by I SLMMEHy |
@ CoderError eMLscript  Embedded... Size mismatch (size [1x1] ~= size [4 x 4]).Function 'eML scri...
& CoderWar.. eML script  Embedded... Functian resalved in the MATLAB workspace and will only b...
[ McCoder Error [eML script  [Embedded. {Expected either a Ingical, char, single, or double Found an
@ CoderError eMLscript  Embedded... Errars oceurted during parsing of Embedded MATLAS uncti...

< |

0 untitledfehdL script
Expected either a logical, char, single, or double.
Found an mxdrray. oxarrays are returned from calls to the MATLAB interpreter and ar

Function 'eML script' (#40.158.158), line 7, column 9:
g

| | i

Open | Help | Cloze |

To prevent this error, you must set y to be a 4-by-4 matrix of type double
before the assignment is made to the return value from the call magic(4).
You can do this by using the Embedded MATLAB run-time library function
zeros as follows:
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)

= zeros(4); //x is a 4-by-4 array of type double
zeros(4); //y is a 4-by-4 array of type double

= magic(4); //Return from magic converted to type double

X +y;

N < < X
(|

In this case, the Embedded MATLAB function knows that the call to the
Embedded MATLAB run-time library function zeros with an argument of 4
returns a 4-by-4 matrix of type double, and x is sized accordingly. In the next
line, y = zeros(4), y becomes a 4-by-4 matrix of type double in the same
way. In the next line, y = magic(4), the return value from the call to the
MATLAB function magic is converted at run-time to an array of type double
for assignment to y. Finally, the last line, z = x + y, is now homogeneous
in type.

In the preceding example, the line y = zeros(4) permanently sets both the

type and size of y. This means that if you assign to y the results of magic(5) in
the next line by mistake, a size mismatch error results and simulation stops.
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drop shadows 4-18

duplicating 4-6

grouping to create subsystem 3-31
hiding block names 4-20

input ports with direct feedthrough 1-24
library 4-34

moving between windows 4-5
moving in a model 4-6

names
editing 4-19

orientation 4-17

reference 4-34

resizing 4-17

reversing signal flow through 7-3

showing block names 4-20

signal flow through 4-17

under mask 11-15

updating 1-14

<>blocks 4-19

See also block names

Bogacki-Shampine formula 9-14
Boolean type checking 9-67
bounding box

grouping blocks for subsystem 3-31
selecting objects 3-5

branch lines 3-15

Break Library Link menu item 4-45
breaking links to library block 4-45
breakpoints

setting 12-22

setting at end of block 12-25

setting at timesteps 12-25

setting on nonfinite values 12-25
setting on step-size-limiting steps 12-26
setting on zero crossings 12-26

Browser 8-22
building models

tips 7-8

Bus Editor 5-64
bus objects, editing 5-64

C

callback routines 3-83
callback routines, referencing mask

parameters in 3-85

callback tracing 3-83
Cancel button on Mask Editor 11-15
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canvas, editor 2-6
changing
signal labels font 5-48
Clear menu item 4-6
Clock block
example 10-3
CloseFcn block callback parameter 3-85
CloseFcn model callback parameter 3-84
colors for sample times 1-38
command line debugger for Embedded
MATLAB Function block 14-28
commands
undoing 2-6
CompiledSize property for Embedded
MATLAB Function block variables 14-48
complex variables in Embedded MATLAB
Function block functions 14-55
composite signals 5-9
conditional execution behavior 3-47
conditionally executed subsystem 1-11
conditionally executed subsystems 3-35
configurable subsystem 3-121
Configuration Parameters dialog box 9-37
Data Import/Export pane 9-48
Diagnostics pane 9-67
increasing Simulink Accelerator
performance 13-6
Solver pane 9-38
connecting blocks 3-14
ConnectionCallback
port callback parameters 3-87
constant sample time 1-39
context menu 2-6
continuous sample time 1-32
control flow blocks
and Stateflow 3-80
control flow diagrams
and Stateflow 3-71
compared to Stateflow 3-79
do-while 3-76

for 3-76
if-else 3-72
resetting of states 3-80
sample times 3-79
switch 3-73
while 3-75
control flow subsystem 3-35
control input 3-35
control signal 3-35 5-9
Control System Toolbox
linearization 10-5
copy
definition 4-34
Copy menu item 4-4
CopyFcn block callback parameter 3-85
copying
blocks 4-4
signal labels 5-48
Create Mask menu item 11-15
Created model parameter 3-113
Creator model parameter 3-113
Cut menu item 4-5

D

dash-dot lines 5-9
Data Import/Export pane
Configuration Parameters dialog box 9-48
data store, global 3-96
data types
displaying 6-6
propagation 6-6
specifying 6-5
dbstop if error command 11-28
dbstop if warning command 11-28
Dead Zone block
zero crossings 1-23
debugger
running incrementally 12-15
setting breakpoints 12-22
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setting breakpoints at time steps 12-25
setting breakpoints at zero crossings 12-26
setting breakpoints on nonfinite
values 12-25
setting breakpoints on step-size-limiting
steps 12-26
skipping breakpoints 12-19
starting 12-10
stepping by time steps 12-17
debugging
breakpoints in Embedded MATLAB
Function block function 14-21
display variable values in Embedded
MATLAB Function block
function 14-27
displaying Embedded MATLAB Function
block variables in MATLAB 14-28
Embedded MATLAB Function block
example 14-20
Embedded MATLAB Function block
function 14-20
operations for debugging Embedded
MATLAB functions 14-38
stepping through Embedded MATLAB
Function block function 14-22
debugging initialization commands 11-25
decimation factor
saving simulation output 9-26
Delete key
deleting blocks 4-6
deleting signal labels 5-48
DeleteFcn block callback parameter 3-85
Derivative block
linearization 10-6
Description model parameter 3-114
description of masked blocks 11-29
DestroyFcn block callback parameter 3-85
diagnosing simulation errors 9-101
Diagnostics pane
Configuration Parameters dialog box 9-67
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diagonal line segments 3-16
diagonal lines 3-14
dialog boxes

creating for masked blocks 11-32
direct feedthrough blocks 1-24
direct-feedthrough ports 4-24
disabled subsystem

output 3-37
disabling zero-crossing detection 1-22
disconnecting blocks 3-19
discrete blocks

in enabled subsystem 3-38

in triggered systems 3-43
discrete sample time 1-32
Discrete-Time Integrator block

sample time colors 1-38
discrete-time systems 1-31
discretization methods 3-118
discretizing a Simulink model 3-115
dlinmod function

extracting linear models 10-4
do-while control flow diagram 3-76
Documentation pane of Mask Editor 11-15
Dormand-Prince

pair 9-13
drawing coordinates

Autoscale 11-18

normalized 11-18

Pixel 11-19
drop shadows 4-18
duplicating blocks 4-6

E
editing
Embedded MATLAB Function block
function code 14-30
editing look-up tables 4-26
editor 2-5
canvas 2-6
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toolbar 2-5
either trigger event 3-40
Embedded MATLAB blocks
and Embedded MATLAB Language 14-1
description 14-1
Embedded MATLAB Editor
description 14-10
Embedded MATLAB Function blocks
and embedded applications 14-5
and MATLAB 14-6
and stand-alone executables 14-5
breakpoints in function 14-21
calling MATLAB functions 14-5 14-13
14-60
calling MATLAB functions with
feval 14-61
calling other functions 14-58
comment and uncomment lines 14-34
creating model with 14-7
debugging 14-20
debugging example 14-20
debugging function for 14-20
debugging operations 14-38
description 14-3
diagnostic errors 14-14
display variable value 14-27
displaying variable values in
MATLAB 14-28
Embedded MATLAB Editor 14-10 14-30
Embedded MATLAB run-time library of
functions 14-5
example model with 14-7
example program 14-9
function library 14-12
implicitly declared variables 14-12
inherite data types and sizes 14-6
inheriting variable size 14-48
input values 14-53
library of real-time functions 14-59
model explorer 14-17

multiple inputs and outputs 14-5

names and ports 14-8

output values 14-53

parameter arguments 14-51

persistent variables 14-12 14-54

Real-Time Workshop targets and calling
MATLAB functions 14-62

Real-Time Workshop targets,
building 14-62

return values from MATLAB
functions 14-62

searching and replacing in function 14-34

simulating function 14-20

sizing variables 14-46

sizing variables by expression 14-49

stepping through function 14-22

subfunctions 14-5 14-14 14-58

tiling windows in editor 14-31

typing variables 14-40

typing with other variables 14-44

undo and redo operations 14-34

variable type by inheritance 14-42

variable types 14-44

variables 14-53

variables for 14-17

variables in Model Explorer 14-53

variables, complex 14-55

variables, declaring implicitly 14-53

variables, declaring with Model
Explorer 14-53

why use them? 14-5

Embedded MATLAB Language 14-1
Embedded MATLAB run-time library

functions 14-5

Enable block

creating enabled subsystems 3-37
outputting enable signal 3-38
states when enabling 3-38

enabled subsystems 3-36

setting states 3-38
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ending Simulink session 2-25
equations
modeling 7-2
error checking
Embedded MATLAB Function
blocks 14-14
error tolerance 9-15 9-42
simulation accuracy 9-106
simulation speed 9-105
ErrorFcn block callback parameter 3-86
eval command
masked block help 11-30
examples
Clock block 10-3
continuous system 7-3
converting Celsius to Fahrenheit 7-2
equilibrium point determination 10-7
linearization 10-4
masking 11-6
multirate discrete model 1-34
Outport block 10-2
return variables 10-2
To Workspace block 10-3
Transfer Function block 7-4
execution context
defined 3-48
displaying 3-49
propagating 3-48
Exit MATLAB menu item 2-25

F

falling trigger event 3-40
Fen block

simulation speed 9-105
files

writing to 9-4
Final State check box 9-24
fixed in minor time step 1-32
fixed-point data 6-3
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fixed-step solvers
definition 1-17
Flip Block menu item 4-17
Flip Name menu item 4-20
floating Display block 9-5
floating Scope block 9-5
font
annotations 3-21
block 4-19
block names 4-19
signal labels 5-48
Font menu item
changing block name font 4-19
changing the font of a signal label 5-48
font size, setting for Model Explorer 8-3
font size, setting for Simulink dialog boxes 8-3
for control flow diagram 3-76
For Iterator block
and Assignment block 3-78
in subsystem 3-77
output iteration number 3-77
specifying number of iterations 3-77
From Workspace block
zero crossings 1-23
functions
Embedded MATLAB Function block
run-time library 14-12
fundamental sample time 9-8

G

Gain block

algebraic loops 1-24
get _param command

checking simulation status 9-108
global data store 3-96
Go To Library Link menu item 4-46
Greek letters

using in annotations 3-27
grouping blocks 3-30
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H

handles on selected object 3-4
held output of enabled subsystem 3-37
held states of enabled subsystem 3-38
Help button on Mask Editor 11-15
help text for masked blocks 11-10
Hide Name menu item

hiding block names 4-20

hiding port labels 3-34
Hide Port Labels menu item 3-33
hiding block names 4-20
hierarchy of model

advantage of subsystems 7-8

replacing virtual subsystems 1-14
Hit Crossing block

notification of zero crossings 1-21

Zero crossings

and Disable zero crossing detection
option 1-23

hybrid systems

integrating 1-41

Icon pane of Mask Editor 11-14
icons

creating for masked blocks 11-16
If block

connecting outputs 3-72

data input ports 3-72

data output ports 3-72

Zero crossings

and Disable zero crossing detection
option 1-23

if-else control flow diagram 3-72

and Stateflow 3-80
inherited sample time 1-32

inheriting Embedded MATLAB Function block

variable size 14-48

inheriting Embedded MATLAB Function
variable types 14-42
InitFcn block callback parameter 3-85
InitFcn model callback parameter 3-84
initial conditions
specifying 9-24
Initial State check box 9-25
initial states
loading 9-25
initial step size
simulation accuracy 9-106
initialization commands 11-26
debugging 11-25
Initialization pane of Mask Editor 11-14
inlining S-functions using the TLC
and Simulink Accelerator
performance 13-12
Inport block
in subsystem 3-30
linearization 10-5
supplying input to model 9-17
inputs
loading from base workspace 9-17
mixing vector and scalar 5-19
scalar expansion 5-18
to Embedded MATLAB Function
block 14-53
Integrator block
algebraic loops 1-24
example 7-3
sample time colors 1-38
simulation speed 9-106
zero crossings 1-23
invalid loops, avoiding 7-6
invalid loops, detecting 7-6
invariant constants 1-39

J

Jacobian matrices 9-14
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K

keyboard actions summary 2-21
keyboard command 11-28

L

labeling signals 5-47
labeling subsystem ports 3-33
LastModificationDate model
parameter 3-114
libinfo command 4-48
libraries, see block libraries
library blocks
breaking links to 4-45
definition 4-34
finding 4-46
getting information about 4-46
Library Browser 4-48
adding libraries to 4-51
copying blocks from 4-50
library links
creating 4-35
definition 4-34
disabling 4-36
displaying 4-47
modifying 4-37
propagating changes to 4-37
showing in Model Browser 8-23
status of 4-46
unresolved 4-36
line segments 3-15
diagonal 3-16
moving 3-16
line vertices
moving 3-17
linear models
extracting
example 10-4
linearization 10-4
lines
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branch 3-15

connecting blocks 3-11

diagonal 3-14

moving 4-6

signals carried on 9-5
links

breaking 4-45

to library block 4-35
LinkStatus block parameter 4-46
linmod function

example 10-4

LoadFcn block callback parameter 3-86

loading from base workspace 9-17
loading initial states 9-25

location of block names 4-19
logging signals 5-34

Look Under Mask menu item 11-15
Look-Up Table Editor 4-26

look-up tables, editing 4-26

loops, algebraic, see algebraic loops
loops, avoiding invalid 7-6

loops, detecting invalid 7-6

M

M-file S-functions
simulation speed 9-105
Mask Editor 11-14
mask help text 11-10
Mask Subsystem menu item 11-14
mask type
defining 11-10
mask workspace 11-28
masked blocks
block descriptions 11-10
dialog boxes
creating dynamic 11-32
setting parameters for 11-32
documentation 11-28
help text 11-10
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icons
creating 11-10
Icon pane 11-16
initialization commands 11-26
looking under 11-15
parameters
assigning values to 11-21
default values 11-25
mapping 11-6
predefined 11-33
prompts for 11-20
referencing in callbacks 3-85
showing in Model Browser 8-23
type 11-29
unmasking 11-15
masked subsystems
showing in Model Browser 8-23
Math Function block
algebraic loops 1-24
mathematical symbols
using in annotations 3-27
MATLAB
in Embedded MATLAB Function
blocks 14-13
terminating 2-25
MATLAB Fen block
simulation speed 9-105
MATLAB functions
calling in Embedded MATLAB Function
block functions 14-5
returning values from in Embedded
MATLAB Function blocks 14-62
MATLAB functions in Embedded MATLAB
Function blocks 14-60
Max step size parameter 9-40
maximum order of ode15s solver
and stability 9-42
maximum step size 9-40
mdl files 2-9
Memory block

simulation speed 9-105
memory issues 7-8
menu
context 2-6
menus 2-5
MinMax block
zero crossings 1-23
mixed continuous and discrete systems 1-41
model
editor 2-5
Model Browser 8-22
showing library links in 8-23
showing masked subsystems in 8-23
model callback parameters 3-83
model configuration preferences 8-4
model discretization
configurable subsystems 3-121
discretizing a model 3-115
overview 3-115

specifying the discretization method 3-118

starting the model discretizer 3-117
model explorer
Embedded MATLAB Function
blocks 14-17
Model Explorer
declaring variables for Embedded
MATLAB Function block
function 14-53
font size 8-3
model file name, maximum size of 2-9
model files
mdl file 2-9
model navigation commands 3-32
model parameters for version control 3-113
model verification blocks
disabling 9-66

ModelCloseFcn block callback parameter 3-86

modeling equations 7-2
modeling strategies 7-8
models
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callback routines 3-83

creating 3-3

creating change histories for 3-112

creating templates 3-3

editing 2-3

navigating 3-32

organizing and documenting 7-8

printing 2-13

properties of 3-107

saving 2-9

selecting entire 3-5

tips for building 7-8

version control properties of 3-113
ModelVersion model parameter 3-114
ModelVersionFormat model parameter 3-114
ModifiedBy model parameter 3-113
ModifiedByFormat model parameter 3-114
ModifiedComment model parameter 3-114
ModifiedDate model parameter 3-114
ModifiedDateFormat model parameter 3-114
ModifiedHistory> model parameter 3-114
Monte Carlo analysis 9-107
mouse actions summary 2-21
MoveFcn block callback parameter 3-86
multirate systems

example 1-34

NameChangeFcn block callback parameter 3-86
names

blocks 4-19

copied blocks 4-4
New Library menu item 4-34
New menu item 3-3
normalized icon drawing coordinates 11-18
numerical differentiation formula 9-14
numerical integration 1-15
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o

objects
selecting more than one 3-4
selecting one 3-4
ode113 solver
advantages 9-14
hybrid systems 1-41
Memory block
and simulation speed 9-105
ode15s solver
advantages 9-14
and stiff problems 9-105
hybrid systems 1-41
maximum order 9-42
Memory block
and simulation speed 9-105
unstable simulation results 9-106
ode23 solver 9-14
hybrid systems 1-41
ode23s solver
advantages 9-14
maximum order 9-42
simulation accuracy 9-106
ode45 solver
hybrid systems 1-41
Open menu item 2-3
OpenFcn block callback parameter
purpose 3-86
opening
Subsystem block 3-32
orientation of blocks 4-17
Outport block
example 10-2
in subsystem 3-30
linearization 10-5
output
additional 9-27
between trigger events 3-42
disabled subsystem 3-37
enable signal 3-38
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options 9-26
saving to workspace 9-22
smoother 9-26
specifying for simulation 9-27
trajectories
viewing 10-2
trigger signal 3-43
writing to file
when written 9-4
writing to workspace 9-22
when written 9-4
output ports
Enable block 3-38
Trigger block 3-43
outputs
from Embedded MATLAB Function
block 14-53

P

panning block diagrams 2-7
PaperOrientation model parameter 2-16
PaperPosition model parameter 2-16
PaperPositionMode model parameter 2-16
PaperType model parameter 2-16
parameter arguments for Embedded MATLAB
Function blocks 14-51
parameters
block 4-7
setting values of 4-8
tunable
definition 1-8
Inline parameters option 9-57
Parameters pane of Mask Editor 11-14
ParentCloseFcn block callback
parameter 3-86
Paste menu item 4-4
performance
comparing Simulink Accelerator to
Simulink 13-11

Pixel icon drawing coordinates 11-19
ports

block orientation 4-17

labeling in subsystem 3-33
PostLoadFcn model callback parameter 3-84
PostSaveFcn block callback parameter 3-87
PostSaveFcn model callback parameter 3-84
PostScript files

printing to 2-15
preferences, model configuration 8-4
PreLoadFcn model callback parameter 3-84
PreSaveFcn block callback parameter 3-86
PreSaveFcn model callback parameter 3-84
print command 2-13
Print menu item 2-13
printing to PostScript file 2-15
Priority block parameter 4-25
produce additional output option 9-27
produce specified output only option 9-27
Product block

algebraic loops 1-24
purely discrete systems 1-34

Q
Quit MATLAB menu item 2-25

Random Number block
simulation speed 9-106
Real-Time Workshop
and Simulink Accelerator 13-2
Redo menu item 2-6
reference blocks
definition 4-34
refine factor
smoothing output 9-26
Relational Operator block
zero crossings 1-23
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relative tolerance
definition 9-15
simulation accuracy 9-106
Relay block
zero crossings 1-23
reset
output of enabled subsystem 3-37
states of enabled subsystem 3-38
resizing blocks 4-17
return variables
example 10-2
reversing direction of signal flow 7-3
rising trigger event 3-40
Rosenbrock formula 9-14
Rotate Block menu item 4-17
Runge-Kutta (2,3) pair 9-14
Runge-Kutta (4,5) formula 9-13

S

sample time
backpropagating 1-38
changing during simulation 1-33
colors 1-38
constant 1-39
continuous 1-32
discrete 1-32
fixed in minor time step 1-32
fundamental 9-8
inherited 1-32
simulation speed 9-106
variable 1-33
Sample Time Colors menu item 1-39
updating coloring 3-9
sampled data systems 1-31
Saturation block
zero crossings 1-23
how used 1-21
Save As menu item 2-9
Save menu item 2-9
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Save options area 9-22
save_system command
breaking links 4-46
scalar expansion 5-18
Scope block
example of a continuous system 7-4
Select All menu item 3-5
Set Font dialog box 4-19
set_param command
breaking link 4-45
controlling model execution 13-10
running a simulation 9-2 9-107
setting simulation mode 13-10
setting breakpoints 12-22
Shampine, L. F. 9-14
Show Name menu item 4-20
show output port
Enable block 3-38
Trigger block 3-43

Show Propagated Signals menu item 5-42

showing block names 4-20
Sign block
zero crossings 1-23
Signal Builder
snap grid 5-57
Signal Builder block
zero crossings 1-23
Signal Builder dialog box 5-50
Signal Builder time range
about 5-58
changing 5-59
signal buses 5-14
signal flow through blocks 4-17
signal groups 5-49
activating 5-60
creating a custom waveform in 5-53
creating a set of 5-49
creating and deleting 5-52
creating signals in 5-52
cutting and pasting 5-53
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discrete 5-63

editing 5-50

exporting to workspace 5-59

final values 5-61

hiding waveforms 5-52

moving 5-52

renaming 5-52

renaming signals in 5-60

running all 5-60

simulating with 5-60

specifying final values for 5-61

specifying sample time of 5-63

time range of 5-58
signal labels

changing font 5-48

copying 5-48

creating 5-47

deleting 5-48

editing 5-48

moving 5-47

using to document models 7-8
signal logging, enabling 5-34
signal propagation 5-6
Signal Properties dialog box 5-38
signals

composite 5-9

simulation

accuracy 9-106
checking status of 9-108
command line 9-107
displaying information about
algebraic loops 12-30
block execution order 12-32
block I/O 12-28
debug settings 12-35
integration 12-31
nonvirtual blocks 12-34
nonvirtual systems 12-33
system states 12-31
zero crossings 12-34
Embedded MATLAB Function block
function 14-20
execution phase 1-15
parameters
specifying 9-101
running incrementally 12-15
running nonstop 12-19
speed 9-105
status bar 2-6
stepping by breakpoints 12-22
stepping by time steps 12-17
unstable results 9-106

labeling 5-47

labels 5-47

names 5-47

reversing direction of flow 7-3
setting properties 5-38
showing propagated 5-42
storage class of 5-41

virtual 5-6

Simulation Diagnostics Viewer 9-101
simulation errors
diagnosing 9-101
Simulation Options dialog box 5-61
simulation profile 13-17
simulation time
compared to clock time 9-6 9-39
writing to workspace 9-22
Simulink

signals, creating 5-3

signals, logging 5-34

sim command
comparing performance 13-11
simulating an accelerated model 13-10
syntax 9-107

ending session 2-25
icon 2-2

menus 2-5

starting 2-2
terminating 2-25
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Simulink Accelerator

blocks whose performance is not improved
by 13-7

description 13-2

how to run 13-4

Simulink profiler 13-14

using with Simulink debugger 13-9

Simulink block library, see block libraries
simulink command

starting Simulink 2-2

Simulink dialog boxes

font size 8-3

Simulink Library Browser 2-2
Simulink profiler

purpose 13-14

size of block

changing 4-17

sizing Embedded MATLAB Function block

variables by expression 14-49

sizing Embedded MATLAB Function block

variables by inheritance 14-48

sizing Embedded MATLAB Function

variables 14-46

sldebug command

starting the Simulink debugger 12-13

snap grid, Signal Builder’s 5-57
Solver pane

Configuration Parameters dialog box 9-38

solvers
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fixed-step
definition 1-17
ode113
advantages 9-14
and simulation speed 9-105
odei15s
advantages 9-14
and simulation speed 9-105
and stiff problems 9-105
maximum order 9-42
simulation accuracy 9-106

ode23 9-14
ode23s
advantages 9-14
maximum order 9-42
simulation accuracy 9-106
sorted order
displaying 4-24
Source Control menu item 3-104
speed of simulation 9-105
stairs function 1-35
Start menu item 7-3
start time 9-6 9-39
StartFcn block callback parameter 3-87
StartFcn model callback parameter 3-84
starting Simulink 2-2
starting the model discretizer 3-117
State-Space block
algebraic loops 1-24
Stateflow
and if-else control flow diagrams 3-80
and Simulink Accelerator
performance 13-6
and switch control flow diagrams 3-80
and While subsystems 3-81
compared to control flow diagrams 3-79
states
between trigger events 3-42
loading initial 9-25
when enabling 3-38
writing to workspace 9-22
status
checking simulation 9-108
status bar 2-6
Step block
zero crossings 1-23
step size
simulation speed 9-105
stiff problems 9-14
stiff systems
simulation speed 9-105
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stop time 9-6 9-39
StopFcn block callback parameter 3-87
StopFcn model callback parameter 3-84
storage class of signals
displaying 5-41
selecting 5-41
subfunctions
in Embedded MATLAB Function block
functions 14-5
in Embedded MATLAB Function
blocks 14-14
subfunctions in Embedded MATLAB Function
blocks 14-58
subsystem
atomic 1-11
conditionally executed 1-11
Subsystem block
adding to create subsystem 3-30
opening 3-32
zero crossings 1-24
Subsystem Examples block library 7-6
subsystem ports
labeling 3-33
subsystems
controlling access to 3-34
creating 3-30
displaying parent of 3-33
labeling ports 3-33
model hierarchy 7-8
opening 3-32
triggered and enabled 3-43
underlying blocks 3-32
undoing creation of 3-32
Sum block
algebraic loops 1-24
summary of mouse and keyboard actions 2-21
Switch block
zero crossings 1-24
Switch Case block

Zero crossings
and Disable zero crossing detection
option 1-24
switch control flow diagram 3-73
and Stateflow 3-80
SwitchCase block
adding cases 3-73
connecting to Action subsystem 3-73
data input 3-73

T

terminating MATLAB 2-25
terminating Simulink 2-25
terminating Simulink session 2-25
test point icons 5-44
test points 5-43
TeX commands
using in annotations 3-27
tic command
comparing performance 13-11
time interval
simulation speed 9-105
time range
of a Signal Builder block 5-58
tips for building models 7-8
To Workspace block
example 10-3
toc command
comparing performance 13-11
toolbar
editor 2-5
Transfer Fen block
algebraic loops 1-24
example 7-4
Transport Delay block
linearization 10-6
Trigger block
creating triggered subsystem 3-42
outputting trigger signal 3-43
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showing output port 3-43
triggered and enabled subsystems 3-43
triggered subsystems 3-40
triggers
control signal
outputting 3-43
either 3-40
events 3-40
falling 3-40
input 3-40
rising 3-40
type parameter 3-42
tunable parameters
definition 1-8
Inline parameters option 9-57
types of Embedded MATLAB Function
variables 14-44
typing Embedded MATLAB Function block
variables with other variables 14-44
typing Embedded MATLAB Function
variables 14-40

U

Undo menu item 2-6
UndoDeleteFcn block callback parameter 3-87
undoing commands 2-6
Unmask button on Mask Editor 11-15
unstable simulation results 9-106
Update Diagram menu item
fixing bad link 4-36
out-of-date reference block 4-38
recoloring model 3-9
updating a diagram programmatically 9-107
URL specification in block help 11-30
user
specifying current 3-104
user data 6-36
user-written S-functions
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increasing Simulink Accelerator
performance 13-6
UserData 6-36
UserDataPersistent 6-36

v

variables
creating for Embedded MATLAB Function
blocks 14-17
vector length
checking 1-14
version control model parameters 3-113
vertices
moving 3-17
viewing output trajectories 10-2
virtual blocks 4-2
virtual signals 5-6

w

web command

masked block help 11-30
while control flow diagram 3-75
While Iterator block

changing to do-while 3-76

condition input 3-75

in subsystem 3-75

initial condition input 3-75

iterator number output 3-76
While subsystem

and Stateflow 3-81
window reuse 3-33
workspace

loading from 9-17

mask 11-28

saving to 9-22

writing to

simulation terminated or
suspended 9-4
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Z enabling selectively 9-40
zero crossings zero-crossing slope method 3-36
disabled by non-double data types 6-7 Zero-Pole block
Saturation block 1-21 algebraic loops 1-24
zero-crossing detection zooming block diagrams 2-7

enabling globally 9-40
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